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1 Перед началом работы 
  

Темы данной главы: 
• Об этом руководстве 

• Код модели преобразователя 

• Средства коммуникации и протоколы 

• Дополнительная документация и источники 

 

 

1.1 Об этом руководстве 
 

 Данное руководство содержит информацию, которая поможет Вам при конфигурировании, 
запуске, эксплуатации, обслуживании, поиске и устранении неисправностей преобразователя 
Micro Motion Модели 2700. 

 

 Важно 

В данном руководстве предполагается, что преобразователь правильно установлен в полном 
соответствии с инструкцией по установке преобразователя, и что монтаж отвечает всем при-
менимым требованием безопасности. 

 

1.2 Код модели преобразователя 
 

 Для определения типа преобразователя воспользуйтесь номером модели преобразователя, 
представленного на идентификационной табличке преобразователя. 

Номер модели преобразователя имеет вид: 

2700(I/R/C/B)**A****** 

I     интегральный монтаж (преобразователь смонтирован на сенсоре) 

R     удалённый (удалённый 4-хпроводный монтаж) 

C     удалённый 9-типроводный монтаж 

B     удалённый базовый процессор с удалённым преобразователем 

A     преобразователь с платой аналоговых выходов 

 

1.3 Средства коммуникации и протоколы 

 Для связи с преобразователем используются различные средства коммуникации и протоколы. 
Вы можете использовать различные средства при различных обстоятельствах для решения 
различных задач. 
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Таблица 1-1:     Средства коммуникации, протоколы и связанная информация 

Средства ком-
муникации 

Поддерживаемые 
протоколы 

Область при-
менения 

В данном руково-
дстве 

Дополнительная инфор-
мация 

Дисплей Не применимо Базовая конфи-
гурация и запуск 

Полная информация 
для пользователя. 
См. Приложение А. 

Не применимо 

ProLink II • HART/RS-485 
• HART/Bell 202 
• Modbus/RS-485 
• Сервисный 

порт 

Полная конфи-
гурация и запуск 

Базовая информа-
ция для пользовате-
ля. См. Приложение 
В. 

Руководство пользователя 

• Устанавливается с ПО 
• На CD с документацией 

Micro Motion 
• На сайте Micro Motion 

(www.micromotion.com) 

ProLink III • HART/RS-485 
• HART/Bell 202 
• Modbus/RS-485 
• Сервисный 

порт 

Полная конфи-
гурация и запуск 

Базовая информа-
ция для пользовате-
ля. См. Приложение 
С. 

Руководство пользователя 

• Устанавливается с ПО 
• На CD с документацией 

Micro Motion 
• На сайте Micro Motion 

(www.micromotion.com) 

Коммуникатор • HART/Bell 202 Полная конфи-
гурация и запуск 

Базовая информа-
ция для пользовате-
ля. См. Приложение 
D. 

Руководство пользователя 
на сайте Micro Motion 
(www.micromotion.com) 

 

 Полезный совет 
 
Возможно использование и других средств коммуникации, предлагаемых Emerson Process 
Management, таких как AMS Suite: Intelligent Device Manager или Smart Wireless THUM™ 
Adapter. Использование AMS и Smart Wireless THUM™ Adapter не обсуждается в данном ру-
ководстве. Интерфейс AMS аналогичен интерфейсу ProLink II. Дополнительная информация о 
Smart Wireless THUM™ Adapter доступна на сайте www.micromotion.com. 

 

1.4 Дополнительная документация и источники 
 

 Micro Motion предоставляет дополнительную документацию для поддержки процессов уста-
новки и эксплуатации преобразователя. 
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Таблица 1-2:     Дополнительная документация и источники 

 Тема Документ 

 Сенсор Документация на сенсор 

 Установка преобра-
зователя 

Преобразователи Micro Motion Модели 1700 и 2700: Руководство по 
установке. 

 Установка в опас-
ных зонах 

См. разрешительную документацию, поставляемую вместе с преобра-
зователем, или загрузите соответствующую документацию с сайта 
Micro Motion www.micromotion.com. 

  

Вся документация доступна на сайте Micro Motion www.micromotion.com и на CD Micro Mo-
tion с пользовательской документацией. 
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2 Быстрый запуск 
 

  
Темы данной главы: 
• Подача питания на преобразователь 

• Проверка состояния расходомера 

• Установление коммуникации с преобразователем при запуске 

• Характеризация расходомера (при необходимости) 

• Проверка измерения расхода 

• Проверка нуля 

 

2.1 Подача питания на преобразователь 
 

 Для выполнения задач конфигурирования или запуска в эксплуатацию, а также для измерения 
переменных процесса преобразователь должен быть запитан. 

1. Убедитесь, что все крышки корпусов сенсора и преобразователя закрыты и затянуты. 

 ПРЕДУПРЕЖДЕНИЕ! 

Для предотвращения возгорания, проверьте, что все крышки и уплотнения туго за-
тянуты. Для установок в опасных зонах подача питания при отсутствующих или не-
затянутых крышках корпусов может привести к взрыву. 

 

2. Включите электропитание источника питания. 

Расходомер автоматически выполнит процедуры диагностики. В течение этого периода 
Аларм 009 будет активен. Диагностическая процедура занимает около 30 секунд. После 
того, как расходомер выполнит стартовую последовательность при включении питания, 
светодиодный индикатор состояния дисплея загорается зеленым и начинает мигать (если 
трансмиттер оборудован дисплеем). Если светодиодный индикатор состояния дисплея ве-
дёт себя по-другому, значит, присутствуют условия аларма. 

Дополнительная информация 

Несмотря на то, что вскоре после подачи питания расходомер готов принять рабочую жид-
кость, для прогрева электроники и установления температурного равновесия требуется при-
близительно десять минут. Вот почему, если это первоначальный запуск или питание отсутст-
вовало достаточно продолжительное время, обеспечьте приблизительно 10-тиминутный ин-
тервал времени для обеспечения готовности к измерениям. В течение этого десятиминутного 
периода преобразователь может демонстрировать небольшую нестабильность или неточность. 

 

2.2 Проверка состояния расходомера  
 

 Проверьте расходомер на наличие условий ошибки, требующих действий со стороны пользо-
вателя или влияющих на точность измерений. 
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Таблица 2-1:     Состояние светодиодного индикатора преобразователя 

Состояние светодио-
да (LED) 

Описание Рекомендация 

Зеленый Нет активных тревожных сообще-
ний (алармов). 

Продолжайте конфигурирование или процесс 
измерений. 

Мигающий зеленый(1) Нет активных тревожных сообще-
ний (алармов). Одно тревожное 
сообщение или более, ранее ак-
тивные, не подтверждены.  

Продолжайте конфигурирование или процесс 
измерений. Возможно подтверждение алармов. 

Желтый Одно или более подтверждённых 
тревожных сообщений  (алармов) 
низкого приоритета.  

Условия тревожного сообщения низкого при-
оритета не влияют на точность измерений и на 
значения выходов. Вы можете продолжать 
конфигурирование или процесс измерений. 
Возможны идентификация и устранение усло-
вий тревожного сообщения. 

Мигающий желтый(2) Одно или более неподтверждён-
ных тревожных сообщений (алар-
мов) низкого приоритета. 

Условия тревожного сообщения низкого при-
оритета не влияют на точность измерений и на 
значения выходов. Вы можете продолжать 
конфигурирование или процесс измерений. 
Возможны идентификация и устранение усло-
вий тревожного сообщения. Возможно также 
подтверждение алармов. 

Красный Одно или более подтверждённых 
тревожных сообщений (алармов) 
высокого приоритета 

Условия тревожного сообщения высокого при-
оритета влияют на точность измерений и на 
значения выходов. Перед продолжением устра-
ните условия тревожного сообщения. 

Мигающий красный(3) Одно или более неподтверждён-
ных тревожных сообщений (алар-
мов) высокого приоритета. 

Условия тревожного сообщения высокого при-
оритета влияют на точность измерений и на 
значения выходов. Перед продолжением устра-
ните условия тревожного сообщения. Возмож-
но также подтверждение алармов. 

 

 Дополнительная информация 

Информация о просмотре активных алармов содержится в Разделе 9.4. 

Информация о конкретных алармах и возможных способах решения проблем содержится в 
Разделе 12.2. 

 

 

 

(1) Если функция мигания светодиода выключена, то светодиод будет постоянно гореть зелёным. 

(2) Если функция мигания светодиода выключена, то светодиод будет постоянно гореть жёлтым. 

(3) Если функция мигания светодиода выключена, то светодиод будет постоянно гореть красным. 

  

 1. Подождите приблизительно 10 секунд до завершения последовательности стартовой про-
цедуры. 

Сразу после подачи питания, преобразователь выполнит процедуры диагностики и про-
верку наличия условий ошибки. В течение этого периода Аларм 009 будет активен. Он 
должен сброситься автоматически при завершении последовательности стартовой проце-
дуры. 

2. Проверьте состояние светодиодного индикатора преобразователя. 
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2.3 Установление коммуникации с преобразователем 
при запуске  

 Для всех средств коммуникации, кроме дисплея, для конфигурирования преобразователя не-
обходимо иметь активную коммуникацию с преобразователем. Для осуществления первой 
коммуникации с преобразователем следуйте следующей процедуре. 

Определите необходимый тип коммуникации и следуйте инструкции для этого типа коммуни-
кации, содержащейся в соответствующем приложении. Используйте параметры коммуникации 
по умолчанию, приведенные в приложении. 

 

 

Средство коммуникации Тип коммуникации Инструкции 

ProLink II HART/RS-485 Приложение В 

ProLink III HART/RS-485 Приложение C 

Полевой Коммуникатор HART Приложение D 

 

 Дополнительная информация 

При необходимости, возможно изменение коммуникационных параметров. 

Для изменения коммуникационных параметров при использовании ProLink II: 

• Для изменения протокола, скорости обмена, контроля чётности и количества стоповых 
битов, выберите ProLink>Configuration>RS-485. 

• Для изменения адреса, выберите ProLink>Configuration>Device 

Для изменения коммуникационных параметров при использовании ProLink III, выберите Device 
Tools>Configuration>Communications. 

Для изменения коммуникационных параметров при использовании Полевого Коммуникатора, 
выберите On-Line Menu>Configure>Manual Setup>Inputs/Outputs>Communications. 

 

 

 Важно 

При изменении коммуникационных параметров для используемого типа коммуникации, связь 
с преобразователем будет нарушена сразу после записи параметров в преобразователь. Уста-
новить коммуникацию можно, используя новые параметры. 
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2.4 Характеризация расходомера  
(при необходимости)  

Дисплей Не доступно 

ProLink II • ProLink>Configuration>Device>Sensor Type 

• ProLink>Configuration>Flow 

• ProLink>Configuration>Density 

• ProLink>Configuration>T Series 

ProLink III Device Tools>Calibration Data 

Полевой Комму-
никатор 

Configure>Manual Setup>Characterize 

 

Обзор 

При характеризации расходомера происходит настройка преобразователя под конкретные 
свойства сенсора, в паре с которым он будет работать. Параметры характеризации, также на-
зываемые параметрами калибровки, описывают чувствительность сенсора к расходу, плотно-
сти и температуре. Параметры характеризации, необходимые при конфигурировании, зависят 
от типа сенсора расходомера. Параметры характеризации для Вашего сенсора приводятся на 
сенсорной табличке и в калибровочном сертификате. 

 

Полезный совет 

Если преобразователь, базовый процессор и сенсор были заказаны вместе, то характеризация 
расходомера уже проведена на заводе. Тем не менее, необходимо проверить параметры харак-
теризации. 

 

Процедура 

1. Определите тип сенсора (Sensor Type). 

• Прямотрубный (Т-Серия) 

• С изогнутыми трубками (все сенсоры Micro Motion, кроме Т-Серии) 

2. Установите параметры характеризации расхода, включая все десятичные точки. 

• Для прямотрубных сенсоров, введите FCF (Flow Cal или Flow Calibration Factor), FTG 
и FFQ. 

• Для сенсоров с изогнутыми трубками, введите Flow Cal (Flow Calibration Factor). 

3. Установите параметры характеризации плотности. 

• Для прямотрубных сенсоров, введите D1, D2, DT, DTG, K1, K2, FD, DFQ1 и DFQ2. 

• Для сенсоров с изогнутыми трубками, введите D1, D2, TС, K1, K2 и FD. (TC иногда 
фигурирует как DT). 

 

2.4.1 Источники и форматы параметров характеризации 

 На различных сенсорных табличках параметры характеризации выглядят по-разному. На ранее 
выпускавшихся сенсорах некоторые параметры характеризации могут быть не указаны. 

  



Быстрый запуск 

Руководство по конфигурированию и применению 

 

11 

 Примеры сенсорных табличек 

Примеры сенсорных табличек приведены на следующих рисунках: 

• “Старые” сенсоры с изогнутыми трубками (все сенсоры, кроме Т-Серии): см. Рисунок 2-1 

• “Новые” сенсоры с изогнутыми трубками (все сенсоры, кроме Т-Серии): см. Рисунок 2-2 

• “Старые” прямотрубные сенсоры (сенсоры Т-Серии): см. Рисунок 2-3 

• “Новые” прямотрубные сенсоры (сенсоры Т-Серии): см. Рисунок 2-4 

 

 

Рисунок 2-1:     Табличка на “старых” сенсорах с изогнутыми трубками  
(все сенсоры, кроме Т-Серии) 

 

                             
 

Рисунок 2-2:     Табличка на “новых” сенсорах с изогнутыми трубками  
(все сенсоры, кроме Т-Серии) 
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Рисунок 2-3:     Табличка на “старых” прямотрубных сенсорах (сенсоры Т-Серии) 

 

                                   
 

Рисунок 2-4:     Табличка на “новых” прямотрубных сенсорах (сенсоры Т-Серии) 

 

                       
 

 Калибровочные коэффициенты плотности (D1, D2, K1, K2, FD, DT, TC) 

Если на табличке Вашего сенсора отсутствуют значения D1 или D2: 

• В качестве D1 используйте значение Dens A или D1 из калибровочного сертификата. Это 
значение плотности при рабочих условиях калибровочной среды низкой плотности. Micro 
Motion использует в качестве таковой- воздух. Если Вы не найдёте значений Dens A или 
D1, используйте значение 0.001 г/см3. 

• В качестве D2 используйте значение Dens В или D2 из калибровочного сертификата. Это 
значение плотности при рабочих условиях калибровочной среды высокой плотности. Mi-
cro Motion использует в качестве таковой- воду. Если Вы не найдёте значений Dens В или 
D2, используйте значение 0.998 г/см3. 

Если на табличке Вашего сенсора отсутствуют значения К1 или К2: 

• В качестве К1 используйте первые 5 цифр калибровочного коэффициента плотности. В 
примере калибровочной таблички на Рисунке 2-1, это значение показано как 12500. 

• В качестве К2 используйте вторые 5 цифр калибровочного коэффициента плотности. В 
примере калибровочной таблички на Рисунке 2-1, это значение показано как 14286. 

Если на табличке Вашего сенсора отсутствует значение FD, проконсультируйтесь с Micro Mo-
tion. 
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 Если на табличке Вашего сенсора отсутствуют значения DТ или ТС, используйте последние 3 
цифры калибровочного коэффициента плотности. В примере калибровочной таблички на Ри-
сунке 2-1, это значение показано как 4.44. 

 

Калибровочные параметры расхода (FCF, FT) 

Для описания калибровки по расходу используются два отдельных значения: 6-тизначное FCF 
и 4-хзначное FT. Оба значения содержат десятичную точку. При характеризации они вводятся 
как два значения или как одна 10-тизначная строка, включающая две десятичных точки. Это 
10-тизначное значение называется Flowcal или FCF. 

Если на калибровочной табличке Вашего сенсора значения FCF и FT показаны отдельно, а Вам 
необходимо ввести одно значение, объедините значение FCF со значением FT для получения 
одного параметра. 

Если на калибровочной табличке Вашего сенсора значения Flowcal или FCF и FT показаны объ-
единёнными, а Вам необходимо ввести значения FCF и FT отдельно, разделите их. 

• FCF = Первые 6 знаков, включая десятичную точку 

• FT  = Последние 4 знака, включая десятичную точку 

 

Пример: Объединение FCF и FT 

FCF = x.xxxx 
FT = y.yy 
Flow Calibration Parameter: x.xxxxy.yy 

 

Пример: Разделение значений Flowcal или FCF 

Flow Calibration Parameter: x.xxxxy.yy  
FCF = x.xxxx 
FT = y.yy 

 

2.5 Проверка измерения расхода 

 Убедитесь в точности выводимого преобразователем значения массового расхода. Для этого 
можно воспользоваться любым из доступных методов. 

• Прочитайте значение Mass Flow Rate на дисплее преобразователя. 

• Подключитесь к преобразователю с помощью ProLink II и прочитайте значение Mass Flow 
Rate в окне Process Variables (ProLink > Process Variables). 

• Подключитесь к преобразователю с помощью ProLink III и прочитайте значение Mass 
Flow Rate на закладке Process Variables. 

• Подключитесь к преобразователю с помощью Коммуникатора прочитайте значение Mass 
Flow Rate в меню Process Variables (On-Line Menu > Overview > Primary Purpose Variables). 

Дополнительная информация 

Если выводимое преобразователем значение массового расхода не точно: 

• Проверьте параметры характеризации. 

Просмотрите рекомендации по поиску и устранению неисправностей при измерении расхода, 
приведённые в Разделе 12.3. 

 



Быстрый запуск 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

14 

2.6 Проверка нуля  

 Проверка нуля помогает определить, соответствует ли сохраняемое значение нуля Вашей ус-
тановке, или калибровка нуля в полевых условиях может повысить точность измерения расхо-
да. 

Процедура проверки нуля анализирует значение Live Zero (“Живой Ноль”) в условиях отсут-
ствия расхода и сравнивает его с диапазоном стабильности нуля сенсора. Если среднее значе-
ние нуля находится в разумных пределах, сохраняемое в преобразователе значение нуля дей-
ствительно. Полевая калибровка нуля не повысит точности измерения расхода. 

 

2.6.1 Проверка нуля с помощью ProLink II 

 Проверка нуля помогает определить, соответствует ли сохраняемое значение нуля Вашей ус-
тановке, или калибровка нуля в полевых условиях может повысить точность измерения расхо-
да. 

 

Важно 

В большинстве случаев установленный на заводе ноль точнее, чем получаемый при калибров-
ке в полевых условиях. Не проводите калибровку нуля до тех пор, пока: 

• Установка нуля необходима по местным правилам. 

• Процедура проверки нуля выдаёт ошибку при сохраняемом значении нуля. 

Предварительные требования 

ProLink II v2.94 или новее  

Важно 

Не проводите проверку или установку нуля при активном тревожном сообщении (аларме) вы-
сокого приоритета. Устраните причину аларма, а затем проводите проверку или установку ну-
ля. Можно проводить проверку или установку нуля при активном тревожном сообщении 
(аларме) низкого приоритета. 

 

Процедура 

1. Подготовка расходомера: 

a. Обеспечьте прогрев расходомера в течение 20 минут после подачи питания. 

b. Обеспечьте поток рабочей жидкости через расходомер до достижения темпера-
туры сенсора нормальной рабочей температуры процесса. 

c. Перекройте поток через сенсор, закрыв клапан ниже по потоку, а затем – клапан 
выше по потоку (при наличии). 

d. Убедитесь в том, что отсутствует расход, и в том, что сенсор полностью запол-
нен продуктом. 

2. Выберите ProLink > Calibration > Zero Verification and Calibration > Verify Zero и дождитесь окон-
чания процедуры. 
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3. При возникновении ошибки при прохождении процедуры проверки нуля: 

a. Убедитесь в том, что отсутствует расход, и в том, что сенсор полностью заполнен 
продуктом. 

b. Убедитесь в однофазности рабочей жидкости и в отсутствии осевших частиц. 

c. Повторите процедуру проверки нуля. 

d. При повторении ошибки, проведите установку нуля расходомера. 

Инструкции по установку нуля расходомера содержатся в Разделе 11.3. 

Дополнительная информация 

Восстановите нормальный расход через сенсор, открыв клапаны. 

2.6.2 Проверка нуля с помощью ProLink III 

 Проверка нуля помогает определить, соответствует ли сохраняемое значение нуля Вашей ус-
тановке, или калибровка нуля в полевых условиях может повысить точность измерения расхо-
да. 

 

Важно 

В большинстве случаев установленный на заводе ноль точнее, чем получаемый при калибров-
ке в полевых условиях. Не проводите калибровку нуля до тех пор, пока: 

• Установка нуля необходима по местным правилам. 

• Процедура проверки нуля выдаёт ошибку при сохраняемом значении нуля. 

Предварительные требования 

ProLink III v1.0 с Patch Build 31 или новее  

Важно 

Не проводите проверку или установку нуля при активном тревожном сообщении (аларме) вы-
сокого приоритета. Устраните причину аларма, а затем проводите проверку или установку ну-
ля. Можно проводить проверку или установку нуля при активном тревожном сообщении 
(аларме) низкого приоритета. 

 

Процедура 

1. Подготовка расходомера: 

a. Обеспечьте прогрев расходомера в течение 20 минут после подачи питания. 

b. Обеспечьте поток рабочей жидкости через расходомер до достижения температуры 
сенсора нормальной рабочей температуры процесса. 

c. Перекройте поток через сенсор, закрыв клапан ниже по потоку, а затем – клапан выше 
по потоку (при наличии). 

d. Убедитесь в том, что отсутствует расход, и в том, что сенсор полностью заполнен 
продуктом. 

2. Выберите Device Tools > Device Calibration > Zero Verification and Calibration > Verify Zero и дож-
дитесь окончания процедуры. 
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3. При возникновении ошибки при прохождении процедуры проверки нуля: 

a. Убедитесь в том, что отсутствует расход, и в том, что сенсор полностью заполнен 
продуктом. 

b. Убедитесь в однофазности рабочей жидкости и в отсутствии осевших частиц. 

c. Повторите процедуру проверки нуля. 

d. При повторении ошибки, проведите установку нуля расходомера. 

Инструкции по установке нуля расходомера содержатся в Разделе 11.3. 

Дополнительная информация 

Восстановите нормальный расход через сенсор, открыв клапаны. 

2.6.3 Терминология, используемая при проверке и калибровке 
нуля 

Таблица 2-2:     Терминология, используемая при проверке и калибровке нуля 

Термин Определение 

Ноль (Zero) В общем случае, сдвиг, необходимый для синхронизации левой и правой детектор-
ных катушек в условиях отсутствия расхода. Единицы измерения = микросекунды. 

Заводской ноль  
(Factory Zero) 

Значение нуля, полученное на заводе, в лабораторных условиях. 

Ноль, установленный 
в полевых условиях 
(Field Zero) 

Значение нуля, полученное в результате калибровки вне завода. 

“Предыдущий”  ноль 
(Prior Zero) 

Значение нуля, хранящееся в преобразователе на момент начала калибровки вне за-
вода. Может быть равным заводскому нулю или “предыдущему” нулю. 

Значение Нуля  
(Manual Zero) 

Значение нуля, хранящееся в преобразователе, обычно формирующееся по результа-
там калибровки нуля. Может быть введено вручную. Также называется “механиче-
ским нулём” (“mechanical zero”) или “stored zero”. 

“Живой” ноль  
(Live Zero) 

Массовый расход в реальном масштабе времени, с учётом двунаправленного потока, 
без учёта сконфигурированных значений отсечки и демпфирования. Адаптивное зна-
чение демпфирования используется только при резком изменении массового расхода 
за короткий интервал времени. Единицы измерения = сконфигурированные единицы 
измерения мгновенного массового расхода. 

Стабильность нуля 
(Zero Stability) 

Значение, определённое в лабораторных условиях, служащее для определения ожи-
даемой погрешности сенсора. В лабораторных условиях, при отсутствии расхода, 
ожидаемый измеренный расход находится в диапазоне, определяемом стабильно-
стью нуля (0 ± Стабильность нуля). Каждая модель и типоразмер сенсора имеют своё 
значение Стабильности нуля. Статистически 95% всех точек данных должны нахо-
диться в диапазоне, определяемом стабильностью нуля. 

Калибровка нуля  
(Zero Calibration) 

Процедура, осуществляемая для определения значения нуля. 

Время калибровки 
нуля (Zero Time) 

Период времени, в течение которого проводится процедура калибровки нуля. Едини-
цы измерения = секунды. 

Полевая проверка 
нуля  (Field Verifica-
tion Zero) 

Среднее, за 3 минуты, значение “Живого“ Нуля (“Live Zero”), рассчитываемое пре-
образователем. Единицы измерения = сконфигурированные единицы измерения 
мгновенного массового расхода. 

Проверка нуля  
 (Zero Verification) 

Процедура, используемая для оценки хранящегося значения нуля и определения воз-
можности повышения точности измерений с помощью калибровки нуля. 
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Часть II 
Конфигурирование и  
ввод в эксплуатацию 
 

 

 

Темы данной части 
• Конфигурирование и ввод в эксплуатацию. Введение. 

• Конфигурирование переменных процесса 

• Конфигурирование опций и предпочтений 

• Интеграция расходомера с системой управления 

• Завершение конфигурирования 

• Установка приложения Коммерческого учёта 
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3 Конфигурирование и ввод в эксплуатацию. 
Введение 

 Темы данной главы 
• Блок-схема конфигурирования 

• Значения и диапазоны по умолчанию 

• Разрешение доступа к меню off-line дисплея 

• Снятие защиты записи конфигурации преобразователя 

• Восстановление заводской конфигурации 

 

 

3.1 Блок-схема конфигурирования 

 Приведённую ниже блок-схему можно использовать в качестве общего руководства в процессе 
конфигурирования и ввода в эксплуатацию. 

Некоторые опции могут оказаться неприменимыми к Вашей установке. При использовании 
приложения коммерческого учёта, необходимы дополнительные установки и конфигурации. 
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Таблица 3-1:     Блок-схема конфигурирования 
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3.2 Значения и диапазоны по умолчанию 

 Для просмотра значений и диапазонов по умолчанию, обратитесь к Разделу Е.1. 

3.3 Разрешение доступа к меню off-line дисплея 
Дисплей OFF-LINE MAINT > OFF-LINE CONFIG > DISPLAY 

ProLink II ProLink>Configuration>Display>Display Options 

ProLink III Device Tools>Calibration>Transmitter Display>Display Security 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Offline Variable Menu Features 

 

Обзор 

По умолчанию доступ к меню off-line дисплея разрешен. Если доступ запрещен, его необхо-
димо разрешить, чтобы использовать дисплей для конфигурирования преобразователя. 

 

Ограничение 

Вы не можете исользовать дисплей, чтобы разрешить доступ к меню off-line дисплея. Вы 
должны подключиться через другое средство коммуникации. 

 

3.4 Снятие защиты записи конфигурации 
преобразователя 

Дисплей OFF-LINE MAINT > OFF-LINE CONFIG > LOCK 

ProLink II ProLink>Configuration>Device>Enable Write Protection 

ProLink III Device Tools>Configuration>Write-Protection 

Полевой Ком-
муникатор 

Configure>Manual Setup>Info Parameters>Transmitter Info>Write Protection 

 

Обзор 

Если преобразователь защищен от записи конфигурации, то конфигурирование запрещено, и 
Вы должны разрешить его, прежде чем сможете изменять параметры конфигурации. По умол-
чанию преобразователь не защищен от записи конфигурации. 
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Полезный совет 

Защита от записи конфигурации преобразователя позволяет предотвратить случайные измене-
ния в конфигурации. Это не мешает нормальному функционированию устройства. Вы можете 
в любой момент снять защиту, выполнить необходимое конфигурирование, а затем снова 
включить защиту. 

 

3.5 Восстановление заводской конфигурации 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Device>Restore Factory Configuration 

ProLink III Device Tools>Configuration Transfer>Restore Factory Configuration 

Полевой Ком-
муникатор 

Не доступно 

 

Обзор 

Восстановление заводской конфигурации возвращает преобразователь к известной работоспо-
собной конфигурации. Это может быть полезно, если у Вас возникли проблемы во время кон-
фигурирования. 

 

Полезный совет 

Восстановление заводской конфигурации – это не широко распространенное действие. Вы 
можете связаться с Micro Motion, чтобы узнать о приоритетных способах устранения непола-
док. 
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4 Конфигурирование измерения технологических 
параметров процесса 

 

Темы данной главы 
• Конфигурирование измерения массового расхода 

• Конфигурирование измерения объёмного расхода жидкостей 

• Конфигурирование измерения стандартного объёмного расхода газов (GSV) 

• Конфигурирование параметра направления потока 

• Конфигурирование измерения плотности 

• Конфигурирование измерения температуры 

• Конфигурирование приложения измерения нефтепродуктов по API 

• Конфигурирование приложения измерения концентрации 

• Конфигурирование компенсации давления 

 

4.1 Конфигурирование измерения массового расхода 
   Параметры измерения массового расхода определяют, как измеряется массовый расход, и как 

он отображается. 

 Параметры измерения массового расхода включают: 

• Единицы измерения массового расхода 

• Демпфирование по расходу 

• Отсечки по массовому расходу 

 

4.1.1 Конфигурирование единиц измерения массового расхода 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>UNITS>MASS 

ProLink II ProLink>Configuration>Flow>Mass Flow Units 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Flow>Mass Flow Unit 

 

Обзор 

Единицы измерения массового расхода определяют единицы измерения, которые будут использо-
ваться для массового расхода. Единицы измерения для сумматора и инвентаризатора массово-
го расхода соответствуют этим единицам. 

Процедура 

Установите желаемые Единицы измерения массового расхода. 

Единицы измерения массового расхода по умолчанию- g/sec (граммы в cекунду). 
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Полезный совет 

Если желаемая Вами единица измерения недоступна, Вы можете определить специальную 
единицу измерения массового расхода. 

 

   Варианты единиц измерения массового расхода 
 Преобразрватель предоставляет стандартный набор единиц измерения для массового расхода, а 

также одну определенную пользователем специальную единицу измерения. Различные средст-
ва коммуникации могут использовать разные наименования для этих единиц. 

 

Таблица 4-1:     Варианты единиц измерения массового расхода 

Описание единиц 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Граммы в секунду G/S g/s g/s g/s 

Граммы в минуту G/MIN g/min g/min g/min 

Граммы в час G/H g/hr g/hr g/h 

Килограммы в секунду KG/S kg/s kg/s kg/s 

Килограммы в минуту KG/MIN kg/min kg/min kg/min 

Килограммы в час KG/H kg/hr kg/hr kg/h 

Килограммы в сутки KG/D kg/day kg/day kg/d 

Метрическая тонна в минуту T/MIN mTon/min mTon/min MetTon/min 

Метрическая тонна в час T/H mTon/hr mTon/hr MetTon/h 

Метрическая тонна в сутки T/D mTon/day mTon/day MetTon/d 

Фунты в секунду LB/S lbs/s lbs/s lb/s 

Фунты в минуту LB/MIN lbs/min lbs/min lb/min 

Фунты в час LB/H lbs/hr lbs/hr lb/h 

Фунты в сутки LB/D lbs/day lbs/day lb/d 

Короткие тонны (2000 фунтов) 
в минуту 

ST/MIN sTon/min sTon/min STon/min 

Короткие тонны (2000 фунтов) 
в час 

ST/H sTon/hr sTon/hr STon/h 

Короткие тонны (2000 фунтов) 
в сутки 

ST/D sTon/day sTon/day STon/d 

Длинные тонны (2240 фунтов) 
в час 

LT/H lTon/hr lTon/hr LTon/h 

Длинные тонны (2240 фунтов) 
в сутки 

LT/D lTon/day lTon/day LTon/d 

Специальные единицы SPECL special special Spcl 
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   Создание специальной единицы измерения массового расхода 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Special Units 

ProLink III Device Tools>Configuration>Process Measurement>Flow>Special Units 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Special Units>Mass Special Units 

 

Обзор 

Специальная единица измерения – это определенная пользователем единица измерения, кото-
рая позволяет отображать данные процесса, сумматора и инвентаризатора в единицах, которые 
не доступны на преобразователе. Специальная единица измерения вычисляется из сущест-
вующей единицы с помощью коэффициента преобразования. 

Примечание 

Несмотря на то, что Вы не можете создать специальную единицу измерения с помощью дис-
плея, Вы можете использовать дисплей, чтобы выбрать уже созданную единицу и просматри-
вать данные процесса в этих единицах измерения. 

 

Процедура 

1. Определить Базовую единицу массы. 

Базовая единица массы – это существующая единица измерения массы, на которой будет 
основана специальная единица. 

2. Определить Базовую единицу времени. 

Базовая единица времени – это существующая единица измерения времени, на которой бу-
дет основана специальная единица. 

3. Рассчитать коэффициент преобразования массового расхода по приведенной ниже формуле: 

a. x базовых единиц = y специальных единиц 

b. коэффициент преобразования массового расхода = x/y 

4. Ввести коэффициент преобразования массового расхода. 

5. Установить в Mass Flow Label наименование, которое Вы хотите использовать как единицу 
измерения массового расхода. 

6. Установить в Mass Total Label наименование, которое Вы хотите использовать как единицу 
измерения для сумматора и инвентаризатора массы. 

Специальная единица измерения хранится в преобразователе. Вы можете сконфигурировать 
преобразователь на использование специальной единицы измерения в любой момент. 

Пример: Создание специальной единицы измерения массового расхода 

Вы хотите измерять массовый расход в унциях в секунду (oz/sec) 

1. Установите Базовую единицу массы на Фунты (lb). 

2. Установите Базовую единицу времени на Секунды (sec). 

3. Рассчитайте коэффициент преобразования массового расхода: 

a. 1 lb/sec (фунт в секунду)= 16 oz/sec (унций в секунду) 

b. коэффициент преобразования массового расхода =  1/16 = 0.0625 
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4. Установите коэффициент преобразования массового расхода в значение 0.0625. 

5. Установите Mass Flow Label в oz/sec (унций в секунду). 

6. Установите Mass Total Label в oz (унций). 

 

4.1.2 Конфигурирование демпфирования по расходу 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Flow>Flow Damp 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements> Flow>Flow Damping 

 

Обзор 

Демпфирование помогает сгладить небольшие, резкие колебания в процессе измерений. Значе-
ние демпфирования определяет период времени (в секундах), в течение которого преобразова-
тель будет отслеживать изменения значений переменной процесса. По окончании этого перио-
да показания значений переменной процесса отразят 63% её действительного изменения. 

Процедура 

Установите для Flow Damping значение, которое Вы хотите использовать. 

Значение по умолчанию – 0.8 секунд. Диапазон зависит от типа базового процессора и устано-
вок скорости опроса (Update Rate), как показано в следующей таблице. 

 

Тип базового процессора Установки скорости  
опроса (Update Rate) 

Диапазон демпфирования по  
расходу (Flow Damping) 

Стандартный Нормальная От 0 до 51.2 секунды 

Специальная От 0 до 10.24 секунды 

Усовершенствованный Не применимо От 0 до 51.2 секунды 

 

Полезные советы 

• Высокое значение демпфирования делает выход более гладким, поскольку отображаемое 
значение будет меняться медленнее. 

• Низкое значение демпфирования делает выход более неравномерным, поскольку отобра-
жаемое значение будет меняться быстрее. 

• Сочетание высокого значения демпфирования и быстрых значительных изменений расхо-
да может привести к значительным ошибкам измерения 

• Если величина демпфирования не равна нулю, то отображаемое значение будет отставать 
от действительного, поскольку показания будут усредненными за время демпфирования. 

• Обычно, низкие значения демпфирования предпочтительнее, поскольку это сокращает 
шанс потери данных, и уменьшает временное отставание показаний от реальных измере-
ний. 

• Для газовых приложений Micro Motion рекомендует устанавливать Flow Damping на уровне 
2.56 или выше. 
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Значение демпфирования, которое Вы вводите, автоматически округляется в меньшую сторо-
ну до ближайшего допустимого значения. Допустимые значения демпфирования приведены в 
следующей таблице. 

 

Таблица 4-2:     Допустимые значения демпфирования по расходу 

Тип базового процессора Установки скорости оп-
роса (Update Rate) 

Допустимые значения демпфиро-
вания по расходу (Flow Damping) 

Стандартный Нормальная 0, 0.2, 0.4, 0.8, ... 51.2 

Специальная 0, 0.04, 0.08, 0.16, ... 10.24 

Усовершенствованный Не применимо 0, 0.2, 0.4, 0.8, … 51.2 

 

   Влияние демпфирования по расходу на измерение объёма 
 Демпфирование по расходу влияет на результаты измерений объёма жидкостей. Демпфирование 

по расходу также влияет на данные измерений стандартного объёмного расхода для газов 
(GSV). Преобразователь высчитывает объём из данных массового расхода с учётом демпфиро-
вания. 

   Взаимодействие демпфирования по расходу (Flow Damping) и доба-
вочного демпфирования (Added Damping) 

 Иногда на отображаемое значение массового расхода влияет как демпфирование по расходу, так 
и дополнительное демпфирование. 

Демпфирование по расходу определяет скорость изменения переменных расхода. Дополнительное 
демпфирование определяет скорость изменения миллиамперного выхода. Если переменная 
процесса, назначенная на миллиамерный выход (mA Output Process Variable), установлена на мас-
совый расход (Mass Flow Rate), и оба значения демпфирования Flow Damping и Added Damping  
установлены в ненулевые значения, то сначала применяется демпфирование по расходу, а за-
тем к результату этого вычисления применяется добавочное демпфирование. 

 

4.1.3 Конфигурирование отсечки по массовому расходу 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Flow>Mass Flow Cutoff 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements> Flow> Mass Flow Cutoff 

 

Обзор 

Отсечка по массовому расходу (Mass Flow Cutoff) определяет минимальное значение массового 
расхода, которое будет отображено как измеренное. Все значения массового расхода ниже от-
сечки будут отображены равными нулю. 
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Процедура 

Установите для Mass Flow Cutoff значение, которое Вы хотите использовать. 

Значение по умолчанию – 0.0 г/с или специальное значение для сенсора, установленное на за-
воде. Рекомендуемое значение равно 0.5% от максимального значения массового расхода для 
сенсора, или другое значение, ниже наибольшего ожидаемого значения. Не устанавливайте 
Mass Flow Cutoff в значение 0.0 г/с. 

 

   Влияние отсечки по массовому расходу на измерение объёма 
 Отсечка по массовому расходу не влияет на результаты измерений объёма. Объём рассчитыва-

ется из реальных данных по массе, а не из отображаемых значений. 

   Взаимодействие отсечки по массовому расходу и отсечки АО (анало-
гового выхода) 

 Отсечка по массовому расходу определяет минимальное значение массового расхода, которое 
будет отображено преобразователем. Отсечка AO определяет минимальное значение массово-
го расхода, которое будет отображено миллиамперным выходом. Если переменная процесса на 
миллиамерном выходе установлена на значение массового расхода, отображаемое на милли-
амперном выходе значение массового расхода, регулируется большим из этих значений отсеч-
ки. 

Отсечка по массовому расходу влияет на все отображаемые значения и значения, используе-
мые преобразователем (например, события, определяемые значением массового расхода). 

Отсечка аналогового выхода (AO) влияет только на значение массового расхода, отображае-
мое на миллиамперном выходе. 

Пример: Взаимодействие отсечек, если AO Cutoff меньше, чем Mass Flow Cutoff 

Конфигурация: 

• mA Output Process Variable: Mass Flow Rate 

• Frequency Output Process Variable: Mass Flow Rate 

• AO Cutoff: 10 г/с 

• Mass Flow Cutoff: 15 г/с 

Результат: Если значение массового расхода падает ниже 15 г/с, массовый расход будет ото-
бражён равным нулю, и ноль будет использован при всех внутренних вычислениях. 

Пример: Взаимодействие отсечек, если AO Cutoff больше, чем Mass Flow Cutoff 

Конфигурация: 

• mA Output Process Variable: Mass Flow Rate 

• Frequency Output Process Variable: Mass Flow Rate 

• AO Cutoff: 15 г/с 

• Mass Flow Cutoff: 10 г/с 

Результат: 

• Если значение массового расхода падает ниже 15 г/с, но не ниже10 г/с: 

-Миллиамперный выход отобразит нулевой расход 

-Частотный выход отобразит реальный расход, и реальный расход будет использован при 
всех внутренних вычислениях. 

• Если значение массового расхода падает ниже 10 г/с, оба выхода отобразят массовый рас-
ход равным нулю, и ноль будет использован при всех внутренних вычислениях. 
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4.2 Конфигурирование измерения объёмного 
расхода жидкостей 

   Параметры измерения объёмного расхода определяют, как измеряется объёмный расход жид-
костей, и как он отображается. 

 Параметры измерения объёмного расхода включают: 

• Тип объёмного расхода 

• Единицы измерения объёмного расхода 

• Отсечки по объёмному расходу 

Ограничение 

Вы не можете применять объёмный расход жидкостей и стандартный объёмный расход газов 
одновременно. Вы должны выбрать один или другой. 

 

4.2.1 Конфигурирование типа объемного расхода для приложений 
измерения расхода жидкостей 

 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Flow>Vol Flow Type>Liquid Volume 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements> GSV>Volume Flow Type>Liquid 

 

Обзор 

Тип объёмного расхода определяет, будет использоваться измерение объёмного расхода жидко-
стей или измерение стандартного объёмного расхода газов. 

Ограничение 

Если Вы используете приложение измерения нефтепродуктов, Вы должны установить Тип объ-
ёмного расхода на Жидкость. Измерение стандартного объёмного расхода газов несовместимо с 
приложением измерения нефтепродуктов. 

 

Ограничение 

Если Вы используете приложение измерения концентрации, Вы должны установить Тип объём-
ного расхода на Жидкость. Измерение стандартного объёмного расхода газов несовместимо с 
приложением измерения концентрации. 

 

Процедура 

Установите Тип объёмного расхода на Жидкость. 
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4.2.2 Конфигурирование единиц измерения объемного расхода 
 

Дисплей OFF-LINE MAINT>OFF-LINE CONFG>UNITS>VOL 

ProLink II ProLink>Configuration>Flow>Vol Flow Units 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Flow>Volume Flow Unit 

 

Обзор 

Единицы измерения объёмного расхода определяют единицы измерения, которые будут исполь-
зоваться для объёмного расхода. Единицы измерения для сумматора и инвентаризатора объ-
ёмного расхода соответствуют этим единицам. 

Предварительные требования 

Прежде чем конфигурировать Единицы измерения объёмного расхода, убедитесь, что Тип объёмно-
го расхода установлен на Жидкость. 

Процедура 

Установите желаемые Единицы измерения объёмного расхода. 

Единицы измерения объёмного расхода по умолчанию- l/sec (литры в cекунду). 

 

Полезный совет 

Если желаемая Вами единица измерения недоступна, Вы можете определить специальную 
единицу измерения объемного расхода. 

 

   Варианты единиц измерения объёмного расхода для приложений 
измерения расхода жидкостей 

 Преобразрватель предоставляет стандартный набор единиц измерения для объёмного расхода, а 
также одну определенную пользователем специальную единицу измерения. Различные средст-
ва коммуникации могут использовать разные наименования для этих единиц. 
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Таблица 4-3:     Варианты единиц измерения объемного расхода жидкостей 

Описание единиц 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Кубические футы в секунду CUFT/S ft3/sec ft3/sec Cuft/s 

Кубические футы в минуту CUF/MN ft3/min ft3/min Cuft/min 

Кубические футы в час CUFT/H ft3/hr ft3/hr Cuft/h 

Кубические футы в сутки CUFT/D ft3/day ft3/day Cuft/d 

Кубические метры в секунду M3/S m3/sec m3/sec Cum/s 

Кубические метры в минуту M3/MIN m3/min m3/min Cum/min 

Кубические метры в час M3/H m3/hr m3/hr Cum/h 

Кубические метры в сутки M3/D m3/day m3/day Cum/d 

U.S. галлоны в секунду USGPS US gal/sec US gal/sec gal/s 

U.S. галлоны в минуту USGPM US gal/min US gal/min gal/min 

U.S. галлоны в час USGPH US gal/hr US gal/hr gal/h 

U.S. галлоны в сутки USGPD US gal/d US gal/d gal/d 

Миллионы U.S. галлонов в 
сутки 

MILG/D mil US gal/day mil US gal/day MMgal/d 

Литры в секунду L/S l/sec l/sec L/s 

Литры в минуту L/MIN l/min l/min L/min 

Литры в час L/H l/hr l/hr L/h 

Миллионы литров в сутки MILL/D mil l/day mil l/day ML/d 

Английские галлоны в секунду UKGPS lmp gal/sec lmp gal/sec lmpgal/s 

Английские галлоны в минуту UKGPM lmp gal/min lmp gal/min lmpgal/min 

Английские галлоны в час UKGPH lmp gal/hr lmp gal/hr lmpgal/h 

Английские галлоны в сутки UKGPD lmp gal/day lmp gal/day lmpgal/d 

Баррели в секунду(1) BBL/S barrels/sec barrels/sec bbl/s 

Баррели в минуту(1) BBL/MN barrels/min barrels/min bbl/min 

Баррели в час(1) BBL/H barrels/hr barrels/hr bbl/h 

Баррели в сутки(1) BBL/D barrelsday barrelsday bbl/d 

Пивные баррели в секунду(2) BBBL/S Beer barrels/sec Beer barrels/sec bbl/s 

Пивные баррели в минуту(2) BBBL/MN Beer barrels/min Beer barrels/min bbl/min 

Пивные баррели в час(2) BBBL/H Beer barrels/hr Beer barrels/hr bbl/h 

Пивные баррели в сутки(2) BBBL/D Beer barrelsday Beer barrelsday bbl/d 

Специальные единицы SPECL special special Spcl 

 

 

(1) Единицы базируются на нефтяных баррелях (42 U.S. галлона). 

(2)  Единицы базируются на объёме пивных бочек (31 U.S. галлона). 
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   Создание специальной единицы измерения объёмного расхода 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Special Units 

ProLink III Device Tools>Configuration>Process Measurement>Flow>Special Units 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Special Units>Volume Special Units 

 

Обзор 

Специальная единица измерения – это определенная пользователем единица измерения, кото-
рая позволяет отображать данные процесса, сумматора и инвентаризатора в единицах, которые 
не доступны на преобразователе. Специальная единица измерения вычисляется из сущест-
вующей единицы с помощью коэффициента преобразования. 

Примечание 

Несмотря на то, что Вы не можете создать специальную единицу измерения с помощью дис-
плея, Вы можете использовать дисплей, чтобы выбрать уже созданную единицу и просматри-
вать данные процесса в этих единицах измерения. 

 

Процедура 

1. Определить Базовую единицу объёма. 

Базовая единица объёма – это существующая единица измерения объёма, на которой будет 
основана специальная единица. 

2. Определить Базовую единицу времени. 

Базовая единица времени – это существующая единица измерения времени, на которой бу-
дет основана специальная единица. 

3. Рассчитать коэффициент преобразования объёмного расхода по приведенной ниже формуле: 

a. x базовых единиц = y специальных единиц 

b. коэффициент преобразования объемного расхода = x/y 

4. Ввести коэффициент преобразования объёмного расхода. 

5. Установить в Volume Flow Label наименование, которое Вы хотите использовать как едини-
цу измерения объёмного расхода. 

6. Установить в Volume Total Label наименование, которое Вы хотите использовать как едини-
цу измерения для сумматора и инвентаризатора объёма. 

Специальная единица измерения хранится в преобразователе. Вы можете сконфигурировать 
преобразователь на использование специальной единицы измерения в любой момент. 

Пример: Создание специальной единицы измерения массового расхода 

Вы хотите измерять массовый расход в пинтах в секунду (pints/sec) 

1. Установите Базовую единицу массы на Галлон (gal). 

2. Установите Базовую единицу времени на Секунды (sec). 

3. Рассчитайте коэффициент преобразования массового расхода: 

a. 1 gal/sec (галлон в секунду)= 8 pints/sec (пинт в секунду) 

b. коэффициент преобразования объёмного расхода =  1/8 = 0.1250 
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4. Установите коэффициент преобразования объёмного расхода в значение 0.1250. 

5. Установите Volume Flow Label в pints/sec (пинт в секунду). 

6. Установите Volume Total Label в pints (пинт). 

 

4.2.3 Конфигурирование отсечки по объёмному расходу 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Flow>Vol Flow Cutoff 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements> Flow> Volume Flow Cutoff 

 

Обзор 

Отсечка по объёмному расходу (Volume Flow Cutoff) определяет минимальное значение объём-
ного расхода, которое будет отображено как измеренное. Все значения объёмного расхода ни-
же отсечки будут отображены равными нулю. 

 

Процедура 

Установите для Volume Flow Cutoff значение, которое Вы хотите использовать. 

Значение по умолчанию – 0.0 l/s (литров в секунду). Минимальный предел – ноль. Максималь-
ный предел – калибровочный коэффициент сенсора, в литрах в секунду, умноженный на 0.2. 

 

   Взаимодействие отсечки по объёмному расходу и отсечки АО (ана-
логового выхода) 

 Отсечка по объёмному расходу определяет минимальное значение объёмного расхода, которое 
будет отображено преобразователем. Отсечка AO определяет минимальное значение объёмно-
го расхода, которое будет отображено миллиамперным выходом. Если переменная процесса на 
миллиамерном выходе установлена на значение объёмного расхода, отображаемое на милли-
амперном выходе значение объёмного расхода, регулируется большим из этих значений от-
сечки. 

Отсечка по объёмному расходу влияет на оба отображаемых значения объёмного расхода и 
значения, используемые преобразователем (например, события, определяемые значением объ-
ёмного расхода). 

Отсечка аналогового выхода (AO) влияет только на значение объёмного расхода, отображае-
мое на миллиамперном выходе. 

Пример: Взаимодействие отсечек, если AO Cutoff меньше, чем Volume Flow Cutoff 

Конфигурация: 

• mA Output Process Variable: Volume Flow Rate 

• Frequency Output Process Variable: Volume Flow Rate 

• AO Cutoff: 10 л/с 

• Volume Flow Cutoff: 15 л/с 

Результат: Если значение объёмного расхода падает ниже 15 л/с, объёмный расход будет ото-
бражён равным нулю, и ноль будет использован при всех внутренних вычислениях. 
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Пример: Взаимодействие отсечек, если AO Cutoff больше, чем Volume Flow Cutoff 

Конфигурация: 

• mA Output Process Variable: Volume Flow Rate 

• Frequency Output Process Variable: Volume Flow Rate 

• AO Cutoff: 15 л/с 

• Volume Flow Cutoff: 10 л/с 

Результат: 

• Если значение объёмного расхода падает ниже 15 л/с, но не ниже10 л/с: 

-Миллиамперный выход отобразит нулевой расход 

-Частотный выход отобразит реальный расход, и реальный расход будет использован при 
всех внутренних вычислениях. 

• Если значение объёмного расхода падает ниже 10 л/с, оба выхода отобразят объёмный 
расход равным нулю, и ноль будет использован при всех внутренних вычислениях. 

 

4.3 Конфигурирование измерения стандартного 
объёмного расхода газов (GSV) 

   Параметры измерения стандартного объёмного расхода газов (GSV) определяют, как измеря-
ется стандартный объёмный расход газа, и как он отображается. 

 Параметры измерения объёмного расхода включают: 

• Тип объёмного расхода 

• Стандартная плотность газов 

• Единицы измерения стандартного объёмного расхода газов 

• Отсечки по стандартному объёмному расходу газов 

Ограничение 

Вы не можете применять объёмный расход жидкостей и стандартный объёмный расход газов 
одновременно. Вы должны выбрать один или другой. 

 

4.3.1 Конфигурирование типа объемного расхода для приложений 
измерения расхода газов 

 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Flow>Vol Flow Type 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements> GSV>Volume Flow Type>Standard Gas Volume 
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Обзор 

Тип объёмного расхода определяет, будет использоваться измерение объёмного расхода жидко-
стей или измерение стандартного объёмного расхода газов. 

Ограничение 

Если Вы используете приложение измерения нефтепродуктов, Вы должны установить Тип объ-
ёмного расхода на Жидкость. Измерение стандартного объёмного расхода газов несовместимо с 
приложением измерения нефтепродуктов. 

 

Ограничение 

Если Вы используете приложение измерения концентрации, Вы должны установить Тип объём-
ного расхода на Жидкость. Измерение стандартного объёмного расхода газов несовместимо с 
приложением измерения концентрации. 

 

Процедура 

Установите Тип объёмного расхода на Стандартный объем газа. 

 

4.3.2 Конфигурирование стандартной плотности газов 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Flow>Std Gas Density 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>GSV>Gas Ref Density 

 

Обзор 

Значение Стандартной плотности газов используется для перевода результатов измерений расхо-
да в стандартные значения. 

Предварительные требования 

Убедитесь, что установлены те Единицы измерения плотности, которыми Вы хотите использовать 
для Стандартной плотности газов. 

Процедура 

Установите Стандартную плотность газов в стандартное значение для газа, который Вы меряете. 

 

Примечание 

ProLink II и ProLink III предоставляют пошаговую инструкцию, которую можно использовать, 
чтобы рассчитать стандартную плотность Вашего газа, если Вы ее не знаете. 
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4.3.3 Конфигурирование единиц измерения стандартного 
объемного расхода газа 

 

Дисплей OFF-LINE MAINT>OFF-LINE CONFG>UNITS>GSV 

ProLink II ProLink>Configuration>Flow>Std Gas Vol Flow Units 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>GSV>GSV Flow Unit 

 

Обзор 

Единицы измерения стандартного объёмного расхода газа определяют единицы измерения, которые 
будут использоваться для стандартного объёмного расхода газа. Единицы измерения для сум-
матора и инвентаризатора стандартного объёмного расхода газа соответствуют этим едини-
цам. 

Предварительные требования 

Прежде чем конфигурировать Единицы измерения стандартного объёмного расхода газа, убедитесь, 
что Тип объёмного расхода установлен на Стандартный объем газа. 

Процедура 

Установите желаемые Единицы измерения стандартного объёмного расхода газа. 

Единицы измерения стандартного объёмного расхода газа по умолчанию - SCFM (стандартный ку-
бический фут в минуту). 

 

Полезный совет 

Если желаемая Вами единица измерения недоступна, Вы можете определить специальную 
единицу измерения стандартного объемного расхода газа. 

 

   Варианты единиц измерения стандартного объёмного расхода газа 
 Преобразователь предоставляет стандартный набор единиц измерения для стандартного объём-

ного расхода газа, а также одну определенную пользователем специальную единицу измерения. 
Различные средства коммуникации могут использовать разные наименования для этих единиц. 
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Таблица 4-4:     Варианты единиц измерения стандартного объёмного расхода газа 

Описание единиц 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Нормальные кубические мет-
ры в секунду 

NM3/S Nm3/sec Nm3/sec Не применимо 

Нормальные кубические мет-
ры в минуту 

NM3/MN Nm3/min Nm3/min Не применимо 

Нормальные кубические мет-
ры в час 

NM3/H Nm3/hr Nm3/hr Не применимо 

Нормальные кубические мет-
ры в сутки 

NM3/D Nm3/day Nm3/day Не применимо 

Нормальные литры в секунду NLPS NLPS NLPS Не применимо 
Нормальные литры в минуту NLPM NLPM NLPM Не применимо 
Нормальные литры в час  NLPH NLPH NLPH Не применимо 
Нормальные литры в сутки NLPD NLPD NLPD Не применимо 
Стандартные кубические футы 
в секунду 

SCFS SCFS SCFS Не применимо 

Стандартные кубические футы 
в минуту 

SCFM SCFM SCFM Не применимо 

Стандартные кубические футы 
в час 

SCFH SCFH SCFH Не применимо 

Стандартные кубические футы 
в сутки 

SCFD SCFD SCFD Не применимо 

Стандартные кубические мет-
ры в секунду 

SM3/S Sm3/S Sm3/S Не применимо 

Стандартные кубические мет-
ры в минуту 

SM3/MIN Sm3/min Sm3/min Не применимо 

Стандартные кубические мет-
ры в час 

SM3/H Sm3/hr Sm3/hr Не применимо 

Стандартные кубические мет-
ры в сутки 

SM3/D Sm3/dat Sm3/dat Не применимо 

Стандартные литры в секунду SLPS SLPS SLPS Не применимо 
Стандартные литры в минуту SLPM SLPM SLPM Не применимо 
Стандартные литры в час SLPH SLPHr SLPHr Не применимо 
Стандартные литры в сутки SLPD SLPD SLPD Не применимо 
Специальные единицы SPECL special special Special 

 

   Создание специальной единицы измерения стандартного объёмного 
расхода газа 

 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Special Units 

ProLink III Device Tools>Configuration>Process Measurement>Flow>Special Units 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Special Units>Special GSV Units 
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Обзор 

Специальная единица измерения – это определенная пользователем единица измерения, кото-
рая позволяет отображать данные процесса, сумматора и инвентаризатора в единицах, которые 
не доступны на преобразователе. Специальная единица измерения вычисляется из сущест-
вующей единицы с помощью коэффициента преобразования. 

Примечание 

Несмотря на то, что Вы не можете создать специальную единицу измерения с помощью дис-
плея, Вы можете использовать дисплей, чтобы выбрать уже созданную единицу и просматри-
вать данные процесса в этих единицах измерения. 

 

Процедура 

1. Определить Базовую единицу стандартного объёма газа. 

Базовая единица стандартного объёма газа – это существующая единица измерения стан-
дартного объёма газа, на которой будет основана специальная единица. 

2. Определить Базовую единицу времени. 

Базовая единица времени – это существующая единица измерения времени, на которой бу-
дет основана специальная единица. 

3. Рассчитать коэффициент преобразования стандартного объёмного расхода газа по приведенной 
ниже формуле: 

a. x базовых единиц = y специальных единиц 

b. коэффициент преобразования стандартного объёмного расхода газа = x/y 

4. Ввести коэффициент преобразования стандартного объёмного расхода газа. 

5. Установить в Gas Standard Volume Flow Label наименование, которое Вы хотите использовать 
как единицу измерения стандартного объёмного расхода газа. 

6. Установить в Gas Standard Volume Total Label наименование, которое Вы хотите использовать 
как единицу измерения для сумматора и инвентаризатора объёма. 

Специальная единица измерения хранится в преобразователе. Вы можете сконфигурировать 
преобразователь на использование специальной единицы измерения в любой момент. 

Пример: Создание специальной единицы измерения массового расхода 

Вы хотите измерять массовый расход в тысячах стандартных кубических футов в минуту 
(KSCFM) 

1. Установите Базовую единицу стандартного объема газа на стандартные кубические футы (SCF). 

2. Установите Базовую единицу времени на Минуты (min). 

3. Рассчитайте коэффициент преобразования массового расхода: 

a. 1 KSCFM (тысяча стандартных кубических футов в минуту)= 1000 SCFM (стандартных 
кубических футов в минуту) 

b. коэффициент преобразования объёмного расхода =  1/1000 = 0.001 

4. Установите коэффициент преобразования стандартного объёмного расхода газа в значение 
0.001. 

5. Установите Volume Flow Label в KSCFM (тысячи стандартных кубических футов в минуту). 

6. Установите Volume Total Label в KSCF (тысячи стандартных кубических футов). 
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4.3.4 Конфигурирование отсечки по стандартному объёмному 
расходу газа 

 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Flow>Std Gas Vol Flow Cutoff 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements> GSV> GSV Cutoff 

 

Обзор 

Отсечка по стандартному объёмному расходу газа (Gas Standard Volume Flow Cutoff) определяет 
минимальное значение стандартного объёмного расхода газа, которое будет отображено как 
измеренное. Все значения стандартного объёмного расхода газа ниже отсечки будут отобра-
жены равными нулю. 

 

Процедура 

Установите для Gas Standard Volume Flow Cutoff значение, которое Вы хотите использовать. 

Значение по умолчанию – 0.0. Минимальный предел – ноль. Максимального предела нет.  

 

   Взаимодействие отсечки по стандартному объёмному расходу газа и 
отсечки АО (аналогового выхода) 

 Отсечка по стандартному объёмному расходу газа определяет минимальное значение стан-
дартного объёмного расхода газа, которое будет отображено преобразователем. Отсечка AO 
определяет минимальное значение стандартного объёмного расхода газа, которое будет ото-
бражено миллиамперным выходом. Если переменная процесса на миллиамерном выходе уста-
новлена на значение стандартного объёмного расхода газа, отображаемое на миллиамперном 
выходе значение стандартного объёмного расхода газа, регулируется большим из этих значе-
ний отсечки. 

Отсечка по стандартному объёмному расходу газа влияет на оба отображаемых значения объ-
ёмного расхода и значения, используемые преобразователем (например, события, определяе-
мые значением стандартного объёмного расхода газа). 

Отсечка аналогового выхода (AO) влияет только на значение стандартного объёмного расхода 
газа, отображаемое на миллиамперном выходе. 

Пример: Взаимодействие отсечек, если AO Cutoff меньше, чем Gas Standard Volume Flow 
Cutoff 

Конфигурация: 

• mA Output Process Variable для первичного миллиамперного выхода: Gas Standard Volume 
Flow Rate 

• Frequency Output Process Variable: Gas Standard Volume Flow Rate 

• AO Cutoff для первичного миллиамперного выхода: 10 SLPM (стандартных литров в ми-
нуту) 

• Gas Standard Volume Flow Cutoff: 15 SLPM (стандартных литров в минуту) 

Результат: Если значение стандартного объёмного расхода газа падает ниже 15 SLPM, стан-
дартный объёмный расход газа будет отображён равным нулю, и ноль будет использован при 
всех внутренних вычислениях. 
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Пример: Взаимодействие отсечек, если AO Cutoff больше, чем Gas Standard Volume Flow 
Cutoff 

Конфигурация: 

• mA Output Process Variable для первичного миллиамперного выхода: Gas Standard Volume 
Flow Rate 

• Frequency Output Process Variable: Gas Standard Volume Flow Rate 

• AO Cutoff для первичного миллиамперного выхода: 15 SLPM (стандартных литров в ми-
нуту) 

• Gas Standard Volume Flow Cutoff: SLPM (стандартных литров в минуту) 

Результат: 

• Если значение стандартного объёмного расхода газа падает ниже 15 SLPM, но не ниже10 
SLPM: 

-Миллиамперный выход отобразит нулевой расход 

-Частотный выход отобразит реальный расход, и реальный расход будет использован при 
всех внутренних вычислениях. 

• Если значение стандартного объёмного расхода газа падает ниже 10 SLPM, оба выхода 
отобразят стандартный объёмный расход равным нулю, и ноль будет использован при 
всех внутренних вычислениях. 

 

4.4 Конфигурирование параметра направления 
потока 

 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Flow>Flow Direction 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Flow>Flow Direction 

 

Обзор 

Параметр Flow Direction (направление потока) определяет, каким образом прямой поток и об-
ратный поток влияют на измерения и их отображение. 

Параметр Flow Direction (направление потока) определяется соответственно направлению стрел-
ки изображенной на сенсоре. 

• Прямой (положительный) поток движется в направлении стрелки, изображенной на сен-
соре.  

• Обратный (отрицательный) поток движется в направлении, противоположном изобра-
женной на сенсоре стрелке. 

Полезный совет 

Сенсоры Micro Motion двунаправленные. Точность измерений не зависит от реального направ-
ления потока и установок параметра направления потока. 

Процедура 

Установите параметр Flow Direction (направление потока) в значение, которое Вы хотите ис-
пользовать. 
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4.4.1 Варианты параметра направления потока 
Таблица 4-5:     Варианты параметра направления потока 

Установки параметра направления потока 
Отношение к стрелке, указывающей  

направление потока на сенсоре ProLink II ProLink III Полевой Комму-
никатор 

Прямой 
Forward 

Прямой 
Forward 

Прямой 
Forward 

Применяется, если стрелка, указывающая на-
правление потока на сенсоре, совпадает с реаль-
ным направлением потока. 

Обратный 
Reverse 

Обратный 
Reverse 

Обратный 
Reverse 

Применяется, если стрелка, указывающая на-
правление потока на сенсоре, противоположна 
реальному направлению потока. 

Абсолютное 
значение 
Absolute value 

Абсолютное 
значение 
Absolute value 

Абсолютное 
значение 
Absolute value 

Направление потока по отношению к стрелке не 
имеет значения. 

Двунаправленный 
Bidirectional 

Двунаправленный 
Bidirectional 

Двунаправленный 
Bi-directional 

Применяется, если ожидается как прямой, так и 
обратный поток, и прямой будет преобладать, но 
величина обратного будет значительной. 

Инвертированный 
прямой 
Negate Forward 

Инвертированный 
прямой 
Negate Forward 

Инвертированный 
прямой 
Negate/Forward 
Only 

Применяется, если стрелка, указывающая на-
правление потока на сенсоре, противоположна 
реальному направлению потока. 

Инвертированный 
двунаправленный 
Negate  
Bidirectional 

Инвертированный 
двунаправленный 
Negate  
Bidirectional 

Инвертированный 
двунаправленный 
Negate/ 
Bi-directional 

Применяется, если ожидается как прямой, так и 
обратный поток, и обратный будет преобладать, 
но величина прямого будет значительной. 

 

   Влияние направления потока на миллиамперные выходы 

 Параметр Flow Direction (направление потока) влияет на то, как преобразователь отображает 
значения потока на миллиамперных выходах. Параметр направления потока влияет на милли-
амперные выходы, только если переменная процесса на миллиамерном выходе установлена на 
значение переменной расхода. 

Направление потока и миллиамперные выходы 

Влияние параметра Flow Direction (направление потока) на миллиамперные выходы зависит от 
Lower Range Value (нижней границы диапазона), сконфигурированной для миллиамперного вы-
хода: 

• Если нижняя граница диапазона установлена на 0, см. Рисунок 4-1 

• Если нижняя граница диапазона установлена на отрицательное значение, см. Рисунок 
4-2 
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Рисунок 4-1:     Влияние направления потока на миллиамперный выход: нижняя граница диапазона = 0 

 
• Нижняя граница диапазона (Lower Range Value) = 0 

• Верхняя граница диапазона (Upper Range Value) = x 

 

Рисунок 4-2:     Влияние направления потока на миллиамперный выход: нижняя граница диапазона < 0 

 
• Нижняя граница диапазона (Lower Range Value) = – x 

• Верхняя граница диапазона (Upper Range Value) = x 

 

Пример: Параметр направления потока = прямой, нижняя граница диапазона = 0 

Конфигурация: 

• Направление потока = прямой 

• Нижняя граница диапазона (Lower Range Value) = 0 г/с 

• Верхняя граница диапазона (Upper Range Value) = 100 г/с 
Результат: 

• В условиях обратного потока или нулевого расхода, величина миллиамперного выхода 
равна 4 мА.  

• В условиях прямого потока вплоть до 100 г/с, величина миллиамперного выхода варьиру-
ется от 4 до 20 мА, пропорционально величине расхода. 

• В условиях прямого потока, если величина потока равна или превышает 100 г/с, величина 
миллиамперного выхода пропорциональна величине расхода до 20.5 мА, и равна 20.5 мА 
при более высоких значениях расхода. 
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Пример: Параметр направления потока = прямой, нижняя граница диапазона < 0 

Конфигурация: 

• Направление потока = прямой 

• Нижняя граница диапазона (Lower Range Value) = – 100 г/с 

• Верхняя граница диапазона (Upper Range Value) = + 100 г/с 
Результат: 

• В условиях нулевого расхода, величина миллиамперного выхода равна 12 мА.  

• В условиях прямого потока, при величине потока от 0 до + 100 г/с, величина миллиампер-
ного выхода варьируется от 12 до 20 мА, пропорционально (абсолютной) величине расхо-
да. 

• В условиях прямого потока, если (абсолютная) величина потока равна или превышает 
100 г/с, величина миллиамперного выхода пропорциональна величине расхода до 20.5 мА, 
и равна 20.5 мА при более высоких значениях расхода. 

• В условиях обратного потока, при величине потока от 0 до – 100 г/с, величина миллиам-
перного выхода варьируется от 4 до 12 мА, обратнопропорционально абсолютной вели-
чине расхода. 

• В условиях обратного потока, если абсолютная величина потока равна или превышает 
100 г/с, величина миллиамперного выхода обратнопропорциональна величине расхода до 
3.8 мА, и равна 3.8 мА при более высоких абсолютных значениях расхода. 

 

Пример: Параметр направления потока = прямой, нижняя граница диапазона < 0 

Конфигурация: 

• Направление потока = обратный 

• Нижняя граница диапазона (Lower Range Value) = 0 г/с 

• Верхняя граница диапазона (Upper Range Value) = 100 г/с 
Результат: 

• В условиях прямого потока или нулевого расхода, величина миллиамперного выхода рав-
на 4 мА.  

• В условиях обратного потока, при величине потока от 0 до + 100 г/с, величина миллиам-
перного выхода варьируется от 12 до 20 мА, пропорционально абсолютной величине рас-
хода. 

• В условиях обратного потока, если величина потока равна или превышает 100 г/с, величи-
на миллиамперного выхода пропорциональна абсолютной величине расхода до 20.5 мА, и 
равна 20.5 мА при более высоких абсолютных значениях расхода. 
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   Влияние направления потока на частотные выходы 

 Параметр Flow Direction (направление потока) влияет на то, как преобразователь отображает 
значения потока на частотных выходах. Параметр направления потока влияет на частотные 
выходы, только если переменная процесса на миллиамерном выходе установлена на значение 
переменной расхода. 

Таблица 4-6:     Влияние параметра направления потока и реального направления потока 
на частотные выходы 

Установки параметра 
направления потока 

Реальное направление потока 

Прямой Нулевой Обратный 

Прямой 
Forward 

Hz > 0 0 Hz(Гц) 0 Hz(Гц) 

Обратный 
Reverse 

0 Hz(Гц) 0 Hz(Гц) Hz > 0 

Двунаправленный 
Bidirectional  

Hz > 0 0 Hz(Гц) Hz > 0 

Абсолютное 
значение 
Absolute value 

Hz > 0 0 Hz(Гц) Hz > 0 

Инвертированный прямой 
Negate Forward 

0 Hz(Гц) 0 Hz(Гц) Hz > 0 

Инвертированный двуна-
правленный 
Negate Bidirectional 

Hz > 0 0 Hz(Гц) Hz > 0 

 

   Влияние направления потока на дискретные выходы 

 Параметр Flow Direction (направление потока) влияет на дискретные выходы, только если ис-
точник для дискретного выхода установлен на значение направления потока. 

Таблица 4-7:     Влияние параметра направления потока и реального направления потока 
на дискретные выходы 

Установки параметра 
направления потока 

Реальное направление потока 

Прямой Нулевой Обратный 

Прямой 
Forward 

OFF OFF ON 

Обратный 
Reverse 

OFF OFF ON 

Двунаправленный 
Bidirectional  

OFF OFF ON 

Абсолютное 
значение 
Absolute value 

OFF OFF OFF 

Инвертированный прямой 
Negate Forward 

ON OFF OFF 

Инвертированный двуна-
правленный 
Negate Bidirectional 

ON OFF OFF 
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   Влияние направления потока на цифровые средства коммуникации 

 Параметр Flow Direction (направление потока) влияет на то, как отображаются значения потока 
на цифровых средствах коммуникации. 

Таблица 4-8:     Влияние параметра направления потока и реального направления потока 
на значения потока на цифровых средствах коммуникации 

Установки параметра 
направления потока 

Реальное направление потока 

Прямой Нулевой Обратный 

Прямой Forward Положительный 0 Отрицательный 

Обратный Reverse Положительный 0 Отрицательный 

Двунаправленный 
Bidirectional  

Положительный 0 Отрицательный 

Абсолютное значение 
Absolute value 

Положительный 0 Положительный 

Инвертированный прямой 
Negate Forward 

Отрицательный 0 Положительный 

Инвертированный двуна-
правленный 
Negate Bidirectional 

Отрицательный 0 Положительный 

 

   Влияние направления потока на сумматоры 

 Параметр Flow Direction (направление потока) влияет на то, как считаются сумматоры и инвен-
таризаторы. 

Таблица 4-9:     Влияние параметра направления потока и реального направления потока 
на сумматоры и инвентаризаторы 

Установки параметра 
направления потока 

Реальное направление потока 

Прямой Нулевой Обратный 

Прямой Forward Увеличиваются Не изменяются Не изменяются 

Обратный Reverse Не изменяются Не изменяются Увеличиваются 

Двунаправленный 
Bidirectional  

Увеличиваются Не изменяются Уменьшаются 

Абсолютное значение 
Absolute value 

Увеличиваются(3) Не изменяются Увеличиваются 

Инвертированный прямой 
Negate Forward 

Не изменяются Не изменяются Увеличиваются 

Инвертированный двуна-
правленный 
Negate Bidirectional 

Уменьшаются Не изменяются Увеличиваются 

 

4.5 Конфигурирование измерения плотности 
   Параметры измерения плотности определяют, как измеряется плотность, и как она отобража-

ется. Измерение плотности (вместе с измерением массового расхода) используется для опре-
деления объёмного расхода жидкости. 

 

 

(3) Справьтесь с битом состояния цифровой связи, для индикации положительного или отрицательного расхода. 
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 Параметры измерения плотности включают: 

• Единицы измерения плотности 

• Параметры пробкового течения (Slug Flow) 

• Демпфирование по плотности 

• Отсечки по плотности 

 

4.5.1 Конфигурирование единиц измерения плотности 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>UNITS>DENS 

ProLink II ProLink>Configuration>Density>Density Units 

ProLink III Device Tools>Configuration>Process Measurement>Density 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements> Density>Density Unit 

 

Обзор 

Единицы измерения плотности определяют единицы измерения, которые будут использоваться 
для плотности. 

Процедура 

Установите желаемые Единицы измерения плотности. 

Единицы измерения плотности по умолчанию- g/cm3 (граммы на кубический сантиметр). 

   Варианты единиц измерения плотности 
 Преобразователь предоставляет стандартный набор единиц измерения плотности. Различные 

средства коммуникации могут использовать разные наименования для этих единиц. 

Таблица 4-10:     Варианты единиц измерения плотности 

Описание единиц 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Плотность по отношению к 
плотности воды (без темпера-
турной коррекции) 

SGU SGU SGU SGU 

Граммы на кубический санти-
метр 

G/CM3 g/cm3 g/cm3 g/Cucm 

Граммы на литр G/L g/l g/l g/L 

Граммы на миллилитр G/ML g/ml g/ml g/mL 

Килограммы на литр KG/L kg/l kg/l kg/L 

Килограммы на кубический 
метр 

KG/M3 kg/m3 kg/m3 kg/Cum 

Фунтов на галлон LB/GAL lbs/Usgal lbs/Usgal lb/gal 

Фунтов на кубический фунт LB/CUF lbs/ft3 lbs/ft3 lb/Cuft 

Фунтов на кубический дюйм LB/CUI lbs/in3 lbs/in3 lb/Culn 

Градусы API D API degAPI degAPI degAPI 

Коротких тонн на кубический 
ярд 

ST/CUY sT/yd3 sT/yd3 STon/Cuyd 
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4.5.2 Конфигурирование параметров пробкового течения 
Дисплей Не доступно 

ProLink II • ProLink>Configuration>Density>Slug High Limit 

• ProLink>Configuration>Density>Slug Low Limit 

• ProLink>Configuration>Density>Slug Duration 

ProLink III Device Tools>Configuration>Process Measurement>Density 

Полевой Ком-
муникатор 

• Configure>Manual Setup>Measurements>Density>Slug High Limit 

• Configure>Manual Setup>Measurements>Density>Slug Low Limit 

• Configure>Manual Setup>Measurements>Density>Slug Duration 

 

Обзор 

Параметры пробкового течения определяют, как преобразователь выявляет и отображает 
двухфазный поток (газ в потоке жидкости или жидкость в газовом потоке). 

Процедура 

1. Установите Slug Low Limit (Нижний предел пробкового течения) в наименьшее значение плотно-
сти, которое считается нормальным для Вашего процесса. 

При значениях ниже этого, преобразователь будет запускать сконфигурированные для 
пробкового течения действия. Обычно, это самая низкая точка диапазона плотности Ваше-
го процесса. 

 

Полезный совет 

Вовлечение газа может повлечь временное понижение плотности Вашего процесса. Чтобы 
снизить частоту появления тревожных сообщений о незначительных для Вашего процесса 
пробковых течениях, установите нижний предел пробкового течения немного ниже наимень-
шей ожидаемой плотности процесса. 

 

Нижний предел пробкового течения должн вводиться в g/cm3 (г/см3), даже если Вы сконфи-
гурировали другие единицы для измерения плотности. 

Значение Нижнего предела пробкового течения по умолчанию 0.0 g/cm3 (г/см3). Диапазон  от 
0.0 до 10.0 g/cm3 (г/см3). 

2. Установите Slug High Limit (Верхний предел пробкового течения) в наибольшее значение плот-
ности, которое считается нормальным для Вашего процесса. 

При значениях выше этого, преобразователь будет запускать сконфигурированные для 
пробкового течения действия. Обычно, это самая высокая точка диапазона плотности Ва-
шего процесса. 

 

Полезный совет 

Чтобы снизить частоту появления тревожных сообщений о незначительных для Вашего 
процесса пробковых течениях, установите верхний предел пробкового течения немного выше 
наибольшей ожидаемой плотности процесса. 

 

Верхний предел пробкового течения должн вводиться в g/cm3 (г/см3), даже если Вы сконфи-
гурировали другие единицы для измерения плотности. 

Значение Верхнего предела пробкового течения по умолчанию 5.0 g/cm3 (г/см3). Диапазон  от 
0.0 до 10.0 g/cm3 (г/см3). 

  



Конфигурирование измерения технологических параметров процесса 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

48 

3. Установите для Slug Duration (Длительность пробкового течения) количество секунд, в течение 
которых преобразователь будет ожидать окончания условий пробкового течения, прежде 
чем запустит сконфигурированные для пробкового течения действия. 

Значение Длительности пробкового течения по умолчанию 0.0 секунд. Диапазон от 0.0 до 60.0 
секунд. 

 

Выявление и отображение пробкового течения 
Пробковое течение обычно используется как индикатор двухфазного потока (газ в потоке 
жидкости или жидкость в газовом потоке). Двухфазный поток может вызвать ряд проблем с 
контролем процесса. Сконфигурировав параметры пробкового течения подходящим для ваше-
го приложения образом, Вы можете выявить условия процесса, которые необходимо коррек-
тировать. 

 

Полезный совет 

Чтобы снизить частоту появления тревожных сообщений, снизьте нижний предел пробкового 
течения или повысьте верхний предел пробкового течения. 

 

Условия пробкового течения возникают, когда измеряемая плотность становится ниже нижнего 
предела пробкового течения или выше верхнего предела пробкового течения. Если это происходит: 

Тревожное сообщение о пробковом течении появляется в активной строке тревожных сообще-
ний. 

Все выходы, сконфигурированные показывать значения параметров потока, в течение Длитель-
ности пробкового течения показывают последние значения, которые были до возникновения 
пробкового течения. 

Если условия пробкового течения исчезают до истечения Длительности пробкового течения: 

Выходы, показывающие значения параметров потока, снова показывают действительные дан-
ные. 

Тревожное сообщение о пробковом течении деактивируется, но остается в активной строке 
тревожных сообщений, пока не будет подтверждено. 

Если условия пробкового течения не исчезают до истечения Длительности пробкового течения, 
выходы, показывающие значения параметров потока, покажут нулевой поток. 

Если Длительность пробкового течения установлена на 0.0 секунд, то выходы, показывающие 
значения параметров потока, покажут нулевой поток, как только будет выявлено пробковое 
течение. 

 

4.5.3 Конфигурирование демпфирования по плотности 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Density>Density Damping 

ProLink III Device Tools>Configuration>Process Measurement>Density 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Density>Density Damping 
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Обзор 

Демпфирование помогает сгладить небольшие, резкие колебания в процессе измерений. Значе-
ние демпфирования определяет период времени (в секундах), в течение которого преобразова-
тель будет отслеживать изменения значений переменной процесса. По окончании этого перио-
да показания значений переменной процесса отразят 63% её действительного изменения. 

Процедура 

Установите для Density Damping значение, которое Вы хотите использовать. 

Значение по умолчанию – 1.6 секунд. Диапазон зависит от типа базового процессора и устано-
вок скорости опроса (Update Rate), как показано в следующей таблице. 

 

Тип базового процессора Установки скорости  
опроса (Update Rate) 

Диапазон демпфирования по  
Плотности (Density Damping) 

Стандартный Нормальная От 0 до 51.2 секунды 

Специальная От 0 до 10.24 секунды 

Усовершенствованный Не применимо От 0 до 40.96 секунды 

 

Полезные советы 

• Высокое значение демпфирования делает выход более гладким, поскольку отображаемое 
значение будет меняться медленнее. 

• Низкое значение демпфирования делает выход более неравномерным, поскольку отобра-
жаемое значение будет меняться быстрее. 

• Если величина демпфирования не равна нулю, то отображаемое значение будет отставать 
от действительного, поскольку показания будут усредненными за время демпфирования. 

• Обычно, низкие значения демпфирования предпочтительнее, поскольку это сокращает 
шанс потери данных, и уменьшает временное отставание показаний от реальных измере-
ний. 

 

Значение демпфирования, которое Вы вводите, автоматически округляется в меньшую сторо-
ну до ближайшего допустимого значения. Допустимые значения демпфирования по плотности 
зависят от установок скорости опроса (Update Rate). 

 

Таблица 4-11:     Допустимые значения демпфирования по плотности 

Тип базового процессора Установки скорости оп-
роса (Update Rate) 

Допустимые значения демпфиро-
вания по плотности (Density Damp-
ing) 

Стандартный Нормальная 0, 0.2, 0.4, 0.8, ... 51.2 

Специальная 0, 0.04, 0.08, 0.16, ... 10.24 

Усовершенствованный Не применимо 0, 0.04, 0.08, 0.16, ... 40.96 

 

   Влияние демпфирования по плотности на измерение объёма 
 Демпфирование по плотности влияет на измерение объёма жидкостей. Значения объёма жидко-

стей высчитывается из данных о плотности с учётом демпфирования, а не из измеренных зна-
чений плотности. Демпфирование по плотности не влияет на данные измерений стандартного 
объёмного расхода для газов (GSV). 
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   Взаимодействие демпфирования по плотности (Density Damping) и 
добавочного демпфирования (Added Damping) 

 Иногда на отображаемое значение плотности влияет как демпфирование по плотности, так и до-
полнительное демпфирование. 

Демпфирование по плотности определяет скорость изменения переменной плотности. Дополни-
тельное демпфирование определяет скорость изменения миллиамперного выхода. Если пере-
менная процесса, назначенная на миллиамерный выход (mA Output Process Variable), установлена 
на плотность (Density), и оба значения демпфирования Density Damping и Added Damping  уста-
новлены в ненулевые значения, то сначала применяется демпфирование по плотности, а затем 
к результату этого вычисления применяется добавочное демпфирование. 

 

4.5.4 Конфигурирование отсечки по плотности 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Density>Low Density Cutoff 

ProLink III Device Tools>Configuration>Process Measurement>Density 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Density>Density Cutoff 

 

Обзор 

Отсечка по плотности (Density Cutoff) определяет минимальное значение плотности, которое 
будет отображено как измеренное. Все значения плотности ниже отсечки будут отображены 
равными нулю. 

 

Процедура 

Установите для Density Cutoff значение, которое Вы хотите использовать. 

Значение по умолчанию – 0.2 г/см3 . Диапазон от 0.0 до 0.5 г/см3. 

 

   Влияние отсечки по массовому расходу на измерение объёма 
 Отсечка по плотности влияет на измерения объёма жидкостей. Если значение плотности пода-

ет ниже отсечки по плотности, то объёмный расход отображается равным нулю. Отсечка по 
плотности не влияет на результаты измерений стандартного объёмного расхода газа. Значения 
стандартного объёмного расхода газа всегда рассчитываются из значений, сконфигурирован-
ных для Стандартной плотности газа. 

 

4.6 Конфигурирование измерения температуры 
   Параметры измерения температуры определяют, как отображаются данные о температуре с 

сенсора. Данные о температуре используются для компенсации влияния температуры на сен-
сорные трубки в процессе измерения расхода. 

 

 Параметры измерения плотности включают: 

• Единицы измерения температуры 

• Демпфирование по температуре 
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4.6.1 Конфигурирование единиц измерения температуры 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>UNITS>TEMP 

ProLink II ProLink>Configuration>Temperature>Temperature Units 

ProLink III Device Tools>Configuration>Process Measurement>Temperature 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Temperature>Temperature Unit 

 

Обзор 

Единицы измерения температуры определяют единицы измерения, которые будут использоваться 
для температуры. 

Процедура 

Установите желаемые Единицы измерения температуры. 

Единицы измерения температуры по умолчанию- Degrees Celsius (градусы Цельсия). 

   Варианты единиц измерения температуры 
 Преобразователь предоставляет стандартный набор единиц измерения температуры. Различные 

средства коммуникации могут использовать разные наименования для этих единиц. 

 

Таблица 4-12:     Варианты единиц измерения температуры 

Описание единиц 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Градусы Цельсия ºC degC ºC degC 

Градусы Фаренгейта ºF degF ºF degF 

Градусы Ренкина ºR degR ºR degR 

Градусы Кельвина ºK degK ºK Kelvin 

 

4.6.2 Конфигурирование демпфирования по температуре 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Temperature>Temp Damping 

ProLink III Device Tools>Configuration>Temperature 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Temperature>Temperature Damping 
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Обзор 

Демпфирование помогает сгладить небольшие, резкие колебания в процессе измерений. Значе-
ние демпфирования определяет период времени (в секундах), в течение которого преобразова-
тель будет отслеживать изменения значений переменной процесса. По окончании этого перио-
да показания значений переменной процесса отразят 63% её действительного изменения. 

Процедура 

Установите для Temperature Damping значение, которое Вы хотите использовать. 

Значение по умолчанию – 4.8 секунд. Диапазон от 0.0 до 76.8 секунды. 

 

Полезные советы 

• Высокое значение демпфирования делает выход более гладким, поскольку отображаемое 
значение будет меняться медленнее. 

• Низкое значение демпфирования делает выход более неравномерным, поскольку отобра-
жаемое значение будет меняться быстрее. 

• Если величина демпфирования не равна нулю, то отображаемое значение будет отставать 
от действительного, поскольку показания будут усредненными за время демпфирования. 

• Обычно, низкие значения демпфирования предпочтительнее, поскольку это сокращает 
шанс потери данных, и уменьшает временное отставание показаний от реальных измере-
ний. 

 

Значение демпфирования, которое Вы вводите, автоматически округляется в меньшую сторо-
ну до ближайшего допустимого значения. Допустимые значения демпфирования по температуре: 
0, 0.6, 1.2, 2.4, 4.8, … 76.8. 

 

   Влияние демпфирования по температуре на измерения  
технологических параметров процесса 

 Демпфирование по температуре влияет на скорость реакции на компенсацию по температуре при 
неустойчивой температуре. Компенсация по температуре подстраивает измерения технологи-
ческих параметров процесса для компенсации влияния температуры на сенсорные трубки. 

Демпфирование по температуре влияет на переменные процесса измерения нефтепродуктов, 
только если преобразователь сконфигурирован на использование данных о температуре с сен-
сора. Если для измерения нефтепродуктов используется внешнее значение температуры, то 
Демпфирование по температуре не влияет на переменные процесса измерения нефтепродуктов. 

Демпфирование по температуре влияет на переменные процесса измерения концентрации, только 
если преобразователь сконфигурирован на использование данных о температуре с сенсора. 
Если для измерения нефтепродуктов используется внешнее значение температуры, то Демпфи-
рование по температуре не влияет на переменные процесса измерения концентрации. 
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4.7 Конфигурирование приложения измерения 
нефтепродуктов по API 

В приложении измерения нефтепродуктов по API включена коррекция объёма жидкости по 
температуре (Correction of Temperature on volume of Liquids (CTL)), путем вычисления и при-
менения объёмного поправочного коэффициента (Volume Correction Factor (VCF)) при измере-
ниях объёма. Внутренние вычисления осуществляются в соответствии со стандартами API. 

 

4.7.1 Конфигурирование приложения измерения нефтепродуктов 
по API с помощью ProLink II 

1. Выберите ProLink>Configuration>API Setup. 

2. Определите справочную таблицу API, которая будет использоваться. 

a. В разделе API Chapter 11.1 Table Type выберите группу таблиц API. 

b. В разделе Units выберите единицы измерения, которые Вы хотите использовать. 

Эти два параметра определяют конкретную справочную таблицу API. 

3. Если Вы выбрали таблицу 53A, 53B, 53D или 54C, установите Эталонную температуру (Ref-
erence Temperature) в подходящее для Вашего приложения значение. Введите значение в °C. 

4. Если Вы выбрали таблицу 6С, 24С или 54C, установите Коэффициент теплового расширения 
(Thermal Expansion Coefficient) в подходящее для Вашего приложения значение. 

5. Определите, как преобразователь будет получать данные о температуре для расчетов из-
мерения нефтепродуктов и проведите требуемую установку. 

Вариант Установка 

Данные температур-
ного сенсора 

a. Выберите View>Preferences. 

b. Отключите пункт Use External Temperature (Использование 
внешнего датчика температуры). 

Постоянное значение 
температуры, уста-
новленное пользова-
телем 

a. Выберите View>Preferences. 

b. Включите пункт Use External Temperature. 

c. Выберите ProLink>Configuration>Temperature. 

d. Установите External Temperature в значение, которое будет 
использоваться. 
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Вариант Установка 

Опрос внешнего 
датчика температу-
ры 

a. Убедитесь, что кабель первого миллиамперного выхода 
смонтирован так, что возможен опрос по HART-протоколу. 

b. Выберите View>Preferences. 
c. Включите пункт Use External Temperature. 
d. Выберите ProLink>Configuration>Polled Variables (опрос пере-

менной). 
e. Для опроса выберите свободный слот (unused polling slot). 
f. Установите параметр Polling Control (режим опроса) в значе-

ние Poll As Primary или Poll As Secondary и щелкните кнопкой 
мыши по Apply (применить). 

g. Установите параметр External Tag (Внешний Тэг) в соответст-
вии с тэгом HART внешнего датчика температуры. 

h.  Установите параметр Varible Type (Тип переменной) в значе-
ние External Temperature. 

 
 

Полезный совет 

• Poll As Primary: в сети HART не будет другого мастер-
устройства. 

• Poll As Secondary: в сети HART предполагается второе 
мастер-устройство. Полевой коммуникатор не является 
мастер-устройством HART. 

Значение, вводимое с 
помощью цифровой 
коммуникации 

a. Выберите View>Preferences. 
b. Включите пункт Use External Temperature. 
c. Осуществите необходимое программирование хоста и ус-

тановку коммуникации для ввода данных о температуре в 
преобразователь с требуемым интервалом времени. 

 
 

Примечание 

Если приложение коммерческого учета активировано, и 
преобразователь находится в режиме защиты записи (se-
cured), то данные о температуре не могут вводиться в пре-
образователь с помощью цифровой коммуникации. 

 

 

4.7.2 Конфигурирование приложения измерения нефтепродуктов 
по API с помощью ProLink III 

1. Выберите Device Tools>Configuration>Process Measurement>Petroleum Measurement. 

2. Определите справочную таблицу API, которая будет использоваться. 

a. Выберите группу таблиц API из раздела API Table Type. 

b. Установите параметр Petroleum Measurement Units на единицы измерения, которые Вы 
хотите использовать. 

c. Щелкните кнопкой мыши по Apply. 

Эти два параметра определяют конкретную справочную таблицу API. 

3. Если Вы выбрали таблицу 53A, 53B, 53D или 54C, установите Эталонную температуру (Ref-
erence Temperature) в подходящее для Вашего приложения значение. Введите значение в °C. 

4. Если Вы выбрали таблицу 6Сб 24С или 54C, установите Коэффициент теплового расширения 
(Thermal Expansion Coefficient) в подходящее для Вашего приложения значение. 
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5. Установите в параметр Temperature Source метод, который преобразователь будет исполь-
зовать для получения данных о температуре. 

Вариант Описание 

Опрос внешнего дат-
чика для получения 
значения переменной  

Преобразователь будет опрашивать внешний датчик темпера-
туры, используя HART-протокол по первому миллиамперному 
выходу. 

Термосопротивление 
(RTD) 

Преобразователь будет использовать данные сенсора о темпе-
ратуре. 

Постоянное (Static) 
значение или значе-
ние, вводимое с по-
мощью цифровой 
коммуникации (Digital 
Communications) 

Преобразователь будет использовать значения температуры из 
памяти. 
• Static: используется установленное значение. 
• Digital Communications: Внешний хост вводит данные в 

память преобразователя. 
Один и тот же участок памяти используется для обоих вариан-
тов. 

 

Данные о температуре с внешнего датчика используются только для вычислений для из-
мерений нефтепродуктов. Все остальные вычисления преобразователя используют данные 
с сенсора. 

6. Если Вы выбираете термосопротивление, дополнительная конфигурация не требуется. 
Щелкните кнопкой мыши по Apply. 

7. Если Вы выбираете опрос для получения данных о температуре: 

a. Выберите свободный слот для опроса (Polling Slot). 

На преобразователе доступно два слота для опроса. Вы можете использовать один для 
температуры, а второй – для давления, если доступна компенсация по давлению. 

b. Установите параметр Polling Control (режим опроса) в значение Poll As Primary или Poll As 
Secondary и щелкните кнопкой мыши по Apply (применить). 

 

Полезный совет 

• Poll As Primary: в сети HART не будет другого мастер-устройства 

• Poll As Secondary: в сети HART предполагается второе мастер-устройство. Полевой 
коммуникатор не является мастер-устройством HART. 

 

c. Установите параметр External Tag (Внешний Тэг) в соответствии с тэгом HART внешнего 
датчика температуры, и щелкните кнопкой мыши по Apply. 

8. Если Вы выбираете постоянное значение температуры, установите параметр External Tem-
perature в желаемое значение, и щелкните кнопкой мыши по Apply. 

9.  Если Вы хотите использовать значение, вводимое с помощью цифровой коммуникации, 
осуществите необходимое программирование хоста и установку коммуникации для ввода 
данных о температуре в преобразователь с требуемым интервалом времени. 

 

Примечание 

Если приложение коммерческого учета активировано, и преобразователь находится в 
режиме защиты записи (secured), то данные о температуре не могут вводиться в преоб-
разователь с помощью цифровой коммуникации. 
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4.7.3 Конфигурирование приложения измерения нефтепродуктов 
по API с помощью Полевого Коммуникатора 

1. Выберите Online>Configure>Manual Setup>Measurements>Set Up Petroleum. 

2. Определите справочную таблицу API, которая будет использоваться. 

a. Откройте меню Petroleum Measurement Source (источник данных для измерения нефте-
продуктов) и выберите числовую часть номера таблицы API. 

В зависимости от Вашего выбора, Вам может быть предложено выбрать Эталонную темпе-
ратуру (Reference Temperature) или Коэффициент теплового расширения (Thermal Expansion Coeffi-
cient). 
b. Введите буквенную часть номера таблицы API. 

Эти два параметра определяют конкретную справочную таблицу API. 

3. Определите, как преобразователь будет получать данные о температуре для расчетов из-
мерения нефтепродуктов и проведите требуемую установку. 

Вариант Установка 

Данные о температу-
ре с сенсора 

a. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>Temperature. 

b. Установите External Temperature в значение Disabled. 

Постоянное значение 
температуры, уста-
новленное пользова-
телем 

a. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>Temperature. 

b. Установите External Temperature в значение Enabled. 

c. Установите Correction Temperature (Корректрирующая тем-
пература) в значение, которое будет использоваться. 

Опрос внешнего 
датчика 

a. Убедитесь, что кабель первого миллиамперного выхода 
смонтирован так, что возможен опрос по HART-протоколу. 

b. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>Temperature. 

c. Установите External Temperature в значение Enabled. 

d. Выберите External Polling (опрос переменной). 

e. Установите параметр Poll Control (режим опроса) в значение 
Poll As Primary или Poll As Secondary  

f. Определите, какой слот Вы будете использовать для опроса 
Polling Slot 1 или Polling Slot 2. 

g. Для выбранного слота установите параметр Ext Dev Tag 
(Внешний Тэг) в соответствии с тэгом HART внешнего 
датчика температуры. 

h. Для выбранного слота установите параметр Polled Varible 
(Переменная опроса) в значение Temperature. 

 
 

Полезный совет 

• Poll As Primary: в сети HART не будет другого мастер-
устройства. 

• Poll As Secondary: в сети HART предполагается второе 
мастер-устройство. Полевой коммуникатор не является 
мастер-устройством HART. 
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Вариант Установка 

Значение, вводимое с 
помощью цифровой 
коммуникации 

a. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>Temperature. 

b. Установите External Temperature в значение Enabled. 
c. Осуществите необходимое программирование хоста и ус-

тановку коммуникации для ввода данных о температуре в 
преобразователь с требуемым интервалом времени. 

 
 

Примечание 

Если приложение коммерческого учета активировано, и 
преобразователь находится в режиме защиты записи (se-
cured), то данные о температуре не могут вводиться в пре-
образователь с помощью цифровой коммуникации. 

 

 

4.7.4 Справочные таблицы API 
Таблица 4-13:     Справочные таблицы API, связанные с ними технологические жидкости и значения для 
вычислений 

Номер 
таблицы 

Технологическая 
жидкость 

Источник данных для CTL Эталонная темпе-
ратура 

Единицы 
плотности 

5A Сырая нефть и JP4 Экспериментальная плотность и 
температура 

60ºF (неконфигури-
руемая) 

Градусы API 
Диапазон: от 0 
до 100 

5B Сырые нефтепро-
дукты 

Экспериментальная плотность и 
температура 

60ºF (неконфигури-
руемая) 

Градусы API 
Диапазон: от 0 
до 85 

5D Смазочные масла Экспериментальная плотность и 
температура 

60ºF (неконфигури-
руемая) 

Градусы API 
Диапазон: от –
10 до +40 

6C Жидкости с посто-
янной базовой плот-
ностью или извест-
ным коэффициентом 
теплового расшире-
ния 

Предоставленная пользователем 
стандартная плотность (или ко-
эффициент теплового расшире-
ния) и экспериментальная темпе-
ратура 

60ºF (неконфигури-
руемая) 

Градусы API 

23A Сырая нефть и JP4 Экспериментальная плотность и 
температура 

60ºF (неконфигури-
руемая) 

Относительная 
плотность 
Диапазон: от 
0.6110 до 
1.0760 

23B Сырые нефтепро-
дукты 

Экспериментальная плотность и 
температура 

60ºF (неконфигури-
руемая) 

Относительная 
плотность 
Диапазон: от 
0.6535 до 
1.0760 

23D Смазочные масла Экспериментальная плотность и 
температура 

60ºF (неконфигури-
руемая) 

Относительная 
плотность 
Диапазон: от 
0.8520 до 
1.1640 
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Таблица 4-13:     Справочные таблицы API, связанные с ними технологические жидкости и значения для 
вычислений (продолжение) 

Номер 
таблицы 

Технологическая жид-
кость 

Источник данных для CTL Эталонная темпе-
ратура 

Единицы 
плотности 

24C Жидкости с постоянной 
базовой плотностью или 
известным коэффициен-
том теплового расшире-
ния 

Предоставленная пользовате-
лем стандартная плотность 
(или коэффициент теплового 
расширения) и эксперимен-
тальная температура 

60ºF (неконфигури-
руемая) 

Относительная 
плотность 

53A Сырая нефть и JP4 Экспериментальная плот-
ность и температура 

15ºС (конфигури-
руемая) 

Базовая плот-
ность 
Диапазон: от 
610 до 1075 
kg/m3 (кг/м3) 

53B Сырые нефтепродукты Экспериментальная плот-
ность и температура 

15ºС (конфигури-
руемая) 

Базовая плот-
ность 
Диапазон: от 
653 до 1075 
kg/m3 (кг/м3) 

53D Смазочные масла Экспериментальная плот-
ность и температура 

15ºС (конфигури-
руемая) 

Базовая плот-
ность 
Диапазон: от 
825 до 1164 
kg/m3 (кг/м3) 

54C Жидкости с постоянной 
базовой плотностью или 
известным коэффициен-
том теплового расшире-
ния 

Предоставленная пользовате-
лем стандартная плотность 
(или коэффициент теплового 
расширения) и эксперимен-
тальная температура 

15ºС (конфигури-
руемая) 

Базовая плот-
ность в kg/m3 
(кг/м3) 

 

4.8 Конфигурирование приложения измерения 
концентрации 

 

Приложение измерения концентрации рассчитывает данные о концентрации из технологиче-
ской температуры и плотности. Micro Motion предоставляет набор матриц концентрации, ко-
торые содержат данные для некоторых стандартных промышленных приложений и техноло-
гических жидкостей. При необходимости Вы можете создать специальную матрицу для вашей 
технологической жидкости или заказать специальную матрицу в Micro Motion. 

Информация о приложении измерения концентрации приведена в документе, под названием 
Micro Motion Enhanced Density Application: Theory, Configuration, and Use. 

 

Примечание 

Приложение измерения концентрации (the concentration measurement application) также назы-
вают специальным использованием измерения плотности (the enhanced density application). 

 

4.8.1 Конфигурирование приложения измерения концентрации с 
помощью ProLink II 
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Этот алгоритм является руководством по загрузке и установке матрицы концентрации для из-
мерений. Он не описывает процедуру создания матрицы концентрации. 

 

Примечание 

Матрицы концентрации можно использовать в преобразователе либо загрузив существующую 
матрицу из файла, либо создав новую матрицу. До шести матриц могут быть доступны в Ва-
шем преобразователе, но только одна может использоваться для измерений в каждый конкрет-
ный момент времени. Дополнительная информация по созданию матрицы содержится в доку-
менте: Micro Motion Enhanced Density Application: Theory, Configuration, and Use. 

 

Предварительные требования 

Прежде чем Вы сможете конфигурировать измерение концентрации: 

• Приложение измерения концентрации должно быть разрешено в Вашем преобразователе. 

• Матрица концентрации, которую Вы хотите использовать, должна быть доступна в пре-
образователе или на Вашем компьютере в виде файла. 

• Вы должны знать производную переменную, для которой создана Ваша матрица. 

• Вы должны знать единицы измерения плотности, используемые Вашей матрицей. 

• Вы должны знать единицы измерения температуры, используемые Вашей матрицей. 

• Приложение измерения концентрации должно быть разблокировано. 

Процедура 

1. Выберите ProLink>Configuration>Density и установите параметр Density Units (единицы измерения 
плотности) на единицы измерения, используемые матрицей. 

2. Выберите ProLink>Configuration>Temperature и установите параметр Temp Units (единицы изме-
рения температуры) на единицы измерения, используемые матрицей. 

3. Выберите ProLink>Configuration>CM Setup 

4. В глобальных настройках (Global Config) установите параметр Derived Variable (производная 
переменная) на производную переменную, используемую матрицей. 

 

Важно 

• Все матрицы концентрации в Вашем преобразователе должны использовать одну и 
ту же производную переменную. Если Вы используете одну из стандартных мат-
риц Micro Motion, установите параметр Derived Variable в значение Mass Conc 
(Density) (плотность). Если вы используете специальную матрицу, обратитесь к спра-
вочной информации для Вашей матрицы. 

• Если вы меняете установку параметра Derived Variable, все существующие матрицы 
концентрации будут удалены из памяти преобразователя. Устанавливайте пара-
метр Derived Variable прежде, чем загружать матрицу концентрации. 

 

5. Загрузите одну или более матриц. 

a. В разделе конфигурирования кривой (Curve Specific Config), установите параметр Curve 
Configured (конфигурирование кривой) на место, куда будет загружена матрица. 

b. Щелкните кнопкой мыши по Load this curve from a file (загрузить кривую из файла), укажите 
путь к файлу матрицы на Вашем ПК и загрузите его. 

c. Повторите для загрузки всех необходимых матриц. 

6. Установите тревожные сообщения экстраполяции. 

 

Каждая матрица концентрации создана для конкретного диапазона плотности и темпера-
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туры. Если технологическая плотность или температура выходят из этого диапазона, пре-
образователь будет экстраполировать значения концентрации. Однако экстраполяция мо-
жет повлиять на точность измерений. Тревожные сообщения экстраполяции используют-
ся, чтобы сообщить оператору, что идет экстраполирование. 

a. В разделе конфигурирования кривой (Curve Specific Config), установите параметр Curve 
Configured (конфигурирование кривой) на матрицу, которую Вы хотите сконфигурировать. 

b. Установите параметр Alarm Limit (предел аларма) на значение, в процентах, при котором 
будет отображено тревожное сообщение экстраполяции. 

c. По желанию включите или отключите верхний и нижний пределы тревожных сообще-
ний для температуры и плотности. 
 

Ограничение 

Для верхнего и нижнего пределов аларма требуется усовершенствованный процессор. 

 

Пример: Если Alarm Limit (предел аларма) установлен на 5%, проверен параметр Enable Temp 
High (разрешить верхний предел по температуре), а матрица создана для диапазона температу-
ры от 40°F до 80°F, тревожное сообщение экстраполяции будет отображено, если техноло-
гическая температура станет выше 82°F 

7. Установите наименование, которое будет использоваться для единиц измерения концен-
трации. 

a. В разделе конфигурирования кривой (Curve Specific Config), установите параметр Curve 
Configured (конфигурирование кривой) на матрицу, которую Вы хотите сконфигурировать. 

b. Установите желаемое наименование из вариантов единиц измерения (Units). 

c. Если Вы устанавливаете специальные единицы измерения, введите специальное на-
именование. 

8. Определите, как преобразователь будет получать данные о температуре для расчетов из-
мерения нефтепродуктов и проведите требуемую установку. 

Вариант Установка 

Данные температур-
ного сенсора 

a. Выберите View>Preferences. 

b. Отключите пункт Use External Temperature (Использование 
внешнего датчика температуры). 

Постоянное значение 
температуры, уста-
новленное пользова-
телем 

a. Выберите View>Preferences. 

b. Включите пункт Use External Temperature. 

c. Выберите ProLink>Configuration>Temperature. 

d. Установите External Temperature в значение, которое будет 
использоваться. 

Опрос внешнего 
датчика температу-
ры 

a. Убедитесь, что кабель первого миллиамперного выхода 
смонтирован так, что возможен опрос по HART-протоколу. 

b. Выберите View>Preferences. 
c. Включите пункт Use External Temperature. 
d. Выберите ProLink>Configuration>Polled Variables (опрос пере-

менной). 
e. Для опроса выберите свободный слот (unused polling slot). 
f. Установите параметр Polling Control (режим опроса) в значе-

ние Poll As Primary или Poll As Secondary и щелкните кнопкой 
мыши по Apply (применить). 

g. Установите параметр External Tag (Внешний Тэг) в соответст-
вии с тэгом HART внешнего датчика температуры. 

h.  Установите параметр Varible Type (Тип переменной) в значе-
ние External Temperature. 
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Полезный совет 

• Poll As Primary: в сети HART не будет другого мастер-
устройства. 

• Poll As Secondary: в сети HART предполагается второе 
мастер-устройство. Полевой коммуникатор не является 
мастер-устройством HART. 

 

Вариант Установка 

Значение, вводимое с 
помощью цифровой 
коммуникации 

a. Выберите View>Preferences. 
b. Включите пункт Use External Temperature. 
c. Осуществите необходимое программирование хоста и ус-

тановку коммуникации для ввода данных о температуре в 
преобразователь с требуемым интервалом времени. 

 
 

Примечание 

Если приложение коммерческого учета активировано, и 
преобразователь находится в режиме защиты записи (se-
cured), то данные о температуре не могут вводиться в пре-
образователь с помощью цифровой коммуникации. 

 

9. В глобальных настройках (Global Config) Установите параметр Active Curve (используемая 
кривая) на матрицу, которая будет использоваться для измерения технологических пара-
метров процесса. 

Переменные измерения концентрации теперь доступны на преобразователе. Вы можете про-
сматривать и отображать их так же, как Вы просматриваете и отображаете другие переменные 
процесса. 

 

4.8.2 Конфигурирование приложения измерения концентрации с 
помощью ProLink III 

Этот алгоритм является руководством по загрузке и установке матрицы концентрации для из-
мерений. Он не описывает процедуру создания матрицы концентрации. 

 

Примечание 

Матрицы концентрации можно использовать в преобразователе либо загрузив существующую 
матрицу из файла, либо создав новую матрицу. До шести матриц могут быть доступны в Ва-
шем преобразователе, но только одна может использоваться для измерений в каждый конкрет-
ный момент времени. Дополнительная информация по созданию матрицы содержится в доку-
менте: Micro Motion Enhanced Density Application: Theory, Configuration, and Use. 

 

Предварительные требования 

Прежде чем Вы сможете конфигурировать измерение концентрации: 

• Приложение измерения концентрации должно быть разрешено в Вашем преобразователе. 

• Матрица концентрации, которую Вы хотите использовать, должна быть доступна в преоб-
разователе или на Вашем компьютере в виде файла. 

• Вы должны знать производную переменную, для которой создана Ваша матрица. 

• Вы должны знать единицы измерения плотности, используемые Вашей матрицей. 
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• Вы должны знать единицы измерения температуры, используемые Вашей матрицей. 

• Приложение измерения концентрации должно быть разблокировано. 

Процедура 

1. Выберите Devica Tools>Configuration>Process Measurement>Density и установите параметр Densi-
ty Unit (единицы измерения плотности) на единицы измерения, используемые матрицей. 

2. Выберите Device Tools>Configuration>Process Measurement>Temperature и установите параметр 
Temperature Unit (единицы измерения температуры) на единицы измерения, используемые мат-
рицей. 

3. Выберите Device Tools>Configuration>Process Measurement>Concentration Measurement 

4. Установите параметр Derived Variable (производная переменная) на производную переменную, 
используемую матрицей, и щелкните кнопкой мыши по Apply. 

 

Важно 

• Все матрицы концентрации на Вашем преобразователе должны использовать одну 
и ту же производную переменную. Если Вы используете одну из стандартных мат-
риц Micro Motion, установите параметр Derived Variable в значение Mass Conc 
(Density) (плотность). Если вы используете специальную матрицу, обратитесь к спра-
вочной информации для Вашей матрицы. 

• Если вы меняете установку параметра Derived Variable, все существующие матрицы 
концентрации будут удалены из памяти преобразователя. Устанавливайте пара-
метр Derived Variable прежде, чем загружать матрицу концентрации. 

 
5. Загрузите одну или более матриц. 

a. Установите параметр Matrix Being Configured (конфигурирование матрицы) на место, куда 
будет загружена матрица. 

b. Щелкните кнопкой мыши по Load matrix from a file (загрузить матрицу из файла), укажите 
путь к файлу матрицы на Вашем ПК и загрузите его. 

c. Повторите для загрузки всех необходимых матриц. 

6. Проверьте и сконфигурируйте данные матрицы. 

a. При необходимости, установите параметр Matrix Being Configured (конфигурирование мат-
рицы) на матрицу, которую Вы хотите видеть и щелкните кнопкой мыши по Change Ma-
trix (поменять матрицу). 

b. Установите для Concentration Unit (единицы измерения концентрации) наименование, кото-
рое будет использоваться как единицы концентрации. 

c. Если Вы устанавливаете специальные единицы измерения, введите специальное на-
именование. 

d. По желанию можно поменять название матрицы. 

e. Проверьте данные матрицы. 

f. Не изменяйте параметры Reference Temperature (эталонная температура) и Curve Fit Maxi-
mum Order. 

g. Если Вы изменили какие-либо данные матрицы, щелкните кнопкой мыши по Apply. 

7. Установите тревожные сообщения экстраполяции. 

Каждая матрица концентрации создана для конкретного диапазона плотности и темпера-
туры. Если технологическая плотность или температура выходят из этого диапазона, пре-
образователь будет экстраполировать значения концентрации. Однако экстраполяция мо-
жет повлиять на точность измерений. Тревожные сообщения экстраполяции используют-
ся, чтобы сообщить оператору, что идет экстраполирование. 

a. При необходимости, установите параметр Matrix Being Configured (конфигурирование мат-
рицы) на матрицу, которую Вы хотите видеть и щелкните кнопкой мыши по Change Ma-
trix (поменять матрицу). 
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b. Установите параметр Extrapolation Alarm Limit (предел аларма экстраполяции) на значение, в 
процентах, при котором будет отображено тревожное сообщение экстраполяции. 

c. По желанию включите или отключите верхний и нижний пределы тревожных сообще-
ний для температуры и плотности и щелкните кнопкой мыши по Apply. 
 

Ограничение 

Для верхнего и нижнего пределов аларма требуется усовершенствованный процессор. 

 

Пример: Если Alarm Limit (предел аларма) установлен на 5%, проверен параметр Enable Temp 
High (разрешить верхний предел по температуре), а матрица создана для диапазона температу-
ры от 40°F до 80°F, тревожное сообщение экстраполяции будет отображено, если техноло-
гическая температура станет выше 82°F 

8. Установите в параметр Temperature Source метод, который преобразователь будет исполь-
зовать для получения данных о температуре. 

Вариант Описание 

Опрос внешнего дат-
чика для получения 
значения переменной  

Преобразователь будет опрашивать внешний датчик темпера-
туры, используя HART-протокол по первому миллиамперному 
выходу. 

Термосопротивление 
(RTD) 

Преобразователь будет использовать данные сенсора о темпе-
ратуре. 

Постоянное (Static) 
значение или значе-
ние, вводимое с по-
мощью цифровой 
коммуникации (Digital 
Communications) 

Преобразователь будет использовать значения температуры из 
памяти. 
• Static: используется установленное значение. 
• Digital Communications: Внешний хост вводит данные в 

память преобразователя. 

 
 

Примечание 

Если приложение коммерческого учета активировано, и 
преобразователь находится в режиме защиты записи (se-
cured), то данные о температуре не могут вводиться в пре-
образователь с помощью цифровой коммуникации. 

 

9. Если Вы выбираете термосопротивление, дополнительная конфигурация не требуется. 
Щелкните кнопкой мыши по Apply. 

10. Если Вы выбираете опрос для получения данных о температуре: 

a. Выберите свободный слот для опроса (Polling Slot). 

b. Установите параметр Polling Control (режим опроса) в значение Poll As Primary или Poll As 
Secondary и щелкните кнопкой мыши по Apply (применить). 

 

Полезный совет 

• Poll As Primary: в сети HART не будет другого мастер-устройства 

• Poll As Secondary: в сети HART предполагается второе мастер-устройство. Полевой 
коммуникатор не является мастер-устройством HART. 

 

c. Установите параметр External Device Tag (Тэг Внешнего устройства) в соответствии с тэгом 
HART внешнего датчика температуры, и щелкните кнопкой мыши по Apply. 

11. Если Вы выбираете постоянное значение температуры, установите параметр External Tem-
perature в желаемое значение, и щелкните кнопкой мыши по Apply. 

12.  Если Вы хотите использовать значение, вводимое с помощью цифровой коммуникации, 
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щелкните кнопкой мыши по Apply, затем осуществите необходимое программирование 
хоста и установку коммуникации для ввода данных о температуре в преобразователь с 
требуемым интервалом времени. 

13. Установите параметр Active Matrix (используемая матрица) на матрицу, которая будет исполь-
зоваться для измерения технологических параметров процесса. 

Переменные измерения концентрации теперь доступны на преобразователе. Вы можете про-
сматривать и отображать их так же, как Вы просматриваете и отображаете другие переменные 
процесса. 

4.8.3 Конфигурирование приложения измерения концентрации с 
помощью Полевого коммуникатора 

Этот алгоритм является руководством по установке матрицы концентрации для измерений. Он 
не описывает процедуру создания матрицы концентрации. 

Примечание 

Матрицы концентрации можно использовать в преобразователе либо загрузив существующую 
матрицу из файла, либо создав новую матрицу. До шести матриц могут быть доступны в Ва-
шем преобразователе, но только одна может использоваться для измерений в каждый конкрет-
ный момент времени. Дополнительная информация по созданию матрицы содержится в доку-
менте: Micro Motion Enhanced Density Application: Theory, Configuration, and Use. 

 

Предварительные требования 

Прежде чем Вы сможете конфигурировать измерение концентрации: 

• Приложение измерения концентрации должно быть разрешено на Вашем преобразовате-
ле. 

• Вы должны знать производную переменную, для которой создана Ваша матрица. 

• Вы должны знать единицы измерения плотности, используемые Вашей матрицей. 

• Вы должны знать единицы измерения температуры, используемые Вашей матрицей. 

• Приложение измерения концентрации должно быть разблокировано. 

Процедура 

1. Выберите Online>Configure>Manual Setup>Measurements>Density и установите параметр Density 
Unit (единицы измерения плотности) в соответствии с единицами измерения, используемыми 
матрицей. 

2. Выберите Online>Configure>Manual Setup>Measurements>Temperature и установите параметр 
Temperature Unit (единицы измерения плотности) в соответствии с единицами измерения, ис-
пользуемыми матрицей. 

3. Выберите Online>Configure>Manual Setup>Measurements>Conc Measurement (CM)>CM Configuration. 

4. Установите предупреждения об экстраполяции. 

Каждая матрица концентрации создана для конкретного диапазона плотности и темпера-
туры. Если технологическая плотность или температура выходят из этого диапазона, пре-
образователь будет экстраполировать значения концентрации. Однако экстраполяция мо-
жет повлиять на точность измерений. Предупреждения об экстраполяции используются, 
чтобы сообщить оператору, что идет экстраполирование. 

a. Выберите Online>Configure>Manual Setup>Measurements>Conc Measurement (CM)> 
Matrix Configuration. 

b. Eстановите параметр Matrix Being Configured (конфигурирование матрицы) на матрицу, кото-
рую Вы хотите сконфигурировать. 

c. Установите параметр Extrapolation Alert Limit (предел предупреждения об экстраполяции) на 
значение, в процентах, при котором будет отображено предупреждение об экстраполя-
ции. 

d. Выберите Online>Configure>Alert Setup>CM Alerts. 
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e. По желанию включите или отключите верхний и нижний пределы тревожных сообще-
ний для температуры и плотности и щелкните кнопкой мыши по Apply. 

 

Пример: Если Alarm Limit (предел аларма) установлен на 5%, проверен параметр Enable Temp 
High (разрешить верхний предел по температуре), а матрица создана для диапазона температу-
ры от 40°F до 80°F, тревожное сообщение экстраполяции будет отображено, если техноло-
гическая температура станет выше 82°F 

5. Установите наименование, которое будет использоваться для единиц измерения концен-
трации. 

a. Выберите Online>Configure>Manual Setup>Measurements>Conc Measurement (CM)> 
Matrix Configuration. 

b. Установите параметр Matrix Being Configured (конфигурирование матрицы) на матрицу, ко-
торую Вы хотите сконфигурировать. 

c. Установите желаемое наименование для единиц измерения концентрации (Concentration 
Units). 

d. Если Вы устанавливаете специальные единицы измерения, введите специальное на-
именование. 

6. Определите, как преобразователь будет получать данные о температуре для расчетов из-
мерения концентрации и проведите требуемую установку. 

Вариант Установка 

Данные о температу-
ре с сенсора 

a. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>Temperature. 

b. Отключите параметр External Temperature. 

Постоянное значение 
температуры, уста-
новленное пользова-
телем 

a. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>Temperature. 

b. Включите параметр External Temperature. 

c. Установите Correction Temperature (Корректрирующая тем-
пература) в значение, которое будет использоваться. 

 

 

 

 

 

Ограничение 

Для верхнего и нижнего пределов аларма требуется усовершенствованный процессор. 
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Вариант Описание 

Опрос внешнего 
датчика 

a. Убедитесь, что кабель первого миллиамперного выхода 
смонтирован так, что возможен опрос по HART-протоколу. 

b. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>Temperature. 

c. Включите параметр External Temperature. 

d. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>External Polling. 

e. Установите параметр Poll Control (режим опроса) в значение 
Poll As Primary Host или Poll As Secondary Host.  

f. Для опроса выберите свободный слот (unused polling slot). 

g. Установите параметр External Tag (Внешний Тэг) в соответ-
ствии с тэгом HART внешнего датчика температуры. 

h. Установите параметр Polled Varible (Переменная опроса) в 
значение Temperature. 

 
 

Полезный совет 

• Poll As Primary: в сети HART не будет другого мастер-
устройства. 

• Poll As Secondary: в сети HART предполагается второе 
мастер-устройство. Полевой коммуникатор не является 
мастер-устройством HART. 

Значение, вводимое с 
помощью цифровой 
коммуникации 

a. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>Temperature. 

b. Включите параметр External Temperature. 
c. Осуществите необходимое программирование хоста и ус-

тановку коммуникации для ввода данных о температуре в 
преобразователь с требуемым интервалом времени. 

 
 

Примечание 

Если приложение коммерческого учета активировано, и 
преобразователь находится в режиме защиты записи (se-
cured), то данные о температуре не могут вводиться в пре-
образователь с помощью цифровой коммуникации. 

 

7. Выберите Online>Configure>Manual Setup>Measurements>Conc Measurement (CM)>CM Configuration 
и установите параметр Active Matrix (используемая матрица) на матрицу, которая будет ис-
пользоваться для измерения. 

Переменные измерения концентрации теперь доступны на преобразователе. Вы можете про-
сматривать и отображать их так же, как Вы просматриваете и отображаете другие переменные 
процесса. 

 

4.8.4 Стандартные матрицы для приложения измерения 
концентрации 
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Стандартные матрицы для приложения измерения концентрации доступны от Micro Motion и 
применимы для различных жидкостей. 

В Таблице 4-14 представлен перечень стандартных матриц для приложения измерения концен-
трации, доступных от Micro Motion, сопровождаемых единицами измерения плотности и тем-
пературы, используемыми при вычислениях, и используемыми единицами измерения концен-
трации. 

 

Полезный совет 

Если стандартные матрицы не подходят для Вашего применения, Вы можете создать 
свою или заказать её у Micro Motion. 

 

Таблица 4-14:     Стандартные матрицы концентрации и соответствующие единицы измерения 

Наименование 
матрицы 

Описание Единицы 
измерения 
плотности 

Единицы из-
мерения тем-
пературы 

Единицы из-
мерения кон-
центрации 

Deg Balling 
(градусы Бол-
линга) 

Матрица представляет массовый  процент 
вытяжки в растворе, выраженный в гра-
дусах Боллинга. Например, сусло в 10º 
Боллинга при 100% вытяжке сахарозы, 
означает 10% вытяжки от общей массы. 

g/cm3 (г/см3) ºF º Balling 

Deg Brix 
(градусы Брик-
са) 

Матрица представляет шкалу плотности 
для растворов сахарозы, показывающую 
массовый процент сахарозы в растворе 
при данной температуре. Например, 40 кг 
сахарозы, смешанные с 60 кг воды, дают 
раствор в 40º Брикса. 

g/cm3 (г/см3) ºС º Brix 

Deg Plato 
(градусы Пла-
тона) 

Матрица представляет массовый процент 
вытяжки в растворе, выраженный в гра-
дусах Платона. Например, сусло в 10º 
Платона при 100% вытяжке сахарозы, 
означает 10% вытяжки от общей массы. 

g/cm3 (г/см3) ºF º Plato 

HFCS 42 Матрица представляет шкалу плотности 
для растворов HFCS 42 (high fructose corn 
syrup- глюкоза с высоким содержанием 
фруктозы), показывающую массовый 
процент HFCS в растворе. 

g/cm3 (г/см3) ºС % 

HFCS 55 Матрица представляет шкалу плотности 
для растворов HFCS 55 (high fructose corn 
syrup- глюкоза с высоким содержанием 
фруктозы), показывающую массовый 
процент HFCS в растворе. 

g/cm3 (г/см3) ºС % 

HFCS 90 Матрица представляет шкалу плотности 
для растворов HFCS 90 (high fructose corn 
syrup- глюкоза с высоким содержанием 
фруктозы), показывающую массовый 
процент HFCS в растворе. 

g/cm3 (г/см3) ºС % 

 

4.8.5 Производные переменные и расчётные переменные 
процесса 

Для каждой производной переменной приложение измерения концентрации рассчитывает на-
бор переменных процесса. 
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Таблица 4-15:     Производные переменные и расчётные переменные процесса 

 Доступные переменные процесса 

Производная переменная 
Описание 

Плотность при 
стандартной 
температуре 

Стандартный 
объёмный 
расход 

SG  Концентрация Нетто 
массовый 
расход 

Нетто 
объёмный 
расход 

Density at reference temperature 
Плотность при стандартной температу-
ре 
Масса единицы объёма, приведённая к 
стандартной температуре 

√ √     

Specific gravity (SG) 
Относительная плотность 
Отношение плотности продукта при дан-
ной температуре к плотности воды при 
данной температуре. Совпадение темпера-
тур необязательно. 

√ √ √    

Mass concentration derived from reference 
density Массовая концентрация, получае-
мая по плотности 
Процентное содержание растворённого 
вещества или материала в суспензии во 
всём растворе по массе, определяемое по 
плотности 

√ √ √ √   

Mass concentration derived from specific 
gravity Массовая концентрация, получае-
мая поSG 
Процентное содержание растворённого 
вещества или материала в суспензии во 
всём растворе по массе, определяемое по 
SG 

√ √ √ √ √  

Volume concentration derived from reference 
density Объёмная концентрация, получае-
мая по плотности 
Процентное содержание растворённого 
вещества или материала в суспензии во 
всём растворе по объёму, определяемое по 
плотности 

√ √  √  √ 

Volume concentration derived from specific 
gravity Объёмная концентрация, получае-
мая по SG 
Процентное содержание растворённого 
вещества или материала в суспензии во 
всём растворе по объёму, определяемое по 
SG 

√ √ √ √  √ 

Concentration derived from reference density 
Концентрация, получаемая по плотности 
Масса, объём, вес или количество молей 
растворённого вещества или материала в 
суспензии во всём растворе, определяемое 
по плотности 

√ √  √   
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Таблица 4-15:     Производные переменные и расчётные переменные процесса (продолжение) 

 

 Доступные переменные процесса 

Производная переменная 
Описание 

Плотность при 
стандартной 
температуре 

Стандартный 
объёмный 
расход 

SG  Концентрация Нетто 
массовый 
расход 

Нетто 
объёмный 
расход 

Concentration derived from specific gravity 
Концентрация, получаемая по SG 
Масса, объём, вес или количество молей 
растворённого вещества или материала в 
суспензии во всём растворе, определяемое 
по SG 

√ √ √ √   

 

4.9 Конфигурирование компенсации давления  
 

Компенсация давления подстраивает измерение технологических параметров процесса для 
компенсирования влияния давления на показания сенсора. Влияние давления заключается в 
изменении чувствительности сенсора к расходу и плотности, вызванном разницей между ка-
либровочным давлением и технологическим давлением. 

 

Полезный совет 

Не всем сенсорам необходима компенсация давления. Влияние давления на конкретную мо-
дель сенсора можно найти в его технической документации на сайте www.micromotion.com. 
Если вы неуверенны в применении компенсации по давлению, обратитесь в службу поддержки 
Micro Motion. 

 

4.9.1 Конфигурирование компенсации давления с помощью 
ProLink II 

Предварительные требования 

Вам потребуются значения коэффициента коррекции расхода, коэффициента коррекции плот-
ности и калибровочного давления для вашего сенсора. 

• Чтобы найти Коэффициент коррекции расхода по давлению и Коэффициент коррекции 
плотности по давлению, см. техническую документацию для Вашего сенсора. 

• Чтобы найти Давление калибровки, см. калибровочный лист для Вашего сенсора. Если 
этих данных нет, используйте значение 20 PSI (фунтов на квадратный дюйм). 

Процедура 

1. Выберите View>Preferences и убедитесь, что отмечен параметр Enable External Pressure Com-
pensation (разрешить внешнюю компенсацию давления). 

2. Выберите ProLink>Configuration>Pressure. 

3. Введите Flow Factor (Коэффициент коррекции расхода по давлению) для Вашего сенсора. 
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Коэффициент коррекции расхода по давлению – это изменение в показаниях расхода в 
процентах на один PSI (фунт на квадратный дюйм). Вводя значение, поменяйте его знак. 

Пример: 

Если Коэффициент коррекции расхода по давлению 0.000004% на PSI,  
введите – 0.000004% на PSI. 

4. Введите Density Factor (Коэффициент коррекции плотности по давлению) для Вашего сенсора. 

Коэффициент коррекции плотности по давлению – это изменение плотности жидкости, в 
g/cm3 (граммы на кубический сантиметр) на один PSI (фунт на квадратный дюйм). Вводя 
значение, поменяйте его знак. 

Пример: 

Если Коэффициент коррекции расхода по давлению 0.000006 g/cm3 на PSI,  
введите – 0.000006 g/cm3 на PSI. 

5. Введите Cal Pressure (Давление калибровки) для Вашего сенсора. 

Давление калибровки – это давление, при котором проводилась калибровка Вашего сенсо-
ра, оно определяет давление, при котором не проявляется влияние давления. Если этих 
данных нет, используйте значение 20 PSI. 

6. Определите, как преобразователь будет получать данные о давлении и проведите требуе-
мую установку. 

Вариант Установка 

Постоянное значение 
давления, установ-
ленное пользовате-
лем 

a. Установите желаемые Единицы измерения давления (Pressure 
Units). 

b. Установите Внешнее давление (External Pressure) в желаемое 
значение. 

Опрос внешнего 
датчика давления 

a. Убедитесь, что кабель первого миллиамперного выхода 
смонтирован так, что возможен опрос по HART-протоколу. 

b. Выберите ProLink>Configuration>Polled Variables (опрос пере-
менной). 

c. Для опроса выберите свободный слот (unused polling slot). 
d. Установите параметр Polling Control (режим опроса) в значе-

ние Poll As Primary или Poll As Secondary и щелкните кнопкой 
мыши по Apply (применить). 

e. Установите параметр External Tag (Внешний Тэг) в соответст-
вии с тэгом HART внешнего датчика температуры. 

f.  Установите параметр Varible Type (Тип переменной) в значе-
ние Pressure (давление). 

 
 

Полезный совет 

• Poll As Primary: в сети HART не будет другого мастер-
устройства. 

• Poll As Secondary: в сети HART предполагается второе 
мастер-устройство. Полевой коммуникатор не является 
мастер-устройством HART. 
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Вариант Установка 

Значение, вводимое с 
помощью цифровой 
коммуникации 

a. Установите желаемые Единицы измерения давления (Pressure 
Units). 

b. Осуществите необходимое программирование хоста и ус-
тановку коммуникации для ввода данных о давлении в 
преобразователь с требуемым интервалом времени. 

 
 

Примечание 

Если приложение коммерческого учета активировано, и 
преобразователь находится в режиме защиты записи (se-
cured), то данные о давлении не могут вводиться в преобра-
зователь с помощью цифровой коммуникации. 

 

Дополнительная информация 

Если вы используете значение давления с внешнего источника, проверьте установку, выбрав 
ProLink>Process Variables и проверив значение, отображаемое как Внешнее давление (External Pres-
sure) 

 

4.9.2 Конфигурирование компенсации давления с помощью 
ProLink III 

Предварительные требования 

Вам потребуются значения коэффициента коррекции расхода, коэффициента коррекции плот-
ности и калибровочного давления для вашего сенсора. 

• Чтобы найти Коэффициент коррекции расхода по давлению и Коэффициент коррекции 
плотности по давлению, см. техническую документацию для Вашего сенсора. 

• Чтобы найти Давление калибровки, см. калибровочный листок для Вашего сенсора. Если 
этих данных нет, используйте значение 20 PSI (фунтов на квадратный дюйм). 

Процедура 

1. Выберите Device Tools>Configuration>Process Measurement>Pressure Compensation. 

2.  Установите параметр Pressure Compensation Status (статус компенсации давления) в значение 
Enabled (разрешено). 

3. Введите Flow Calibration Pressure (Давление калибровки) для Вашего сенсора. 

Давление калибровки – это давление, при котором проводилась калибровка Вашего сенсо-
ра, оно определяет давление, при котором не проявляется влияние давления. Если этих 
данных нет, используйте значение 20 PSI. 

4. Введите Flow Factor (Коэффициент коррекции расхода по давлению) для Вашего сенсора. 

Коэффициент коррекции расхода по давлению – это изменение в показаниях расхода в 
процентах на один PSI (фунт на квадратный дюйм). Вводя значение, поменяйте его знак. 

Пример: 

Если Коэффициент коррекции расхода по давлению 0.000004% на PSI,  
введите – 0.000004% на PSI. 

5. Введите Density Factor (Коэффициент коррекции плотности по давлению) для Вашего сенсора. 
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Коэффициент коррекции плотности по давлению – это изменение плотности жидкости, в 
g/cm3 (граммы на кубический сантиметр) на один PSI (фунт на квадратный дюйм). Вводя 
значение, поменяйте его знак. 

Пример: 

Если Коэффициент коррекции расхода по давлению 0.000006 g/cm3 на PSI,  
введите – 0.000006 g/cm3 на PSI. 

6. Установите в параметр Pressure Source метод, который преобразователь будет использо-
вать для получения данных о температуре. 

Вариант Описание 

Опрос внешнего дат-
чика для получения 
значения переменной  

Преобразователь будет опрашивать внешний датчик давления, 
используя HART-протокол по первому миллиамперному вы-
ходу. 

Постоянное (Static) 
значение или значе-
ние, вводимое с по-
мощью цифровой 
коммуникации (Digital 
Communications) 

Преобразователь будет использовать значения давления из 
памяти. 
• Static: используется установленное значение. 
• Digital Communications: Внешний хост вводит данные в 

память преобразователя. 

 
 

Примечание 

Если приложение коммерческого учета активировано, и 
преобразователь находится в режиме защиты записи (se-
cured), то данные о давлении не могут вводиться в преобра-
зователь с помощью цифровой коммуникации. 

 

7. Если Вы выбираете опрос для получения данных о давлении: 

a. Выберите свободный слот для опроса (Polling Slot). 

На преобразователе доступно два слота для опроса. Вы можете использовать один для 
температуры, а второй – для давления, если доступно измерение концентрации или 
нефтепродуктов. 

b. Установите параметр Polling Control (режим опроса) в значение Poll As Primary или Poll As 
Secondary и щелкните кнопкой мыши по Apply (применить). 

 

Полезный совет 

• Poll As Primary: в сети HART не будет другого мастер-устройства 

• Poll As Secondary: в сети HART предполагается второе мастер-устройство. Полевой 
коммуникатор не является мастер-устройством HART. 

 

c. Установите параметр External Device Tag (Тэг Внешнего устройства) в соответствии с тэгом 
HART внешнего датчика давления, и щелкните кнопкой мыши по Apply. 

8. Если Вы выбираете постоянное значение давления: 

a. Установите желаемые Единицы измерения давления (Pressure Unit). 

b. Установите параметр Static (постоянное) или Current Pressure (текущее давление) в желае-
мое значение, и щелкните кнопкой мыши по Apply. 

9. Если Вы хотите использовать значение, вводимое с помощью цифровой коммуникации, 
щелкните кнопкой мыши по Apply, затем осуществите необходимое программирование 
хоста и установку коммуникации для ввода данных о давлении в преобразователь с тре-
буемым интервалом времени. 

 

Дополнительная информация 
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Если вы используете значение давления с внешнего источника, проверьте установку, выбрав 
ProLink>Process Variables и проверив значение, отображаемое как Внешнее давление (External Pres-
sure) 

 

4.9.3 Конфигурирование компенсации давления с помощью 
Полевого коммуникатора 

Предварительные требования 

Вам потребуются значения коэффициента коррекции расхода, коэффициента коррекции плот-
ности и калибровочного давления для вашего сенсора. 

• Чтобы найти Коэффициент коррекции расхода по давлению и Коэффициент коррекции 
плотности по давлению, см. техническую документацию для Вашего сенсора. 

• Чтобы найти Давление калибровки, см. калибровочный лист для Вашего сенсора. Если 
этих данных нет, используйте значение 20 PSI (фунтов на квадратный дюйм). 

Процедура 

1. Выберите Online>Configure>Manual Setup>Measurements>External Pressure/Temperature>Pressure. 

2.  Установите параметр Pressure Compensation (компенсации давления) в значение Enabled (раз-
решено). 

3. Введите Flow Cal Pressure (Давление калибровки) для Вашего сенсора. 

Давление калибровки – это давление, при котором проводилась калибровка Вашего сенсо-
ра, оно определяет давление, при котором не проявляется влияние давления. Если этих 
данных нет, используйте значение 20 PSI. 

4. Введите Flow Press Factor (Коэффициент коррекции расхода по давлению) для Вашего сен-
сора. 

Коэффициент коррекции расхода по давлению – это изменение в показаниях расхода в 
процентах на один PSI (фунт на квадратный дюйм). Вводя значение, поменяйте его знак. 

Пример: 

Если Коэффициент коррекции расхода по давлению 0.000004% на PSI,  
введите – 0.000004% на PSI. 

5. Введите Dens Press Factor (Коэффициент коррекции плотности по давлению) для Вашего 
сенсора. 

Коэффициент коррекции плотности по давлению – это изменение плотности жидкости, в 
g/cm3 (граммы на кубический сантиметр) на один PSI (фунт на квадратный дюйм). Вводя 
значение, поменяйте его знак. 

Пример: 

Если Коэффициент коррекции расхода по давлению 0.000006 g/cm3 на PSI,  
введите – 0.000006 g/cm3 на PSI. 

6. Определите, как преобразователь будет получать данные о давлении и проведите требуе-
мую установку. 
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Вариант Установка 

Постоянное значение 
температуры, уста-
новленное пользова-
телем 

a. Установите желаемые Единицы измерения давления (Pres-
sure Unit). 

b. Установите Компенсационное давление (Compensation Pres-
sure) в желаемое значение.. 

Опрос внешнего 
датчика 

a. Убедитесь, что кабель первого миллиамперного выхода 
смонтирован так, что возможен опрос по HART-протоколу. 

b. Выберите Online>Configure>Manual Setup>Measurements> 
External Pressure/Temperature>External Polling. 

c. Установите параметр Poll Control (режим опроса) в значение 
Poll As Primary Host или Poll As Secondary Host.  

d. Для опроса выберите свободный слот (unused polling slot). 

e. Установите параметр External Tag (Внешний Тэг) в соответ-
ствии с тэгом HART внешнего датчика температуры. 

f. Установите параметр Polled Varible (Переменная опроса) в 
значение Pressure. 

 
 

Полезный совет 

• Poll As Primary: в сети HART не будет другого мастер-
устройства. 

• Poll As Secondary: в сети HART предполагается второе 
мастер-устройство. Полевой коммуникатор не является 
мастер-устройством HART. 

Значение, вводимое с 
помощью цифровой 
коммуникации 

a. Установите желаемые Единицы измерения давления (Pres-
sure Unit). 

b. Осуществите необходимое программирование хоста и ус-
тановку коммуникации для ввода данных о давлении в 
преобразователь с требуемым интервалом времени. 

 
 

Примечание 

Если приложение коммерческого учета активировано, и 
преобразователь находится в режиме защиты записи (se-
cured), то данные о давлении не могут вводиться в преобра-
зователь с помощью цифровой коммуникации. 

 

Дополнительная информация 

Если вы используете значение давления с внешнего источника, проверьте установку, выбрав 
ProLink>Process Variables и проверив значение, отображаемое как Внешнее давление (External Pres-
sure)  

 

4.9.4 Варианты единиц измерения давления 
 Преобразователь предоставляет стандартный набор единиц измерения для давления. Различные 

средства коммуникации могут использовать разные наименования для этих единиц. Для боль-
шинства приложений, единицы измерения давления должны совпадать с единицами измерения 
давления, используемыми внешним устройством. 
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Таблица 4-16:     Варианты единиц измерения давления 

Описание единиц 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Футы воды @ 68˚F FTH20 Ft Water @ 68˚F Ft Water @ 68˚F ftH20 

Дюймы воды @ 4˚C INW4C In Water @ 4˚C In Water @ 4˚C inH20 @4DegC 

Дюймы воды @ 60˚F INW60 In Water @ 60˚F In Water @ 60˚F inH20 @60DegF 

Дюймы воды @ 68˚F INH20 In Water @ 68˚F In Water @ 68˚F inH20 

Миллиметры воды @ 4˚C mmw4C mm Water @ 4˚C mm Water @ 4˚C mmH20 @4DegC 

Миллиметры воды @ 68˚F mmH20 mm Water @ 
68˚F 

mm Water @ 
68˚F 

mmH20 

Миллиметры ртути @ 0˚C mmHG mm Mercury @ 
0˚C 

mm Mercury @ 
0˚C 

mmHg 

Дюймы ртути @ 0˚C INHG In Mercury @ 0˚C In Mercury @ 0˚C inHg 

Фунты на квадратный дюйм PSI PSI PSI psi 

Бар BAR bar bar bar 

Миллибар mBAR millibar millibar mbar 

Грамм на квадратный санти-
метр 

G/SCM g/cm2 g/cm2 g/Sqcm 

Килограмм на квадратный сан-
тиметр 

KG/SCM kg/cm2 kg/cm2 kg/Sqcm 

Паскаль PA pascals pascals Pa 

Килопаскаль KPA Kilopascals Kilopascals kPa 

Мегапаскаль MPA megapascals megapascals MPa 

Тор @ 0˚C TORR Torr @ 0°C Torr @ 0°C torr 

Атмосфера ATM atms atms atms 
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5 Конфигурирование опций и предпочтений 
 

Темы данной главы 
• Конфигурирование дисплея преобразователя 

• Разрешение и запрет на действия оператора с дисплея 

• Конфигурирование безопасности меню дисплея 

• Конфигурирование параметров времени отклика 

• Конфигурирование действий при ошибке 

• Конфигурирование информационных параметров 

 

5.1 Конфигурирование дисплея преобразователя 
   Вы можете контролировать переменные процесса, отображаемые на дисплее и множество ва-

риантов режима работы дисплея. 

 Параметры дисплея преобразователя включают: 

• Язык дисплея 

• Переменные дисплея 

• Разрядность показаний дисплея 

• Период обновления 

• Автопрокрутка (Auto Scroll) и ее скорость (Auto Scroll Rate) 

• Подсветка 

• Мигание светодиода состояния 

 

5.1.1 Конфигурирование языка дисплея 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>DISPLAY>LANG 

ProLink II ProLink>Configuration>Display>Display Language 

ProLink III Device Tools>Configuration>Transmitter Display>General 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Language 

 

Обзор 

Параметр Язык дисплея определяет язык, используемый для технологических данных процесса и 
меню на дисплее. 

Процедура 

Доступные языки зависят от модели и версии Вашего преобразователя. 
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5.1.2 Конфигурирование переменных, отображаемых на дисплее 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Display 

ProLink III Device Tools>Configuration>Transmitter Display>Display Variables 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Display Variables 

 

Обзор 

Вы можете определять переменные процесса, которые будут отображаться на дисплее, а также 
порядок, в котором они будут появляться. На дисплей может выводиться до 15 переменных 
процесса в любом указанном Вами порядке. Кроме того, Вы можете повторять переменные 
или оставить слоты незаполненными. 

Ограничения 

• Нельзя значение Display Variable 1 (Переменной Дисплея 1) установить в значение None 
(Нет). Переменная Дисплея 1 должна быть установлена на значение переменной процесса. 

• При фиксировании соответствия Переменной Дисплея 1 первому мА выходу, Вы не смо-
жете изменить установку Переменной Дисплея 1 рассматриваемым способом. Для изме-
нения установки Переменной Дисплея 1 Вам придётся изменить конфигурацию выхода 
переменной процесса для первого мА выхода. 

 

Примечание 

Если Вы сконфигурируете переменную объёмного расхода в качестве дисплейной переменной 
и затем измените установку Типа Объёмного Расхода (Volume Flow Type), переменная дисплея 
автоматически изменится на соответствующую переменную процесса. Например, если Пере-
менная Дисплея 2 была установлена на мгновенный объёмный расход (Volume Flow Rate), она 
изменится на стандартный мгновенный объёмный расход газа (Gas Standard Volume Flow 
Rate). 

 

Процедура 

Для каждой переменной дисплея, которую Вы хотите изменить, определите переменную про-
цесса, которую Вы хотите использовать. 

Пример: Конфигурация переменных дисплея по умолчанию 

 

Переменная дисплея Переменная процесса 

Переменная дисплея 1 Mass flow (Массовый расход) 

Переменная дисплея 2 Mass totalizer (Массовый сумматор) 

Переменная дисплея 3 Volume flow (Объемный расход) 

Переменная дисплея 4 Volume totalizer (Объемный сумматор) 

Переменная дисплея 5 Density (Плотность) 

Переменная дисплея 6 Temperature (Температура) 

Переменная дисплея 7 External pressure (Давление от внешнего датчика) 

Переменная дисплея 8 Mass flow (Массовый расход) 

Переменная дисплея 9 None (Нет) 

Переменная дисплея 10 None (Нет) 

Переменная дисплея 11 None (Нет) 
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Переменная дисплея Переменная процесса 

Переменная дисплея 12 None (Нет) 

Переменная дисплея 13 None (Нет) 

Переменная дисплея 14 None (Нет) 

Переменная дисплея 15 None (Нет) 

 

   Конфигурирование Переменной дисплея 1 в соответствии с первым 
миллиамперным выходом 

 

Дисплей OFF-LINE MAINT>OFF-LINE CONFG>DISPLAY>VAR1 

ProLink II ProLink>Configuration>Display>Display Options>Display Variable 1 Selection 

ProLink III Device Tools>Configuration>Transmitter Display>Display Security 

Полевой Ком-
муникатор 

Не доступно 

 

Обзор 

Вы можете сконфигурировать Переменную Дисплея 1 , зафиксировав её соответствие пере-
менной процесса, присвоенной первому мА выходу. Когда это соответствие разрешено, Вы 
можете контролировать Переменную Дисплея 1 из меню дисплея. 

 

Полезный совет 

Это единственная возможность конфигурирования дисплейной переменной с помощью меню 
дисплея, и касается только Переменной Дисплея 1. 

 

Процедура 

Сконфигурируйте Переменную Дисплея 1 на соответствие переменной процесса, присвоенной 
первому мА выходу.  

Переменная Дисплея 1 будет автоматически зафиксирована на соответствие переменной про-
цесса, присвоенной первому мА выходу. При изменении конфигурации переменной процесса, 
присвоенной первому мА выходу, Переменная Дисплея 1 автоматически обновится. 

 

 

5.1.3 Конфигурирование разрядности переменных, отображаемых 
на дисплее 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Display>Display Precision 

ProLink III Device Tools>Configuration>Transmitter Display>Display Variables 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Decimal Places 
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Обзор 

Параметр Разрядность переменных, отображаемых на дисплее (Display Precision) определяет 
разрядность (количество знаков после десятичной точки) данных на дисплее. Этот параметр 
устанавливается независимо для каждой переменной. Установка этого параметра не влияет на 
действительное значение переменной. 

Процедура 

1. Выберите переменную процесса. 

2. Для переменных плотности и температуры значение по умолчанию 2. Для всех остальных 
переменных значение по умолчанию 4. Диапазон от 0 до 5. 

 

Полезный совет 

Чем меньше выбрана разрядность, тем больше допустимое изменение переменной про-
цесса, отображаемой на дисплее. 

 

 

5.1.4 Конфигурирование периода обновления данных, 
отображаемых на дисплее 

Дисплей OFF-LINE MAINT>OFF-LINE CONFG>DISPLAY>RATE 

ProLink II ProLink>Configuration>Display>Update Period 

ProLink III Device Tools>Configuration>Transmitter Display>Display Variables 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Display Variable Menu Features>Refresh Rate 

 

Обзор 

Вы можете установить параметр периода обновления (Update Period) для контроля за перио-
дом обновления данных на дисплее. 

Процедура 

Установите параметр периода обновления (Update Period) в желаемое значение. 

Значение по умолчанию 200 миллисекунд. Диапазон от 100 миллисекунд до 10000 миллисе-
кунд (10 секунд). 
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5.1.5 Разрешение и запрет на автопрокурутку переменных 
дисплея 

Дисплей OFF-LINE MAINT>OFF-LINE CONFG>DISPLAY>AUTO SCRLL 

ProLink II ProLink>Configuration>Display>Display Options>Display Auto Scroll 

ProLink III Device Tools>Configuration>Transmitter Display>General 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Display Variable Menu Features>Auto Scroll 

 

Обзор 

Вы можете сконфигурировать дисплей на автоматическую прокрутку дисплейных переменных 
или на отображение одной дисплейной переменной до активации оператором оптического пе-
реключателя Scroll (Прокрутка). При установке автоматической прокрутки, Вы можете также 
сконфигурировать период времени отображения каждой дисплейной переменной.  

Процедура 

1. Разрешите или запретите Auto Scroll (Автопрокрутку). 

Вариант Описание 

Разрешение (Enable) На дисплее автоматически последовательно отображаются дис-
плейные переменные в соответствии со значением периода вре-
мени отображения каждой дисплейной переменной (Scroll Rate). 
Оператор может перейти на отображение следующей дисплей-
ной переменной, используя оптический переключатель Scroll. 

Запрет (Disable) – по 
умолчанию 

На дисплее отображается Первая дисплейная переменная, и ав-
топрокрутка не происходит. Оператор может перейти на ото-
бражение следующей дисплейной переменной, используя опти-
ческий переключатель Scroll. 

 

2. При разрешении автопрокрутки, установите желаемый период отображения дисплейной 
переменной (Scroll Rate). 

Значение по умолчанию 10 секунд. 

Полезный совет 

При разрешении автопрокрутки, период отображения дисплейной переменной (Scroll 
Rate) может быть недоступен. 

 

 

5.1.6 Разрешение и запрет на подсветку дисплея 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>DISPLAY>BKLT 

ProLink II ProLink>Configuration>Display>Display Options>Display Backlight On/Off 

ProLink III Device Tools>Configuration>Transmitter Display>General 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Backlight 

 

Обзор 

Вы можете разрешить или запретить подсветку дисплея. 
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Процедура 

Разрешите или запретите подсветку дисплея. 

Значение по умолчанию Enabled (Разрешена). 

 

5.1.7 Разрешение и запрет на мигание светодиода состояния 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Display>Display Options>Display Status LED Blinking 

ProLink III Device Tools>Configuration>Transmitter Display>General 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Display Variable Menu Features>Status LED Blinking 

 

Обзор 

По умолчанию светодиод состояния мигает для индикации неподтверждённых тревожных со-
общений (алармов). При запрете мигания светодиода состояния, он не будет мигать вне зави-
симости от наличия или отсутствия неподтверждённых тревожных сообщений. Цвет свето-
диода состояния продолжит меняться для индикации активных тревожных сообщений. 

Процедура 

Разрешите или запретите мигание светодиода состояния (Status LED Blinking).. 

Значение по умолчанию Enabled (Разрешено). 

 

5.2 Разрешение и запрет на действия оператора с 
дисплея 

   Вы можете сконфигурировать преобразователь, чтобы он позволял оператору выполнять спе-
циальные действия, используя дисплей. 

 Вы можете сконфигурировать: 

• Пуск/Останов сумматора 

• Сброс сумматора 

• Подтверждение всех тревожных сообщений 
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5.2.1 Разрешение и запрет на пуск/останов сумматора с дисплея 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>DISPLAY>TOTALS STOP 

ProLink II ProLink>Configuration>Display>Display Options>Display Start/Stop Totalizers 

ProLink III Device Tools>Configuration>Totalizer Control Methods 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Display Variable Menu Features>Start/Stop Totalizers 

 

Обзор 

Вы можете разрешить или запретить оператору запуск или останов сумматоров и инвентариза-
торов с дисплея. 

Ограничения 

• Вы не можете запустить или остановить сумматоры с дисплея индивидуально. Все сумма-
торы запускаются или останавливаются с дисплея одновременно. 

• Вы не можете запустить или остановить инвентаризаторы отдельно от сумматоров. При 
запуске или останове сумматора, соответствующий инвентаризатор также запускается или 
останавливается. 

• При установленном приложении измерения нефти по API, для выполнения этой функции 
оператор должен ввести пароль, даже если функция off-line password не активирована. 

Процедура 

1. Убедитесь в том, что хотя бы один сумматор сконфигурирован как дисплейная перемен-
ная. 

2. По желанию, разрешите или запретите сброс сумматора (Totalizer Reset). 

Вариант Описание 

Разрешение (Enable) Оператор может запустить или остановить сумматоры и инвен-
таризаторы с дисплея, если хотя бы один сумматор сконфигу-
рирован как дисплейная переменная. 

Запрет (Disable) – по 
умолчанию 

Оператор не может запустить или остановить сумматоры и ин-
вентаризаторы с дисплея. 

  

 

5.2.2 Разрешение и запрет на сброс сумматора с дисплея 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>DISPLAY>TOTALS RESET 

ProLink II ProLink>Configuration>Display>Display Options>Display Totalizer Reset 

ProLink III Device Tools>Configuration>Totalizer Control Methods 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Display Variable Menu Features>Totalizer Reset 

 

Обзор 

Вы можете разрешить или запретить оператору сброс сумматоров с дисплея. 
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Ограничения 

• Этот параметр не относится к инвентаризаторам. Вы не можете сбросить инвентаризато-
ры с дисплея. 

• Вы не можете сбросить сразу несколько сумматоров с помощью дисплея. Сброс суммато-
ров осуществляется индивидуально. 

• При установленном приложении измерения нефти по API, для выполнения этой функции 
оператор должен ввести пароль, даже если функция off-line password не активирована. 

Процедура 

1. Убедитесь в том, что сумматор, значение которого Вы желаете сбросить, сконфигурирован 
как дисплейная переменная. В противном случае сброс сумматора с дисплея будет невоз-
можен. 

2. Разрешите или запретите сброс сумматора с дисплея. 

Вариант Описание 

Разрешение (Enable) Оператор может сбросить сумматор с дисплея, если сумматор 
сконфигурирован как дисплейная переменная. 

Запрет (Disable) – по 
умолчанию 

Оператор не может сбросить сумматоры с дисплея. 

  

 

5.2.3 Разрешение и запрет на подтверждение всех тревожных 
сообщений с дисплея 

Дисплей OFF-LINE MAINT>OFF-LINE CONFG>DISPLAY>ALARM 

ProLink II ProLink>Configuration>Display>Display Options>Display Ack All Alarms 

ProLink III Device Tools>Configuration>Transmitter Display>Ack All 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Offline Variable Menu Features>Acknowledge All 

 

Обзор 

Вы можете разрешить или запретить оператору использование одной команды для подтвер-
ждения всех алармов с дисплея. 

Процедура 

1. Убедитесь в том, что оператору доступно меню тревожных сообщений (алармов). Для 
подтверждения алармов с дисплея, оператор должен иметь доступ к меню тревожных со-
общений (алармов). 

2. Разрешите или запретите возможность подтверждения всех алармов с дисплея 
(Acknowledge All Alarms). 

Вариант Описание 

Разрешение (Enable) Оператор может использовать одну дисплейную команду для 
подтверждения всех алармов сразу. 

Запрет (Disable) – по 
умолчанию 

Оператор не может использовать одну дисплейную команду для 
подтверждения всех алармов сразу. Они должны подтверждать-
ся индивидуально. 
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5.3 Конфигурирование безопасности меню дисплея 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>DISPLAY 

ProLink II ProLink>Configuration>Display>Display Options 

ProLink III Device Tools>Configuration>Transmitter Display>Display Security 

Полевой Ком-
муникатор 

Configure>Manual Setup>Display>Offline Variable Menu Features 

 

Обзор 

Вы можете контролировать доступ оператора к различным разделам меню дисплея off-line. Вы 
также можете конфигурировать пароль доступа. 

Процедура 

1. Для контроля доступа оператора к разделу обслуживания (maintenance) меню дисплея off-
line, разрешите или запретите доступ к меню (Off-Line Menu). 

Вариант Описание 

Разрешение (Enable) Оператор имеет доступ к разделу обслуживания (maintenance) 
меню дисплея off-line. Этот доступ необходим для конфигури-
рования и калибровки, но не нужен для просмотра алармов и к 
контролю метрологических характеристик (Smart Meter Verifica-
tion) (если применимо). 

Запрет (Disable) – по 
умолчанию 

Оператор не имеет доступа к разделу обслуживания (mainte-
nance) меню дисплея off-line. 

 

2. Для контроля доступа оператора к меню алармов (alarm menu), разрешите или запретите 
доступ к меню тревожных сообщений (Alarm Menu). 

Вариант Описание 

Разрешение (Enable) Оператор имеет доступ к меню тревожных сообщений. Этот 
доступ необходим для просмотра и подтверждения алармов, но 
не нужен для конфигурирования и калибровки и для контроля 
метрологических характеристик (Smart Meter Verification) (если 
применимо). 

Запрет (Disable) – по 
умолчанию 

Оператор не имеет доступа к меню тревожных сообщений. 

 

Примечание 

Светодиод состояния преобразователя изменяет цвет для индикации активных алармов, 
но не указывает на конкретное тревожное сообщение. 
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3. Для запроса пароля для доступа к разделу обслуживания (maintenance) меню дисплея off-
line и к контролю метрологических характеристик (Smart Meter Verification), разрешите 
или запретите Off-Line Password. 

Вариант Описание 

Разрешение (Enable) У оператора запрашивается пароль при попытке входа в раздел 
контроля метрологических характеристик (Smart Meter Verifica-
tion) (если применимо) и в раздел обслуживания (maintenance) 
меню дисплея off-line.  

Запрет (Disable) – по 
умолчанию 

У оператора не запрашивается пароль при попытке входа в раз-
дел контроля метрологических характеристик (Smart Meter Veri-
fication) (если применимо) и в раздел обслуживания (mainte-
nance) меню дисплея off-line. 

 

4. Для запроса пароля для доступа к меню тревожных сообщений разрешите или запретите 
Alarm Password. 

Вариант Описание 

Разрешение (Enable) У оператора запрашивается пароль при попытке входа в меню 
тревожных сообщений. 

Запрет (Disable) – по 
умолчанию 

У оператора не запрашивается пароль при попытке входа в ме-
ню тревожных сообщений. 

 

Если разрешены оба пароля и Off-Line Password и Alarm Password, у оператора запрашива-
ется off-line пароль при попытке входа в меню off-line, и в дальнейшем не запрашивается. 

5. (Не обязательно) Установите Off-Line Password в желаемое значение. 

Для паролей Off-Line Password и Alarm Password используется одно и то же значение. Зна-
чение по умолчанию 1234. Диапазон от 0000 до 9999. 

 

Полезный совет 

Запишите пароль для дальнейшего использования. 
 

 

5.4 Конфигурирование параметров времени отклика 
   Вы можете сконфигурировать частоту опроса данных и расчёта переменных процесса. 

 Параметры времени отклика включают: 

• Частоту обновления 

• Скорость вычислений (время отклика) 
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5.4.1 Конфигурирование частоты обновления (Update Rate) 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Device>Update Rate 

ProLink III Device Tools>Configuration>Process Measurement>Response>Update Rate 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Update Rate 

 

Обзор 

Параметр Update Rate определяет частоту опроса данных процесса и расчёта переменных про-
цесса. Параметр Update Rate, установленный в значение Special приводит к более частому и 
“шумному” отклику на изменения в процессе. Не используйте режим Special, если это не не-
обходимо для Вашего применения. 

Полезный совет 

Для систем со стандартным базовым процессором режим Special может улучшить работу сис-
темы при двухфазном потоке и в. применениях Пустой-Полный-Пустой (Empty-Full-Empty). 
Это не относится к системам с усовершенствованным базовым процессором. 

Предварительные требования 

• Проверьте влияние режима Special на конкретную переменную процесса. 

• Свяжитесь с Micro Motion. 

Процедура 

1. Установите параметр Update Rate в желаемое значение. 

Вариант Описание 

Normal  
(Нормальный) 

Все данные процесса опрашиваются с частотой 20 Гц. 

Все переменные процесса рассчитываются с частотой 20 Гц. 

Этот вариант подходит для большинства применений. 

Special  
(Специальный) 

Одна, определённая пользователем, переменная опрашивается с час-
тотой 100 Гц. Другие данные процесса опрашиваются с частотой 6.25 
Гц. Некоторые данные процесса, диагностические и калибровочные 
данные не опрашиваются. 

Все доступные переменные процесса рассчитываются с частотой 100 
Гц. 

Используйте этот вариант только если это необходимо для Вашего 
применения. 

 

При изменениии параметра Update Rate, установки Flow Damping, Density Damping и Tem-
perature Damping автоматически подстраиваются. 

2. При установке параметра Update Rate в значение Special, выберите переменную процесса 
для её опроса с частотой 100 Гц. 
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   Влияние частоты обновления = Special 
 Функции и процедуры, несовместимые с режимом Special 

Режим Special не совместим со следующими функциями и процедурами. 

• Расширенные события (Enhanced events). Используйте взамен базовые события. 

• Все процедуры калибровки. 

• Контроль стабильности нуля (Zero Verification). 

• Восстановление заводского значения нуля или предыдущего значения нуля. 

При необходимости, можно переключиться в режим Normal, провести желаемые процедуры, и 
затем вернуться в режим Special. 

Обновление переменных процесса 

Некоторые переменные процесса не обновляются в режиме Special. 

 

Таблица 5-1:     Режим Special и обновление переменных процесса 

Всегда опрашиваются и обновляются Обновляются только 
при выключенном 
приложении измере-
ния нефти по API 

Не обновляют-
ся 

• Mass flow (мгновенный массовый расход) 

• Volume flow (мгновенный объёмный расход) 

• Gas standard volume flow (стандартный объёмный расход га-
за) 

• Density (плотность) 

• Temperature (температура) 

• Drive gain (уровень сигнала на возбуждающей катушке) 

• LPO amplitude (амплитуда сигнала на левой детекторной ка-
тушке) 

• Status [содержит Событие 1 и Событие 2 (базовые события)] 

• Raw tube frequency (частота колебаний трубок сенсора) 

• Mass total (массовый сумматор) 

• Volume total (объёмный сумматор) 

• Gas standard volume total (сумматор стандартного объёма га-
за) 

• Temperature-corrected volume total (объёмный сумматор, 
скорректированный по температуре) 

• Temperature-corrected density(плотность, скорректированная 
по температуре) 

• Temperature-corrected volume flow (объёмный расход, скор-
ректированный по температуре) 

• Batch-weighted average temperature (средневзвешенная тем-
пература) 

• Batch-weighted average density (средневзвешенная плотность) 

• RPO amplitude (ам-
плитуда сигнала на пра-
вой детекторной катуш-
ке) 

• Board temperature 
(температура платы 
электроники) 

• Core input voltage 
(напряжение на ба-
зовом процессоре) 

• Mass Inventory (ин-
вентаризатор мас-
сы) 

• Volume inventory 
(инвентаризатор 
объёма) 

• Gas standard volume 
inventory (инвента-
ризатор стандарт-
ного объёма газа) 

 

Все другие пе-
ременные про-
цесса и калиб-
ровочные дан-
ные. Они сохра-
няют значения, 
бывшие на мо-
мент разреше-
ния режима 
Special. 
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5.4.2 Конфигурирование скорости вычислений (времени отклика) 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Device>Response Time 

ProLink III Device Tools>Configuration>Process Measurement>Response>Calculation Speed 

Полевой Ком-
муникатор 

Не доступно 

 

Обзор 

Параметр Calculation speed определяет алгоритм расчёта переменных процесса по исходным 
данным процесса. Параметр Calculation speed, установленный в значение Special приводит к 
более частому и “шумному” отклику на изменения в процессе. 

В ProLink II параметр Calculation speed называется Response Time. 

Ограничение 

Параметр Calculation speed доступен только в системах с усовершенствованным базовым про-
цессором. 

 

Полезный совет 

Вы можете использовать параметр Calculation speed, установленный в значение Special совме-
стно с установкой параметра Update Rate. Параметры контролируют различные аспекты про-
цесса вычислений. 

 

Процедура 

Установите параметр Calculation speed в желаемое значение. 

 

Вариант Описание 

Normal  
(Нормальный) 

Преобразователь рассчитывает значения переменных процесса со 
стандартной скоростью. 

Special  
(Специальный) 

Преобразователь рассчитывает значения переменных процесса с по-
вышенной скоростью. 

 

5.5 Конфигурирование действий при ошибке 
   Параметры действий при ошибке определяют реакцию преобразователя на особенности со-

стояния процесса и оборудования. 

 Действия при ошибке включают: 

• Fault Timeout (Тайм-аут при ошибке) 

• Status Alarm Severity (Приоритет тревожного сообщения состояния) 
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5.5.1 Конфигурирование тайм-аута по ошибке 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Analog Output>Last Measured Value Timeout 

ProLink III Device Tools>Configuration>Frequency/Discrete Output>Frequency>Last Measured Value 
Timeout 

Полевой Ком-
муникатор 

Configure>Alert Setup>Alert Severity>Fault Timeout 

 

Обзор 

Параметр Fault Timeout (Тайм-аут при ошибке) определяет время задержки в использовании 
алгоритма действий при ошибке. 

Ограничение 

Параметр Fault Timeout (Тайм-аут при ошибке) применим только к следующим тревожным 
сообщениям (перечислены в кодах алармов состояния): А003, А004, А005, А008, А016, А017, 
А033. Действия при ошибке для всех других тревожных сообщений осуществляются сразу при 
их обнаружении. 

 

Процедура 

Установите параметр Fault Timeout (Тайм-аут при ошибке) в желаемое значение. 

Значение по умолчанию 0 секунд. Диапазон от 0 до 60 секунд. 

При значении параметра Fault Timeout (Тайм-аут при ошибке) равном нулю, действия при 
ошибке осуществляются сразу при обнаружении условий тревожных сообщений. 

Время действия тайм-аута при ошибке начинается в момент обнаружения преобразователем 
условий тревожного сообщения. В течение тайм-аута при ошибке преобразователь продолжает 
отображать последнее действительное значение измерений. 

По истечению тайм-аута при ошибке и при активном аларме, осуществляются действия при 
ошибке. Если условия тревожного сообщения исчезли до истечения тайм-аута при ошибке, 
действия при ошибке не осуществляются. 

Полезный совет 

В ПО ProLink II установка параметра Fault Timeout (Тайм-аут при ошибке) возможна в двух 
местах. Однако, это один параметр, и для всех выходов применяется одна установка. 

 

5.5.2 Конфигурирование приоритета тревожного сообщения 
состояния 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Alarm>Severity 

ProLink III Device Tools>Configuration>Alert Severity 

Полевой Ком-
муникатор 

Configure>Alert Setup>Alert Severity>Set Alert Severity 
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Обзор 

Используйте параметр Status Alarm Severity (приоритет тревожного сообщения состояния) для 
управления действиями преобразователя при обнаружении условий тревожного сообщения. 

Ограничения 

• Для некоторых тревожных сообщений параметр Status Alarm Severity неконфигурируем. 

• Для некоторых тревожных сообщений параметр Status Alarm Severity может быть уста-
новлен только в два из трёх значений. 

 

Полезный совет 

Micro Motion для параметра Status Alarm Severity рекомендует использовать значения по 
умолчанию и изменять их лишь в случае действительной необходимости. 

 

Процедура 

1. Выберите тревожное сообщение состояния. 

2. Для выбранного тревожного сообщения состояния установите параметр Status Alarm Se-
verity (приоритет тревожного сообщения состояния) в желаемое значение. 

 

Вариант Описание 

Fault 
Ошибка 

Действия при обнаружении ошибки: 

• Аларм помещается в журнал тревожных сообщений. 
• Выходы устанавливаются на сконфигурированные уровни при 

ошибке (по истечению тайм-аута при ошибке, если примени-
мо). 

• Цифровые коммуникации устанавливаются на сконфигуриро-
ванные уровни при ошибке (по истечению тайм-аута при 
ошибке, если применимо). 

• Светодиод состояния (при наличии) загорается красным или 
жёлтым (в зависимости от приоритета тревожного сообщения). 

Действия при исчезновении ошибки: 

• Выходы возвращаются в нормальное состояние. 
• Цифровые коммуникации возвращаются в нормальное состоя-

ние. 
• Светодиод состояния (при наличии) загорается зелёным и мо-

жет мигать или гореть постоянно. 

Informational 
Информационный 

Действия при обнаружении ошибки: 

• Аларм помещается в журнал тревожных сообщений. 
• Светодиод состояния (при наличии) загорается красным или 

жёлтым (в зависимости от приоритета тревожного сообщения). 

Действия при исчезновении ошибки: 

• Светодиод состояния (при наличии) загорается зелёным и мо-
жет мигать или гореть постоянно. 

Ignore 
Игнорируемый 

Нет действий. 
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 Тревожные сообщения состояния и варианты их приоритета 
Таблица 5-2: Тревожные сообщения состояния и варианты их приоритета 

Код Сообщение состояния Приоритет  
по умолчанию 

Примечания Приоритет 
Конфигурируем? 

А001 EEPROM Error (Core Processor) Ошибка 
ЭСППЗУ (базовый процессор) 

Fault  Нет 

А002 RAM Error (Core Processor) Ошибка ОЗУ 
(базовый процессор) 

Fault  Нет 

А003 No Sensor Response  
Неисправность сенсора 

Fault  Да 

А004 Temperature Overrange  
Температура вне диапазона 

Fault  Нет 

А005 Mass Flow Rate Overrange  
Массовый расход вне диапазона 

Fault  Да 

А006 Characterization Required  
Необходима характеризация 

Fault  Да 

А008 Density Overrange  
Плотность вне диапазона 

Fault  Да 

А009 Transmitter Initializing/Warming Up Преобра-
зователь прогревается (Инициализация пре-
образователя) 

Fault  Да 

А010 Calibration Failure 
Ошибка калибровки 

Fault  Нет 

А011 Zero Calibration Failed: Low Ошибка калиб-
ровки нуля: низкое значение 

Fault  Да 

А012 Zero Calibration Failed: High Ошибка калиб-
ровки нуля: высокое значение 

Fault  Да 

А013 Zero Calibration Failed: Unstable Ошибка 
калибровки нуля: нестабильное значение 

Fault  Да 

А014 Transmitter Failure Ошибка преобразователя Fault  Нет 

А016 Sensor RTD Failure Ошибка термосопротив-
ления 

Fault  Да 

А017 T-Series RTD Failure Ошибка термосопро-
тивления сенсора Т-Серии 

Fault  Да 

А018 EEPROM Error (Transmitter) Ошибка ЭСПП-
ЗУ (Преобразователь) 

Fault  Нет 

А019 RAM Error (Transmitter) Ошибка ОЗУ (Пре-
образователь) 

Fault  Нет 

А020 No Flow Cal Value Не введен калибровочный 
коэффициент (Flowcal) 

Fault  Да 

А021 Incorrect Sensor Type (K1) Неправильный 
тип сенсора (К1) 

Fault  Нет 

A022 Configuration Database Corrupt (Core Proces-
sor) Неисправность базы данных конфигу-
рации (базовый процессор) 

Fault Относится только к расхо-
домерам со стандартным 
базовым процессором. 

Нет 

A023 Internal Totals Corrupt (Core Processor) Неис-
правность внутренних сумматоров (базовый 
процессор) 

Fault Относится только к расхо-
домерам со стандартным 
базовым процессором. 

Нет 

A024 Program Corrupt (CoreProcessor) Программ-
ная неисправность (базовый процессор) 

Fault Относится только к расхо-
домерам со стандартным 
базовым процессором. 

Нет 
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Таблица 5-2: Тревожные сообщения состояния и варианты их приоритета (продолжение) 

Код Сообщение состояния Приоритет  
по умолчанию 

Примечания Конфигурируем? 

A025 Boot Sector Fault (CoreProcessor) Ошибка 
загрузочного сектора (базовый процессор) 

Fault Относится только к расходо-
мерам со стандартным базо-
вым процессором. 

Нет 

A026 Sensor/Transmitter Communications Failure 
Ошибка коммуникации сен-
сор/преобразователь 

Fault  Нет 

A027 Security Breach Нарушение защиты Fault  Нет 

A028 Core Processor Write Failure Ошибка записи в 
базовый процессор 

Fault  Нет 

A031 Low Power Низкое питание Fault Относится только к преобра-
зователям с усовершенство-
ванным базовым процессо-
ром. 

Нет 

A032 Meter Verification in Progress: Outputs to Fault 
Контроль метрологических характеристик: 
выходы в состоянии ошибки 

Различный Относится только к расходо-
мерам с функцией Smart Me-
ter Verification. 
Если выходы установлены в 
Last Measured Value- Info. 
Если выходы установлены в 
Fault- Fault. 

Нет 

A033 Insufficient Right/Left Pickoff Signal Слабый 
сигнал на детекторных катушках 

Fault Относится только к преобра-
зователям с усовершенство-
ванным базовым процессо-
ром. 

Да 

A034 Meter Verification Failed Ошибка контроля 
метрологических характеристик 

Informational Относится только к расходо-
мерам с функцией Smart Me-
ter Verification. 

Да 

A035 Meter Verification Aborted Отмена контроля 
метрологических характеристик 

Informational Относится только к расходо-
мерам с функцией Smart Me-
ter Verification. 

Да 

A100 mA Output 1 Saturated Насыщение 1-го мА 
выхода 

Informational Может быть установлен в 
Info или в Ignore, но не в 
Fault. 

Да 

A101 mA Output 1 Fixed Фиксация 1-го мА выхода Informational Может быть установлен в 
Info или в Ignore, но не в 
Fault. 

Да 

A102 Drive Overrange Превышение уровня сигна-
ла на возбуждающей катушке 

Informational  Да 

A103 Data Loss Possible (Totals and Inventories) 
Возможна потеря данных (Сумматоры и 
Инвентаризаторы) 

Informational Относится только к расходо-
мерам со стандартным базо-
вым процессором. 
Может быть установлен в 
Info или в Ignore, но не в 
Fault. 

Да 

A104 Calibration in Progress Идёт калибровка Informational Может быть установлен в 
Info или в Ignore, но не в 
Fault. 

Да 

A105 Slug Flow Пробковое течение Informational  Да 

A106 Burst Mode Enabled  
Активирован пакетный режим 

Informational Может быть установлен в 
Info или в Ignore, но не в 
Fault. 

Да 
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Таблица 5-2: Тревожные сообщения состояния и варианты их приоритета (продолжение) 

Код Сообщение состояния Приоритет  
по умолчанию 

Примечания Конфигурируем? 

A107 Power Reset Occurred Сброс питания Informational Нормальная работа преобразова-
теля; случается после каждого 
цикла вкл/выкл питания 

Да 

A108 Basic Event 1 On Базовое событие 1 вкл. Informational Относится только к базовым со-
бытиям. 

Да 

A109 Basic Event 2 On Базовое событие 2 вкл. Informational Относится только к базовым со-
бытиям. 

Да 

A110 Frequency Output Saturated  
Насыщение частотного выхода 

Informational Может быть установлен в Info 
или в Ignore, но не в Fault. 

Да 

A111 Frequency Output Fixed  
Фиксация частотного выхода 

Informational Может быть установлен в Info 
или в Ignore, но не в Fault. 

Да 

A112 Upgrade Transmitter Software Необхо-
димо обновление ПО преобразователя 

Informational Относится только к системам с 
преобразователями с ПО версии 
5.0 и более ранним. 

Да 

A113 mA Output 2 Saturated Informational Может быть установлен в Info 
или в Ignore, но не в Fault. 

Да 

A114 mA Output 2 Fixed Informational Может быть установлен в Info 
или в Ignore, но не в Fault. 

Да 

A115 No External Input or Polled 
Data 

Informational  Да 

A116 Temperature Overrange 
(Petroleum) 

Informational Относится только к преобразова-
телям с приложением измерения 
нефти по API. 

Да 

A117 Density Overrange (Petroleum) Informational Относится только к преобразова-
телям с приложением измерения 
нефти по API. 

Да 

A118 Discrete Output 1 Fixed Informational Может быть установлен в Info 
или в Ignore, но не в Fault. 

Да 

A119 Discrete Output 2 Fixed Informational Может быть установлен в Info 
или в Ignore, но не в Fault. 

Да 

A120 Curve Fit Failure (Concentration) Informational Относится только к преобразова-
телям с приложением измерения 
концентрации. 

Нет 

A121 Extrapolation Alarm (Concentration) Informational Относится только к преобразова-
телям с приложением измерения 
концентрации. 

Да 

A131 Meter Verification in Progress: 
Outputs to Last 
Measured Value 

Informational Относится только к расходомерам 
с функцией Smart Meter Verifica-
tion. 

Да 

A132 Sensor Simulation Active Informational Относится только к преобразова-
телям с усовершенствованным 
базовым процессором. Может 
быть установлен в Info или в Ig-
nore, но не в Fault. 

Да 

A141 DDC trigger(s) have completed Informational Относится только к преобразова-
телям с усовершенствованным 
базовым процессором. Может 
быть установлен в Info или в Ig-
nore, но не в Fault. 

Да 
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5.6 Конфигурирование информационных параметров 
   Информационные параметры используются для идентификации и описания расходомера. Они 

не используются в работе преобразователя и не являются обязательными. 

 Информационные параметры включают: 

• Параметры устройства 

− Описатель 

− Сообщение 

− Дата 

• Параметры сенсора 

− Серийный номер сенсора 

− Материал сенсора 

− Материал футеровки сенсора 

− Тип фланцев сенсора 
 

5.6.1 Конфигурирование описателя 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Device>Descriptor 

ProLink III Device Tools>Configuration>Informational Parameters>Transmitter 

Полевой Ком-
муникатор 

Configure>Manual Setup>Info Parameters>Transmitter Info>Descriptor 

 

Обзор 

Описатель (Descriptor) позволяет сохранить описание в памяти преобразователя. Описание не 
используется в работе преобразователя и не является обязательным. 

Процедура 

Введите описание в преобразователь. 

Можно использовать до 16 знаков в описании. 

5.6.2 Конфигурирование сообщения 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Device>Message 

ProLink III Device Tools>Configuration>Informational Parameters>Transmitter 

Полевой Ком-
муникатор 

Configure>Manual Setup>Info Parameters>Transmitter Info>Message 

 

Обзор 

Сообщение (Message) позволяет сохранить короткое сообщение в памяти преобразователя. 
Этот параметр не используется в работе преобразователя и не является обязательным. 

Процедура 

Введите короткое сообщение в преобразователь. 

Ваше сообщение может содержать до 32 знаков в описании. 
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5.6.3 Конфигурирование даты 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Device>Date 

ProLink III Device Tools>Configuration>Informational Parameters>Transmitter 

Полевой Ком-
муникатор 

Configure>Manual Setup>Info Parameters>Transmitter Info>Date 

 

Обзор 

Параметр Дата (Date) позволяет сохранить статическую дату (не обновляемую преобразовате-
лем) в памяти преобразователя. Этот параметр не используется в работе преобразователя и не 
является обязательным. 

Процедура 

Введите желаемую дату в форме мм/дд/гггг. 

Полезный совет 

ПО ProLink II и ProLink III предоставляют инструментальный календарь для простоты ввода 
даты. 

 

5.6.4 Конфигурирование серийного номера сенсора 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Sensor>Sensor S/N 

ProLink III Device Tools>Configuration>Informational Parameters>Sensor 

Полевой Ком-
муникатор 

Configure>Manual Setup>Info Parameters>Sensor Information>Sensor Serial Number 

 

Обзор 

Параметр серийный номер сенсора (Sensor Serial Number) позволяет сохранить заводской номер 
сенсора в памяти преобразователя. Этот параметр не используется в работе преобразователя и 
не является обязательным. 

Процедура 

1. Серийный номер сенсора можно найти на заводской табличке сенсора. 

2. Введите серийный номер сенсора в поле Sensor Serial Number. 
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5.6.5 Конфигурирование материала сенсора 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Sensor>Sensor Matl 

ProLink III Device Tools>Configuration>Informational Parameters>Sensor 

Полевой Ком-
муникатор 

Configure>Manual Setup>Info Parameters>Sensor Information>Tube Wetted Material 

 

Обзор 

Параметр материал сенсора (Sensor Material) позволяет сохранить информацию о материале 
смачиваемых частей сенсора в памяти преобразователя. Этот параметр не используется в рабо-
те преобразователя и не является обязательным. 

Процедура 

1. Информацию о материале смачиваемых частей сенсора можно найти в документах, пере-
сылаемых вместе с сенсором, или определить по номеру модели сенсора. 

2. Введите информацию о материале смачиваемых частей сенсора в соответствующем поле. 

 

 

5.6.6 Конфигурирование материала футеровки сенсора 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Sensor>Liner Matl 

ProLink III Device Tools>Configuration>Informational Parameters>Sensor 

Полевой Ком-
муникатор 

Configure>Manual Setup>Info Parameters>Sensor Information>Tube Lining 

 

Обзор 

Параметр материал футеровки сенсора (Sensor Liner Material) позволяет сохранить информацию 
о материале футеровки сенсора в памяти преобразователя. Этот параметр не используется в 
работе преобразователя и не является обязательным. 

Процедура 

1. Информацию о материале футеровки сенсора можно найти в документах, пересылаемых 
вместе с сенсором, или определить по номеру модели сенсора. 

Для интерпретации номера модели сенсора, воспользуйтесь листом технических данных 
(PDS) на Ваш сенсор. 

2. Введите информацию о материале футеровки сенсора в соответствующем поле. 
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5.6.7 Конфигурирование типа фланцев сенсора 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Sensor>Flange 

ProLink III Device Tools>Configuration>Informational Parameters>Sensor 

Полевой Ком-
муникатор 

Configure>Manual Setup>Info Parameters>Sensor Information>Sensor Flange 

 

Обзор 

Параметр тип фланцев сенсора (Sensor Flange Type) позволяет сохранить информацию о типе 
фланцев сенсора в памяти преобразователя. Этот параметр не используется в работе преобра-
зователя и не является обязательным. 

Процедура 

 

1. Информацию о типе фланцев сенсора можно найти в документах, пересылаемых вместе с 
сенсором, или определить по номеру модели сенсора. 

Для интерпретации номера модели сенсора, воспользуйтесь листом технических данных 
(PDS) на Ваш сенсор. 

2. Введите информацию о типе фланцев сенсора в соответствующем поле. 
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6 Интеграция прибора с системой управления 
 

 

Темы данной главы 
• Конфигурирование каналов преобразователя 

• Конфигурирование миллиамперного выхода 

• Конфигурирование частотного выхода 

• Конфигурирование дискретного выхода 

• Конфигурирование событий 

• Конфигурирование цифровой коммуникации 

 

 

6.1 Конфигурирование каналов преобразователя 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>IO>CH B 

ProLink II ProLink>Configuration>Frequency/Discrete Output 

ProLink III Device Tools>Configuration>I/O>Channels 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Channels>Channel B 

 

Обзор 

Канал В может быть сконфигурирован как частотный или дискретный выход. Конфигурация 
канала должна соответствовать подключению кабелей к клеммам преобразователя. 

 

Предварительные требования 

Во избежание ошибок: 
• Конфигурируйте каналы до конфигурирования выходов. 

• При изменении конфигурации каналов убедитесь, что все контуры регулирования, свя-
занные с этими каналами, переведены в режим ручного управления. 

 

Процедура 

Установите конфигурацию Канала В в желаемое значение. 

 

Вариант Описание 

Частотный выход Канал В будет функционировать как частотный выход. 

Дискретный выход Канал В будет функционировать как дискретный выход. 
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Дополнительная информация 

При каждом конфигурировании канала всегда проверяйте конфигурацию соответствующего 
входа или выхода. При изменении конфигурации канала его работа определяется конфигура-
цией, сохранённой для выбранного типа входа или выхода, который может как соответство-
вать, так и не соответствовать процессу. 
 
После проверки конфигурации канала и выхода, верните контуры регулирования в режим ав-
томатического регулирования. 
 

 

6.2 Конфигурирование миллиамперного выхода 
   Миллиамперный (мА) выход используется для отображения переменной процесса. Параметры 

мА выхода управляют отображением переменной процесса. Ваш преобразователь имеет один 
мА выход: Канал А. 

 Параметры мА выхода включают: 

• Переменную процесса мА выхода 

• Нижнюю границу диапазона (LRV) и верхнюю границу диапазона (URV) 

• Отсечку аналогового выхода (АО Cutoff) 

• Добавочное демпфирование 

• Действие при ошибке (AO Fault Action) и значение при ошибке (AO Fault Value) 

 Важно 

Каждый раз, при изменении параметров мА выхода, перед запуском расходомера проверьте 
все другие параметры мА выхода. В некоторых ситуациях преобразователь автоматически за-
гружает набор сохраняемых значений, которые могут не соответствовать Вашему примене-
нию. 

 

6.2.1 Конфигурирование переменной процесса мА выхода 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>IO>CH A 

ProLink II ProLink>Configuration>Analog Output 

ProLink III Device Tools>Configuration>I/O>Outputs>mA Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>mA Output 

 

Обзор 

Для выбора переменной, отображаемой мА выходом используйте Переменную процесса мА 
выхода (mA Output Process Variable). 

Предварительные требования 

• При конфигурировании мА выхода для отображения объёмного расхода, убедитесь в пра-
вильности установки параметра Volume Flow Type (Тип Объёмного Расхода): Liquid 
(Жидкость) или Gas Standard Volume (Стандартный Объём Газа). 
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• При конфигурировании мА выхода для отображения концентрации убедитесь, что при-
ложение измерения концентрации сконфигурировано и желаемая переменная доступна. 

• Имейте в виду, что при использовании переменных HART, изменение конфигурации пе-
ременной мА Выхода приведёт к изменению конфигурации Первой Переменной (PV) 
HART. 

• Имейте в виду, что если Вы сконфигурировали соответствие первой дисплейной пере-
менной (Display Variable 1) переменной мА выхода (mA Output Process Variable), изменение 
конфигурации переменной мА выхода (mA Output Process Variable) изменит конфигурацию 
первой дисплейной переменной (Display Variable 1). 

Процедура 

Установите желаемое значение переменной мА выхода (mA Output Process Variable). 

Значение по умолчанию Мгновенный массовый расход (Mass Flow Rate). 

 

   

 
Варианты переменной процесса мА выхода 

 Преобразователь предоставляет стандартный набор вариантов для переменной мА выхода (mA 
Output Process Variable), а также нескольку специальных вариантов для приложений. Различные 
средства коммуникации могут использовать разные метки для этих вариантов. 

 

Таблица 6-1:     Варианты переменной процесса мА выхода 

Переменные процесса 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Стандартные 

Массовый расход MFLOW Mass Flow Rate Mass Flow Rate Mass flo 

Объёмный расход VFLOW Volume Flow Rate Volume Flow Rate Vol flo 

Стандартный объёмный расход 
газа 

GSV F Gas Std Vol Flow Rate Gas Standard Vol-
ume Flow Rate 

Gas vol flo 

Температура TEMP Temperature Temperature Temp 

Плотность DENS Density Density Dens 

Внешнее давление EXT P External Pressure External Pressure External pres 

Внешняя температура EXT T External Temperature External Temperature External temp 

Уровень сигнала возбуждаю-
щей катушки 

DGAIN Drive Gain Drive Gain Driv signl 

Измерение нефти по API 

Термокомпенсированная плот-
ность 

TCDEN API: Temp Corrected 
Density 

Density at Reference 
Temperature 

TC Dens 

Термокомпенсированный 
(стандартный) объёмный рас-
ход 

TCVOL API: Temp Corrected 
Volume Flow 

Volume Flow Rate at 
Reference Tempera-
ture 

TC Vol 

Средняя термокомпенсирован-
ная плотность 

AVE D API:Avg Density Average Density TC Avg Dens 

Средняя температура AVE T API:Avg Temperature Average Temperature TC Avg Temp 
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Таблица 6-1:     Варианты переменной процесса мА выхода (продолжение) 

Переменные процесса 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Измерение концентрации 

Приведённая плотность RDENS CM: Density @ Ref-
erence 

Density at Reference 
Temperature 

ED Dens at Ref 

Плотность, относительно воды SGU CM: Density (Fixed 
SG units) 

Density (Fixed SG 
Units) 

ED Dens (SGU) 

Стандартный объёмный расход STD V CM: Std Vol Flow 
Rate 

Volume Flow Rate at 
Reference Temperature 

ED Std Vol flo 

Массовый расход нетто NET M CM: Net Mass Flow 
Rate 

Net Mass Flow Rate ED Net Mass flo 

Объёмный расход нетто NET V CM: Net Vol Flow 
Rate 

Net Volume Flow Rate ED Net Vol flo 

Концентрация CONC CM: Concentration Concentration ED Concentration 

Плотность по шкале Боме BAUME CM: Density (Fixed 
Baume Units) 

Baume ED Dens (Baume) 

 

6.2.2 Конфигурирование нижней границы диапазона (LRV) и 
верхней границы диапазона (URV) 

Дисплей • OFF-LINE MAINT>OFF-LINE CONFG>IO>CH A>AO 4mA 

• OFF-LINE MAINT>OFF-LINE CONFG>IO>CH A>AO 20mA 

ProLink II • ProLink>Configuration>Analog Output>Primary Output>Lower Range Value 

• ProLink>Configuration>Analog Output>Primary Output>Upper Range Value 

ProLink III Device Tools>Configuration>I/O>Outputs>mA Output 

Полевой Ком-
муникатор 

• Configure>Manual Setup>Inputs/Outputs>mA Output>mA Output Settings>PV LRV 

• Configure>Manual Setup>Inputs/Outputs>mA Output>mA Output Settings>PV URV 

 

Обзор 

Нижняя граница диапазона (LRV) и Верхняя граница диапазона (URV) используются для мас-
штабирования мА выхода, то есть для определения соответствия между переменной мА выхо-
да и уровнем мА выхода. 

Примечание 

Начиная с ПО преобразователя версии 5.0, если LRV и URV изменены (не являются значения-
ми по умолчанию), а источник мА выхода в дальнейшем изменяется, значения LRV и URV не 
сбрасываются в значения по умолчанию. Например, если мА выходу назначен массовый рас-
ход, и LRV и URV для массового расхода изменены, затем мА выходу назначена плотность, и, 
наконец, мА выходу вновь назначен расход, LRV и URV устанавливаются в сконфигуриро-
ванные значения. В более ранних версиях ПО преобразователя, LRV и URV сбрасываются в 
значения по умолчанию. 
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Процедура 

Установите желаемые значения LRV и URV. 

• Нижняя граница диапазона (LRV) определяет значение переменной, при котором мА вы-
ход равен 4 мА. Значение по умолчанию для LRV зависит от назначения переменной мА 
выхода (mA Output Process Variable). Введите значение LRV в единицах измерения, скон-
фигурированных для переменной мА выхода (mA Output Process Variable). 

• Нижняя граница диапазона (URV) определяет значение переменной, при котором мА вы-
ход равен 20 мА. Значение по умолчанию для URV зависит от назначения переменной мА 
выхода (mA Output Process Variable). Введите значение URV в единицах измерения, скон-
фигурированных для переменной мА выхода (mA Output Process Variable). 

Полезные советы 

Для успешной работы: 

• Установите LRV ≥ LSL (нижний предел сенсора). 

• Установите URV ≤ USL (верхний предел сенсора). 

• Установите эти значения так, чтобы разница между URV и LRV была ≥ Min Span (мини-
мального диапазона). 

 

Примечание 

URV может быть установлено ниже LRV; например, URV может быть установлено равным 50, 
а LRV может быть установлено равным 100. 

 

мА выход использует диапазон 4-20 мА для представления переменной мА выхода (mA Output 
Process Variable). Внутри диапазона мА выход линеен по отношению к переменной. При выхо-
де переменной за границы диапазона, преобразователь устанавливает тревожное сообщение 
(аларм) насыщения выхода. 

 

   Значения нижней границы диапазона (LRV) и верхней границы 
диапазона (URV) по умолчанию 

 Каждая переменная процесса, которая может быть назначена мА выходу, имеет свои LRV и 
URV. При назначении переменной процесса мА выходу, загружаются и используются соответ-
ствующие LRV и URV. 

 

Таблица 6-2:     Значения нижней границы диапазона (LRV) и верхней границы диапазо-
на (URV) по умолчанию 

Переменная процесса LRV URV 

Все переменные массового расхода -200.000 g/sec (г/с) 200.000 g/sec (г/с) 

Все переменные объёмного расхода 
жидкости 

-0.2000 l/sec (л/с) 0.2000 l/sec (л/с) 

Все переменные плотности 0.000 g/cm3 (г/см3) 10.000 g/cm3 (г/см3) 

Все переменные температуры -240.000 ˚С 450.000 ˚С 

Уровень сигнала на возб. катушке 0.00 % 100.00 % 

Стандартный объёмный расход газа -423.78 SCFM (ст.куб.футов 
в мин.) 

423.78 SCFM  

Внешняя температура -240.000 ˚С 450.000 ˚С 

Внешнее давление 0.000 bar (бар) 100.000 bar (бар) 
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Таблица 6-2:     Значения нижней границы диапазона (LRV) и верхней границы диапазо-
на (URV) по умолчанию (продолжение) 

Переменная процесса LRV URV 

Концентрация 0 % 100 % 

Плотность по шкале Боме 0 10 

Плотность относительно воды (Spe-
cific gravity) 

0 10 

 

6.2.3 Конфигурирование отсечки аналогового выхода 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Analog Output>Primary Output>AO Cutoff 

ProLink III Device Tools>Configuration>I/O>Outputs>mA Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>mA Output>mA Output Settings>MAO Cutoff 

 

Обзор 

Отсечка по аналоговому выходу (АО) определяет минимальное значение массового или объ-
ёмного расхода, или стандартного объёмного расхода газа, которое будет отображено мА вы-
ходом. Любое значение расхода ниже отсечки АО будет отображено как ноль.  

Ограничение 

Отсечка АО может быть сконфигурирована только в случае назначения мА выходу массового 
или объёмного расхода, или стандартного объёмного расхода газа. При конфигурировании мА 
выхода на другую переменную, отсечка АО не конфигурируема, и преобразователь не исполь-
зует функцию отсечки аналогового выхода.  

 

Процедура 

Установите желаемое значение отсечки аналогового выхода (AO Cutoff). 

Значение по умолчанию для отсечки аналогового выхода (AO Cutoff) равно 0. 

Полезный совет 

В большинстве приложений используется значение отсечки аналогового выхода (AO Cutoff) по 
умолчанию. Перед изменением значения отсечки аналогового выхода (AO Cutoff), проконсуль-
тируйтесь с отделом поддержки заказчиков Micro Motion. 

 

   Взаимодействие отсечки АО (аналогового выхода) и отсечек пере-
менных процесса 

 Если массовый или объёмный расход назначен мА выходу, отсечка мА выхода взаимодейству-
ет с отсечкой массового расхода или отсечкой объёмного расхода. Отсечка будет происходить 
при наибольшем расходе, при котором отсечки применимы. 
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Пример: Взаимодействие отсечек 

Конфигурация: 

• mA Output Process Variable =  Mass Flow Rate 

• Frequency Output Process Variable =  Mass Flow Rate 

• AO Cutof  = 10 г/с 

• Mass Flow Cutoff = 15 г/с 

Результат: Если значение массового расхода падает ниже 15 г/с, массовый расход будет ото-
бражён равным нулю. 

Пример: Взаимодействие отсечек 

Конфигурация: 

• mA Output Process Variable: Mass Flow Rate 

• Frequency Output Process Variable: Mass Flow Rate 

• AO Cutoff: 15 г/с 

• Mass Flow Cutoff: 10 г/с 

Результат: 

• Если значение массового расхода падает ниже 15 г/с, но не ниже10 г/с: 

-Миллиамперный выход отобразит нулевой расход 

-Частотный выход отобразит реальный расход. 

• Если значение массового расхода падает ниже 10 г/с, оба выхода отобразят массовый рас-
ход равным нулю. 

 

 

6.2.4 Конфигурирование добавочного демпфирования 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Analog Output>Primary Output>AO Added Damp 

ProLink III Device Tools>Configuration>I/O>Outputs>mA Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>mA Output>mA Output Settings> 
PV Added Damping 

 

Обзор 

Демпфирование помогает сгладить небольшие, резкие колебания измерений. Значение демп-
фирования определяет период времени в секундах,  в течение которого значение переменной 
процесса изменяется, отражая 63% её действительного изменения. Параметр добавочного 
демпфирования определяет демпфирование для мА выхода. Он влияет на значение перемен-
ной процесса, выводимой по мА выходу и не влияет как на значение переменной процесса, 
выводимой любым другим способом (например, по частотному или цифровому выходам), так 
и на значение, используемое в вычислениях. 
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Примечание 

Добавочное демпфирование не прикладывается при зафиксированном мА выходе (например, 
во время теста контура) и при индикации ошибки. При активном режиме имитации добавоч-
ное демпфирование прикладывается.  

 

Процедура 

Введите желаемое значение добавочного демпфирования (Added Damping).  

Значение по умолчанию равно 0.0 секунд. 

При вводе значения добавочного демпфирования, преобразователем автоматически выбирает-
ся ближайшее меньшее допустимое значение. 

Примечание 

Значения добавочного демпфирования зависят от параметра частоты опроса (Update Rate) и 
назначения т.н. 100 Гц переменных. 

 

Таблица 6-3:     Допустимые значения для добавочного демпфирования 

Установка параметра час-
тоты опроса (Update Rate) 

Переменная  
процесса 

Действующая  
частота опроса 

Допустимые значения добавоч-
ного демпфирования 

Normal (нормальная) Все 20 Гц 0.0, 0.1, 0.3, 0.75, 1.6, 3.3, 6.5, 13.5, 
27.5, 55, 110, 220, 440 

Special (специальная) 100 Гц переменная, на-
значенная мА выходу 

100 Гц 0.0, 0.04, 0.12, 0.30, 0.64, 1.32, 2.6, 
5.4, 11, 22, 44, 88, 176, 350 

100 Гц переменная, не 
назначенная мА выходу 

Все другие переменные 

6.25 Гц 0.0, 0.32, 0.96, 2.40, 5.12, 10.56, 
20.8, 43.2, 88, 176, 352 

 

   Взаимодействие добавочного демпфирования и демпфирования пе-
ременных процесса 

 Если переменная расхода (массового и объёмного), плотности или температуры назначена мА 
выходу добавочное демпфирование взаимодействует со значениями демпфирования расхода, 
плотности или температуры. Если различные параметры демпфирования применимы, сначала 
будет рассчитан эффект демпфирования переменной процесса, а затем добавочное демпфиро-
вание применено к результату вычислений. 

Пример: Взаимодействие параметров демпфирования 

Конфигурация: 

• Flow Damping (Демпфирование по расходу) = 1 сек 

• mA Output Process Variable (Переменная мА выхода) =  Mass Flow Rate (Массовый расход) 

• Added Damping (Добавочное демпфирование) = 2 сек 

Результат: Изменение массового расхода отразится на первом мА выходе в течение периода 
времени более 3 секунд. Точное значение периода времени рассчитывается преобразователем 
в соответствии с внутренним неконфигурируемым алгоритмом. 
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6.2.5 Конфигурирование действия при ошибке (mA Output Fault 
Action) и значения при ошибке (mA Output Fault Level) для мА 
выхода 

Дисплей Не доступно 

ProLink II • ProLink>Configuration>Analog Output>Primary Output>AO Fault Action 

• ProLink>Configuration>Analog Output>Primary Output>AO Fault Level 

ProLink III Device Tools>Configuration>Fault Processing 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>mA Output>MAO Fault Settings 

 

Обзор 

Параметр mA Output Fault Action определяет уровень выходного мА сигнала, при возникновении 
в преобразователе условия внутренней ошибки. 

Примечание 

Только для некоторых ошибок: Если параметр Last Measured Value Timeout установлен в ненуле-
вое значение, преобразователь не осуществляет действий по ошибке до истечения времени 
тайм-аута. 

Процедура 

1. Установите параметр действия при ошибке (mA Output Fault Action) для мА выхода в желае-
мое значение. 

Значение по умолчанию – Downscale. 

2. Если параметр действия при ошибке (mA Output Fault Action) для мА выхода установлен в 
значение Upscale или Downscale, установите параметр значения при ошибке (mA Output Fault 
Level) для мА выхода в желаемое значение. 

 

   Варианты для параметров mA Output Fault Action и mA Output Fault 
Level 

 

Таблица 6-4:     Варианты для параметров mA Output Fault Action и mA Output Fault Level 

Вариант Состояние мА выхода mA Output Fault Level 

Upscale  
(выше шкалы) 

Устанавливается в сконфигурированное значение 
при ошибке(mA Output Fault Level) 

По умолчанию: 22 мА 

Диапазон: 21-24 мА  

Downscale  
(ниже шкалы) –  
по умолчанию 

Устанавливается в сконфигурированное значение 
при ошибке(mA Output Fault Level) 

По умолчанию: 2.0 мА 

Диапазон: 1.0-3.6 мА 

Internal Zero 
(внутренний ноль) 

Устанавливается в значение, связанное с 0 (нуле-
вым) значением переменной, в соответствии со 
значениями URV и LRV 

Не применимо 

None (нет) Отслеживает данные по назначенной переменной; 
нет действий по ошибке 

Не применимо 
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 ПРЕДУПРЕЖДЕНИЕ! 

Если параметр действие по ошибке для мА или частотного выходов установлен в None 
(нет), параметр действие по ошибке для цифровой коммуникации также должен быть 
установлен в None. В противном случае, выход не будет отражать действительного зна-
чения переменной, а это может привести к ошибке измерения и непредсказуемым по-
следствиям для процесса.  

Ограничение 

Если параметр действие по ошибке для цифровой коммуникации установлен NAN (not a num-
ber), Вы не сможете установить параметр действие по ошибке для мА или частотного выходов 
в None (нет). При попытке сделать это, предлагаемая конфигурация не будет принята преобра-
зователем. 

 

 

6.3 Конфигурирование частотного выхода 
   Частотный выход используется для отображения переменной процесса. Параметры частотного 

выхода управляют отображением переменной процесса. Ваш преобразователь либо не имеет 
частотного выхода, либо имеет один частотный выход: Канал B может быть сконфигурирован 
как частотный или как дискретный выход. 

 Параметры мА выхода включают: 

• Переменную процесса частотного выхода 

• Полярность частотного выхода 

• Метод масштабирования частотного выхода 

• Максимальную ширину импульса частотного выхода 

• Действие при ошибке (Frequency Output Fault Action) и значение при ошибке (Frequency Output Fault 
Value) для частотного выхода. 

 Важно 

Каждый раз, при изменении параметров частотного выхода, перед запуском расходомера про-
верьте все другие параметры частотного выхода. В некоторых ситуациях преобразователь ав-
томатически загружает набор сохраняемых значений, которые могут не соответствовать Ва-
шему применению. 

 

6.3.1 Конфигурирование переменной процесса частотного выхода 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>IO>CH B>SET FO>FO SRC 

ProLink II ProLink>Configuration>Frequency/Discrete Output>Frequency>Tertiary Variable 

ProLink III Device Tools>Configuration>I/O>Outputs>Frequency Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Frequency Output>FO Settings>Third Variable 
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Обзор 

Параметр переменная частотного выхода (Frequency Output Process Variable) определяет перемен-
ную, которая будет отображаться частотным выходом. 

Предварительные требования 

При конфигурировании мА выхода для отображения объёмного расхода, убедитесь в правиль-
ности установки параметра Volume Flow Type (Тип Объёмного Расхода): Liquid (Жидкость) или 
Gas Standard Volume (Стандартный Объём Газа). 

При конфигурировании мА выхода для отображения концентрации убедитесь, что приложение 
измерения концентрации сконфигурировано и желаемая переменная доступна. 

Имейте в виду, что при использовании переменных HART, изменение переменной мА Выхода 
приведёт к изменению конфигурации Третьей Переменной (TV) HART. 

 

Процедура 

Установите параметр переменная частотного выхода (Frequency Output Process Variable) в желае-
мое значение. 

Значение по умолчанию Мгновенный массовый расход (Mass Flow Rate). 

 

   Варианты переменной процесса частотного выхода 
 Преобразователь предоставляет стандартный набор вариантов для переменной процесса час-

тотного выхода (Frequency Output Process Variable), а также нескольку специальных вариантов 
для приложений. Различные средства коммуникации могут использовать разные наименования 
для этих вариантов. 

 

Таблица 6-5:     Варианты переменной процесса частотного выхода 

Переменные процесса 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Стандартные 

Массовый расход MFLOW Mass Flow Mass Flow Rate Mass flo 

Объёмный расход VFLOW Volume Flow Volume Flow Rate Vol flo 

Стандартный объёмный расход 
газа 

GSV F Gas Std Vol Flow 
Rate 

Gas Standard Vol-
ume Flow Rate 

Gas vol flo 

Измерение нефтепродуктов 

Термокомпенсированный 
(стандартный) объёмный рас-
ход 

TCVOL Std Vol Flow Volume Flow Rate 
at Reference Tem-
perature 

TC Vol 

Измерение концентрации 

Стандартный объёмный расход STD V ED: Std Vol Flow 
Rate 

Volume Flow Rate 
at Reference Tem-
perature 

ED Std Vol flo 

Массовый расход нетто NET M ED: Net Mass 
Flow Rate 

Net Mass Flow 
Rate 

ED Net Mass flo 

Объёмный расход нетто NET V ED: Net Vol Flow 
Rate 

Net Volume Flow 
Rate 

ED Net Vol flo 
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6.3.2 Конфигурирование полярности частотного выхода 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>IO>CH B>SET FO>FO SRC 

ProLink II ProLink>Configuration>Frequency/Discrete Output>Frequency>Tertiary Variable 

ProLink III Device Tools>Configuration>I/O>Outputs>Frequency Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Frequency Output>FO Settings>Third Variable 

 

Обзор 

Полярность частотного выхода определяет, каким образом будет представляться активное со-
стояние (ON). Значение по умолчанию, Active high (высокий активный), подходит для большин-
ства применений. Active low (низкий активный) может потребоваться в применениях с исполь-
зованием низкочастотных сигналов. 

Процедура 

Установите параметр полярность частотного выхода (Frequency Output Polarity) в желаемое зна-
чение. 

Значение по умолчанию Active high (высокий активный). 

 

   Варианты полярности частотного выхода 
 

Таблица 6-6:     Варианты полярности частотного выхода 

Полярность 
(Polarity) 

 Относительное 
напряжение (OFF) 

Напряжение импульса 
(ON) 

Active high 

(Активный высокий)  
0 Определяется блоком пи-

тания, нагрузочным сопро-
тивлением и собственно 
нагрузкой (см. Руково-
дство по установке преоб-
разователя) 

Active low 

(Активный низкий)  
Определяется блоком пи-
тания, нагрузочным сопро-
тивлением и собственно 
нагрузкой (см. Руково-
дство по установке преоб-
разователя) 

0 
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6.3.3 Конфигурирование метода масштабирования 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>IO>CH B>SET FO>FO SCALE 

ProLink II ProLink>Configuration>Frequency/Discrete Output>Frequency>Scaling Method 

ProLink III Device Tools>Configuration>I/O>Outputs>Frequency Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Frequency Output>FO Scaling 

 

Обзор 

Метод Масштабирования Частотного Выхода (Frequency Output Scaling Method) определяет связь 
между выходными импульсами и единицами расхода. Установите Метод Масштабирования 
Частотного Выхода в соответствии с требованиями приёмного устройства. 

Процедура 

1. Установите Метод Масштабирования Частотного Выхода (Frequency Output Scaling Method). 

Вариант Описание 

Frequency=Flow (Частота=Расход) Частота, рассчитанная по расходу 

Pulses/Unit (Импульсов на единицу расхода) Определяемое пользователем количество импуль-
сов, соответствующее одной единице расхода 

Units/Pulse (Единиц расхода на импульс) Импульс соответствует определенному пользова-
телем количеству единиц расхода 

 

2.  Установите необходимые дополнительные параметры. 

• Если Вы установили Метод Масштабирования Частотного Выхода в значение Fre-
quency=Flow, определите параметры Rate Factor и Frequency Factor. 

• Если Вы установили Метод Масштабирования Частотного Выхода в значение Puls-
es/Unit (Импульсов на единицу расхода), определите количество импульсов соответ-
ствующее одной единице расхода. 

• Если Вы установили Метод Масштабирования Частотного Выхода в значение 
Units/Pulse (Единиц расхода на импульс), определите количество единиц расхода, со-
ответствующее одному импульсу. 

  

Расчет частоты из расхода 
Вариант Frequency=flow используется для настройки частотного выхода в применении, когда 
неизвестны соответствующие значения Units/Pulse (Единиц расхода на импульс) или Puls-
es/Unit (Импульсов на единицу расхода). 

Если Вы выбрали вариант Frequency=flow, Вам также необходимо определить значения Rate 
Factor и Frequency Factor. 

Rate Factor  Максимальный расход, отображаемый частотным выходом. При 
большем расходе преобразователь сформирует тревожное сообщение (аларм) А110: Frequency 
Output Saturated (выход переменной за границы диапазона частотного выхода). 

Frequency Factor Значение рассчитывается по следующей формуле: 

                                                                                       Rate Factor 

                                                  Frequency factor  =                                  x    N 

                                                                                               T 

где: 
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Т = коэффициент преобразования выбранной единицы измерения времени в секунды 

N = количество импульсов на единицу расхода, в соответствии с конфигурацией приёмного 
устройства 

Результирующее значение Frequency Factor должно быть внутри диапазона частотного выхода 
(0-10000 Гц): 

• Если значение Frequency Factor меньше 1 Гц, переконфигурируйте приёмное устройство на 
более высокое отношение pulses/unit (количество импульсов/единица расхода). 

• Если значение Frequency Factor больше 10000 Гц, переконфигурируйте приёмное устрой-
ство на более низкое отношение pulses/unit (количество импульсов/единица расхода). 

 

Полезный совет 

Если Вы установили Метод Масштабирования Частотного Выхода в значение Frequency=Flow, 
а параметр Frequency Output Maximum Pulse Width (максимальная ширина импульса частотно-
го выхода) установлена в ненулевое значение, Micro Motion рекомендует устанавливать значе-
ние Frequency Factor менее 200 Гц. 

Пример: Конфигурация Frequency=Flow 

Вы хотите, чтобы частотный выход отображал все расходы до 2000 kg/min (кг/мин). 

Приёмное частотное устройство сконфигурировано на 10 pulses/kg (импульсов на кг) 

Решение: 

                                                                                                                                    Rate Factor 

                                                                                        Frequency Factor  =                                    x  N 

                                                                                                                                       T 

 

                                                                                                                                    2000 

                                                                                       Frequency Factor  =                                    x  10 

                                                                                                                                       60 

                                                                                       Frequency Factor  =  333.33 

Установите параметры: 

• Rate Factor = 2000 

• Frequency Factor = 333.33 

 

6.3.4 Конфигурирование максимальной ширины импульса 
частотного выхода 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Frequency/Discrete Output>Frequency>Freq Pulse Width 

ProLink III Device Tools>Configuration>I/O>Outputs>Frequency Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Frequency Output>FO Settings>Max Pulse Width 

 

Обзор 

Максимальная ширина импульса частотного выхода (Frequency Output Maximum Pulse Width) ис-
пользуется для обеспечения того, чтобы длительность «активной» части (ON) сигнала была 
достаточной для частотного приёмного устройства. 

 

Активная часть может быть высоким уровнем напряжения или 0.0 В, в зависимости от уста-
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новленной полярности частотного выхода. 

Таблица 6-7:     Взаимодействие максимальной ширины импульса частотного выхода и 
полярности частотного выхода 

Полярность (Polarity) Ширина импульса (Pulse width) 

Active High  
(Активный высокий) 

 
Active Low  
(Активный низкий) 

 
 

Процедура 

Установите параметр максимальной ширины импульса частотного выхода (Frequency Output 
Pulse Width) в желаемое значение. 

Значение по умолчанию 277 миллисекунд. Значение максимальной ширины импульса может 
быть установлено в 0 (по умолчанию) или в значение в интервале от 0.5 до 277.5 миллисекунд. 
Введённое пользователем значение автоматически подстраивается на ближайшее допустимое. 

Полезный совет 

Micro Motion рекомендует использовать значение по умолчанию для параметра максимальной 
ширины импульса частотного выхода (Frequency Output Pulse Width). Перед изменением значения 
максимальной ширины импульса частотного выхода свяжитесь со службой поддержки заказ-
чика Micro Motion. 

 

6.3.5 Конфигурирование действия при ошибке (Frequency Output 
Fault Action) и значения при ошибке (Frequency Output Fault 
Level) для частотного выхода 

Дисплей Не доступно 

ProLink II • ProLink>Configuration>Frequency/Discrete Output>Frequency>Freq Fault Action 

• ProLink>Configuration> Frequency/Discrete Output>Frequency>Freq Fault Level 

ProLink III Device Tools>Configuration>Fault Processing 

Полевой Ком-
муникатор 

• Configure>Manual Setup>Inputs/Outputs>Frequency Output>FO Fault Parame-
ters>FO Fault Action 

• Configure>Manual Setup>Inputs/Outputs>Frequency Output>FO Fault Parame-
ters>FO Fault Level 

 

Обзор 

Параметр Frequency Output Fault Action определяет состояние частотного выхода, при возникно-
вении в преобразователе условия внутренней ошибки. 
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Примечание 

Только для некоторых ошибок: Если параметр Last Measured Value Timeout установлен в не-
нулевое значение, преобразователь не осуществляет действий по ошибке до истечения време-
ни тайм-аута. 

Процедура 

1.  Установите параметр действия при ошибке (Frequency Output Fault Action) для частотного 
выхода в желаемое значение. 

Значение по умолчанию – Downscale (0 Гц.). 

2. Если параметр действия при ошибке (Frequency Output Fault Action) для частотного выхода 
установлен в значение Upscale, установите параметр значения при ошибке (Frequency Output 
Fault Level) для частотного выхода в желаемое значение. 

Значение по умолчанию 15000 Гц. Диапазон от 10 до 15000 Гц. 

 

   Варианты действия при ошибке частотного выхода 
 

Таблица 6-8:     Варианты действия при ошибке частотного выхода 

Наименование Состояние частотного выхода 

Upscale (выше шкалы) Устанавливается в сконфигурированное для Upscale значе-
ние при ошибке: 

• Диапазон: от 10 до 15000 Гц 

• По умолчанию: 15000 Гц 

Downscale (ниже шкалы) 0 Hz (Гц) 

Internal Zero (внутренний ноль) 0 Hz (Гц) 

None (нет) Отслеживает данные по назначенной переменной; никако-
го действия по ошибке 

 

 ПРЕДУПРЕЖДЕНИЕ! 

Если параметр действие по ошибке для мА или частотного выходов установлен в None 
(нет), параметр действие по ошибке для цифровой коммуникации также должен быть 
установлен в None. В противном случае, выход не будет отражать действительного зна-
чения переменной, а это может привести к ошибке измерения и непредсказуемым по-
следствиям для процесса.  

Ограничение 

Если параметр действие по ошибке для цифровой коммуникации установлен NAN (not a num-
ber), Вы не сможете установить параметр действие по ошибке для мА или частотного выходов 
в None (нет). При попытке сделать это, предлагаемая конфигурация не будет принята преобра-
зователем. 

 

6.4 Конфигурирование дискретного выхода 
   Дискретный выход используется для отображения особых условий процесса или состояния 

расходомера. Параметры дискретного выхода определяют, какое условие отображается и ка-
ким образом. Ваш преобразователь может иметь либо один дискретный выход, либо не иметь 
его: Канал В может быть сконфигурирован либо как частотный выход, либо как дискретный 
выход. 
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 Параметры дискретного выхода включают: 

• Источник сигнала дискретного выхода (Discrete Output Source) 

• Полярность дискретного выхода (Discrete Output Polarity) 

• Действие при ошибке для дискретного выхода (Discrete Output Fault Action) 

 

 Ограничение 

Перед конфигурированием дискретного выхода необходимо сконфигурировать канал как дис-
кретный выход. 

 Важно 

Каждый раз, при изменении параметров дискретного выхода, перед запуском расходомера 
проверьте все другие параметры частотного выхода. В некоторых ситуациях преобразователь 
автоматически загружает набор сохраняемых значений, которые могут не соответствовать Ва-
шему применению. 

 

6.4.1 Конфигурирование источника сигнала дискретного выхода 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>IO>CH B>SET DO>DO SRC 

ProLink II ProLink>Configuration>Frequency/Discrete Output>Discrete Output>DO Assignment 

ProLink III Device Tools>Configuration>I/O>Outputs>Discrete Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Discrete Output>DO Assignment 

 

Обзор 

Параметр источник сигнала дискретного выхода (Discrete Output Source) определяет условие 
расходомера или процесса, отображаемое дискретным выходом. 

Процедура 

Установите параметр источник сигнала дискретного выхода (Discrete Output Source) в желаемое 
значение. 

Значение по умолчанию для параметра источник сигнала дискретного выхода (Discrete Output 
Source) – Направление потока (Flow Direction). 
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   Варианты источника сигнала дискретного выхода 
 

Таблица 6-9:     Варианты источника сигнала дискретного выхода 

Вариант 
Наименование 

Состояние 
Уровень дис-
кретного вы-
хода Дисплей ProLink II ProLink III Полевой 

Коммуникатор 

Discrete 
event 1 – 5(1)  
(Дискрет-
ное Собы-
тие 1 - 5) 

D EVx Discrete Event x  Discrete Event 1  
Discrete Event 2  
Discrete Event 3 
Discrete Event 4  
Discrete Event 5 

Discrete Event x  ON Определяется 
конкретными 
параметрами 
контура 

OFF 0 B 

Event 1 – 2(2) 

(Событие 1 
- 2) 

EVNT1, 
EVNT2, 
E1OR2 

Event 1, Event 2 
Event1 или 
Event 2 

Статус: 
Event 1, Event 2 
Event1 или Event 
2 

Event 1, Event 2, 
Event1 или 
Event2 

ON Определяется 
конкретными 
параметрами 
контура 

OFF 0 B 
Flow switch  
(Реле рас-
хода) 

FLSW Flow Switch 
Indication  

Flow Switch Indi-
cator 

Flow Switch  ON Определяется 
конкретными 
параметрами 
контура 

OFF 0 B 
Flow 
direction 
(Направле-
ние пото-
ка) 

FLDIR  Forward/Reverse 
Indication 

Forward Reverse 
Indication 

Forward/Reverse  Прямой 
поток 

0 B 

Обратный 
поток 

Определяется 
конкретными 
параметрами 
контура 

Calibration in 
progress  
(Проводит-
ся калиб-
ровка) 

ZERO  Calibration in 
Progress 

Calibration in Pro-
gress 

Calibration in Pro-
gress 

ON Определяется 
конкретными 
параметрами 
контура 

OFF 0 B 

Fault 
(Ошибка) 

FAULT  Fault Condition 
Indication 

Fault Indication Fault  ON Определяется 
конкретными 
параметрами 
контура 

OFF 0 B 
 

 Важно 

Информация в таблице предполагает, что параметр полярность дискретного выхода (Discrete 
Output Polarity) установлен в значение Active High (активный высокий). Если параметр поляр-
ность дискретного выхода (Discrete Output Polarity) установлен в значение Active Low (активный 
низкий), значения напряжения будут обратными. 

  

 Важно 

Если параметр Descrete Output Sourse установлен в значение Flow Switch, необходимо также 
сконфигурировать параметры Flow Switch Variable, Flow Switch Setpoint и Flow Switch 
Hystersis. 

 

(1) События, сконфигурированные с использованием расширенной модели (enchanced event model). 

(2) События, сконфигурированные с использованием базовой модели (basic event model) 
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   Конфигурирование параметров реле расхода (Flow Switch) 
 

Дисплей OFF-LINE MAINT>OFF-LINE CONFG>IO>CH B>SET DO>CONFIG FL SW 

ProLink II • ProLink>Configuration>Flow>Flow Switch Variable 

• ProLink>Configuration>Flow>Flow Switch Setpoint 

• ProLink>Configuration>Flow>Flow Switch Hysteresis 

ProLink III Device Tools>Configuration>I/O>Outputs>Discrete Output 

Полевой Ком-
муникатор 

• Configure>Manual Setup>Inputs/Outputs>Discrete Output>Flow Switch Source 

• Configure>Manual Setup>Inputs/Outputs>Discrete Output>Flow Switch Setpoint 

• Configure>Manual Setup>Inputs/Outputs>Discrete Output>Hysteresis 

 

Обзор 

Реле расхода используется для индикации того, что величина расхода (например, массового 
расхода, объёмного расхода жидкости) упала ниже сконфигурированной пользователем устав-
ки. Реле расхода имеет конфигурируемый гистерезис. 

Процедура 

1. Установите параметр Descrete Output Sourse на Flow Switch, если это не было сделано ранее. 

2. Установите параметр Flow Switch Variable на переменную расхода, которая будет контроли-
ровать реле расхода. 

3. Установите параметр Flow Switch Setpoint на значение расхода, ниже которого будет сраба-
тывать реле расхода. 

• Если величина расхода ниже указанного значения, дискретный выход в состоянии 
ON. 

• Если величина расхода выше указанного значения, дискретный выход в состоянии 
OFF. 

4. Установите параметр Hysteresis на значение отклонения в процентах, выше и ниже уставки, 
что будет работать как зона нечувствительности. 

Гистерезис определяет диапазон вокруг уставки, в котором состояние реле расхода не из-
меняется. Значение по умолчанию равно 5%. Диапазон 0.1 % - 10%.  

Пример: Если уставка равна 100 граммов в секунду, а гистерезис равен 5%, реле расхода 
переключится в состояние ON при падении расхода ниже 95 граммов в секунду, но не вы-
ключится до тех пор, пока расход не возрастёт до 105 граммов в секунду. Тогда оно пере-
ключится в состояние OFF и будет оставаться в нём, пока расход не упадёт ниже 95 грам-
мов в секунду. 
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6.4.2 Конфигурирование полярности дискретного выхода 
Дисплей OFF-LINE MAINT>OFF-LINE CONFG>IO>CH B>SET DO>DO POLAR 

ProLink II ProLink>Configuration>Frequency/Discrete Output>Discrete Output>DO Polarity 

ProLink III Device Tools>Configuration>I/O>Outputs>Discrete Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Discrete Output>DO Polarity 

 

Обзор 

Дискретные выходы генерируют два уровня напряжения для представления состояний ON 
(активный) и OFF (пассивный). Уровни напряжения используются для представления этих 
состояний. Параметр полярность дискретного выхода (Descrete Output Polarity) определяет, какой 
уровень напряжения представляет соответствующее состояние. 

Процедура 

Установите параметр полярности дискретного выхода (Descrete Output Polarity) в желаемое зна-
чение. 

Значение по умолчанию Active high (Активный высокий). 

 

   Варианты полярности дискретного выхода 
 

Таблица 6-10:     Варианты полярности частотного выхода 

Полярность 
(Polarity) 

 Описание 

Active high 

(Активный высокий)  
• При подтверждении (условие, связанное с DO (дис-

кретным выходом) истинно), контур предоставляет 
24 В. 

• При неподтверждении (условие, связанное с DO 
ложно), контур предоставляет 0 В. 

Active low 

(Активный низкий)  
• При подтверждении (условие, связанное с DO (дис-

кретным выходом) истинно), контур предоставляет 
0 В. 

• При неподтверждении (условие, связанное с DO 
ложно), контур предоставляет 24 В 
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Рисунок 6-1:     Типовая схема дискретного выхода 

 
A. 24 В (Ном)  
B. 3.2 кОМ 
С. Выход + 
D. Выход –  

 

6.4.3 Конфигурирование действия при ошибке для дискретного 
выхода 

Дисплей OFF-LINE MAINT>OFF-LINE CONFG>IO>CH B>SET DO>DO POLAR 

ProLink II ProLink>Configuration>Frequency/Discrete Output>Discrete Output>DO Polarity 

ProLink III Device Tools>Configuration>I/O>Outputs>Discrete Output 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Discrete Output>DO Polarity 

 

Обзор 

Параметр действие при ошибке (Discrete Output Fault Action) для дискретного выхода использует-
ся для определения состояния, в которое переходит дискретный выход, когда преобразователь 
обнаруживает условие внутренней ошибки. 

Примечание 

Только для некоторых ошибок: Если параметр Last Measured Value Timeout установлен в ненуле-
вое значение, преобразователь не осуществляет действий по ошибке до истечения времени 
тайм-аута. 

 

 ПРЕДУПРЕЖДЕНИЕ! 

Не используйте параметр действие по ошибке для дискретного выхода Discrete Output Fault 
Action в качестве индикатора ошибки. Поскольку состояние дискретного выхода всегда 
либо ON, либо OFF, невозможно различить состояние ошибки от нормального состояния. 
Если же Вы желаете использовать дискретный выход для индикации ошибки, обрати-
тесь к Разделу Индикация ошибки с помощью дискретного выхода. 
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Процедура 

Установите параметр действие при ошибке (Discrete Output Fault Action) для дискретного вы-
хода в желаемое значение. 

Значение по умолчанию None (Нет). 

 

   Варианты действия при ошибке для дискретного выхода 
 

Таблица 6-11:     Варианты действия при ошибке для дискретного выхода 

Наименование Состояние дискретного выхода 

Полярность =  
Активный Высокий 

Полярность =  
Активный Низкий 

Upscale 
(выше шкалы) 

• Fault (ошибка): DO в состоянии 
ON (Напряжение определяется 
контуром) 

• Нет ошибки: DO управляется его 
назначением 

• Fault (ошибка): DO в состоянии 
OFF (0 В) 

• Нет ошибки: DO управляется его 
назначением 

Downscale 
(ниже шкалы) 

• Fault (ошибка): DO в состоянии 
OFF (0 В) 

• Нет ошибки: DO управляется его 
назначением 

• Fault (ошибка): DO в состоянии 
ON (Напряжение определяется 
контуром) 

• Нет ошибки: DO управляется его 
назначением 

None (нет) по умолчанию DO управляется его назначением 

 

   Индикация ошибки с помощью дискретного выхода 
   Для индикации ошибки с помощью дискретного выхода установите параметры следующим 

образом: 

• Descrete Output Sourse = Fault (Ошибка) 

• Descrete Output Fault Action = None 

   Примечание 

При назначении Fault источнику дискретного выхода (Descrete Output Sourse), дискретный выход 
будет в состоянии ON всегда, когда условие ошибки активно. Установки Descrete Output Fault 
Action неприменимы (игнорируются). 

 

6.5 Конфигурирование событий 
   Событие происходит, если значение, определённой пользователем переменной, в реальном 

времени, изменяется по отношению к определённой пользователем уставке, то есть становится 
выше или ниже уставки. События могут использоваться для уведомления об изменениях в 
технологическом процессе или для совершения каких-либо действий при этих изменениях. 

Ваш преобразователь поддерживает две модели событий: 

• Базовая модель события (Basic event model) 

• Расширенная модель события (Enhanced event model) 
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6.5.1 Конфигурирование базового события 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Events 

ProLink III Device Tools>Configuration>Events>Basic Events 

Полевой Ком-
муникатор 

Не доступно 

 

Обзор 

“Базовое” событие используется для уведомления об изменениях в технологическом процессе. 
Базовое событие происходит (ON), если значение, определённой пользователем переменной, в 
реальном масштабе времени, изменяется по отношению к определённой пользователем устав-
ке, то есть становится выше (HI) или ниже (LO) уставки. Можно сконфигурировать до двух 
событий. Состояние события может быть опрошено по цифровой коммуникации. Кроме того, 
при наличии в преобразователе дискретного выхода, можно сконфигурировать дискретный 
выход так, что он будет отображать состояние события. 

 

Процедура 

1. Выберите событие для конфигурирования. 

2. Определите тип события (Event Type). 

 

Вариант Описание 

HI 
высокий 

x > A  
Событие происходит, если значение назначенной переменной (x) превыша-
ет уставку (Setpoint А). 

LO 
низкий 

x < A  
Событие происходит, если значение назначенной переменной (x) меньше 
уставки (Setpoint А).  

 

3. Назначьте переменную событию. 

4. Определите величину уставки A. 

5. (Не обязательно) Сконфигурируйте дискретный выход для переключения состояний в со-
ответствии с состоянием события. 

 

6.5.2 Конфигурирование расширенного события 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Discrete Events 

ProLink III Device Tools>Configuration>Events>Enhanced Events 

Полевой Ком-
муникатор 

Configure>Alert Setup>Discrete Events 
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Обзор 

“Расширенное” событие используется для извещения об изменениях в процессе, а при необхо-
димости и для инициации каких-либо действий преобразователем, если событие “произошло”. 
Расширенное событие происходит (ON), если значение, определённой пользователем пере-
менной, в реальном масштабе времени, изменяется по отношению к определённой пользовате-
лем уставке, то есть становится выше (HI), или ниже (LO) уставки, или находится внутри (IN), 
или вне (OUT) диапазона (определяется двумя уставками). Можно сконфигурировать до пяти 
расширенных событий. Для каждого расширенного события может быть назначено одно или 
более действий, осуществляемых преобразователем, если событие “произошло”. 

 

Процедура 

1. Выберите событие для конфигурирования. 

2. Определите тип события (Event Type). 

 

Вариант Описание 

HI 
высокий 

x > A  
Событие происходит, если значение назначенной переменной (x) превыша-
ет уставку (Setpoint А). 

LO 
низкий 

x < A  
Событие происходит, если значение назначенной переменной (x) меньше 
уставки (Setpoint А). 

IN 
в 

A ≤ x ≤ B  
Событие происходит, если значение назначенной переменной (x) находится 
в “диапазоне”, то есть между уставками (Setpoint А и Setpoint В). 

OUT 
вне 

x ≤ A или x ≥ B  
Событие происходит, если значение назначенной переменной (x) находится 
вне “диапазона”, то есть меньше уставки Setpoint А или больше уставки 
Setpoint В. 

 

3.  Назначьте переменную событию. 

4. Определите требуемые уставки. 

• Для событий HI или LO, определить Уставку А 

• Для событий IN или OUT, определить Уставку A и Уставку В. 

5. (Не обязательно) Сконфигурируйте дискретный выход для переключения состояний в со-
ответствии со статусом события. 

6. (Не обязательно) Определите одно или более действий, осуществляемых преобразовате-
лем в случае, если происходит событие. Для этого: 

• С помощью дисплея: OFF-LINE MAINT>OFF-LINE CONFIG>IO>CH C>SET DI>DI ACT 

• С помощью ProLink II: ProLink→Configuration→Discrete Input 

• С помощью ProLink III: Device Tools>Configuration>I/O>Action Assignment 

• С помощью Коммуникатора: Configure>Alert Setup>Discrete Events>Assign Discrete  
Action 

 

 

  



Интеграция прибора с системой управления 

Руководство по конфигурированию и применению 

 

123 

   Варианты действия по расширенному событию 
Таблица 6-12:     Варианты действия по расширенному событию 

Действие 
Наименование 

Дисплей ProLink II ProLink III Полевой 
Коммуникатор 

Стандартные 

None (нет) – по умолчанию NONE None None None 

Start sensor zero  
Запуск процесса установки нуля 

START ZERO Start Sensor 
Zero 

Start Sensor Zero Perform auto 
zero 

Start/stop all totalizers 
Запуск/останов всех сумматоров 

START STOP Start/Stop All 
Totalization 

Start/Stop All 
Totalization 

Start/Stop totals 

Reset mass total 
Сброс массового сумматора 

RESET MASS Reset Mass 
Total 

Reset Mass Total Reset mass total 

Reset volume total 
Сброс объёмного сумматора 

RESET VOL Reset Volume 
Total 

Reset Volume 
Total 

Reset volume 
total 

Reset gas standard volume total 
Сброс сумматора стандартного объёма 
газа 

RESET GSVT Reset Gas Std 
Volume Total 

Reset Gas Std 
Volume Total 

Reset gas stand-
ard  
volume total 

Reset all totals 
Сброс всех сумматоров 

RESET ALL Reset All To-
tals 

Reset All Totals Reset totals 

Измерение нефтепродуктов по API 

Reset temperature-corrected volume total 
Сброс объёмного сумматора, скоррек-
тированного по температуре 

TCVOL Reset API Ref 
Vol Total 

Reset Volume 
Total at Reference 
Temperature 

Reset corrected  
volume total 

Измерение концентрации 

Reset reference volume total 
Сброс объёмного сумматора, приве-
дённого к нормальным условиям 

RESET STD V Reset CM Ref 
Vol Total 

Reset Volume 
Total at Reference 
Temperature 

Не доступно 

Reset net mass total 
Сброс массового нетто-сумматора 

RESET NET M Reset CM Net 
Mass Total 

Reset Net Mass 
Total 

Не доступно 

Reset net volume total 
Сброс объёмного нетто-сумматора 

RESET NET V Reset CM Net 
Vol Total 

Reset Net Volume 
Total 

Не доступно 

Increment CM matrix 
Переход на следующую матрицу кон-
центрации 

INCr CURVE Increment Cur-
rent CM Curve 

Increment Con-
centration Matrix 

Не доступно 

Тест контроля метрологических характеристик 

Start meter verification test 
Запуск теста контроля метрологиче-
ских характеристик 

START 
VERFY 

Start Meter 
Verification 

Start Meter Veri-
fication 

Не доступно 

 

 ПРЕДУПРЕЖДЕНИЕ! 

Перед назначением действия расширенному событию или дискретному входу, проверьте 
состояние события или удалённого устройства ввода. Если они в состоянии ON, все на-
значенные действия будут осуществлены при реализации новой конфигурации. Если это 
недопустимо, выберите соответствующее время для назначения действия расширенному 
событию или дискретному входу. 
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6.6 Конфигурирование цифровой коммуникации 
   Параметры цифровой коммуникации определяют порядок связи с преобразователем при циф-

ровой коммуникации. 

Ваш преобразователь поддерживает следующие типы цифровой коммуникации: 

• HART/Bell 202 на клеммах первого мА выхода 

• HART/RS-485 на клеммах RS-485 

• Modbus/RS-485 на клеммах RS-485 

• Modbus/RS-485 на клеммах порта обслуживания (service port) 

 Примечание 

Порт обслуживания автоматически откликается на широкий диапазон запросов о соединении. 
Он не конфигурируем. 

 

6.6.1 Конфигурирование коммуникации HART/Bell 202 
Дисплей OFF-LINEMAINT>OFF-LINE CONFG>COMM 

ProLink II ProLink>Configuration>Device>Digital Comm Settings 

ProLink III Device Tools>Configuration>Communications>Communications (HART) 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Communications>HART Communications 

 

Обзор 

Коммуникационные параметры HART/Bell 202 поддерживают коммуникацию HART на клем-
мах первого мА выхода преобразователя в сети HART/Bell 202. 

Параметры HART/Bell 202 включают: 

• Адрес опроса HART 

• Режим токового контура (Loop Current Mode) – (ProLink II) или действие по ошибке для мА 
выхода – (ProLink III) 

• Параметры пакетного режима (Burst Parameters) – (не обязательно) 

• Переменные HART (HART Variables)– (не обязательно) 

 

Процедура 

1. Установите адрес опроса HART (HART Address) в значение от 0 до 15. Данный адрес опроса 
HART должен быть единственным в сети.  

Обычно используется адрес по умолчанию (0), если только не используется моноканаль-
ная (multidrop) сеть. 

 

Полезный совет 

Устройства, использующие HART протокол для связи с трансмиттером, могут исполь-
зовать либо адрес опроса HART, либо программный тэг HART. Можно сконфигуриро-
вать каждый из них либо оба, в соответствии с требованиями других HART устройств. 
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2. Проверьте установки параметра Режима Токового Контура (Loop Current Mode) и измени-
те их при необходимости. 

Вариант Описание 

Разрешено (Enabled) Первый мА выход отображает данные процесса в соответст-
вии с конфигурацией. 

Не разрешено (Disabled) Первый мА выход зафиксирован на значении 4 мА и не ото-
бражает данные процесса. 

 

Важно 

При использовании ProLink II или ProLink III для установки адреса HART в 0, програм-
ма автоматически разрешает параметр Loop Current Mode. При использовании ProLink 
II или ProLink III для установки адреса HART в любое, отличное от нуля (0) значение, 
программа автоматически блокирует параметр Loop Current Mode. Это сделано для об-
легчения правильного конфигурирования преобразователя. После установки адреса оп-
роса HART преобразователя, всегда проверяйте правильность установок параметра 
Loop Current Mode. 

 

3. (Не обязательно) Разрешите и сконфигурируйте параметры пакетного режима (Burst Param-
eters). 

 

Полезный совет 

Обычно, пакетный режим не разрешён (заблокирован). Разрешите пакетный режим, 
только, если другое устройство в сети требует коммуникации в пакетном режиме. 

 

4. (Не обязательно) Сконфигурируйте Переменные HART (HART Variables). 

     Конфигурирование параметров пакетного режима 
Дисплей Не доступно 

ProLink II ProLink>Configuration>Device>Burst Setup 

ProLink III Device Tools>Configuration>Communications>Communications (HART) 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Communications>Set Up Burst Mode 

 

Обзор 

Burst mode (пакетный режим) – это специальный режим, при котором преобразователь регу-
лярно передаёт цифровую информацию HART по первому мА выходу. Параметры пакетного 
режима управляют передаваемой информацией при разрешённой коммуникации в пакетном 
режиме. 

Полезный совет 

Обычно, пакетный режим не разрешён (заблокирован). Разрешите пакетный режим, только, 
если другое устройство в сети требует коммуникации в пакетном режиме. 

Процедура 

1. Разрешите пакетный режим (Burst Mode). 

2. Определите выход пакетного режима (Burst Mode Output). 
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Наименование 

Описание ProLink II ProLink III 
Field Commu-
nicator 

Primary var-
iable 

Source (Pri-
mary Varia-
ble) 

PV Преобразователь посылает значение 
первой переменной в сконфигуриро-
ванных единицах измерения в каждом 
пакете (например, 14.0 g/s, 13.5 g/s, 12.0 
g/s). 

PV current & 
% of range 

Primary Var-
iable (Percent 
Range/ Cur-
rent) 

% range/ cur-
rent 

Преобразователь посылает % от диапа-
зона первой переменной и текущее зна-
чение уровня мА сигнала первой пере-
менной в каждом пакете (например, 
25%, 11.0 мА). 

Dynamic 
vars & PV 
current 

Process Vari-
ables/ Cur-
rent 

Process varia-
bles/ current 

Преобразователь посылает значения 
PV, SV, TV и QV в единицах измерения 
и текущее значение уровня мА сигнала 
первой переменной в каждом пакете 
(например, 50 g/sec, 23ºC, 50 g/sec, 
0.0023 g/cm3, 11.8 mA). 

Transmitter 
vars 

Transmitter 
variables 

Fld dev var Преобразователь посылает значения 
четырех переменных, сконфигуриро-
ванных пользователем, в каждом паке-
те.  

 

3. Проверьте или установите выходные переменные пакетного режима. 

• При установке выхода пакетного режима в режим передачи четырёх определённых 
пользователем переменных, определите четыре переменных, предаваемых в каждом 
пакете 

• При установке выхода пакетного режима в другие значения, убедитесь в правильности 
установок переменных HART. 

 

   Конфигурирование переменных HART (PV, SV, TV, QV) 
 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Variable Mapping 

ProLink III Device Tools>Configuration>Communications>Communications (HART) 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Variable Mapping 

 

Обзор 

В преобразователе для HART коммуникации определяются четыре переменные: PV (Первая 
переменная), SV (Вторая переменная), TV (Третья переменная) и QV (Четвёртая переменная). 
Переменная процесса назначается каждой переменной HART, а затем для чтения или передачи 
значений переменной используются стандартные методы HART. 
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   Варианты переменных HART 
Таблица 6-13:     Варианты переменных HART 

Переменные процесса PV SV TV QV 

Стандартные 

Mass flow rate (Массовый расход) ✓ ✓ ✓ ✓ 

Line (Gross) Volume flow rate (Объёмный расход) ✓ ✓ ✓ ✓ 

Temperature (Температура) ✓ ✓  ✓ 

Density (Плотность) ✓ ✓  ✓ 

Drive gain (Уровень сигнала на возбуждающей катушке) ✓ ✓  ✓ 

Mass total (Массовый сумматор)    ✓ 

Line (Gross) Volume total (Объёмный сумматор)    ✓ 

Mass inventory (Массовый инвентаризатор)    ✓ 

Line (Gross) Volume inventory (Объёмный инвентаризатор)    ✓ 

Tube frequency (Частота колебаний трубок)    ✓ 

Meter temperature (Температура)    ✓ 

LPO amplitude (Амплитуда сигнала на левой детект. катушке)    ✓ 

RPO amplitude (Амплитуда сигнала на правой детект. катушке)    ✓ 

Board temperature (Температура платы)    ✓ 

External pressure (Давление от внешнего датчика) ✓ ✓  ✓ 

External temperature (Температура от внешнего датчика) ✓ ✓  ✓ 

Gas standard volume flow rate (Стандартный объёмный расход газа) ✓ ✓ ✓ ✓ 

Gas standard volume total (Сумматор стандартного объёмного расхода)    ✓ 

Gas standard volume inventory (Инвентаризатор стандартного объёмного расхода)    ✓ 

Live zero (“Живой” ноль)    ✓ 

Измерение нефтепродуктов по API 

API density (Плотность) ✓ ✓  ✓ 

API volume flow rate (Стандартный объёмный расход) ✓ ✓ ✓ ✓ 

API volume total (Сумматор стандартного объёмного расхода)    ✓ 

API volume inventory (Инвентаризатор стандартного объёмного расхода)    ✓ 

API average density (Средняя плотность) ✓ ✓  ✓ 

API average temperature (Средняя температура) ✓ ✓  ✓ 

API CTL     ✓ 

Измерение концентрации 

ED density at refererence temperature (Плотность при станд. темп.) ✓ ✓  ✓ 

ED specific gravity (Относительная плотность) ✓ ✓  ✓ 
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Таблица 6-13:     Варианты переменных HART (продолжение) 

Переменные процесса PV SV TV QV 

Измерение концентрации 

ED standard volume flow rate (Стандартный объёмный расход) ✓ ✓ ✓ ✓ 

ED standard volume total (Сумматор стандартного объёмного расхода)    ✓ 

ED standard volume inventory (Инв-тор станд. объёмн. расхода)    ✓ 

ED net mass flow rate (массовый нетто-расход) ✓ ✓ ✓ ✓ 

ED net mass total (массовый сумматор нетто-расхода)    ✓ 

ED net mass inventory (массовый инвентаризатор нетто-расхода)    ✓ 

ED net volume flow rate (объёмный нетто-расход) ✓ ✓ ✓ ✓ 

ED net volume total (объёмный сумматор нетто-расхода)    ✓ 

ED net volume inventory (объёмный инвентаризатор нетто-расхода)    ✓ 

ED concentration (концентрация) ✓ ✓  ✓ 

ED baume (плотность в градусах боме) ✓ ✓  ✓ 

 

 

   Взаимодействие переменных HART и выходов преобразователя 
 Переменные HART автоматически передаются на выходы преобразователя. Если разрешено, 

они могут передаваться в пакетном режиме HART. 

 

Таблица 6-14:     Переменные HART и выходы преобразователя 

Переменная HART Отображается на Комментарии 

Первая переменная 
(PV) 

Первый мА выход При изменении PV, переменная, назначенная на первый мА вы-
ход, изменяется автоматически, и наоборот. 

Вторая переменная 
(SV) 

Не связана с вы-
ходом 

SV должна конфигурироваться напрямую, а её значение доступ-
но только по цифровой коммуникации. 

Третья переменная 
(TV) 

Частотный выход 
(если есть в пре-
образователе) 

При изменении TV, переменная, назначенная на частотный вы-
ход, изменяется автоматически, и наоборот. Если преобразова-
тель не имеет частотного выхода, TV должна конфигурировать-
ся напрямую, а её значение доступно только по цифровой ком-
муникации. 

Четвёртая переменная 
(QV) 

Не связана с вы-
ходом 

QV должна конфигурироваться напрямую, а её значение доступ-
но только по цифровой коммуникации. 
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6.6.2 Конфигурирование коммуникации HART/RS-485 
Дисплей OFF-LINEMAINT>OFF-LINE CONFG>COMM 

ProLink II ProLink>Configuration>Device>Digital Comm Settings>HART Address 

ProLink>Configuration>RS-485 

ProLink III Device Tools>Configuration>Communications>Communications (HART) 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Communications>HART Communications 

 

Обзор 

Коммуникационные параметры HART/RS-485 поддерживают коммуникацию HART на клем-
мах RS-485 преобразователя. 

Параметры HART/ RS-485 включают: 

• Протокол (Protocol) 

• Адрес опроса HART 

• Контроль чётности (Parity), Количество стоповых битов (Stop Bits) и Скорость обмена 
(Baud Rate) 

 

Ограничение 

Преобразователь использует одни и те же клеммы RS-485 для коммуникации HART/RS-485, 
Modbus RTU и Modbus ASCII. Все запросы на коммуникацию по RS-485 должны использовать 
одни и те же протокол и параметры коммуникации, сконфигурированные в преобразователе. 

 

Процедура 

1.  Установите Protocol (протокол) в HART/ RS-485. 

2. Установите параметр Baud Rate (скорость обмена) так, чтобы он совпадал с используемым 
мастером HART. 

3. Установите параметр Parity (контроль чётности) так, чтобы он совпадал с используемым 
мастером HART. 

4. Установите параметр Stop Bits (количество стоповых битов) так, чтобы он совпадал с ис-
пользуемым мастером HART. 

5. Установите адрес опроса HART (HART Address) в значение от 0 до 15. Данный адрес опроса 
HART должен быть единственным в сети. Обычно используется адрес по умолчанию (0), 
если только не используется моноканальная (multidrop) сеть. 

 

Полезный совет 

Устройства, использующие HART протокол для связи с трансмиттером, могут исполь-
зовать либо адрес опроса HART, либо программный тэг HART. Можно сконфигуриро-
вать каждый из них либо оба, в соответствии с требованиями других HART устройств. 
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6.6.3 Конфигурирование коммуникации Modbus/RS-485 
Дисплей OFF-LINEMAINT>OFF-LINE CONFG>COMM 

ProLink II ProLink>Configuration>Device>Digital Comm Settings 

ProLink III Device Tools>Configuration>Communications>RS-485 Terminals 

Полевой Ком-
муникатор 

Configure>Manual Setup>Inputs/Outputs>Communications>Set Up RS-485 Port 

 

Обзор 

Коммуникационные параметры Modbus/RS-485 поддерживают коммуникацию Modbus на 
клеммах RS-485 преобразователя. 

Параметры Modbus / RS-485 включают: 

 

• Запрет Modbus ASCII (Disable Modbus ASCII) 

• Протокол (Protocol) 

• Адрес Modbus (Slave address) 

• Контроль чётности (Parity), Количество стоповых битов (Stop Bits) и Скорость обмена (Baud 
Rate) 

• Порядок следования байтов в данных с плавающей точкой 

• Дополнительная задержка отклика связи 

 

Ограничение 

Для конфигурирования порядка следования байтов в данных с плавающей точкой и дополни-
тельной задержки отклика связи необходимо использовать ProLink II. 

 

Процедура 

1. Установите параметр запрет Modbus ASCII (Disable Modbus ASCII) в желаемое значение. 

Поддержка Modbus ASCII ограничивает Modbus адресацию преобразователя. 

Поддержка Modbus ASCII Доступные Modbus адреса 

Disabled запрещена 1-127, за исключением 111 (111 зарезервирован для пор-
та обслуживания (service port)) 

Enabled разрешена 1-15? 32-47? 64-79 и 96-110 

 

2. Установите Protocol (протокол) так, чтобы он совпадал с используемым хостом Modbus / 
RS-485. 

Вариант Описание 

Modbus RTU (по умолчанию) 8-мибитная коммуникация 

Modbus ASCII 7-мибитная коммуникация 

Если поддержка Modbus ASCII запрещена, необходимо использовать Modbus/RS-485. 

3. Установите адрес опроса Modbus в значение, неповторяемое в сети. 
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4. Установите параметры Parity, Stop Bits и Baud Rate в соответствии с требованиями сети. 

5. Установите порядок следования байтов в данных с плавающей точкой в соответствии с 
порядком, используемым хостом Modbus. 

 

Код Порядок следования байтов 

0 1-2   3-4 

1 3-4   1-2 

2 2-1   4-3 

3 4-3   2-1 

 

Структура байтов 1, 2, 3 и 4 приведена в Таблице 6-15. 

 

Таблица 6-15:     Содержимое байтов в данных с плавающей точкой 

Байт Биты Определения 

1 SEEEEEEE S = Знак 
E = Экспонента 

2 EMMMMMMM E = Экспонента 
M = Мантисса 

3 MMMMMMMM M = Мантисса 

4 MMMMMMMM M = Мантисса 

 

6. (Не обязательно) Установите дополнительную задержку отклика связи в “единицах за-
держки”. 

Базовая единица задержки представляет собой 2/3 времени передачи одного знака, рассчи-
танного для скоростей и параметров обмена последовательного токового порта. Значение 
может быть от 1 до 255. 

Некоторые хосты работают со скоростями, меньшими, чем преобразователь. Для синхро-
низации коммуникации между устройствами, Вы можете сконфигурировать дополнитель-
ную задержку отклика связи, добавляемую к каждому ответу, посылаемому преобразова-
телем удалённому хосту. 

 

Полезный совет 

Не используйте дополнительную задержку отклика связи, если этого не требует Modbus 
хост. 

  

6.6.4 Конфигурирование действия при ошибке для цифровой 
коммуникации 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Device>Digital Comm Settings>Digital Comm Fault Setting 

ProLink III Device Tools>Configuration>Fault Processing 

Полевой Ком-
муникатор 

Configure>Alert Setup>I/O Fault Actions>Comm Fault Action 
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Обзор 

Параметр действие по ошибке для цифровой коммуникации определяет значения, отображае-
мые по цифровой коммуникации при обнаружении преобразователем условий внутренней 
ошибки. 

Процедура 

Установите параметр действия при ошибке для цифровой коммуникации (Digital Communications 
Fault Action) в желаемое значение. 

Значение по умолчанию None (Нет). 

 

   Варианты действия по ошибке для цифровой коммуникации 
 

Таблица 6-16:     Варианты действия по ошибке для цифровой коммуникации 

Наименование 
Описание ProLink II ProLink III Полевой Комму-

никатор 

Upscale 
Выше шкалы 

Upscale Upscale • Значения переменных процесса становятся 
больше верхней границы сенсора.  

• Сумматоры останавливаются 
Downscale 
Ниже шкалы 

Downscale Downscale • Значение переменных процесса становится 
меньше нижней границы сенсора.  

• Сумматоры останавливаются 
Zero  
Ноль 

Zero IntZero-All 0 
Внутренний ноль-
Все 0 

• Переменная мгновенного расхода передаёт 
значение, представляющее нулевой (0) рас-
ход. 

• Плотность передаётся как 0. 
• Температура передаётся как 0ºС или соответ-

ствующий эквивалент при других единицах 
измерения, например 32ºF. 

• Уровень сигнала на возбуждающей катушке 
(drive gain) передаётся в соответствии с изме-
рением. 

• Сумматоры останавливаются. 

Not-A-Number 
(NaN) 
Число не опре-
делено 

Not a number  
Число не опреде-
лено 

Not-a-Number  
Число не опреде-
лено 

• Переменные процесса не определены – IEEE 
NAN.  

• Уровень сигнала на возбуждающей катушке 
(drive gain) передаётся в соответствии с изме-
рением. 

• Масштабированные целые Modbus устанав-
ливаются в Max. Int. 

• Сумматоры останавливаются. 
Flow to Zero 
Нулевой расход 

Flow to Zero IntZero-Flow 0 
Внутренний ноль-
Расход 0 

• Значения расходов устанавливаются в соот-
ветствующие 0 (нулевому расходу) 

• Другие переменные передаются в соответст-
вии с измерением. 

• Сумматоры останавливаются. 
None (Нет)  
(по умолчанию) 

None None(Нет)  
(по умолчанию) 

• Значения переменных соответствуют изме-
ренным значениям. 

• Значения сумматоров возрастают, если они не 
остановлены. 
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 ПРЕДУПРЕЖДЕНИЕ! 

Если параметр действие при ошибке для мА или частотного выходов установлен в None 
(нет), параметр действие при ошибке для цифровой коммуникации также должен быть 
установлен в None. В противном случае, выход не будет отражать действительного зна-
чения переменной, а это может привести к ошибке измерения и непредсказуемым по-
следствиям для процесса.  

Ограничение 

Если параметр действие при ошибке для цифровой коммуникации установлен в значение NAN 
(not a number), Вы не сможете установить параметр действие при ошибке для мА или частот-
ного выходов в None (нет). При попытке сделать это, предлагаемая конфигурация не будет 
принята преобразователем. 
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7 Завершение конфигурирования 
 

Темы данной главы 
• Проверка и корректировка системы в режиме имитации сенсора 

• Сохранение конфигурации преобразователя 

• Включение защиты записи конфигурации преобразователя 

 

7.1 Проверка и подстройка системы в режиме 
имитации сенсора 

 

Имитация сенсора используется для тестирования отклика системы на различные условия 
процесса, включая граничные и проблемные условия, условия тревожных сообщений или для 
подстройки контура. 

Ограничение 

Функция имитации сенсора доступна только для расходомеров с усовершенствованным базо-
вым процессором. 

 

Предварительные требования 

Перед использованием режима имитации сенсора убедитесь в том, что процесс допускает ими-
тируемые значения переменных. 

Процедура 

1. Найдите в меню режим имитации сенсора. 

Средство коммуникации Путь в меню 

Дисплей Не доступно 

ProLink II ProLink>Configuration>Sensor Simulation 

ProLink III Device Tools>Diagnostics>Testing>Sensor Simulation 

Полевой Коммуникатор Service Tools>Simulate>Simulate Sensor 

 

2. Разрешите режим имитации сенсора. 

3. Для массового расхода выберите желаемую форму сигнала (Wave form) и введите требуе-
мые значения. 

 

Вариант Необходимые значения 

Fixed (фиксированное) Фиксированное значение 

Sawtooth (пилообразное) Период 
Минимум 
Максимум 

Sine (синусоида) Период 
Минимум 
Максимум 
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4. Для плотности выберите желаемую форму сигнала (Wave form) и введите требуемые значе-
ния. 

 

Вариант Необходимые значения 

Fixed (фиксированное) Фиксированное значение 

Sawtooth (пилообразное) Период 
Минимум 
Максимум 

Sine (синусоида) Период 
Минимум 
Максимум 

 

5. Для температуры выберите желаемую форму сигнала (Wave form) и введите требуемые 
значения. 

 

Вариант Необходимые значения 

Fixed (фиксированное) Фиксированное значение 

Sawtooth (пилообразное) Период 
Минимум 
Максимум 

Sine (синусоида) Период 
Минимум 
Максимум 

 

6. Проанализируйте реакцию системы на имитируемые значения и проведите необходимые 
изменения в конфигурации преобразователя или системы. 

7. Измените имитируемые значения и повторите анализ. 

8. По завершению тестирования и подстройки выйдите из режима имитации. 

 

 

7.1.1 Имитация сенсора 
Режим имитации сенсора позволяет Вам протестировать и подстроить систему, не создавая в 
реальности условий тестирования. При разрешённом режиме имитации сенсора преобразова-
тель отображает имитируемые значения массового расхода, плотности и температуры и осу-
ществляет все соответствующие действия. Например, преобразователем используется отсечка, 
активируется событие или формируется тревожное сообщение. 

При разрешённом режиме имитации сенсора имитируемые значения хранятся в том же участке 
памяти, что и данные от сенсора. Таким образом, имитируемые значения используются при 
всех видах функционирования преобразователя. Например, имитация сенсора влияет на: 
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• Все значения массового расхода, плотности и температуры, отображаемые на дисплее, на 
выходах или передаваемые по цифровой коммуникации 

• Значения сумматоров и инвентаризаторов массы 

• Все вычисления объёмного расхода и соответствующие данные, включая отображаемые 
значения и значения сумматоров и инвентаризаторов объёма 

• Все значения массового и объёмного расхода, плотности и температуры, сохраняемые ин-
струментом Data Logger. 

 

Имитация сенсора не оказывает влияния на диагностические данные. 

В отличие от действительных значений массового расхода и плотности, имитируемые значе-
ния не корректируются по температуре (не подстраиваются по температуре расходомерных 
трубок сенсора). 

 

 

7.2 Сохранение конфигурации преобразователя 
 

ПО ProLink II и ProLink III предоставляют функцию загрузки и сохранения (upload/download) 
конфигурации, позволяющую сохранить конфигурацию на ПК. Это позволяет Вам сохранять и 
восстанавливать конфигурацию преобразователя. Кроме того, это удобный способ тиражиро-
вания конфигурации по многим приборам. 

Предварительные требования 

Один из вариантов: 

• Активное соединение с ProLink II 

• Активное соединение с ProLink III 

Ограничение 

Эта функция не доступна для других средств коммуникации. 

 

Процедура 

• Для сохранения конфигурации преобразователя с помощью ProLink II: 

1. Выберите File>Load from Xmtr to file. 

2. Определите имя и место для сохраняемого файла и щёлкните кнопкой мыши по Save 
(Сохранить). 

3. Выберите условия, включаемые в сохраняемый файл, и щёлкните кнопкой мыши по 
Download Configuration. 

• Для сохранения конфигурации преобразователя с помощью ProLink III: 

1. Выберите Device Tools>Configuration Transfer>Save or Load Configuration Data 

2. В окне конфигурации выберите конфигурационные данные, которые Вы желаете со-
хранить. 

3. Щёлкните кнопкой мыши по Save (Сохранить), затем определите имя и место для со-
храняемого файла на Вашем ПК. 

4. Щёлкните кнопкой мыши по Start Save (начать сохранение). 

Резервный файл сохранится под указанным именем в указанном месте. Он имеет текстовый 
формат и может быть прочтён любым текстовым редактором. 
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7.3 Включение защиты записи конфигурации 
преобразователя 

 

Дисплей OFF-LINE MAINT>CONFIG>LOCK 

ProLink II ProLink>Configuration>Device>Enable Write Protection 

ProLink III Device Tools>Configuration>Write Protection 

Полевой Ком-
муникатор 

Configure>Manual Setup>Info Parameters>Transmitter Info>Write Protect 

 

Обзор 

Если преобразователь защищён от записи, конфигурация зафиксирована, и никто не сможет 
изменить её до её разблокирования. Это предотвратит случайное или неавторизованное изме-
нение конфигурации параметров преобразователя. 
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8 Установка приложения коммерческого учета 
 

Темы данной главы 
• Приложение коммерческого учета 

• Установка приложения коммерческого учета с помощью ProLink II 

• Установка приложения коммерческого учета с помощью ProLink III 

 

Информация, содержащаяся в данной главе, применима только в том случае, если преобразова-
тель был заказан с приложением коммерческого учёта. 

 

8.1 Приложение коммерческого учета 
 

Приложение коммерческого учёта используется для обеспечения представления легальных 
данных технологического процесса с использованием утверждённых методов для получения и 
чтения результатов измерений. 

Регулирующие агентства 

При установке, конфигурировании и использовании в соответствии с рекомендациями Micro 
Motion, приложение коммерческого учёта должно быть сертифицировано регулирующим 
агентством: 

• National Type Evaluation Program (NTEP). Требования NTEP применимы в США и Канаде. 

• Organization of Legal Metrology (OIML), типично для большинства других регионов мира. 

В зависимости от регулирующего агентства, требованиям которого отвечает Ваша установка, 
используются различные конфигурации и режимы работы. 

Безопасный и небезопасный режимы 

При установленном приложении коммерческого учёта, преобразователь всегда находится в 
безопасном или небезопасном режиме. При отправке с завода, преобразователь находится в 
небезопасном режиме, и Аларм Состояния А027: Нарушение Защиты (Security Breach) акти-
вен. Кроме того, измерение расхода может быть заблокировано. Данные измерений преобразо-
вателя, находящегося в небезопасном режиме, не могут использоваться при коммерческом 
учёте. 

Для сброса аларма и обеспечения измерения расхода, необходимо сконфигурировать прило-
жение коммерческого учёта и активировать безопасный режим. При активном безопасном ре-
жиме, аларм сбрасывается и измерение расхода разблокируется автоматически. 

 

Типы безопасности и соответствующие требования 

Перед использованием преобразователя для измерений коммерческого учёта, необходимо 
применить как метрологическую, так и физическую безопасность. 
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Метрологическая 
безопасность 

Метрологическая безопасность защищает преобразователь от вся-
ких изменений, которые могут повлиять на результаты измере-
ний. Это включает изменения в конфигурации и в некоторых 
процедурах обслуживания. 

Micro Motion обеспечивает метрологическую безопасность по-
средством “программной безопасности”. Программная безопас-
ность это установки внутри преобразователя, блокирующие про-
граммно все запрещённые действия. Программная безопасность 
может быть активирована или заблокирована с помощью ProLink 
II или ProLink III. Программная безопасность обеспечивает пол-
ную защиту от несанкционированных изменений или действий. 

Физическая безопас-
ность 

Физическая безопасность обеспечивается установкой пломбы 
сертифицированным представителем органов метрологического 
надзора. Пломбирование предотвращает доступ к клеммам порта 
обслуживания. 

Хотя пломба может быть легко нарушена, никто, кроме сертифи-
цированного представителя органов метрологического надзора не 
сможет её восстановить. Таким образом легко обнаруживается 
нарушение безопасности. При нарушении целостности пломбы, 
данные измерений преобразователя не могут использоваться при 
коммерческом учёте. 

 

Методы конфигурирования 

Для конфигурирования параметров коммерческого учёта необходимо пользоваться ПО 
ProLink II или ProLink III и подключением порта обслуживания (service port). 

 

8.2 Установка приложения коммерческого учета с 
помощью ProLink II 

 

Если Ваш преобразователь установлен на соответствие требованиям OIML или NTEP, и нахо-
дится в режиме безопасности (“secured”), выбранные данные измерений преобразователя яв-
ляются легальными для коммерческого учёта. 

Предварительные требования 

Важно 

Наряду с необходимостью соответствия требованиям OIML или NTEP, необходимо обеспе-
чить соответствие местным требованиям к коммерческому учёту. 

 

Организуйте присутствие сертифицированного представителя органов метрологического над-
зора на соответствующем этапе процедуры сертификации установки коммерческого учёта, 
если это необходимо. 

Перед активированием режима безопасности, проведите необходимые процедуры конфигури-
рования, тестирования и подстроек. После активирования режима безопасности становятся 
невозможными изменения в конфигурации, многие действия по обслуживанию и некоторые 
действия оператора. 

Процедура 

1. Установите подключение по порту обслуживания из ProLink II с преобразователем. 

2. Выберите ProLink > Configuration > System. 
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3. Установите значение параметра Approval в значение, соответствующее Вашему примене-
нию. 

Вариант Описание 

NTEP Регулирующее агентство для США и Канады. 

OIML Регулирующее агентство для большинства других стран мира. 

 

4. Установите значение параметра Totalizer Reset Options (варианты сброса сумматора) в же-
лаемое значение. 

Вариант Необходимые значения 

Запрет сброса сумматоров 
с дисплея и по цифровой 
коммуникации 

Если преобразователь находится в режиме безопасности 
(защиты), сумматоры не могут быть сброшены ни с дис-
плея, ни по цифровой коммуникации. 

Разрешение сброса сумма-
торов только по цифровой 
коммуникации 

Если преобразователь находится в режиме безопасности 
(защиты), сумматоры могут быть сброшены только по 
цифровой коммуникации. 

Разрешение сброса сумма-
торов с дисплея и по циф-
ровой коммуникации 

Если преобразователь находится в режиме безопасности 
(защиты), сумматоры могут быть сброшены с дисплея 
или по цифровой коммуникации. 

Разрешение сброса сумма-
торов только с дисплея 

Если преобразователь находится в режиме безопасности 
(защиты), сумматоры могут быть сброшены только с дис-
плея. 

 

Под “цифровой коммуникацией” понимается любой метод, использующий Modbus или 
HART коммуникацию для связи с преобразователем, включая ProLink II, ProLink III, По-
левой Коммуникатор или любой хост. 

5. Если требуется для Вашей установки, сконфигурируйте Ваш преобразователь на два час-
тотных выхода в режиме Quadrature. 

a. Выберите ProLink > Configuration > Channel. 

b. Установите Channel B Type Assignment в значение Frequency Output и щёлкните кнопкой 
мыши по Apply. 

c. Установите Channel C Type Assignment в значение Frequency Output и щёлкните кнопкой 
мыши по Apply. 

d. Выберите ProLink > Configuration > Frequency и установите Freq Output Mode в значение 
Quadrature. 

6. При необходимости, разрешите Alarm Menu Password для дисплея: ProLink > Configuration > 
Display. 

Пароль доступа к меню тревожных сообщений дисплея (Alarm Menu Password) для соответ-
ствия сертификату типа PTB, требуется по немецкому законодательству и, возможно, для 
других мест и приложений. 

7. При необходимости, прочитайте и запишите значение контрольной суммы firmware check-
sum для преобразователя и базового процессора: ProLink > Configuration > Device. 

Мониторинг значений firmware checksum преобразователя и базового процессора осуще-
ствляется во время ввода в эксплуатацию расходомера для соответствия требованиям к 
коммерческому учёту газа в Германии. Указанные значения могут использоваться и в тес-
товых отчётах MID/Velmec 7.2. 

8. При необходимости, сконфигурируйте параметр Field Verification Zero (FVZ) как дисплей-
ную переменную, затем отметьте и запишите текущее значение FVZ: ProLink > Configuration 
> Display. 
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Мониторинг диагностического параметра Field Verification Zero (FVZ) – контроль нуля, 
длится в течение 3-х минут, осуществляется во время ввода в эксплуатацию расходомера 
для соответствия требованиям MID (европейская директива по измерительным приборам) 
2004/22/ЕС для приложений коммерческого учёта. Детальные инструкции содержатся в 
Вашей документации SOP (Standard Operating Procedures). 

9. Активируйте программную безопасность (защиту): 

a. Выберите Plug-ins > Enable/Disable Custody Transfer. 

b. Щёлкните кнопкой мыши по Enable Custody Transfer 

Важно 

В зависимости от местных правил, данный шаг может требовать присутствия сертифи-
цированного представителя органов метрологического надзора. 

После этого шага, преобразователь находится в режиме метрологической безопасности 
(защиты). Преобразователь осуществляет: 

• Защиту всех измеряемых параметров. Вы можете прочитать текущую конфигурацию, 
но не можете изменить её. 

• Сброс Аларма Состояния А027: Нарушение Защиты (Security Breach). 

10. Установите физическую защиту (пломбу). 

Важно 

В большинстве случаев пломба предоставляется и устанавливается сертифицированным 
представителем органов метрологического надзора. Проволока продевается через фик-
сирующий зажим преобразователя (если преобразователь снабжён фиксирующим за-
жимом). 

  

 

Рисунок 8-1:     Пример  фиксирующего зажима и пломбы на преобразователе 
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8.3 Установка приложения коммерческого учета с 
помощью ProLink III 

 

Если Ваш преобразователь установлен на соответствие требованиям OIML или NTEP, и нахо-
дится в режиме безопасности (“secured”), выбранные данные измерений преобразователя яв-
ляются легальными для коммерческого учёта. 

Предварительные требования 

Важно 

Наряду с необходимостью соответствия требованиям OIML или NTEP, необходимо обеспе-
чить соответствие местным требованиям к коммерческому учёту. 

 

Организуйте присутствие сертифицированного представителя органов метрологического над-
зора на соответствующем этапе процедуры сертификации установки коммерческого учёта, 
если это необходимо. 

Перед активированием режима безопасности, проведите необходимые процедуры конфигури-
рования, тестирования и подстроек. После активирования режима безопасности становятся 
невозможными изменения в конфигурации, многие действия по обслуживанию и некоторые 
действия оператора. 

 

Процедура 

1. Установите подключение по порту обслуживания из ProLink III с преобразователем. 

2. Выберите Device Tools > Configuration > Weights & Measures и установите параметр Regulatory 
Agency в значение, соответствующее Вашему применению. 

Вариант Описание 

NTEP Регулирующее агентство для США и Канады. 

OIML Регулирующее агентство для большинства других стран мира. 

 

3. Выберите Device Tools > Configuration > Totalizer Controk Methods и установите параметр методы 
управления сумматорами в желаемое значение. 

 

Параметр Вариант 

Сброса сумматоров с 
дисплея 

• Разрешено:Возможен сброс сумматоров с дисплея вне за-
висимости от режима безопасности преобразователя. 

• Заблокировано: Возможен сброс сумматоров с дисплея 
только при выключенном режиме безопасности преобра-
зователя. 

Сброс сумматоров по 
цифровой коммуни-
кации 

•  Разрешено:Возможен сброс сумматоров по цифровой 
коммуникации вне зависимости от режима безопасности 
преобразователя. 

• Заблокировано: Возможен сброс сумматоров по цифровой 
коммуникации только при выключенном режиме безопас-
ности преобразователя. 
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Под “цифровой коммуникацией” понимается любой метод, использующий Modbus или 
HART коммуникацию для связи с преобразователем, включая ProLink II, ProLink III, По-
левой Коммуникатор или любой хост. 

4. Если требуется для Вашей установки, сконфигурируйте Ваш преобразователь на два час-
тотных выхода в режиме Quadrature. 

a. Выберите Device Tools > Configuration > I/O > Channels. 

b. Для Канала В установите Channel Type в значение Frequency Output и щёлкните кнопкой 
мыши по Apply. 

c. Для Канала С установите Channel Type в значение Frequency Output и щёлкните кнопкой 
мыши по Apply. 

d. Выберите Device Tools > Configuration > I/O > Outputs > Frequency Output Mode и выберите 
значение Quadrature. 

5. При необходимости, выберите Device Tools > Configuration > Transmitter Display > Display Security 
затем разрешите и сконфигурируйте пароль для меню алармов. 

Пароль доступа к меню тревожных сообщений дисплея требуется для соответствия серти-
фикату типа PTB по немецкому законодательству при измерении газа. 

6. При необходимости, выберите Device Tools > Device Information, затем прочитайте и запишите 
значение контрольной суммы firmware checksum для преобразователя и базового процес-
сора. 

Мониторинг значений firmware checksum преобразователя и базового процессора осуще-
ствляется во время ввода в эксплуатацию расходомера для соответствия требованиям к 
коммерческому учёту газа в Германии. Указанные значения могут использоваться и в тес-
товых отчётах MID/Velmec 7.2. 

7. При необходимости, проконтролируйте значение нуля в Вашей системе: 

a. Выберите Device Tools > Configuration > Transmitter Display > Display Variables и сконфигури-
руйте Field Verification Zero (FVZ) как дисплейную переменную. 

b. На дисплее преобразователя прочитайте и запишите текущее значение FVZ. 

Мониторинг диагностического параметра Field Verification Zero (FVZ) – контроль нуля, 
длится в течение 3-х минут, осуществляется во время ввода в эксплуатацию расходомера 
для соответствия требованиям MID (европейская директива по измерительным приборам) 
2004/22/ЕС для приложений коммерческого учёта. Детальные инструкции содержатся в 
Вашей документации SOP (Standard Operating Procedures). 

8. Активируйте программную безопасность (защиту): Device Tools > Configuration > Weights & 
Measures > Software Security. 

Важно 

В зависимости от местных правил, данный шаг может требовать присутствия сертифи-
цированного представителя органов метрологического надзора. 

После этого шага, преобразователь находится в режиме метрологической безопасности 
(защиты). Преобразователь осуществляет: 

• Защиту всех измеряемых параметров. Вы можете прочитать текущую конфигурацию, 
но не можете изменить её. 

• Сброс Аларма Состояния А027: Нарушение Защиты (Security Breach). 
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9. Установите физическую защиту (пломбу). 

Важно 

В большинстве случаев пломба предоставляется и устанавливается сертифицированным 
представителем органов метрологического надзора. Проволока продевается через фик-
сирующий зажим преобразователя (если преобразователь снабжён фиксирующим за-
жимом). 

  

 

Рисунок 8-2:     Пример  фиксирующего зажима и пломбы на преобразователе 

 
 

 

 

 

  



Установка приложения коммерческого учета 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

146 

 

 

 

 

 

  



Рабочий режим, режимо бслуживания и устранение неисправностей 

Руководство по конфигурированию и применению 

 

147 

Часть III 
Рабочий режим, режим обслуживания и 
устранение неисправностей 
 

 

 

 

Темы данной части 
• Рабочий режим преобразователя 

• Эксплуатация преобразователя с приложением коммерческого учета 

• Обеспечение качества измерений 

• Поиск и устранение неисправностей 
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9 Рабочий режим преобразователя 
 

Темы данной главы 
• Запись переменных процесса 

• Просмотр переменных процесса 

• Просмотр состояния преобразователя с помощью светодиода-состояния (LED) 

• Просмотр и подтверждение тревожных сообщений состояния 

• Просмотр показаний сумматора и инвентаризатора 

• Запуск и останов сумматоров и инвентаризаторов 

• Сброс сумматоров 

• Сброс инвентаризаторов 

 

 

9.1 Запись переменных процесса 
 

Micro Motion предлагает Вам делать записи о значениях переменных процесса, включая при-
емлемые диапазоны измерения при нормальных рабочих условиях. Эти данные позволят Вам 
распознать ситуацию с необычно низкими или высокими значениями переменных и диагно-
стировать проблемы приложения. 

Процедура 

Запишите значения следующих переменных при нормальных рабочих условиях: 

 

Переменная процесса 

Измерение 

Типичное среднее Типичное высокое Типичное низкое 

Flow rate (расход)    

Density (плотность)    

Temperature (температу-
ра) 

   

Tube frequency (частота 
колебаний трубок сенсо-
ра) 

   

Pickoff voltage (напряже-
ние на детекторной ка-
тушке) 

   

Drive gain (уровень сиг-
нала на возбуждающей 
катушке) 
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9.2 Просмотр переменных процесса 
Дисплей Прокрутите до желаемой переменной. Если Автопрокрутка включена, вы можете дож-

даться, когда переменная процесса отобразится. Дополнительную информацию см. в 
Разделе 9.2.1 

ProLink II ProLink>Process Variable 

ProLink>API Process variables (приложение измерения нефти по API) 

ProLink>CM process variables (приложение измерения концентрации) 

ProLink III Желаемая переменная отображена на главном экране под заголовком Process Varia-
bles. Дополнительную информацию см. в Разделе 9.2.2 

Полевой Ком-
муникатор 

Overview>Shortcuts>Variables>Process Variables 

 

Обзор 

Переменные процесса представляют информацию о состоянии измеряемой жидкости, напри-
мер, расход, плотность, температура, значения нарастающих сумматоров. Переменные процес-
са могут представлять также данные о работе расходомера, например, уровень сигнала на воз-
буждающей катушке и напряжение на детекторной катушке. Эта информация может исполь-
зоваться для понимания процесса и поиска и устранения неисправностей. 

 

9.2.1 Просмотр переменных процесса с помощью дисплея 
 

Просмотрите значение желаемой переменной. 

При использовании дисплея, по умолчанию на него выводятся значения массового расхода, 
массового сумматора, объёмного расхода, объёмного сумматора, температуры, плотности и 
уровня сигнала на возбуждающей катушке. Дисплей отображает сокращённое название пере-
менной процесса (например, DENS для плотности), текущее значение этой переменной и соот-
ветствующие единицы измерения (например, G/CM3). 

При желании, Вы можете сконфигурировать дисплей для отображения других переменных, 
например сумматоров и инвентаризаторов. 

При включенной автопрокрутке (Auto Scroll), каждая сконфигурированная дисплейная пере-
менная появляется на экране на число секунд, специфицированных для скорости прокрутки. 

 

  



Рабочий режим преобразователя 

Руководство по конфигурированию и применению 

 

151 

Рисунок 9-1:     Элементы дисплея преобразователя 

 
A. Светодиод состояния 
B. Дисплей (ЖК панель) 
С. Переменная процесса 
D. Оптический переключатель Scroll (прокрутка) 
E.  Индикатор оптического переключателя: горит красным, когда активирован Scroll или 
Select 
F. Оптический переключатель Select 
G. Единицы измерения переменной процесса 
H. Текущее значение переменной процесса 

 

9.2.2 Просмотр переменных процесса с ProLink III 
 

При подключении к прибору, переменные процесса отображаются на основном экране ProLink 
III.  

Процедура 

Просмотрите желаемые переменные процесса. 

Полезный совет 

ProLink III позволяет Вам выбрать переменные процесса, отображаемые на основном экране. 
Вы можете выбрать представление данных на аналоговом или цифровом индикаторе, а также 
уточнить параметры индикатора. Дополнительная информация содержится в Руководстве 
пользователя ProLink III. 
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9.3 Просмотр состояния преобразователя с 
помощью светодиода состояния (LED) 

 

Светодиод состояния показывает текущие условия тревожных сообщений преобразователя. 
Светодиод состояния находится на лицевой стороне преобразователя. 

Наблюдайте за состоянием светодиода. 

• При наличии дисплея преобразователя, Вы можете наблюдать за состоянием светодиода, 
не снимая крышки корпуса преобразователя. 

• При отсутствии дисплея преобразователя, отсутствует и светодиод состояния. Эта опция 
не доступна. 

Для интерпретации состояния светодиода, воспользуйтесь следующей таблицей. 

 

Ограничение 

Если функция мигания светодиода заблокирована, светодиод состояния мигает лишь во время 
калибровки. Он не будет мигать для индикации неподтверждённого тревожного сообщения 
(аларма). 

 

Таблица 9-1:     Состояния светодиода-индикатора 

Состояние  
светодиода (LED) 

Условие тревожного  
сообщения 

Описание 

Постоянный зеленый Нет активных тревожных сооб-
щений (алармов). 

Нормальное функционирование 

Мигающий зеленый Нет активных тревожных сооб-
щений (алармов).  

Ранее активное тревожное сооб-
щение не подтверждено. 

Постоянный желтый Активное тревожное сообщение 
(аларм) низкого приоритета.  

Тревожное сообщение подтвер-
ждено. 

Мигающий желтый Активное тревожное сообщение 
(аларм) низкого приоритета.  

Тревожное сообщение не под-
тверждено. 

Постоянный красный Активное тревожное сообщение 
(аларм) высокого приоритета.  

Тревожное сообщение подтвер-
ждено. 

Мигающий красный Активное тревожное сообщение 
(аларм) высокого приоритета.  

Тревожное сообщение не под-
тверждено. 

 

9.4 Просмотр и подтверждение тревожных 
сообщений состояния 

Преобразователь выставляет тревожное сообщение состояния и при превышении переменной 
установленных для неё пределов, и при обнаружении условий ошибки. Вы можете просматри-
вать тревожные сообщения и подтверждать их. 

9.4.1 Просмотр и подтверждение тревожных сообщений состояния 
с помощью дисплея 

Вы можете просмотреть список, содержащий все активные и неактивные, но не подтверждён-
ные тревожные сообщения. Вы можете индивидуально подтверждать тревожные сообщения из 
списка. 

Примечание 

В список включаются тревожные сообщения с приоритетом Fault и Informational. Алармы с 
приоритетом Ignor автоматически отфильтровываются преобразователем. 
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Предварительные требования 

Доступ оператора к меню алармов должен быть разрешён (установка по умолчанию). Если 
доступ оператора к меню алармов заблокирован, Вам придётся использовать другой метод 
просмотра и подтверждения алармов. 

Процедура 

См. Рисунок 9-2. 

 

Рисунок 9-2:     Просмотр и подтверждение тревожных сообщений состояния с помощью дисплея 

 
 

Активируете Scroll и Select одновре-
менно на 4 секунды 
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Дополнительная информация 

• Для сброса следующих тревожных сообщений необходимо устранить причину аларма, 
подтвердить его и включить-выключить преобразователь: A001, A002, A010, A011, A012, 
A013, A018, A019, A022, A023, A024, A025, A028, A029, A031. 

• Для всех остальных тревожных сообщений (алармов): 

− Если аларм не активен, после подтверждения он удаляется из списка. 

− Если аларм активен, после подтверждения он удаляется из списка лишь при исчезно-
вении условий тревожного сообщения. 

 

9.4.2 Просмотр и подтверждение тревожных сообщений с 
помощью ProLink II 

 

Вы можете просмотреть список, содержащий все активные и неактивные, но не подтверждён-
ные тревожные сообщения. Вы можете индивидуально подтверждать тревожные сообщения из 
списка. 

1. Выберите ProLink > Alarm Log 

2. Выберите панель High Priority (высокого приоритета) или Low Priority (низкого приорите-
та). 

Примечание 

Распределение алармов по этим двум категориям жёстко запрограммировано и не зави-
сит от параметра Status Alarm Severity. 

Все активные или неподтверждённые алармы в списке: 

• Индикатор красного цвета: В настоящее время аларм активен. 

• Зелёный индикатор: Аларм неактивен, но не подтверждён. 

Примечание 

В список включаются тревожные сообщения с приоритетом Fault и Informational. Алар-
мы с приоритетом Ignor автоматически отфильтровываются преобразователем. 

3. Для подтверждения аларма, поставьте метку в окошке Ack.  

 

Дополнительная информация 

• Для сброса следующих тревожных сообщений необходимо устранить причину аларма, 
подтвердить его и включить-выключить преобразователь: A001, A002, A010, A011, A012, 
A013, A018, A019, A022, A023, A024, A025, A028, A029, A031. 

• Для всех остальных тревожных сообщений (алармов): 

− Если аларм не активен, после подтверждения он удаляется из списка. 

− Если аларм активен, после подтверждения он удаляется из списка лишь при исчезно-
вении условий тревожного сообщения. 
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9.4.3 Просмотр и подтверждение тревожных сообщений состояния 
с помощью ProLink III 

Вы можете просмотреть список, содержащий все активные и неактивные, но не подтверждён-
ные тревожные сообщения (alerts). Вы можете индивидуально подтверждать тревожные сооб-
щения из списка или выбрать вариант одновременного подтверждения всех тревожных сооб-
щений. 

1. Просмотрите тревожные сообщения (alerts) на основном экране ProLink III под закладкой 
Alerts. 

Все активные или неподтверждённые тревожные сообщения содержатся в списке и ото-
бражаются в соответствии со следующими категориями: 

Категория Описание 

Failed: Fix now Ошибка прибора требует немедленного принятия мер. 

Maintenance: Fix soon Условие, которое может быть устранено позже. 

Advisory: Informational Условие, не требующее Вашего внимания. 

 

Примечание 

• Все сообщения об ошибках отражаются в категории Failed: Fix now. 

• Все информационные сообщения отображаются в категории Maintenance: Fix soon 
или в категории Advisory: Informational. Распределение алармов жёстко запрограм-
мировано. 

• Алармы с приоритетом Ignor автоматически отфильтровываются преобразовате-
лем. 

2. Для подтверждения одиночного тревожного сообщения, поставьте метку в окошке Ack 
для этого тревожного сообщения. Для подтверждения всех тревожных сообщений одно-
временно, щёлкните кнопкой мыши по Ack All. 

Дополнительная информация 

• Для сброса следующих тревожных сообщений необходимо устранить причину аларма, 
подтвердить его и включить-выключить преобразователь: A001, A002, A010, A011, A012, 
A013, A018, A019, A022, A023, A024, A025, A028, A029, A031. 

• Для всех остальных тревожных сообщений (алармов): 

− Если аларм не активен, после подтверждения он удаляется из списка. 

− Если аларм активен, после подтверждения он удаляется из списка лишь при исчезно-
вении условий тревожного сообщения. 

 

9.4.4 Просмотр тревожных сообщений с помощью Полевого 
коммуникатора 

 

Вы можете просмотреть список, содержащий все активные и неактивные, но не подтверждён-
ные тревожные сообщения. 

• Для просмотра активных или неподтверждённых алармов, нажмите Service Tools > Alerts. 

Список содержит все активные и неподтверждённые тревожные сообщения. 

Примечание 

В список включаются тревожные сообщения с приоритетом Fault и Informational. Алар-
мы с приоритетом Ignor автоматически отфильтровываются преобразователем. 
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• Для обновления списка активных или неподтверждённых алармов, нажмите Service Tools > 
Alerts > Refresh Alerts.. 

 

9.4.5 Данные тревожных сообщений в памяти преобразователя 
 

Преобразователь поддерживает три набора данных для каждого выставленного тревожного 
сообщения. 

Для каждого произошедшего аларма в памяти преобразователя формируется три набора дан-
ных: 

• Alert List (Список тревожных сообщений) 

• Alert Statistics (Статистика тревожных сообщений) 

• Recent Alerts (Последние тревожные сообщения) 

 

Таблица 9-2:     Данные тревожных сообщений в памяти преобразователя 

Структура данных тре-
вожных сообщений 

Действие преобразователя 

Содержимое Сброс (очистка) 

Alert List (Список тревож-
ных сообщений) 

В соответствии с битом состояния аларма: 

• Все активные алармы на данный мо-
мент времени 

• Все ранее активные, но неподтвер-
ждённые алармы 

Очищается и генерируется при ка-
ждом включении-выключении пи-
тания 

Alert Statistics (Статистика 
тревожных сообщений) 

Одна запись для каждого аларма (по номеру 
аларма), произошедшему после последнего 
общего сброса. 

• Счётчик числа эпизодов возникновения 
аларма 

• Отметка времени для самых последних 
эпизодов возникновения аларма и 
сброса аларма  

Не сбрасывается; сохраняется и 
при выключенном питании 

Recent Alerts (Последние 
тревожные сообщения) 

50 самых последних эпизодов возникнове-
ния аларма или сброса аларма 

Не сбрасывается; сохраняется и 
при выключенном питании 

 

 

9.5 Просмотр значений сумматора и инвентаризатора 
 

Дисплей Для просмотра показаний сумматора или инвентаризатора на дисплее, они должны 
быть сконфигурированы в качестве переменной дисплея. 

ProLink II ProLink>Totalizer Control 

ProLink III Найдите желаемую переменную на главном экране под заголовком Process Variables 

Полевой Ком-
муникатор 

Service Tools>Variables>Totalizer Control 
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Обзор 

Сумматоры отслеживают суммарное количество массы или объёма, измеренное преобразова-
телем после последнего сброса сумматора. Инвентаризаторы отслеживают суммарное количе-
ство массы или объёма, измеренное преобразователем после последнего сброса инвентариза-
тора. 

Полезный совет 

Инвентаризаторы могут отслеживать общее суммарное количество массы или объёма при 
многократных сбросах сумматора. 

 

9.6 Запуск и останов сумматоров и 
инвентаризаторов 

 

Дисплей См. Раздел 9.6.1 

ProLink II ProLink>Totalizer Control>Start 

ProLink>Totalizer Control>Stop 

ProLink III Device Tools>Totalizer Control>Totalizer and Inventories>Start All Totals 

Device Tools>Totalizer Control>Totalizer and Inventories>Stop All Totals 

Полевой Ком-
муникатор 

Service Tools>Variables>Totalizer Control>All Totalizers>Start Totalizers 

Service Tools>Variables>Totalizer Control>All Totalizers>Stop Totalizers 

 

Обзор 

При запуске сумматора, он отслеживает текущие измерения. Обычно, значения сумматоров 
возрастают с расходом. При останове сумматора, он прекращает отслеживать текущие измере-
ния и его значение не изменяется с расходом. Инвентаризаторы запускаются и останавливают-
ся автоматически вместе с запуском и остановом сумматоров. 

Важно 

Сумматоры и инвентаризаторы запускаются и останавливаются как группа, одновременно. 
При запуске любого сумматора, одновременно все другие сумматоры и инвентаризаторы так-
же запускаются. При останове любого сумматора, одновременно все другие сумматоры и ин-
вентаризаторы также останавливаются. Вы не можете запустить или остановить инвентариза-
торы напрямую. 

 

9.6.1 Запуск и останов сумматоров и инвентаризаторов с 
помощью дисплея 

 

Предварительные требования 

Функция Start/Stop (Запуск/Останов) с дисплея должна быть активирована. 

Как минимум, один сумматор должен быть сконфигурирован как дисплейная переменная. 
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Процедура 

• Для запуска всех сумматоров и инвентаризаторов с помощью дисплея: 

1. Активируйте Scroll до тех пор, пока не появится TOTAL в нижнем левом углу дисплея. 

Важно 

Так как все сумматоры запускаются и останавливаются одновременно, неважно какой 
сумматор используется Вами. 

2. Select. 

3. Scroll, пока не появится START под текущим значением сумматора. 

4. Select. 

5. Select ещё раз для подтверждения. 

6. Scroll до EXIT (выход). 

• Для останова всех сумматоров и инвентаризаторов с помощью дисплея: 

1. Активируйте Scroll до тех пор, пока не появится TOTAL в нижнем левом углу дисплея. 

Важно 

Так как все сумматоры запускаются и останавливаются одновременно, неважно какой 
сумматор используется Вами. 

2. Select. 

3. Scroll, пока не появится STOP под текущим значением сумматора. 

4. Select. 

5. Select ещё раз для подтверждения. 

6. Scroll до EXIT (выход). 
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9.7 Сброс сумматоров 
 

Дисплей См. Раздел 9.7.1 

ProLink II ProLink>Totalizer Control>Reset Mass Total 

ProLink>Totalizer Control>Reset Volume Total 

ProLink>Totalizer Control>Reset Gas Volume Total 

ProLink>Totalizer Control>Reset 

ProLink III Device Tools>Totalizer Control>Totalizer and Inventories>Reset Mass Total 

Device Tools>Totalizer Control>Totalizer and Inventories>Reset Volume Total 

Device Tools>Totalizer Control>Totalizer and Inventories>Reset Gas Total 

Device Tools>Totalizer Control>Totalizer and Inventories>Reset All Totals 

Полевой Ком-
муникатор 

Service Tools>Variables>Totalizer Control>Mass>Mass Total 

Service Tools>Variables>Totalizer Control>Gas Standard Volume>Volume Total 

Service Tools>Variables>Totalizer Control>Gas Standard Volume>GSV Total 

Service Tools>Variables>Totalizer Control>All Totalizers>Reset Totals 

 

Обзор 

При сбросе сумматора, преобразователь устанавливает его значение в 0. При этом не имеет 
значения, запущен или остановлен сумматор. При запущенном сумматоре, он продолжает от-
слеживать измерения. 

Полезный совет 

При сбросе одного сумматора, значения других сумматоров не сбрасываются. Значения инвен-
таризаторов не сбрасываются. 

 

9.7.1 Запуск и останов сумматоров с помощью дисплея 
 

Предварительные требования 

Функция Totalizer Reset (Сброс сумматора) с помощью дисплея должна быть активирована.  

Сумматор, который Вы хотите сбросить, должен быть сконфигурирован как дисплейная пере-
менная. Например: 

• Если Вы хотите сбросить значение массового сумматора, переменная Mass Total должна 
быть сконфигурирована как дисплейная переменная. 

• Если Вы хотите сбросить значение объёмного сумматора, переменная Volume Total долж-
на быть сконфигурирована как дисплейная переменная. 
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Процедура 

• Для сброса массового сумматора: 

1. Активируйте Scroll до появления значения массового сумматора. 

2. Select. 

3. Scroll, пока не появится RESET (сброс) под текущим значением сумматора. 

4. Select. 

5. Select ещё раз для подтверждения. 

6. Scroll до EXIT (выход). 

7. Select. 

• Для сброса массового сумматора: 

1. Активируйте Scroll до появления значения объёмного сумматора. 

2. Select. 

3. Scroll, пока не появится RESET (сброс) под текущим значением сумматора. 

4. Select. 

5. Select ещё раз для подтверждения. 

6. Scroll до EXIT (выход). 

7. Select. 

• Для сброса сумматора стандартного объёма газа: 

1. Активируйте Scroll до появления значения сумматора стандартного объёма газа. 

2. Select. 

3. Scroll, пока не появится RESET (сброс) под текущим значением сумматора. 

4. Select. 

5. Select ещё раз для подтверждения. 

6. Scroll до EXIT (выход). 

7. Select. 

 

 

9.8 Сброс инвентаризаторов 
 

ProLink II ProLink>Totalizer Control>Reset Inventories 

ProLink>Totalizer Control>Reset Mass Inventory 

ProLink>Totalizer Control>Reset Volume Inventory 

ProLink>Totalizer Control>Reset Gas Volume Inventory 

ProLink III Device Tools>Totalizer Control>Totalizer and Inventories>Reset Mass Inventory 

Device Tools>Totalizer Control>Totalizer and Inventories>Reset Volume Inventory 

Device Tools>Totalizer Control>Totalizer and Inventories>Reset Gas Inventory 

Device Tools>Totalizer Control>Totalizer and Inventories>Reset All Inventories 
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Обзор 

При сбросе инвентаризатора, преобразователь устанавливает его значение в 0. При этом не 
имеет значения, запущен или остановлен инвентаризатор. При запущенном инвентаризаторе, 
он продолжает отслеживать измерения. 

Полезный совет 

При сбросе одного инвентаризатора, значения других инвентаризаторов не сбрасываются. 
Значения сумматоров не сбрасываются. 

 

Предварительные требования 

Для использования ProLink II или ProLink III для сброса инвентаризаторов, эта функция долж-
на быть разрешена (активирована). 

• Для разрешения сброса инвентаризаторов в ProLink II: 

1. Щёлкните кнопкой мыши по View > Preferences. 

2. Поставьте метку в окошке Enable Inventory Totals Reset. 

3. Щёлкните кнопкой мыши по Apply. 

• Для разрешения сброса инвентаризаторов в ProLink III: 

1. Выберите Tools > Options. 

2. Выберите Reset Inventories from ProLink III. 

 

 

 

 

 

 

 

 

 



Эксплуатация преобразователя с приложением коммерческого учета 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

162 

 
 
 
 
 
 
 
 
 
 
 



Эксплукатация преобразователя с приложением коммерческого учета 

Руководство по конфигурированию и применению 

 

163 

10 Эксплуатация преобразователя с  
приложением коммерческого учета 

 

Темы данной главы 
• Эксплуатация преобразователя, с установленным приложением коммерческого учета 

• Переключение режимов secured mode (режим защиты) и unsecured mode 

• Удаление тревожного сообщения состояния A027: Security Breach (нарушение защиты) 

• Замена базового процессора в установке приложения коммерческого учета 

 

Информация из этой главы применима только, если Ваш преобразователь был заказан с при-
ложением коммерческого учета. 

 

10.1 Эксплуатация преобразователя, с 
установленным приложением коммерческого 
учета 

При установленном приложении коммерческого учёта многие базовые функции преобразова-
теля видоизменяются. 

• При подключении: 

− В условиях отсутствия механической (физической) защиты, возможно использование 
любого из поддерживаемых типов подключения. 

− В условиях наличия механической (физической) защиты, Вы не можете воспользо-
ваться подключением через порт обслуживания (service port). 

• При получении данных процесса: 

− Для сертифицированных измерений Вы должны пользоваться сертифицированными 
методами. 

− Если измерения не должны сертифицироваться, Вы можете воспользоваться любыми 
доступными методами. 

 

Важно 

Функционирование выходов преобразователя и переменных процесса изменяется при 
коммерческом учёте. Убедитесь в том, что Вы понимаете влияние приложения на функ-
ционирование выходов преобразователя и переменных процесса. 

• Для сброса сумматоров: 

− Если преобразователь находится в небезопасном режиме, Вы можете сбрасывать зна-
чения сумматоров. При сбросе одного сумматора, все другие сумматоры сбрасывают-
ся автоматически. 

− Если преобразователь находится в безопасном режиме, Вы можете или не можете 
сбрасывать значения сумматоров, в зависимости от конфигурации. Если сброс сумма-
тора разрешён, Вы не сможете сбросить значение сумматора до тех пор, пока значение 
расхода не станет равным нулю. Для сброса сумматора с помощью дисплея, Вам, воз-
можно, придётся ввести пароль меню алармов (alarm menu), в зависимости от того, 
разрешёно или заблокировано его использование. Значение по умолчанию Alarm Menu 
Password 1234. 
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• Если преобразователь находится в безопасном режиме, Вы не можете остановить сумма-
торы. 

• Если преобразователь находится в безопасном режиме, Вы не можете сбросить значения 
инвентаризаторов. 

 

10.1.1 Одобренные методы просмотра и получения 
технологических данных 

 

При установленном приложении коммерческого учёта, данные процесса сертифицированы для 
коммерческого учёта только при использовании сертифицированного метода получения дан-
ных. 

Примечание 

Коммуникация HART/Bell 202 на первом мА выходе может использоваться для опроса давле-
ния и температуры в сочетании с отображением данных процесса. 

 

Таблица 10-1:     Сертификация NTEP методов получения и чтения данных процесса 

Данные процесса мА выход Modbus/RS-485 или 
HART/RS-485 

Дисплей преобра-
зователя 

Масса  ✓ ✓ 

Объем  ✓ ✓ 

Плотность ✓ ✓ ✓ 

Показания сумматора  ✓ ✓ 

Показания инвентаризатора  ✓ ✓ 

 

Таблица 10-2:     Сертификация OIML методов получения и чтения данных процесса 

Данные процесса мА выход Modbus/RS-485 или 
HART/RS-485 

Дисплей преобра-
зователя 

Масса  ✓ ✓ 

Объем  ✓ ✓ 

Плотность ✓ ✓ ✓ 

Показания сумматора  ✓ ✓(1) 

Показания инвентаризатора  ✓ ✓ 

 

 

10.1.2 Большие значения сумматора на дисплее (только 
приложения OIML) 

 

Если параметр Approval установлен в значение OIML, и значение сумматора становится доста-
точно большим, дисплей представляет большие значения особым образом. Значение на дис-
плее может не отражать действительного значения. 

(1)      Дисплей представляет большие значения сумматора особым образом. 
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Дисплей способен выводить максимум 8 (восемь) знаков, включая десятичную точку. Для всех 
значений сумматоров, сконфигурированных как дисплейная переменная, положение десятич-
ной точки на дисплее фиксировано на разрядность дисплейной переменной. 

При достижении сумматором наибольшего значения, которое может быть отражено в данных 
обстоятельствах: 

• Все цифры 9 меняются на 0.  

• Десятичная точка не меняет положения. 

• Число цифр на дисплее не увеличивается. 

• Внутренний сумматор сбрасывается в ноль. 

Например, значение 99999.999 меняется на 00000.000. 

 

Полезный совет 

Если Вы не уверены в том, что выбранная разрядность сумматора окажется достаточной, для 
чтения текущих данных воспользуйтесь другим методом. 

 

Примечания 

• Значения массового и объёмного сумматоров необязательно превысят разрядность одно-
временно. 

• Данная функция не относится к инвентаризаторам. Большие значения инвентаризаторов 
представляются на дисплее обычным образом. 

 

10.1.3 Влияние приложения коммерческого учёта на измерения и 
значения выходов 

 

При установленном приложении коммерческого учёта, измерения и представление данных 
изменяются для предотвращения несанкционированного их использования. Соответствующие 
изменения определяются режимом преобразователя (secured или unsecured). 

 

Таблица 10-3:     Выходы преобразователя и данные процесса при Approval=NTEP 

Функция Режим преобразователя 

Unsecured (небезопасный) Secured (безопасный) 

Выходы мА выход При отображении переменной расхо-
да – нулевой расход. В противном 
случае – нормальный. 

Нормально 

Частотный выход Неактивный (импульсы не вырабаты-
ваются), даже в условиях ошибки. 

Нормально 

Дискретный выход Нормальный Нормально 

Переменные 
процесса 

Все расходы Отображаются нулевыми Отображается нормально 

Плотность Отображается нормально Отображается нормально 

Температура Отображается нормально Отображается нормально 

Сумматоры Значения Не увеличиваются и не уменьшаются Увеличиваются нормально 

Инвентаризаторы Значения Не увеличиваются и не уменьшаются Увеличиваются нормально 
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Таблица 10-4:     Выходы преобразователя и данные процесса при Approval=OIML 

Функция Режим преобразователя 

Unsecured (небезопасный) Secured (безопасный) 

Выходы мА выход Осуществляет сконфигурированное дейст-
вие при ошибке 

Нормально 

Частотный 
выход 

Осуществляет сконфигурированное дейст-
вие при ошибке 

Нормально 

Дискретный 
выход 

Осуществляет сконфигурированное дейст-
вие при ошибке 

Нормально 

Переменные про-
цесса 

Все расходы Отображается нормально Отображается нормально 

Плотность Отображается нормально Отображается нормально 

Температура Отображается нормально Отображается нормально 

Сумматоры Значения Не увеличиваются и не уменьшаются Увеличиваются нормально 

Инвентаризаторы Значения Не увеличиваются и не уменьшаются Увеличиваются нормально 

 

10.1.4 Влияние приложения коммерческого учёта на работу и 
обслуживание 

При установленном приложении коммерческого учёта, некоторые рабочие функции и функции 
обслуживания могут быть запрещены. Вы можете переключиться в небезопасный режим (un-
secured mode), провести необходимые действия и затем переключиться в безопасный режим 
(secured mode). 

 

Таблица 10-5:     Допустимые действия при  Approvals = NTEP 

Функция Режим преобразователя 

Unsecured (не-
безопасный) 

Secured (безопасный) 

Подключение ProLink II, ProLink III, 
Полевого коммуникатора или хоста. 

Все поддержи-
ваемые типы 
подключений 
доступны. 

Механическая (физическая) защита препятству-
ет доступу к клеммам пора обслуживания. Под-
ключения Modbus/RS-485, HART/RS-485 и 
HART/Bell 202 могут использоваться для чтения 
данных из преобразователя, но программная 
защита препятствует записи в преобразователь. 

Конфигурирование Чтение Разрешено Разрешено 

Изменение Разрешено Не разрешено 

Калибровка Нуля Разрешено Не разрешено 

Плотности Разрешено Не разрешено 

Температуры Разрешено Не разрешено 

Контроль метроло-
гических характе-
ристик (Smart Me-
ter  
Verification) 

Выходы устанав-
ливаются на про-
должение измере-
ний 

Разрешено Разрешено 

Выходы устанав-
ливаются на 
Ошибку 

Разрешено Разрешено 
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Таблица 10-5:     Допустимые действия при  Approvals = NTEP (продолжение) 

Функция Режим преобразователя 

Unsecured (небезо-
пасный) 

Secured (безопасный) 

 Выходы устанавливаются 
на последнее действитель-
ное значение 

Разрешено Не разрешено 

Данные о внеш-
них давлении и 
температуре 

Получаются с помощью 
опроса 

Разрешено Разрешено 

Записываются по Modbus 
или HART хоста 

Разрешено Не разрешено 

Тестирование и 
подстройка вы-
ходов 

Тест конура мА выхода Разрешено Не разрешено 

Подстройка мА выхода Разрешено Не разрешено 

Тест контура частотного 
выхода 

Не разрешено Не разрешено 

Тест контура дискретного 
выхода 

Разрешено Не разрешено 

Сумматоры Сброс  Разрешено. При 
сбросе любого сум-
матора, все другие 
сумматоры сбрасы-
ваются автоматиче-
ски. 

Может быть разрешено или запреще-
но, в зависимости от конфигурации. 
Может осуществляться лишь при ну-
левом расходе. При сбросе любого 
сумматора, все другие сумматоры 
сбрасываются автоматически. 

Запуск Не разрешено Не применимо 

Останов Не применимо Не разрешено 

Инвентаризаторы Сброс Не разрешено Не разрешено 

Имитация сенсора Разрешено Не разрешено 

 

Таблица 10-6:     Допустимые действия при  Approvals = OIML 

Функция Режим преобразователя 

Unsecured (не-
безопасный) 

Secured (безопасный) 

Подключение ProLink II, ProLink III, 
Полевого коммуникатора или хоста. 

Все поддержи-
ваемые типы 
подключений 
доступны. 

Механическая (физическая) защита препятству-
ет доступу к клеммам пора обслуживания. Под-
ключения Modbus/RS-485, HART/RS-485 и 
HART/Bell 202 могут использоваться для чтек-
ния данных из преобразователя, но программная 
защита препятствует записи в преобразователь. 

Конфигурирование Чтение Разрешено Разрешено 

Изменение Разрешено Не разрешено 

Калибровка Нуля Разрешено Не разрешено 

Плотности Разрешено Не разрешено 

Температуры Разрешено Не разрешено 
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Таблица 10-6:     Допустимые действия при  Approvals = OIML (продолжение) 

Функция Режим преобразователя 

Unsecured (небезо-
пасный) 

Secured (безопасный) 

Контроль метро-
логических ха-
рактеристик 
(Smart Meter  
Verification) 

Выходы устанавливаются 
на продолжение измерений 

Разрешено Разрешено 

Выходы устанавливаются 
на Ошибку 

Разрешено Разрешено 

Выходы устанавливаются 
на последнее действитель-
ное значение 

Разрешено Не разрешено 

Данные о внеш-
них давлении и 
температуре 

Получаются с помощью 
опроса 

Разрешено Разрешено 

Записываются по Modbus 
или HART хоста 

Разрешено Не разрешено 

Выходы Тест конура мА выхода Разрешено Не разрешено 

Подстройка мА выхода Разрешено Не разрешено 

Тест контура частотного 
выхода 

Разрешено Не разрешено 

Тест контура дискретного 
выхода 

Разрешено Не разрешено 

Переменные 
процесса 

Все расходы Отображается нор-
мально 

Отображается нормально 

Плотность Отображается нор-
мально 

Отображается нормально 

Температура Отображается нор-
мально 

Отображается нормально 

Сумматоры Сброс  Разрешено. При 
сбросе любого сум-
матора, все другие 
сумматоры сбрасы-
ваются автоматиче-
ски. 

Может быть разрешено или запреще-
но, в зависимости от конфигурации. 
Может осуществляться лишь при ну-
левом расходе. При сбросе любого 
сумматора, все другие сумматоры 
сбрасываются автоматически. 

Запуск Не разрешено Не применимо 

Останов Не применимо Не разрешено 

Инвентаризаторы Сброс Разрешено Не разрешено 

Имитация сенсора Разрешено Не разрешено 

 

10.2 Переключение режимов secured mode (режим 
защиты) и unsecured mode (небезопасный режим) 

Для изменения конфигурации преобразователя или осуществления административных задач, 
Вам придется переключиться в небезопасный режим (unsecured mode). Для соответствия тре-
бованиям коммерческого учёта, процесса измерений, Вам придется переключиться в безопас-
ный режим (secured mode). 
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Для переключения режимов Вы можете воспользоваться одним из следующих средств: 

• ProLink II 

• ProLink III  

• Утилита переключения режимов коммерческого учета. Эта утилита бесплатна и доступна 
на вебсайте Micro Motion: www.micromotion.com/softwaredownloads 

Никаким другим способом переключить режимы нельзя. 

10.2.1 Переключение режимов secured mode (режим защиты) и 
unsecured mode с помощью ProLink II 

Предварительные требования 

Перед переключением в небезопасный режим, убедитесь, что Вы сможете вновь переключить-
ся в режим защиты. Так как переключение в небезопасный режим требует нарушения пломбы, 
переключение вновь в режим защиты может потребовать присутствия сертифицированного 
представителя метрологического надзора и установки новой пломбы. 

Убедитесь в готовности подключения порта обслуживания. Вам может понадобиться наруше-
ние пломбы и удаление фиксирующего зажима. 

Процедура 

• Для переключения из режима защиты в небезопасный режим: 

1. Подключитесь к порту обслуживания Вашего преобразователя.  

2. Выберите Plug-ins > Enable/Disable Custody Tranfer  

3. Щелкните кнопкой мышь по Disable Custody Tranfer. 

• Для переключения из небезопасного режима в режим защиты: 

1. Подключитесь к порту обслуживания Вашего преобразователя. 

2. Выберите Plug-ins > Enable/Disable Custody Tranfer  

3. Щелкните кнопкой мышь по Enable Custody Tranfer. 

10.2.2 Переключение режимов secured mode (режим защиты) и 
unsecured mode с помощью ProLink III 

Предварительные требования 

Перед переключением в небезопасный режим, убедитесь, что Вы сможете вновь переключить-
ся в режим защиты. Так как переключение в небезопасный режим требует нарушения пломбы, 
переключение вновь в режим защиты может потребовать присутствия сертифицированного 
представителя метрологического надзора и установки новой пломбы. 

Убедитесь в готовности подключения порта обслуживания. Вам может понадобиться наруше-
ние пломбы и удаление фиксирующего зажима. 

Процедура 

• Для переключения из режима защиты в небезопасный режим:  

1. Подключитесь к порту обслуживания Вашего преобразователя.   

2. Выберите Device Tools > Configuration > Weights & Measures. 

3. Установите параметр Software Security в значение Disabled  

• Для переключения из небезопасного режима в режим защиты: 

1. Подключитесь к порту обслуживания Вашего преобразователя.   

2. Выберите Device Tools > Configuration > Weights & Measures.  

3. Установите параметр Software Security в значение Enabled 
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10.2.3 Переключение режимов secured mode (режим защиты) и 
unsecured mode с помощью утилиты переключения режимов 

 

Предварительные требования 

Утилита переключения режимов должна быть установлена на Вашем ПК. Эта утилита доступ-
на на вебсайте Micro Motion: www.micromotion.com/softwaredownloads 

Перед переключением в небезопасный режим, убедитесь, что Вы сможете вновь переключить-
ся в режим защиты. Так как переключение в небезопасный режим требует нарушения пломбы, 
переключение вновь в режим защиты может потребовать присутствия сертифицированного 
представителя метрологического надзора и установки новой пломбы. 

Убедитесь в готовности подключения порта обслуживания. Вам может понадобиться наруше-
ние пломбы и удаление фиксирующего зажима. 

 

Процедура 

• Для переключения из режима защиты в небезопасный режим:   

1. Запустите утилиту переключения режимов.  

2. Выберите COM порт, используемый для подключения. 

3. Щелкните кнопкой мышь по Disable Custody Tranfer.  

• Для переключения из небезопасного режима в режим защиты: 

1. Запустите утилиту переключения режимов.  

2. Выберите COM порт, используемый для подключения.  

3. Щелкните кнопкой мышь по Enable Custody Tranfer.   

 

10.3 Сброс тревожного сообщения состояния A027: 
Security Breach (нарушение защиты) 

Тревожное сообщение состояния A027: Security Breach (нарушение защиты) выставляется, 
если преобразователь переключился в небезопасный режим, или преобразователь обнаружил 
изменение ID базового процессора. 

1. Если преобразователь находится в режиме защиты, переключите его в небезопасный ре-
жим.  

2. Осуществите все необходимые действия, связанные с нарушением защиты.  

3. Переключитесь в режим защиты. 
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10.4 Замена базового процессора в установках 
коммерческого учета 

 

В установках коммерческого учёта замена базового процессора требует перепломбировки пре-
образователя.  

Когда преобразователь впервые переключается в режим защиты, уникальный ID базового про-
цессора регистрируется в преобразователе. При замене базового процессора другим, преобра-
зователь выставит тревожное сообщение состояния A026: Sensor/Xmtr Communication Error. 
Для сброса этого тревожного сообщения Вам понадобится переключить преобразователь в 
небезопасный режим и вновь в режим защиты. Все это потребует нарушения механической 
защиты и установки новой пломбы по завершению всего процесса. 

Могут понадобиться и другие процедуры. Обратитесь к документации коммерческого учёта 
для Вашей установки. 

 

Важно 

В большинстве случаев механическая пломба устанавливается в присутствии сертифициро-
ванного представителя метрологического надзора.  
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11 Обеспечение качества измерений 
 

Темы данной главы 
• Процедуры определения качества измерений 

• Контроль метрологических характеристик расходомера 

• Установка нуля расходомера 

• Подтверждение характеристик расходомера (поверка) 

• Проведение (стандартной) калибровки плотности D1(низкая плотность) D2(высокая 
плотность) 

• Проведение калибровки плотности D3 и D4 (только для сенсоров Т-серии) 

• Проведение калибровки температуры 

 

11.1 Процедуры обеспечения качества измерений 
 

Micro Motion предоставляет различные методы обеспечения качества измерений с тем, чтобы 
оценить и поддерживать точность измерений расходомера. 

Доступны следующие методы: 

• Контроль метрологических характеристик (Smart Meter Verification) оценивает структур-
ную целостность трубок сенсора, сравнивая текущее значение жесткости трубок с жест-
костью, измеренной на заводе. Жесткость определяется как нагрузка на единицу прогиба, 
или как сила, деленная на смещение. Поскольку изменение структурной целостности из-
меняет реакцию сенсора на массу и плотность, это значение может использоваться как 
индикатор качества измерений. 

• При проведении процедуры подтверждения характеристик расходомера (поверки) срав-
ниваются результаты измерений расходомера, отображаемые преобразователем, с внеш-
ним измерительным стандартом. При поверке требуется одна точка данных. 

• При калибровке устанавливается связь между переменной процесса и сигналом сенсора.  

 

Полезные советы 

• Регулярно проводите контроль метрологических характеристик для получения наилучших 
результатов при работе прибора.  

• Для подтверждения характеристик расходомера по стандарту, или для коррекции ошибки 
измерения используйте процедуру поверки и т.н. М-факторы (meter factors).  

• Перед проведением Полевой калибровки свяжитесь с Micro Motion для поиска альтерна-
тивы. Во многих случаях калибровка в полевых условиях оказывает негативный эффект 
на точность измерений. 

 

11.2 Контроль метрологических характеристик 
расходомера 

Вы можете запускать процедуру контроля метрологических характеристик, просматривать и 
оценивать результаты тестирования, а также конфигурировать автоматическое выполнение 
процедуры.  
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11.2.1 Требования для процедуры контроля метрологических 
характеристик расходомера 

 

Для использования процедуры контроля метрологических характеристик, преобразователь 
должен работать в паре с усовершенствованным базовым процессором и опция контроля мет-
рологических характеристик должна быть заказана для преобразователя. 

В Таблице 11-1 представлена информация о минимальных версиях преобразователя, базового 
процессора и средств коммуникации, необходимых для поддержки процедуры контроля мет-
рологических характеристик. (Если Вы намерены проводить процедуру контроля метрологи-
ческих характеристик с помощью дисплея, только версии преобразователя и усовершенство-
ванного базового процессора имеют значение.) 

 

Таблица 11-1:     Минимальные версии для поддержки контроля метрологических харак-
теристик 

Пункт Минимальная версия 

Преобразователь 6.0 

Усовершенствованный базовый процессор 3.6 

ProLink II 2.9 

ProLink III 1.0 

Полевой Коммуникатор HART DD: dev rev 6, DD rev 2 

 

Если Ваши приборы или средства коммуникации не соответствуют требованиям о минималь-
ных версиях для контроля метрологических характеристик (Smart Meter Verification), у Вас все 
же есть возможность доступа к старой версии процедуры, если она была заказана для Вашего 
преобразователя. В Таблице 11-2 представлено описание основных различий между старой 
версией (Meter Verification) и новой (Smart Meter Verification). 

Таблица 11-2:     Основные различия между старой (Meter Verification) и новой (Smart 
Meter Verification) версиями функции контроля метрологических характеристик 

Функция Meter Verification (старая) Smart Meter Verification (новая) 

Прерывание измерений Прерывание измерений на время 
прохождения теста (3 минуты) 

Нет необходимости в прерыва-
нии 

Хранение результатов Результаты в преобразователе не 
сохраняются 

В преобразователе хранятся 20 
последних результатов 

Отчет о результатах Успешное завершение / ошибка / 
прерывание 

Успешное завершение / ошибка / 
прерывание, код прерывания, 
сравнительные таблицы и диа-
граммы, сохраняемых результа-
тов тестирования (1) 

Методы запуска теста Только вручную Вручную, по расписанию, на 
основе событий 

 

11.2.2 Подготовка к тесту контроля метрологических характеристик  
Несмотря на то, что нет необходимости совпадения с заводскими условиями или в изменении 
конфигурации преобразователя во время теста контроля метрологических характеристик, тест 
пройдет более плавно при стабильных условиях. 

(1) Детальный анализ результатов тестирования, например сравнительные диаграммы недоступен с локального дисплея. 
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Контроль метрологических характеристик (Smart Meter Verification) имеет режим состояния 
выходов, называемый Continuous Measurement (непрерывные измерения), позволяющий преоб-
разователю продолжать измерения во время прохождения теста. Если же Вы запустите тест в 
режимах Last Measured Value (последнее измеренное действительное значение) или Fault (ошиб-
ка), на выходах преобразователя будут поддерживаться постоянные значения в течение двух 
минут тестирования. Если контуры регулирования зависят от выходов преобразователя, обес-
печьте соответствующие действия. 

Избегайте нестабильности процесса во время тестирования. Если условия слишком нестабиль-
ны, процедура контроля метрологических характеристик будет прервана. Для повышения ста-
бильности процесса: 

• Поддерживайте постоянными давление и температуру жидкости.  

• Избегайте изменений в составе жидкости, например, двухфазного потока, посторонних 
включений.  

• Поддерживайте постоянной величину расхода. 

 

Полезные советы 

• Процедура контроля метрологических характеристик проходит лучше, при отсутствии 
расхода через сенсор.  

• На процедуру контроля метрологических характеристик не влияют конфигурационные 
параметры преобразователя для расхода, плотности и температуры.   

 

11.2.3 Запуск теста контроля метрологических характеристик  
 

Запуск теста метрологических характеристик расходомера с помо-
щью дисплея 
1. Воспользуйтесь меню контроля метрологических характеристик.  

 

Рисунок 11-1:     Контроль метрологических характеристик – меню верхнего уровня 

 
 

2. Выберите Run Verify.  

3. Выберите Outputs и выберите желаемый режим для выходов.  

 

 

  

Активируйте одновременно 
Scroll и Select на 4 секунды 
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Вариант Описание 

Continue Measr (непрерыв-
ные измерения) 

Во время тестирования все выходы продолжают отобра-
жать значения назначенных переменных процесса. Тести-
рование длится приблизительно 90 секунд. 

Last Value (последнее из-
меренное действительное 
значение) 

Во время тестирования все выходы отображают последние 
действительные измеренные значения назначенных пере-
менных процесса. Тестирование длится приблизитель-
но140 секунд. 

Fault (ошибка) Во время тестирования на всех выходах сформируются 
значения, сконфигурированные как значения при ошибке. 
Тестирование длится приблизительно 140 секунд. 

 

 

При прохождении теста, по дисплею перемещаются точки, и выводится информация об 
активности теста.  

Дополнительная информация 

Просмотрите результаты тестирования и осуществите необходимые действия. 
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Блок-схема меню Smart Meter Verification: запуск теста с помощью дис-
плея 

 

Рисунок 11-2:     Запуск контроля метрологических характеристик с помощью дисплея 

 
 

Запуск контроля метрологических характеристик расходомера с 
помощью ProLink II 
1. Выберите Tools > Meter Verification > Run Meter Verification. 

 

  



Обеспечение качества измерений 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

178 

Возможно, Вам придется подождать несколько секунд, пока  ProLink II синхронизирует 
свою базу данных с данными преобразователя. 

2. Просмотрите информацию на экране и щелкните кнопкой мыши по Next.  

3. Введите желаемую информацию на экране  Test Definition Screen, затем щелкните кнопкой 
мыши по Next.    

Вся информация на этом экране необязательна. 

4. Выберите желаемый режим работы выходов.  

Вариант Описание 

Outputs Continue Measuring 
(непрерывные измерения) 

Во время тестирования все выходы продолжают отобра-
жать значения назначенных переменных процесса. Тести-
рование длится приблизительно 90 секунд. 

Outputs Held at Last Value 
(последнее измеренное 
действительное значение) 

Во время тестирования все выходы отображают последние 
действительные измеренные значения назначенных пере-
менных процесса. Тестирование длится приблизитель-
но140 секунд. 

Outputs Held at Fault (ошиб-
ка) 

Во время тестирования на всех выходах сформируются 
значения, сконфигурированные как значения при ошибке. 
Тестирование длится приблизительно 140 секунд. 

 

5. Нажмите Start Meter Verification. 

Выводится информация о прохождении теста. 

Дополнительная информация 

Просмотрите результаты тестирования и осуществите необходимые действия. 

Запуск теста контроля метрологических характеристик расходомера 
с помощью ProLink III 
1. Выберите Device Tools > Diagnostics > Meter Verification > Run Test.  

Возможно, Вам придется подождать несколько секунд, пока  ProLink II синхронизирует 
свою базу данных с данными преобразователя. 

2. Введите желаемую информацию на экране  Test Definition Screen, затем щелкните кнопкой 
мыши по Next.    

Вся информация на этом экране необязательна. 

3. Выберите желаемый режим работы выходов.   

Вариант Описание 

Continue Measuring (не-
прерывные измерения) 

Во время тестирования все выходы продолжают отображать 
значения назначенных переменных процесса. Тестирование 
длится приблизительно 90 секунд. 

Held at Last Value (по-
следнее измеренное 
действительное значе-
ние) 

Во время тестирования все выходы отображают последние 
действительные измеренные значения назначенных перемен-
ных процесса. Тестирование длится приблизительно140 се-
кунд. 

Held at Fault (ошибка) Во время тестирования на всех выходах сформируются значе-
ния, сконфигурированные как значения при ошибке. Тестиро-
вание длится приблизительно 140 секунд. 

4. Нажмите Start. 

Выводится информация о прохождении теста. 
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Дополнительная информация 

Просмотрите результаты тестирования и осуществите необходимые действия. 

Запуск теста контроля метрологических характеристик расходомера 
с помощью Полевого коммуникатора 
1. Воспользуйтесь меню контроля метрологических характеристик.  

• Overview > Shortcuts > Meter Verification  

• Service Tools > Maintenance > Routine Mainenance > Meter Verification  

2. Выберите Manual Verification.  

3. Выберите Start.  

4. Выберите желаемый  режим работы выходов и нажмите OK, после появления подсказки. 

Вариант Описание 

Continue Measuring (не-
прерывные измерения) 

Во время тестирования все выходы продолжают отображать 
значения назначенных переменных процесса. Тестирование 
длится приблизительно 90 секунд. 

Outputs Held at Last Value 
(последнее измеренное 
действительное значе-
ние) 

Во время тестирования все выходы отображают последние 
действительные измеренные значения назначенных перемен-
ных процесса. Тестирование длится приблизительно140 се-
кунд. 

Outputs Held at Fault 
(ошибка) 

Во время тестирования на всех выходах сформируются значе-
ния, сконфигурированные как значения при ошибке. Тестиро-
вание длится приблизительно 140 секунд. 

 

Выводится информация о прохождении теста. 

Дополнительная информация 

Просмотрите результаты тестирования и осуществите необходимые действия.  

 

11.2.4 Просмотр результатов тестирования 
 

Вы можете просмотреть результаты текущего тестирования. Кроме того, вы можете просмот-
реть результаты предыдущих тестов. 

В преобразователе сохраняется следующая информация о последних двадцати тестах контроля 
метрологических характеристик. 

• Длительность состояния включения во время тестирования. 

• Результаты тестирования (Pass, Fail, Abort). 

• Жёсткость левой и правой катушек, в процентах отклонения от заводского значения. При 
прерывании теста, для этих величин сохраняется 0. 

• Код прерывания, если применимо. 

В дополнение, ProLink II и ProLink III предоставляют детальный отчёт и анализ теста. Эта ин-
формация сохраняется на ПК, на котором установлены ProLink II или ProLink III. Она включа-
ет: 

• Отметку времени от часов ПК 
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• Текущие идентификационные данные расходомера 

• Текущие параметры конфигурации расхода и плотности 

• Текущие значения нуля 

• Текущие значения массового расхода, объёмного расхода, плотности, температуры и 
внешнего давления 

• Описания теста и заказчика (если данные введены пользователем). 

  

 

Просмотр результатов теста с помощью дисплея 
1. Если Вы только что запустили тест, результаты выводятся на дисплей автоматически по-

сле завершения тестирования. 

2. Если Вы желаете просмотреть результаты предыдущих тестов: 

 

a. Воспользуйтесь меню контроля метрологических характеристик (Smart Meter Verifica-
tion). 

Рисунок 11-3:     Контроль метрологических характеристик – меню верхнего уровня 

 
 

b. Активируйте Scroll до Results Read и нажмите Select. 

Порядковый номер самого последнего теста выводится на дисплей. 

c. Для просмотра данных этого теста нажмите Select, затем нажимайте Scroll для прокрут-
ки данных тестирования.  

d. Для выбора другого теста нажмите Scroll, затем нажмите Select, когда на дисплее пре-
образователя появится Results More?. При появлении желаемого теста, определяемого 
порядковым номером, нажмите Select.  

 

  

Активируйте одновременно 
Scroll и Select на 4 секунды 
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Блок-схема меню Smart Meter Verification: просмотр результатов тести-
рования с помощью дисплея 

 

Рисунок 11-4:     Просмотр результатов тестирования контроля метрологических характеристик с помо-
щью дисплея 
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Просмотр результатов тестирования с помощью ProLink II 
1. Выберите Tools > Meter Verification > Run Meter Verification и щёлкните кнопкой мыши по View 

Previous Test Results and Print Report. 

На диаграмме представлены результаты тестирования для всех тестов, хранящихся в базе 
данных ProLink II. 

2. (Необязательно) Щёлкните кнопкой мыши по Next для просмотра и печати тестового отче-
та. 

3. (Необязательно) Щёлкните кнопкой мыши по Export Data to CSV File для сохранения данных 
в файле на Вашем ПК. 

Просмотр результатов тестирования с помощью ProLink III 
1. Выберите Device Tools > Diagnostics > Meter Verification > и щёлкните кнопкой мыши по View 

Previous Test Results. 

На диаграмме представлены результаты тестирования для всех тестов, хранящихся в базе 
данных ProLink III. 

2. (Необязательно) Щёлкните кнопкой мыши по Next для просмотра и печати тестового отче-
та.  

3. (Необязательно) Щёлкните кнопкой мыши по Export Data to CSV File для сохранения данных 
в файле на Вашем ПК  

Просмотр результатов тестирования с помощью Полевого Комму-
никатора 
1. Воспользуйтесь меню Smart Meter Verification  

• Ocerview > Shortcuts > Meter Verification  

• Service Tools > Maintenance > Routine Maintenance > Meter Verification  

2. (Необязательно) Если База данных Полевого Коммуникатора необновлена, выберите Up-
load Results Data from Device.  

3. Для просмотра данных самого последнего теста выберите Most Recent Test Results.  

4. Для просмотра данных всех тестов в базе данных Полевого Коммуникатора: 

a. Нажмите Show Results Table.  

Выводятся данные самого последнего теста.   

b. Нажмите  OK для прокрутки данных предыдущих тестов.  

c. Для выхода из таблицы результатов нажмите Abort.   

Интерпретация результатов теста контроля метрологических ха-
рактеристик расходомера 
При завершении теста контроля метрологических характеристик, результаты отображаются 
как Pass (успешное завершение теста), Fail (ошибка) или Abort (прерывание теста). (В некото-
рых средствах коммуникации отчет Fail (ошибка) отображается как Caution (внимание).) 

Pass -успешное завершение теста. Результаты тестирования находятся внутри специфи-
кации предела неопределённости. Другими словами, жёсткость, относительно пра-
вой и левой катушек, соответствует заводским значениям, плюс-минус специфика-
ция предела неопределённости. Если ноль преобразователя и его конфигурация 
соответствуют заводским значениям, сенсор будет соответствовать заводским спе-
цификациям по измерению расхода и плотности. Предполагается прохождение тес-
та расходомерами при каждом запуске. 
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Fail -ошибка. Результаты тестирования не находятся в пределах спецификации неопре-
делённости. Micro Motion рекомендует сразу перезапустить тест контроля метроло-
гических характеристик расходомера. Если использовалась версия Smart Meter Ver-
ification, и выходы были установлены на продолжение измерений, измените уста-
новку на Last Measured Value или Fault. 

• При успешном завершении повторного теста, первый результат Fail/Caution 
может быть игнорирован.  

• При неуспешном завершении повторного теста, возможно трубки сенсора по-
вреждены. Используя сведения о Вашем технологическом процессе, попытай-
тесь определить тип повреждения и необходимые мероприятия. Мероприятия 
предполагают снятие сенсора и физическую инспекцию трубок. Как минимум, 
необходимо провести поверку по расходу и калибровку плотности.  

Abort -прерывание теста. Возникновение проблем во время прохождения процедуры кон-
троля метрологических характеристик расходомера (например, нестабильность 
технологического процесса). В Таблице 11-3 перечислены коды прерывания и для 
каждого из них представлены возможные действия. 

 

 

Таблица 11-3:      Коды прерывания процедуры контроля метрологических характери-
стик расходомера 

Код  Описание Предлагаемые действия 

1 Прерывание по инициативе поль-
зователя 

Нет необходимости в каких-либо действиях. 
Перед запуском нового теста, подождите 15 
секунд. 

3 Дрейф (сдвиг) частоты Убедитесь в стабильности температуры, рас-
хода и плотности, и перезапустите тест. 

5 Высокое значение уровня сигнала 
на возбуждающей катушке 

Убедитесь в стабильности расхода, минимизи-
руйте наличие свободного газа, и перезапусти-
те тест. 

8 Нестабильный расход Проверьте условия, которые могли привести к 
нестабильности и перезапустите тест. Для 
максимальной стабильности процесса: 

• Поддерживайте постоянными давление и 
температуру жидкости.  

• Избегайте изменений в составе жидкости, 
т.е. двухфазного потока и посторонних 
включений. 

• Поддерживайте постоянным значение 
расхода  

13 Отсутствие заводских данных по 
проверке расходомера по воздуху 

Обратитесь в службу поддержки заказчиков 
Micro  Motion. 

14 Отсутствие заводских данных по 
проверке расходомера по воде 

Обратитесь в службу поддержки заказчиков 
Micro  Motion. 

15 Отсутствие конфигурационных 
данных по проверке расходомера  

Обратитесь в службу поддержки заказчиков 
Micro  Motion. 

Другие Общее прерывание Повторите тест. В случае очередного преры-
вания, обратитесь в службу поддержки заказ-
чиков Micro Motion. 
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11.2.5 Планирование автоматического исполнения теста контроля 
метрологических характеристик расходомера 

 

Вы можете запрограммировать запуск одиночного теста в определенное пользователем будущее время. 
Вы может также запрограммировать запуск тестов по расписанию 

Запуск тестов по расписанию с помощью дисплея 
1.  Воспользуйтесь меню Smart Meter Verification 

Рисунок 11-5:     Контроль метрологических характеристик – меню верхнего уровня 

 
 

2. Активируйте Scroll до Schedule Verify и нажмите Select  

3. Для планирования одиночного теста или первого теста из периодической серии:  

a. Активируйте Scroll до Set Next и нажмите Select  

b. Введите количество часов ожидания преобразователем до запуска теста.  

4. Для планирования периодического исполнения тестов:  

a. Активируйте Scroll до Set Recur и нажмите Select  

b. Введите количество часов, соответствующее интервалу между тестами.  

5. Для отмены периодического исполнения тестов:  

• Для отмены исполнения одиночного запланированного теста установите Set Next в значение 0.  

• Для отмены периодического исполнения тестов установите Set Recur  в значение 0. 

• Для отмены всех запланированных к исполнению тестов, при входе в меню Smart Meter Verifica-
tion выберите Turn Off Sched. 

 

 

  

Активируйте одновременно 
Scroll и Select на 4 секунды 
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Блок-схема меню Smart Meter Verification: планирование выполнения 
тестов с помощью дисплея 

 

Рисунок 11-6:     Планирование тестов контроля метрологических характеристик с помощью дисплея 

 
 

Запуск тестов по расписанию с помощью ProLink II 
1. Выберите Tools > Meter Verification > Schedule Meter Verification.  

2. Для планирования одиночного теста или первого теста из периодической серии определи-
те значение параметра Hours Until Next Run.  

3. Для планирования периодического исполнения тестов определите значение параметра 
Hours Between Recurring Runs.  
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4. Для отмены автоматического исполнения тестов: 

• Для отмены исполнения одиночного запланированного теста установите параметр 
Hours Until Next Run в значение 0.  

• Для отмены периодического исполнения тестов установите параметр Hours Between 
Recurring Runs в значение 0. 

• Для отмены всех запланированных к исполнению тестов, щелкните кнопкой мыши по 
Turn Off Schedule. 

 

 

Запуск тестов по расписанию с помощью ProLink III 
1. Выберите Device Tools > Diagnostics > Meter Verification > Schedule Meter Verification.  

2. Для планирования одиночного теста или первого теста из периодической серии определи-
те значение параметра Hours Until Next Run.  

3. Для планирования периодического исполнения тестов определите значение параметра 
Hours Between Recurring Runs.   

4. Для отмены автоматического исполнения тестов: 

• Для отмены исполнения одиночного запланированного теста установите параметр 
Hours Until Next Run в значение 0.  

• Для отмены периодического исполнения тестов установите параметр Hours Between 
Recurring Runs в значение 0. 

• Для отмены всех запланированных к исполнению тестов, щелкните кнопкой мыши по 
Disable Scheduled Execution. 

 

Запуск тестов по расписанию с помощью Полевого Коммуникатора 
1. Воспользуйтесь меню Smart Meter Verification:  

• Overview > Shortcuts > Meter Verification  

• Service Tools > Maintenance > Routine Maintenance > Meter Verification  

2. Выберите Automatic Verification.  

3. Для планирования одиночного теста или первого теста из периодической серии определи-
те значение параметра Hrs Until Next Run.  

4. Для планирования периодического исполнения тестов установите значение для параметра 
Set Recurring Hours.  

5. Для отмены автоматического исполнения тестов: 

• Для отмены исполнения одиночного запланированного теста установите параметр Hrs 
Until Next Run в значение 0.  

• Для отмены периодического исполнения тестов установите параметр Set Recurring Hours 
в значение 0. 

• Для отмены всех запланированных к исполнению тестов, щелкните кнопкой мыши по 
Turn Off Schedule. 

 

11.3 Установка нуля расходомера 
Установка нуля расходомера вводит опорную точку расходомера, основанную на анализе вы-
хода сенсора при отсутствии потока. 
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Важно 

В большинстве случаев значение нуля, установленное на заводе (factory zero), точнее, чем зна-
чение, полученное в полевых условиях. Проводите процедуру установки нуля только если: 

• Установка нуля является обязательным требованием местных правил, или 

• При текущем значении нуля не проходит процедура контроля нуля (Zero Verification). 

Предварительные требования 

Перед проведением процедуры установки нуля, проведите процедуру контроля нуля (Zero Ver-
ification) с тем, чтобы понять улучшит ли точность измерений процедура установки нуля. См. 
Раздел 2.6. 

Важно 

Не проводите процедуры контроля нуля или установки нуля расходомера при активном тре-
вожном сообщении высокого приоритета. Устраните неисправность, и лишь затем проведите 
контроль нуля установку нуля расходомера. Допускается контроль нуля или установка нуля 
расходомера при активном тревожном сообщении низкого приоритета. 

 

11.3.1 Установка нуля расходомера с помощью дисплея 
Установка нуля расходомера вводит опорную точку расходомера, основанную на анализе вы-
хода сенсора при отсутствии потока. 

Ограничение 

С помощью дисплея невозможно изменить время установки нуля Zero Time. При проведении 
процедуры установки нуля будет использовано текущее значение параметра Zero Time. Значе-
ние по умолчанию 20 секунд. При необходимости изменения времени установки нуля, вос-
пользуйтесь средством коммуникации, например программным обеспечением ProLink II. 

Предварительные требования 

Назначьте следующие переменные в качестве дисплейных переменных: 

• Live Zero или Field Verification Zero 

• Drive gain 

• Temperature 

• Density 

См. Раздел 5.1.2. 

Процедура 

1. Подготовьте расходомер: 

a. Подайте питание на расходомер. Дайте расходомеру прогреться, приблизительно 20 
минут. 

b. Пропустите технологическую среду через сенсор до тех пор, пока температура сенсо-
ра не достигнет нормальной рабочей температуры процесса. 

c. Остановите поток, закрыв запорный клапан, расположенный ниже сенсора по потоку, 
а затем и клапан, расположенный выше сенсора по потоку (при наличии). 

d. Убедитесь, что течение технологической среды полностью остановлено и сенсор пол-
ностью заполнен средой. 

e. Оцените значения уровня сигнала на возбуждающей катушке (drive gain), температу-
ры и плотности. При их стабильности, проверьте значение переменных Live Zero или 
Field Verification Zero. Если среднее значение близко к 0, нет необходимости в проведе-
нии процедуры установки нуля. 
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2. Воспользуйтесь меню OFFLINE MAINT > ZERO > CAL ZERO и выберите CAL/YES?. 

Во время прохождения процедуры установки нуля по дисплею перемещаются точки. 

3. Ознакомьтесь с результатами процедуры установки нуля на дисплее. 

На дисплее отображается CAL PASS при успешном завершении процедуры, и CAL FAIL в 
противном случае. 

Дополнительная информация 

Откройте клапаны для восстановления нормального расхода. 

Требуется помощь?  Если процедура установки нуля завершилась ошибкой (CAL FAIL): 

• Убедитесь в отсутствии расхода и повторите процедуру. 

• Устраните или ограничьте влияние источников электромеханических помех и повторите процедуру. 

• Установите параметр Zero Time на меньшее значение и повторите процедуру. 

• При сохранении проблемы, обратитесь в службу поддержки заказчиков Micro Motion. 

• Если Вы хотите восстановить работу расходомера с использованием предыдущего значения нуля: 

− Для восстановления заводского значения нуля: OFFLINE MAINT > ZERO >RESTORE ZERO > RE-
STORE/YES?. Эта функция доступна только для усовершенствованного базового процессора. 

Ограничение 

Используйте функцию восстановления заводского значения нуля только в случае, если расходо-
мер был заказан как целое, на заводе была проведена процедура установки нуля, и Вы используе-
те оригинальные компоненты. 

 

 

11.3.2 Установка нуля расходомера с помощью ProLink II 
Установка нуля расходомера вводит опорную точку расходомера, основанную на анализе вы-
хода сенсора при отсутствии потока. 

Предварительные требования 

ProLink II должен быть подключён к преобразователю и запущен. 

Процедура 

1. Подготовьте расходомер: 

a. Подайте питание на расходомер. Дайте расходомеру прогреться, приблизительно 20 
минут. 

b. Пропустите технологическую среду через сенсор до тех пор, пока температура сенсо-
ра не достигнет нормальной рабочей температуры процесса. 

c. Остановите поток, закрыв запорный клапан, расположенный ниже сенсора по потоку, 
а затем и клапан, расположенный выше сенсора по потоку (при наличии). 

d. Убедитесь, что течение технологической среды полностью остановлено и сенсор пол-
ностью заполнен средой. 

e. Оцените значения уровня сигнала на возбуждающей катушке (drive gain), температу-
ры и плотности. При их стабильности, проверьте значение переменных Live Zero или 
Field Verification Zero. Если среднее значение близко к 0, нет необходимости в проведе-
нии процедуры установки нуля. 

 

 

  



Обеспечение качества измерений 

Руководство по конфигурированию и применению 

 

189 

2. Выберите ProLink > Calibration > Zero Verification and Calibration 

3. Щёлкните кнопкой мыши по Calibrate Zero. 

4. При необходимости, измените значение Zero Time.  

Время установки нуля равно интервалу времени, которое требуется преобразователю для 
определения опорной точки нулевого потока. По умолчанию время установки нуля равно 
20 секундам. Для большинства применений подходит значение по умолчанию для времени 
установки нуля. 

5. Щёлкните кнопкой мыши по Peform Auto Zero (Провести калибровку нуля). 

Индикатор Calibration in Progress горит красным цветом во время всей процедуры установки 
нуля. По окончанию процедуры: 

• При успешном завершении процедуры установки нуля, индикатор Calibration in Progress 
вновь загорается зелёным цветом, и выводится новое значение нуля. 

• При ошибочном завершении процедуры установки нуля, индикатор Calibration in Pro-
gress загорается красным цветом. 

 

Дополнительная информация 

Откройте клапаны для восстановления нормального расхода. 

Требуется помощь?  Если процедура установки нуля завершилась ошибкой: 

• Убедитесь в отсутствии расхода и повторите процедуру. 

• Устраните или ограничьте влияние источников электромеханических помех и повторите процедуру. 

• Установите параметр Zero Time на меньшее значение и повторите процедуру. 

• При сохранении проблемы, обратитесь в службу поддержки заказчиков Micro Motion. 

• Если Вы хотите восстановить работу расходомера с использованием предыдущего значения нуля: 

− Для восстановления заводского значения нуля: ProLink > Zero Verification and Calibration > Calibrate Ze-
ro > Restore Factory Zero. Эта функция доступна только для усовершенствованного базового процессо-
ра. 

− Для восстановления самого последнего действительного значения нуля из памяти преобразова-
теля: ProLink > Zero Verification andCalibration > Calibrate Zero > Restore Prior Zero. Функция Restore Prior Zero 
доступна до тех пор, пока окно Flow Calibration открыто. После закрытия окна Flow Calibration, 
Функция Restore Prior Zero не доступна. 

 

Ограничение 

Используйте функцию восстановления заводского значения нуля только в случае, если расходомер был 
заказан как целое, на заводе была проведена процедура установки нуля, и Вы используете оригинальные 
компоненты. 

 

11.3.3 Установка нуля расходомера с помощью ProLink III 
Установка нуля расходомера вводит опорную точку расходомера, основанную на анализе вы-
хода сенсора при отсутствии потока. 

Предварительные требования 

ProLink III должен быть подключён к преобразователю и запущен. 
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Процедура 

1. Подготовьте расходомер: 

a. Подайте питание на расходомер. Дайте расходомеру прогреться, приблизительно 20 
минут. 

b. Пропустите технологическую среду через сенсор до тех пор, пока температура сенсо-
ра не достигнет нормальной рабочей температуры процесса. 

c. Остановите поток, закрыв запорный клапан, расположенный ниже сенсора по потоку, 
а затем и клапан, расположенный выше сенсора по потоку (при наличии). 

d. Убедитесь, что течение технологической среды полностью остановлено и сенсор пол-
ностью заполнен средой. 

e. Оцените значения уровня сигнала на возбуждающей катушке (drive gain), температу-
ры и плотности. При их стабильности, проверьте значение переменных Live Zero или 
Field Verification Zero. Если среднее значение близко к 0, нет необходимости в проведе-
нии процедуры установки нуля. 

2. Выберите Device Tools > Calibration > Zero Verification and Calibration 

3. Щёлкните кнопкой мыши по Calibrate Zero. 

4. При необходимости, измените значение Zero Time.  

Время установки нуля равно интервалу времени, которое требуется преобразователю для оп-
ределения опорной точки нулевого потока. По умолчанию время установки нуля равно 20 се-
кундам. Для большинства применений подходит значение по умолчанию для времени уста-
новки нуля. 

5. Щёлкните кнопкой мыши по Calibrate Zero (Провести калибровку нуля). 

Выводится сообщение Calibration in Progress (Идёт калибровка). По окончанию процедуры: 

• При успешном завершении процедуры установки нуля, выводится сообщение Calibration 
Success и новое значение нуля. 

• При ошибочном завершении процедуры установки нуля, выводится сообщение Calibration 
Failed. 

 

Дополнительная информация 

Откройте клапаны для восстановления нормального расхода. 

Требуется помощь?  Если процедура установки нуля завершилась ошибкой : 

• Убедитесь в отсутствии расхода и повторите процедуру. 

• Устраните или ограничьте влияние источников электромеханических помех и повторите процедуру. 

• Установите параметр Zero Time на меньшее значение и повторите процедуру. 

• При сохранении проблемы, обратитесь в службу поддержки заказчиков Micro Motion. 

• Если Вы хотите восстановить работу расходомера с использованием предыдущего значения нуля: 

− Для восстановления заводского значения нуля: Device Tools > Zero Verification and Calibration > Cali-
brate Zero > Restore Factory Zero. Эта функция доступна только для усовершенствованного базового 
процессора. 

− Для восстановления самого последнего действительного значения нуля из памяти преобразова-
теля: Device Tools > Zero Verification andCalibration > Calibrate Zero > Restore Prior Zero. Функция Restore Prior 
Zero доступна до тех пор, пока окно Flow Calibration открыто. После закрытия окна Flow Calibration, 
Функция Restore Prior Zero не доступна. 

Ограничение  

Используйте функцию восстановления заводского значения нуля только в случае, если расходомер был 
заказан как целое, на заводе была проведена процедура установки нуля, и Вы используете оригинальные 
компоненты. 
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11.3.4 Установка нуля расходомера с помощью Полевого 
коммуникатора 

Установка нуля расходомера вводит опорную точку расходомера, основанную на анализе вы-
хода сенсора при отсутствии потока. 

 

1. Подготовьте расходомер: 

a. Подайте питание на расходомер. Дайте расходомеру прогреться, приблизительно 20 
минут. 

b. Пропустите технологическую среду через сенсор до тех пор, пока температура сенсо-
ра не достигнет нормальной рабочей температуры процесса. 

c. Остановите поток, закрыв запорный клапан, расположенный ниже сенсора по потоку, 
а затем и клапан, расположенный выше сенсора по потоку (при наличии). 

d. Убедитесь, что течение технологической среды полностью остановлено и сенсор пол-
ностью заполнен средой. 

e. Оцените значения уровня сигнала на возбуждающей катушке (drive gain), температу-
ры и плотности. При их стабильности, проверьте значение переменных Live Zero или 
Field Verification Zero. Если среднее значение близко к 0, нет необходимости в проведе-
нии процедуры установки нуля. 

2. Нажмите Service Tools > Maintenance > Zero Calibration > Peform Auto Zero. 

3.   При необходимости, измените значение Zero Time.  

Время установки нуля равно интервалу времени, которое требуется преобразователю для 
определения опорной точки нулевого потока. По умолчанию время установки нуля равно 
20 секундам. Для большинства применений подходит значение по умолчанию для времени 
установки нуля. 

4. Нажмите ОК для запуска процедуры установки нуля, и подождите её завершения. 

5. После завершения процедуры установки нуля, выводятся данные калибровки. 

• Если Вы принимаете данные и желаете их сохранить, нажмите ОК. 

• Если Вы не принимаете данные и желаете вернуться к предыдущему значению нуля, 
нажмите ABORT. 

 

Дополнительная информация 

Откройте клапаны для восстановления нормального расхода. 

Требуется помощь?  Если процедура установки нуля завершилась ошибкой : 

• Убедитесь в отсутствии расхода и повторите процедуру. 

• Устраните или ограничьте влияние источников электромеханических помех и повторите процедуру. 

• Установите параметр Zero Time на меньшее значение и повторите процедуру. 

• При сохранении проблемы, обратитесь в службу поддержки заказчиков Micro Motion. 

• Если Вы хотите восстановить работу расходомера с использованием предыдущего значения нуля: 

− Для восстановления заводского значения нуля: Service Tools > Maintenance > Zero Calibration > Re-
store Factory Zero. Эта функция доступна только для усовершенствованного базового процессора. 

 

Ограничение 

Используйте функцию восстановления заводского значения нуля только в случае, если расхо-
домер был заказан как целое, на заводе была проведена процедура установки нуля, и Вы ис-
пользуете оригинальные компоненты. 
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11.4 Подтверждение характеристик расходомера 
(поверка) 

 

Дисплей OFF-LINE MAINT>CONFG>UNITS>MTR F 

ProLink II ProLink>Configuration>Flow 

ProLink III Device Tools>Configuration>Process Measurement>Flow 

Device Tools>Configuration>Process Measurement>Density 

Полевой Ком-
муникатор 

Configure>Manual Setup>Measurements>Flow 

Configure>Manual Setup>Measurements>Density 

 

Обзор 

При поверке сравниваются результаты измерений расходомера, отображаемые преобразовате-
лем, с данными внешнего измерительного стандарта. При существенном различии между дан-
ными преобразователя и данными внешнего измерительного стандарта по массовому расходу, 
объёмному расходу или плотности, Вам, возможно, придётся подстроить соответствующий М-
фактор. Действительное измеренное значение умножается на М-фактор (коэффициент), и ото-
бражается как результат, используемый в дальнейшей работе. 

Предварительные требования 

Определите М-фактор(ы), который Вы будете рассчитывать и устанавливать. Возможна уста-
новка любой комбинации из трёх М-факторов: массового расхода, объёмного расхода и плот-
ности. Заметьте, что все три коэффициента независимы: 

• М-фактор (коэффициент) для массового расхода влияет только на массовый расход. 

• М-фактор (коэффициент) для плотности влияет только на плотность. 

• М-фактор (коэффициент) для объёмного расхода влияет только на объёмный расход или 
стандартный объёмный расход газа. 

 

Важно 

Для подстройки объёмного расхода Вам необходимо установить М-фактор для объёмного рас-
хода. Установка М-факторов для массового расхода и плотности не приведет к желаемому 
результату. Расчет объёмного расхода основывается на первоначальных значениях массового 
расхода и плотности, до использования соответствующих М-факторов. 

 

Если Вы планируете расчет М-фактора для объёмного расхода, имейте в виду, что поверка 
объёма в полевых условиях может оказаться дорогостоящей, и процедура может быть опасной 
для некоторых технологических жидкостей. Вот почему, основываясь на том, что объём об-
ратно пропорционален плотности, альтернативой прямого измерения является расчет М-
фактора для объёмного расхода из М-фактора для плотности. В Разделе 11.4.1 содержатся ин-
струкции для использования этого метода. 

Обеспечьте наличие внешнего измерительного стандарта для соответствующей переменной 
процесса. 

 

Важно 

Для получения хороших результатов, внешний измерительный стандарт должен обладать вы-
сокой точностью. 
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Процедура 

1. Определите М-фактор следующим образом:  

a. Используя расходомер, произведите измерения пробы.  

b. Проведите измерения пробы, используя внешний измерительный стандарт. 

c. Рассчитайте М-фактор по формуле:  

Новый Meter factor  = Сконфигурированный Meter factor Х     
Внешний стандарт 

  
Текущее измерение преобразователя 

 

2. Убедитесь в том, что рассчитанный М-фактор находится в пределах от 0.8 до 1.2. Если 
значение М-фактора выходит за эти пределы, свяжитесь со службой поддержки заказчи-
ков Micro Motion. 

3. Сконфигурируйте М-фактор в преобразователе.   

Пример: Расчет М-фактора для массового расхода 

Расходомер установлен и поверяется впервые. Измерение массового расхода преобразователем 
250.27 фунтов. Измерение массового расхода внешним стандартом 250 фунтов. Расчет М-
фактора для массового расхода: 

 
Значение первого М-фактора для массового расхода 0.9989. 

Год спустя расходомер поверяется вновь. Измерение массового расхода преобразователем 
250.07 фунтов. Измерение массового расхода внешним стандартом 250.25 фунтов. Расчет но-
вого М-фактора для массового расхода: 

 
Значение нового М-фактора для массового расхода 0.9996. 

 

11.4.1 Альтернативный метод расчета М-фактора для объёмного 
расхода 

Альтернативный метод расчета М-фактора для объёмного расхода используется для избежа-
ния сложностей, которые могут быть связаны с обычным методом. 

Альтернативный метод основан на том факте, что объём обратно пропорционален плотности. 
Он обеспечивает частичную коррекцию измерения объемного расхода подстройкой части 
суммарного отклонения, вызванного отклонением в измерении плотности. Используйте этот 
метод только при недоступности эталона объемного расхода и при наличии эталона плотно-
сти. 

Процедура 

1. Рассчитайте М-фактор для плотности, используя стандартный метод (см. Раздел 11.4).  

2. Рассчитайте М-фактор для объёмного расхода по М-фактору плотности:  
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М-фактор объёма  =      1 
М-фактор плотности 

 

Примечание 

Следующее уравнение математически эквивалентно первому. Вы можете использовать 
предпочитаемую версию.  

М-фактор объёма = Сконфигурированный М-фактор плотности Х     
Плотность расходомера 

  
Плотность эталона 

  

 

3.  Убедитесь в том, что рассчитанный М-фактор находится в пределах от 0.8 до 1.2. Если 
значение М-фактора выходит за эти пределы, свяжитесь со службой поддержки заказчи-
ков Micro Motion. 

4. Сконфигурируйте М-фактор в преобразователе.   

 

 

11.5 Проведение (стандартной) калибровки плотности 
D1 и D2 

 

При калибровке плотности устанавливается соответствие между плотностью калибровочных 
жидкостей и сигналом сенсора. Калибровка плотности включает калибровку точек D1 (низкой 
плотности) и D2 (высокой плотности). 

Важно 

Расходомеры Micro Motion откалиброваны на заводе и, обычно, не требуют калибровки в по-
левых условиях. Проводите калибровку расходомера только, если это необходимо для соот-
ветствия местным правилам. Свяжитесь с Micro Motion перед проведением калибровки расхо-
домера. 

 

Полезный совет 

Для подтверждения метрологических характеристик по внешнему стандарту или для коррек-
ции ошибок измерения Micro Motion рекомендует проводить поверку расходомера (использо-
вать М-факторы) вместо калибровки. 

 

11.5.1 Проведение калибровки плотности D1и D2 с помощью 
ProLink II 

 

Предварительные требования 

• Во время калибровки сенсор должен быть полностью заполнен калибровочной жидко-
стью, а расход через сенсор должен быть минимальным, допускаемым Вашим примене-
нием. Обычно это достигается закрытием отсечного клапана ниже по потоку от сенсора и 
заполнением сенсора соответствующей жидкостью. 

• Для проведения D1 и D2 калибровки плотности необходимы жидкости D1 (низкая плот-
ность) и D2 (высокая плотность). Вы можете использовать воздух и воду.  
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• Если была активирована функция LD Optimization, заблокируйте её. Для этого выберите 
ProLink > Configuration > Sensor и убедитесь, что в соответствующем окошке отсутствует 
метка. Функция LD Optimization используется лишь при измерении углеводородов сенсора-
ми большого размера. В некоторых установках доступом к этому параметру обладает 
только представитель службы поддержки заказчиков Micro Motion. В этом случае свяжи-
тесь с Micro Motion. 

• Калибровка должна проводиться без прерываний, в представленной последовательности. 
Убедитесь, что Вы готовы завершить процесс без прерываний. 

• Перед проведением калибровки, запишите текущие калибровочные параметры. Вы може-
те сделать это, сохранив текущую конфигурацию в файле на Вашем компьютере. При 
сбое калибровки, восстановите известные значения.  

 

Ограничение 

При калибровке сенсоров Т-Серии, калибровка D1 должна проводиться по воздуху, а калиб-
ровка D2 должна проводиться по воде. 

Процедура 

См. Рисунок 11-7 

 

Рисунок 11-7:     Калибровка плотности D1и D2 с помощью ProLink II 

 
 

  

Закройте отсечной 
клапан ниже сенсора 
по потоку 
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Дополнительная информация 

Если перед проведением калибровки Вы заблокировали функцию LD Optimization, реактивируй-
те её. 

 

11.5.2 Проведение калибровки плотности D1и D2 с помощью 
ProLink III 

 

Предварительные требования 

• Во время калибровки сенсор должен быть полностью заполнен калибровочной жидко-
стью, а расход через сенсор должен быть минимальным, допускаемым Вашим примене-
нием. Обычно это достигается закрытием отсечного клапана ниже по потоку от сенсора и 
заполнением сенсора соответствующей жидкостью. 

• Для проведения D1 и D2 калибровки плотности необходимы жидкости D1 (низкая плот-
ность) и D2 (высокая плотность). Вы можете использовать воздух и воду.   

• Если была активирована функция LD Optimization, заблокируйте её. Для этого выберите 
ProLink > Configuration > Sensor и убедитесь, что в соответствующем окошке отсутствует 
метка. Функция LD Optimization используется лишь при измерении углеводородов сенсора-
ми большого размера. В некоторых установках доступом к этому параметру обладает 
только представитель службы поддержки заказчиков Micro Motion. В этом случае свяжи-
тесь с Micro Motion. 

• Калибровка должна проводиться без прерываний, в представленной последовательности. 
Убедитесь, что Вы готовы завершить процесс без прерываний. 

• Перед проведением калибровки, запишите текущие калибровочные параметры. Вы може-
те сделать это, сохранив текущую конфигурацию в файле на Вашем компьютере. При 
сбое калибровки, восстановите известные значения.  

Ограничение 

При калибровке сенсоров Т-Серии, калибровка D1 должна проводиться по воздуху, а калиб-
ровка D2 должна проводиться по воде. 

Процедура 

См. Рисунок 11-8. 
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Рисунок 11-8:     Калибровка плотности D1и D2 с помощью ProLink III 

 
 

Дополнительная информация 

Если перед проведением калибровки Вы заблокировали функцию LD Optimization, реактивируй-
те её. 

11.5.3 Проведение калибровки плотности D1и D2 с помощью 
Полевого Коммуникатора 

 

Предварительные требования 

• Во время калибровки сенсор должен быть полностью заполнен калибровочной жидко-
стью, а расход через сенсор должен быть минимальным, допускаемым Вашим примене-
нием. Обычно это достигается закрытием отсечного клапана ниже по потоку от сенсора и 
заполнением сенсора соответствующей жидкостью. 

• Для проведения D1 и D2 калибровки плотности необходимы жидкости D1 (низкая плот-
ность) и D2 (высокая плотность). Вы можете использовать воздух и воду.   

• Если была активирована функция LD Optimization, заблокируйте её. Для этого выберите 
ProLink > Configuration > Sensor и убедитесь, что в соответствующем окошке отсутствует 
метка. Функция LD Optimization используется лишь при измерении углеводородов сенсора-
ми большого размера. В некоторых установках доступом к этому параметру обладает 
только представитель службы поддержки заказчиков Micro Motion. В этом случае свяжи-
тесь с Micro Motion. 

• Калибровка должна проводиться без прерываний, в представленной последовательности. 
Убедитесь, что Вы готовы завершить процесс без прерываний. 

 

  

Закройте отсечной клапан 
ниже сенсора по потоку 
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• Перед проведением калибровки, запишите текущие калибровочные параметры. Вы може-
те сделать это, сохранив текущую конфигурацию в файле на Вашем компьютере. При 
сбое калибровки, восстановите известные значения. 

 

Ограничение 

При калибровке сенсоров Т-Серии, калибровка D1 должна проводиться по воздуху, а калиб-
ровка D2 должна проводиться по воде. 

Процедура 

См. Рисунок 11-9 

 

Рисунок 11-9:     Калибровка плотности D1и D2 с помощью Полевого Коммуникатора 

 
 

Дополнительная информация 

Если перед проведением калибровки Вы заблокировали функцию LD Optimization, реактивируй-
те её. 

 

  

Закройте отсечной 
клапан ниже сенсо-
ра по потоку 
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11.6 Проведение калибровки плотности D3 и D4 
(только для сенсоров Т-серии) 

 

Для сенсоров Т-Серии, дополнительные калибровки D3 и D4 могут повысить точность изме-
рения плотности жидкостей, если их плотность меньше 0.8 г/см3 или больше 1.2 г/см3 . 

При проведении калибровки D3 и D4: 

• Не проводите калибровку D1, D2  

• Проведите калибровку D3, если у Вас только одна калибровочная жидкость.  

• Проведите калибровку D3 и D4, если у Вас две калибровочные жидкости (отличные от 
воздуха и воды). Калибровка должна проводиться без прерываний, в представленной по-
следовательности. Убедитесь, что Вы готовы завершить процесс без прерываний. 

 

 

11.6.1 Проведение калибровки плотности D3 или D3 и D4 с 
помощью ProLink II 

 

Предварительные требования 

• Во время калибровки сенсор должен быть полностью заполнен калибровочной жидко-
стью, а расход через сенсор должен быть минимальным, допускаемым Вашим примене-
нием. Обычно это достигается закрытием отсечного клапана ниже по потоку от сенсора и 
заполнением сенсора соответствующей жидкостью.  

• Для D3 калибровки, жидкость D3 должна соответствовать следующим требованиям:  

− Минимальная плотность 0,6 г/см3  

− Минимальная разница в 0,1 г/см3, между плотностью жидкости D3 и плотностью во-
ды. Плотность жидкости D3 может быть как больше, так и меньше плотности воды  

• Для D4 калибровки, жидкость D4 должна соответствовать следующим требованиям:  

− Минимальная плотность 0,6 г/см3  

− Минимальная разница в 0,1 г/см3, между плотностью жидкости D4 и плотностью жид-
кости D3. Плотность жидкости D4 должна быть больше плотности жидкости D3  

− Минимальная разница в 0,1 г/см3, между плотностью жидкости D4 и плотностью во-
ды. Плотность жидкости D4 может быть как больше, так и меньше плотности воды  

• Перед проведением калибровки, запишите текущие калибровочные параметры. Вы може-
те сделать это, сохранив текущую конфигурацию в файле на Вашем компьютере. При 
сбое калибровки, восстановите известные значения.  

 

Процедура 

См. Рисунок 11-10. 
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Рисунок 11-10:     Калибровка плотности D3 или D3и D4 с помощью ProLink II 

 
 

11.6.2 Проведение калибровки плотности D3 или D3 и D4 с 
помощью ProLink III 

 

Предварительные требования 

• Во время калибровки сенсор должен быть полностью заполнен калибровочной жидко-
стью, а расход через сенсор должен быть минимальным, допускаемым Вашим примене-
нием. Обычно это достигается закрытием отсечного клапана ниже по потоку от сенсора и 
заполнением сенсора соответствующей жидкостью.  

• Для D3 калибровки, жидкость D3 должна соответствовать следующим требованиям:  

− Минимальная плотность 0,6 г/см3  

− Минимальная разница в 0,1 г/см3, между плотностью жидкости D3 и плотностью во-
ды. Плотность жидкости D3 может быть как больше, так и меньше плотности воды  

 

  

Закройте отсечной 
клапан ниже сенсора 
по потоку 
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• Для D4 калибровки, жидкость D4 должна соответствовать следующим требованиям:  

− Минимальная плотность 0,6 г/см3  

− Минимальная разница в 0,1 г/см3, между плотностью жидкости D4 и плотностью жид-
кости D3. Плотность жидкости D4 должна быть больше плотности жидкости D3  

− Минимальная разница в 0,1 г/см3, между плотностью жидкости D4 и плотностью во-
ды. Плотность жидкости D4 может быть как больше, так и меньше плотности воды  

• Перед проведением калибровки, запишите текущие калибровочные параметры. Вы може-
те сделать это, сохранив текущую конфигурацию в файле на Вашем компьютере. При 
сбое калибровки, восстановите известные значения.  

 

Процедура 

См. Рисунок 11-11. 

 

Рисунок 11-11:     Калибровка плотности D3 или D3и D4 с помощью ProLink III 

 
 

11.6.3 Проведение калибровки плотности D3 или D3 и D4 с 
помощью Полевого Коммуникатора 

 

Предварительные требования 

• Во время калибровки сенсор должен быть полностью заполнен калибровочной жидко-
стью, а расход через сенсор должен быть минимальным, допускаемым Вашим примене-
нием. Обычно это достигается закрытием отсечного клапана ниже по потоку от сенсора и 
заполнением сенсора соответствующей жидкостью.   

 

  

Закройте отсечной клапан 
ниже сенсора по потоку 
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• Для D3 калибровки, жидкость D3 должна соответствовать следующим требованиям:  

− Минимальная плотность 0,6 г/см3  

− Минимальная разница в 0,1 г/см3, между плотностью жидкости D3 и плотностью во-
ды. Плотность жидкости D3 может быть как больше, так и меньше плотности воды  

• Для D4 калибровки, жидкость D4 должна соответствовать следующим требованиям:  

− Минимальная плотность 0,6 г/см3  

− Минимальная разница в 0,1 г/см3, между плотностью жидкости D4 и плотностью жид-
кости D3. Плотность жидкости D4 должна быть больше плотности жидкости D3  

− Минимальная разница в 0,1 г/см3, между плотностью жидкости D4 и плотностью во-
ды. Плотность жидкости D4 может быть как больше, так и меньше плотности воды  

• Перед проведением калибровки, запишите текущие калибровочные параметры. Вы може-
те сделать это, сохранив текущую конфигурацию в файле на Вашем компьютере. При 
сбое калибровки, восстановите известные значения.  

 

Процедура 

См. Рисунок 11-12. 
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Рисунок 11-12:     Калибровка плотности D3 или D3и D4 с помощью Полевого Коммуникатора 

 
 

 

11.7 Проведение калибровки температуры 
 

Калибровка температуры устанавливает соответствие между температурой калибровочных 
жидкостей и сигналом сенсора. 

Предварительные требования 

Температурная калибровка – это  двухэтапная процедура: температурная калибровка сдвига и 
температурная калибровка наклона характеристики. Вся процедура должна проводиться без 
прерываний в представленной последовательности. Убедитесь, что Вы готовы завершить про-
цесс без прерываний.  

Для калибровки температуры необходимо использовать ProLink II или ProLink III. 

 

  

Закройте отсечной 
клапан ниже сенсо-
ра по потоку 
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Важно 

Перед проведением процедуры калибровки температуры, проконсультируйтесь с Micro 
Motion. В нормальных условиях температурный контур стабилен и не нуждается в подстройке. 

Процедура 

См. Рисунок 11-13 и Рисунок 11-14. 

 

Рисунок 11-13:     Калибровка температуры с помощью ProLink II 
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Рисунок 11-14:     Калибровка температуры с помощью ProLink III 
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12 Поиск и устранение неисправностей 
 

Темы данной главы 
• Состояния светодиодного индикатора преобразователя 

• Тревожные сообщения состояния 

• Проблемы, возникающие при измерении расхода 

• Проблемы, возникающие при измерении плотности 

• Проблемы, возникающие при измерении температуры 

• Проблемы с миллиамперным выходом 

• Проблемы с частотным выходом 

• Использование режима имитации сенсора для поиска и устранения неисправностей 

• Проверка подключения кабелей питания 

• Проверка подключения кабелей от сенсора к преобразователю 

• Проверка заземления 

• Проведение тестов контура 

• Проверка радиочастотных помех (RFI) 

• Проверка коммуникационного контура HART 

• Проверка адреса-HART и режима токового контура 

• Проверка пакетного режима HART 

• Подстройки миллиамперного выхода 

• Проверка нижнего и верхнего пределов диапазона 

• Проверка действия при ошибке для миллиамперного выхода 

• Проверка максимальной ширины импульса частотного выхода 

• Проверка метода масштабирования частотного выхода 

• Проверка действия при ошибке для частотного выхода 

• Проверка параметра направления потока 

• Проверка отсечек 

• Проверка пробкового (двухфазного) течения 

• Проверка уровня сигнала на возбуждающей катушке 

• Проверка уровней напряжения на детекторных катушках 

• Проверка на короткое замыкание 

• Проверка светодиода базового процессора 

• Проведение теста сопротивлений базового процессора 

  



Поиск и устранение неисправностей 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

208 

12.1 Состояние светодиодного индикатора 
преобразователя 

Светодиод состояния преобразователя указывает на наличие или отсутствие активных тревож-
ных сообщений. При наличии активных алармов, обратитесь к списку алармов для идентифи-
кации тревожных сообщений, а затем принятия мер к устранению условий тревожных сооб-
щений. 

Преобразователь имеет светодиод состояния только при наличии дисплея. 

При наличии дисплея у преобразователя и заблокированном параметре мигания светодиода 
(LED Blinking), светодиод не мигает и не указывает на наличие неподтверждённого аларма. 

  

 

Таблица 12-1:     Состояние светодиодного индикатора преобразователя 

Условие Параметр мигания 
светодиода 

Состояние свето-
диода (LED) 

Нормальный рабочий режим (нет тревожных 
сообщений) 

Не применимо Зеленый 

Неподтвержденное исправленное условие (нет 
тревожных сообщений) 

Включен Мигающий зеленый 

Выключен Зеленый 
Подтвержденное тревожное сообщение низко-
го уровня (выходы продолжают отображать 
данные процесса) 

Не доступен Желтый 

Неподтвержденное тревожное сообщение низ-
кого уровня (выходы продолжают отображать 
данные процесса) 

Включен Мигающий желтый 

Выключен Желтый 

Подтвержденное тревожное сообщение высо-
кого уровня (выходы в состоянии ошибки) 

Не доступен Красный 

Неподтвержденное тревожное сообщение вы-
сокого уровня (выходы в состоянии ошибки) 

Включен Мигающий красный 

Выключен Красный 
 

12.2 Тревожные сообщения состояния 
 

Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия 

Код аларма Сообщение состояния Рекомендованные действия 

А001 Ошибка контрольной сум-
мы ЭСППЗУ – базовый 
процессор 

Преобразователь обнаружил проблемы при коммуникации с сен-
сором. Можно попытаться включить-выключить питание, и если 
условие аларма не пропадёт, базовый процессор требует замены. 

А002 Ошибка ОЗУ – базовый 
процессор 

Преобразователь обнаружил проблемы при коммуникации с сен-
сором. Можно попытаться включить-выключить питание, и если 
условие аларма не пропадёт, базовый процессор требует замены. 
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код аларма Сообщение состояния Рекомендованные действия 

А003 Неисправность сенсора Преобразователь не получает один или несколько базовых сигна-
лов от сенсора. Это может означать неисправность кабеля между 
сенсором и преобразователем или необходимость заводского ре-
монта сенсора. 

• Проверьте уровень сигнала на возбуждающей катушке и на-
пряжение на детекторных катушках. (См. Раздел 12.26 и Раз-
дел 12.27). 

• Проверьте кабель между сенсором и преобразователем. 

a. Убедитесь, что подключение сенсора к преобразователю 
проведено в соответствии с инструкциями руководства 
по установке на Ваш преобразователь. Выполняйте все 
требования по безопасности при открытии отделений 
подключения кабелей. 

b. Убедитесь, что проводники имеют хороший контакт с 
клеммами. 

c. Проведите тест сопротивлений RTD (термосопротивле-
ния)  и убедитесь в отсутствии короткого замыкания. 
(См. Раздел 12.28.1). 

d. Убедитесь в целостности всех проводников кабеля сен-
сор-преобразователь. 

• Убедитесь в отсутствии короткого замыкания. См. Раздел 
12.28. 

• Убедитесь в целостности трубок сенсора. 

 

А004 Температура вне пределов 
диапазона 

Сопротивление сенсора RTD вне пределов диапазона. 

1. Проведите тест сопротивлений RTD (термосопротивления)  и 
убедитесь в отсутствии короткого замыкания. (См. Раздел 
12.28.1).  

2. Проверьте кабель между сенсором и преобразователем. 

a. Убедитесь, что подключение сенсора к преобразователю 
проведено в соответствии с инструкциями руководства по 
установке на Ваш преобразователь. Выполняйте все тре-
бования по безопасности при открытии отделений под-
ключения кабелей. 

b. Убедитесь, что проводники имеют хороший контакт с 
клеммами. 

c. Проведите тест сопротивлений RTD (термосопротивле-
ния)  и убедитесь в отсутствии короткого замыкания. 
(См. Раздел 12.28.1). 

d. Убедитесь в целостности всех проводников кабеля сен-
сор-преобразователь. 

3. Проверьте параметры характеризации температуры (Temp Cal 
Factor). 

4. Сравните условия процесса со значениями, отображаемыми 
расходомером.  
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код аларма Сообщение состояния Рекомендованные действия 

А005 Массовый расход вне диа-
пазона 

Сенсор сообщает, что расход вне пределов диапазона сенсора. 

1. При наличии других алармов, сначала устраните их причины. 
Если текущий аларм продолжает существовать, продолжайте 
выполнять рекомендованные действия. 

2. Сравните условия процесса со значениями, отображаемыми 
расходомером.   

3. Поверьте наличие пробкового течения (двухфазного потока). 

a. Проверьте условия пробкового течения. Если пробковое 
течение является проблемой, будет выставлен аларм. 

b. Проверьте процесс на наличие кавитации или протечек.  

c. Наблюдайте за плотностью рабочей жидкости при нор-
мальных условиях Вашего процесса. 

 

А006 Требуется характеризация Калибровочные коэффициенты сенсора не введены, или непра-
вильный тип сенсора, или неправильные калибровочные коэффи-
циенты для данного типа сенсора.  

1. Проверьте, что все параметры характеризации соответствуют 
данным на табличке сенсора. 

2. Проверьте сопротивление компенсационного проводника 
термосопротивления (См. Раздел 12.28.1).  

3. Проверьте параметр Sensor Type и убедитесь, что он соответ-
ствует типу Вашего сенсора.  

4. Если параметр Sensor Type установлен в значение Curved Tube, 
убедитесь, что ни один из параметров, специфичных для 
прямотрубных сенсоров, не установлен.  

5. Если все параметры правильны, а аларм присутствует, заме-
ните базовый процессор. 
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код аларма Сообщение состояния Рекомендованные действия 

А008 Плотность вне диапазона Сенсор сообщает, что плотность нижу 0 г/см3  или выше 10 г/см3 . 
Обычными причинами данного аларма являются частичная за-
полненность трубок сенсора, высокое содержание газа в жидко-
сти, засорение трубок (налипание посторонних материалов к 
стенкам трубок, неравномерное обрастание внутренней поверх-
ности трубок или закупоренность трубок), или деформация тру-
бок (постоянное изменение в геометрии трубок из-за их передав-
ливания или гидроудара). 

1. При наличии других алармов, сначала устраните их причины. 
Если текущий аларм продолжает существовать, продолжайте 
выполнять рекомендованные действия.  

2. Сравните условия процесса со значениями, отображаемыми 
расходомером.    

3. Проверьте наличие воздуха в трубках расходомера, незапол-
ненность трубок, наличие посторонних материалов в трубках 
или наслоение на стенках трубок.  

4. Поверьте наличие пробкового течения (двухфазного потока). 

a. Проверьте условия пробкового течения. Если пробковое 
течение является проблемой, будет выставлен аларм. 

b. Проверьте процесс на наличие кавитации или протечек.  

c. Наблюдайте за плотностью рабочей жидкости при нор-
мальных условиях Вашего процесса. 

d. Проверьте значения параметров Slug Low Limit, Slug High 
Limit и Slug Duration. 

5. Если сопровождается алармом A003, проверьте на короткое 
замыкание между клеммами сенсора или между клеммами 
сенсора и корпусом сенсора. 

6. Проверьте, что все параметры характеризации соответствуют 
данным на табличке сенсора.  

7. Проверьте катушки сенсора (См. Раздел 12.28.1).  

8. Проверьте уровень сигнала на возбуждающей катушке и на-
пряжение на детекторных катушках.  

9. Проведите калибровку плотности.  

10. Свяжитесь с Micro Motion. 

 

А009 Инициализация преобразо-
вателя / прогрев 

Преобразователь находится в режиме включения питания. Дайте 
время для прогрева преобразователя. Аларм должен сброситься 
автоматически.  

Если условия аларма не исчезли: 

1. Убедитесь в достаточности питания базового процессора. На 
клеммах базового процессора всегда должно быть минимум 
11.5 В пост. Если питание на базовом процессоре недоста-
точное, проверьте питание преобразователя.  

2. Убедитесь в заполненности трубок сенсора жидкостью. 

3. Проверьте кабель между сенсором и преобразователем.  

 



Поиск и устранение неисправностей 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

212 

Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код аларма Сообщение состояния Рекомендованные действия 

А010 Ошибка калибровки Этот аларм обычно вызывается наличием расхода через сенсор во 
время установки нуля или при отклонении нуля, превышающем до-
пустимый предел. Выключение-включение питания преобразователя 
должно сбросить этот аларм. 

1. Выключите-включите питание расходомера.  

2. Убедитесь в отсутствии расхода через сенсор.  

3. Повторите калибровку нуля.  

4. Выключите-включите питание преобразователя. 

А011 Ошибка калибровки 
нуля: низкое 

Этот аларм обычно вызывается наличием обратного расхода через 
сенсор во время установки нуля или отклонением нуля, ниже допус-
тимого диапазона. Этот аларм обычно сопровождается алармом A010. 
Выключение-включение питания преобразователя должно сбросить 
этот аларм. 

1. Выключите-включите питание расходомера.  

2. Убедитесь в отсутствии расхода через сенсор.  

3. Повторите калибровку нуля.  

4. Выключите-включите питание преобразователя. 

А012 Ошибка калибровки 
нуля: высокое 

Этот аларм обычно вызывается наличием прямого расхода через сен-
сор во время установки нуля или отклонением нуля, выше допустимо-
го диапазона. Этот аларм обычно сопровождается алармом A010.  Вы-
ключение-включение питания преобразователя должно сбросить этот 
аларм. 

1. Выключите-включите питание расходомера.  

2. Убедитесь в отсутствии расхода через сенсор.  

3. Повторите калибровку нуля.  

4. Выключите-включите питание преобразователя. 

А013 Ошибка калибровки 
нуля: нестабильное 

Во время процедуры калибровки нуля наблюдались нестабильные ус-
ловия. Выключение-включение питания преобразователя должно 
сбросить этот аларм. 

1. Устраните или сократите влияние источников электромеханиче-
ских помех (напр., насосы, вибрации, напряжение трубопровода).  

• Проверьте уровень сигнала на возбуждающей катушке и на-
пряжение на детекторных катушках для подтверждения ста-
бильного состояния сенсора.  

• Повторите процедуру.  

2. Выключите-включите питание расходомера, затем повторите про-
цедуру.  

А014 Ошибка преобразова-
теля 

1. Проверьте правильность установки всех крышек отделений под-
ключения кабелей.  

2. Убедитесь, что подключение кабелей преобразователя соответст-
вует спецификациям, и что оплетки кабелей правильно заземлены. 

3. Убедитесь в правильности заземления сенсора и преобразователя.  

4. Проверьте наличие источников сильных электромагнитных помех 
и, при необходимости, переместите преобразователь и кабели. 
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код аларма Сообщение со-
стояния 

Рекомендованные действия 

А016 Ошибка сенсора 
RTD 

Сопротивление сенсора RTD вне пределов диапазона. 

1. Проверьте кабель между сенсором и преобразователем. 

a. Убедитесь, что подключение сенсора к преобразователю проведе-
но в соответствии с инструкциями руководства по установке на 
Ваш преобразователь. Выполняйте все требования по безопасно-
сти при открытии отделений подключения кабелей. 

b. Убедитесь, что проводники имеют хороший контакт с клеммами. 

c. Проведите тест сопротивлений RTD (термосопротивления)  и 
убедитесь в отсутствии короткого замыкания. (См. Раздел 
12.28.1). 

d. Убедитесь в целостности всех проводников кабеля сенсор-
преобразователь. 

2. Сравните условия процесса со значениями, отображаемыми расходо-
мером.  

3. Свяжитесь с Micro Motion. 

А017 Ошибка RTD сен-
сора Т-Серии 

Сопротивление сенсора RTD вне пределов диапазона. 

1. Проверьте кабель между сенсором и преобразователем. 

a. Убедитесь, что подключение сенсора к преобразователю проведе-
но в соответствии с инструкциями руководства по установке на 
Ваш преобразователь. Выполняйте все требования по безопасно-
сти при открытии отделений подключения кабелей. 

b. Убедитесь, что проводники имеют хороший контакт с клеммами. 

c. Проведите тест сопротивлений RTD (термосопротивления)  и 
убедитесь в отсутствии короткого замыкания. (См. Раздел 
12.28.1). 

d. Убедитесь в целостности всех проводников кабеля сенсор-
преобразователь. 

2. Сравните условия процесса со значениями, отображаемыми расходо-
мером. Температура должна быть от -200°F до +400°F. 

3. Проверьте, что все параметры характеризации соответствуют данным 
на табличке сенсора. 

4. Свяжитесь с Micro Motion. 

А018 Ошибка EEPROM 
(преобразователь) 

Выключение-включение питания преобразователя должно сбросить этот 
аларм. 

1. Проверьте правильность установки всех крышек отделений подклю-
чения кабелей.  

2. Убедитесь, что подключение кабелей преобразователя соответствует 
спецификациям, и что оплетки кабелей правильно заземлены. 

3. Убедитесь в правильности заземления сенсора и преобразователя.  

4. Проверьте наличие источников сильных электромагнитных помех и, 
при необходимости, переместите преобразователь и кабели.  

5. Выключите-включите питание преобразователя.  

6. Если условия аларма не исчезли, замените преобразователь.  
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код аларма Сообщение состояния Рекомендованные действия 

А019 Ошибка RAM (Преобразо-
ватель) 

Выключение-включение питания преобразователя должно сбро-
сить этот аларм. 

1. Проверьте правильность установки всех крышек отделений 
подключения кабелей.  

2. Убедитесь, что подключение кабелей преобразователя соот-
ветствует спецификациям, и что оплетки кабелей правильно 
заземлены. 

3. Убедитесь в правильности заземления сенсора и преобразова-
теля.  

4. Проверьте наличие источников сильных электромагнитных 
помех и, при необходимости, переместите преобразователь и 
кабели.  

5. Выключите-включите питание преобразователя.  

6. Если условия аларма не исчезли, замените преобразователь.  

А020 Нет калибровочного коэф-
фициента расхода 

Калибровочный коэффициент расхода и/или К1 не введены после 
последнего общего сброса. Проверьте, что все параметры харак-
теризации соответствуют данным на табличке сенсора. Если про-
блема не исчезла: 

1. Проверьте, что параметр тип сенсора выбран правильно 
(curved или straight – с кривыми трубками или прямотруб-
ный). 

2. Если это сенсор с кривыми трубками, убедитесь, что калиб-
ровочные параметры “Т-Серии” не были введены. 

А021 Неправильный тип сенсора 
(K1) 

Сенсор распознаётся как прямотрубный, а значение К1 указывает 
на кривотрубный сенсор, или наоборот. Проверьте, что все пара-
метры характеризации соответствуют данным на табличке сенсо-
ра. Если проблема не исчезла: 

1. Проверьте, что параметр тип сенсора выбран правильно 
(curved или straight – с кривыми трубками или прямотруб-
ный). 

2. Если это сенсор с кривыми трубками, убедитесь, что калиб-
ровочные параметры “Т-Серии” не были введены.   

3. Если этот аларм сопровождается алармом А006, проверьте 
сопротивление компенсационного провода и короткое замы-
кание на корпус (Раздел 12.28.1). 

A022 Неисправность базы данных 
конфигурации (Базовый 
процессор) 

Попробуйте выключить-включить питание расходомера. Если 
ошибка не исчезнет, замените базовый процессор. 

A023 Неисправность внутренних 
сумматоров 
(Базовый процессор) 

Попробуйте выключить-включить питание расходомера. Если 
ошибка не исчезнет, замените базовый процессор. 

A024 Программная Ошибка (Ба-
зовый процессор) 

Попробуйте выключить-включить питание расходомера. Если 
ошибка не исчезнет, замените базовый процессор. 

A025 Ошибка загрузочного сек-
тора (Базовый процессор) 

Попробуйте выключить-включить питание расходомера. Если 
ошибка не исчезнет, замените базовый процессор. 
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код аларма Сообщение состояния Рекомендованные действия 

A026 Ошибка коммуникации сен-
сор-преобразователь 

Потеря связи преобразователя с базовым процессором. Этот 
аларм указывает на возможную проблему с преобразователем или 
базовым процессором, требующую замены одной или обеих час-
тей. 

1. Проверьте кабель между сенсором и преобразователем. 

a. Убедитесь, что подключение сенсора к преобразователю 
проведено в соответствии с инструкциями руководства по 
установке на Ваш преобразователь. Выполняйте все тре-
бования по безопасности при открытии отделений под-
ключения кабелей. 

b. Убедитесь, что проводники имеют хороший контакт с 
клеммами. 

c. Проведите тест сопротивлений RTD (термосопротивле-
ния)  и убедитесь в отсутствии короткого замыкания. 
(См. Раздел 12.28.1). 

d. Убедитесь в целостности всех проводников кабеля сен-
сор-преобразователь. 

2. Проверьте светодиод базового процессора.  

3. Если не удалось определить причины неисправности, замени-
те базовый процессор. 

a. Если ошибка не исчезла, установите оригинальный базо-
вый процессор и замените преобразователь. 

b. Если ошибка не исчезла, замените и базовый процессор и 
преобразователь. 

A027 Нарушение защиты 1. Проверьте HART ID устройства. 

2. Преобразователь содержит функцию коммерческого учёта, в 
данный момент установленную в значение “unsecure”. Для 
сброса аларма, установите преобразователь в режим защиты 
(“secure”). Для восстановления режима безопасности может 
потребоваться соответствующая процедура. 

A028 Ошибка записи базового 
процессора 

Ошибка электроники преобразователя. Если после выключения-
включения питания расходомера ошибка не исчезла, замените 
базовый процессор. 

A029 PIC/Ошибка коммуникации 
дочерней платы 

Этот аларм указывает на возможность ошибки коммуникации 
между преобразователем и модулем дисплея. Для устранения 
ошибки попробуйте выключить-включить питание расходомера. 
При возможности, замените модуль дисплея. 

A030 Неправильный тип платы ПО или конфигурация, загруженные в преобразователь несовмес-
тимы с типом платы. Если этот аларм возник в результате загруз-
ки конфигурации в преобразователь, убедитесь, что модель пре-
образователя соответствует загружаемой конфигурации. 

Если в результате выключения-включения питания расходомера 
ошибка не исчезла, свяжитесь с Micro Motion для получения до-
полнительной помощи. 
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код аларма Сообщение состояния Рекомендованные действия 

A031 Недостаточное питание Питание базового процессора недостаточно. Проверьте питание 
преобразователя и кабель питания между преобразователем и ба-
зовым процессором. Для сброса данного аларма необходимо вы-
ключить-включить питание преобразователя. 

1. Убедитесь, что подключение сенсора к преобразователю про-
ведено в соответствии с инструкциями руководства по уста-
новке на Ваш преобразователь. Выполняйте все требования 
по безопасности при открытии отделений подключения кабе-
лей.  

2. Убедитесь, что проводники имеют хороший контакт с клем-
мами.  

3. Убедитесь в целостности всех проводников кабеля сенсор-
преобразователь.  

4. Выключите-включите питание расходомера и повторите про-
цедуру.  

5. Измерьте напряжение на клеммах базового процессора. По-
стоянно должно быть минимум 11.5 В. 

a. Если напряжение менее 11.5 В, убедитесь в том, что пре-
образователь получает достаточное питание. (обратитесь 
к руководству по установке преобразователя).  

b.  Если преобразователь получает достаточное питание, а 
ошибка не исчезает, замените преобразователь. 

A032 Идет контроль метрологи-
ческих характеристик: вы-
ходы в состоянии при 
ошибке 

Идет процедура контроля метрологических характеристик с вы-
ходами, установленными в состояние Fault (ошибка) или Last 
Measured Value (последнее действительное измеренное значение). 

A033 Недостаточный уровень 
сигнала на правой / левой 
детекторной катушке 

Сигнал, приходящий от детекторных катушек сенсора, недоста-
точен, что предполагает, что трубки сенсора не колеблются с соб-
ственной частотой. Этот аларм часто появляется в паре с алармом 
A102. 

1. Проверьте возможность расслоения жидкости, наблюдая за 
значением плотности и сравнивая результаты с ожидаемыми 
значениями плотности.  

2. Проверьте возможность закупоривания трубок, отложений на 
них или пробкового течения.  

3. Постороннее включение от двух- или трехфазного потока 
могут вызвать появление этого аларма, даже при заполнен-
ных трубках сенсора. Это может означать необходимость пе-
реориентации сенсора. Обратитесь к руководству по установ-
ке сенсора за дополнительными рекомендациями. 

A035 Прерывание процедуры 
контроля метрологических 
характеристик 

Тест контроля метрологических характеристик не был завершен. 
Возможно, он был прерван вручную. 

1. Убедитесь в стабильности процесса, затем запустите тест 
вновь.  

2. Свяжитесь с Mocro Motion. 
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код 
аларма 

Сообщение со-
стояния 

Рекомендованные действия 

A100 Насыщение перво-
го мА выхода 

Рассчитанное значение мА выхода находится за пределами сконфигурирован-
ного диапазона. 
1. Проверьте параметры Верхняя Граница Диапазона (URV) и Нижняя Гра-

ница Диапазона (LRV). Они правильны? 
2. Сравните условия процесса со значениями, отображаемыми расходомером. 
3. Убедитесь в правильности конфигурирования единиц измерения для Ва-

шего приложения.  
4. Продуйте трубки расходомера.  
5. Проверьте условия процесса, обратив особое внимание на воздух в труб-

ках сенсора, заполненность трубок сенсора, наличие посторонних мате-
риалов в трубках сенсора и отложения на трубках сенсора.  

A101 мА выход 1 зафик-
сирован 

Сконфигурирован ненулевой адрес HART или мА выход сконфигурирован на 
постоянное значение. 
1. Проверьте, не находится ли выход в режиме тестирования контура. Если 

да, расфиксируйте выход.  
2. Если применимо, выйдите из режима подстройки мА выхода.  
3. Проверьте адрес опроса HART.  
4. Проверьте, не установлен ли выход на постоянное значение по цифровой 

коммуникации.  
A102 Превышение уров-

ня сигнала на воз-
буждающей ка-
тушке 

Питание возбуждающей катушки (ток / напряжение) находится на максималь-
ном значении. 
1. Проверьте уровень сигнала на возбуждающей катушке и напряжение на 

детекторных катушках.  
2. Проверьте на короткое замыкание между клеммами сенсора или между 

клеммами сенсора и корпусом сенсора.  
3. Проверьте, что трубки сенсора заполнены жидкостью, убедитесь в отсут-

ствии посторонних материалов, деформации трубок или большого содер-
жания воздуха.  

4. Постороннее включение от двух- или трехфазного потока могут вызвать 
появление этого аларма, даже при заполненных трубках сенсора. Это мо-
жет означать необходимость переориентации сенсора. Обратитесь к руко-
водству по установке сенсора за дополнительными рекомендациями.  

A103 Возможна потеря 
данных (суммато-
ры и инвентариза-
торы) 

Значения сумматоров сохраняются неправильно. Базовый процессор не может 
сохранять значения сумматоров после последнего выключения питания и ис-
пользует последнее сохраненное значение. Сохраненные значения сумматоров 
могут отличаться от действительных до двух часов. 

1. Убедитесь в достаточности питания преобразователя и базового процессо-
ра.  

2. Проверьте блок питания и кабель блока питания.  

A104 Идет калибровка Идет процедура калибровки. 

A105 Пробковое течение Плотность рабочей жидкости выходит за пределы определенных пользовате-
лем границ. Убедитесь в отсутствии пробкового течения (двухфазного потока). 

A106 Разрешен пакет-
ный режим 

Пакетный режим HART разрешен. 

A107 Произошло отклю-
чение питания 

Преобразователь был перезапущен. 

A108 Базовое событие 1 
вкл. 

Действий не требуется. 

A109 Базовое событие 2 
вкл. 

Действий не требуется. 
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код 
аларма 

Сообщение состояния Рекомендованные действия 

A110 Насыщение частотного 
выхода 

Рассчитанное значение частотного выхода находится за пределами сконфигу-
рированного диапазона. 
1. Проверьте параметр Frequency Output Scaling Method (метод масштабирова-

ния частотного выхода). 

2. Сравните условия процесса со значениями, отображаемыми расходоме-
ром.  

3. Проверьте условия процесса, обратив особое внимание на воздух в труб-
ках сенсора, заполненность трубок сенсора, наличие посторонних мате-
риалов в трубках сенсора и отложения на трубках сенсора.  

4. Убедитесь в правильности конфигурирования единиц измерения для Ва-
шего приложения.   

5. Продуйте трубки расходомера.   

A111 Частотный выход за-
фиксирован 

Частотный  выход сконфигурирован на постоянное значение. 
1. Остановка сумматоров установит частотный выход в значение ноль. Вы-

ключение-включение питания преобразователя или перезапуск суммато-
ров восстановит нормальную работу частотного выхода.  

2. Проверьте не находится ли выход в режиме тестирования контура. Если 
да, расфиксируйте выход.  

3. Проверьте, не установлен ли выход на постоянное значение по цифровой 
коммуникации.  

A112 Обновите ПО преобра-
зователя 

Свяжитесь с Micro Motion. 

A113 Насыщение мА выхода 
2 

1. Сравните условия процесса со значениями, отображаемыми расходоме-
ром.  

2. Проверьте условия процесса, обратив особое внимание на воздух в труб-
ках сенсора, заполненность трубок сенсора, наличие посторонних мате-
риалов в трубках сенсора и отложения на трубках сенсора.  

3. Убедитесь в правильности конфигурирования единиц измерения для Ва-
шего приложения.   

4. Продуйте трубки расходомера.  

5. Проверьте параметры Верхняя Граница Диапазона (URV) и Нижняя Гра-
ница Диапазона (LRV). Они правильны?  

A114 мА выход 2 зафикси-
рован 

1. Проверьте, не находится ли выход в режиме тестирования контура. Если 
да, расфиксируйте выход. 

2. Если применимо, выйдите из режима подстройки мА выхода.  

3. Проверьте, не установлен ли выход на постоянное значение по цифровой 
коммуникации.  

A115 Отсутствие внешнего 
ввода или опрашивае-
мых данных 

Ошибка HART коммуникации с внешним устройством. Нет ответа от опра-
шиваемого устройства. 

1. Проверьте работу внешнего устройства.  

2. Проверьте кабель между преобразователем и внешним устройством.  

3. Проверьте конфигурацию HART-опроса.  

A116 Температура вне пре-
делов диапазона (изме-
рение нефтепродуктов 
по API) 

1. Сравните условия процесса со значениями, отображаемыми расходоме-
ром.   

2. Проверьте конфигурацию типа таблицы измерения нефтепродуктов по 
API и температуры.  
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Таблица 12-2:     Тревожные сообщения состояния и рекомендованные действия (продолжение) 

Код аларма Сообщение состояния Рекомендованные действия 

A117 Плотность вне пределов 
диапазона (измерение 
нефтепродуктов по API) 

1. Сравните условия процесса со значениями, отображаемыми 
расходомером.   

2. Проверьте конфигурацию типа таблицы измерения нефте-
продуктов по API и плотности.  

A118 Дискретный выход 1 
зафиксирован 

Дискретный выход сконфигурирован на постоянное значение. 

A120 Ошибка несоответствия 
данных (измерение кон-
центрации) 

Проверьте конфигурацию приложения измерения концентрации. 

A121 Ошибка экстраполяции 
(измерение концентра-
ции) 

Если температурные или плотностные свойства продукта, нахо-
дящегося в сенсоре, находятся вне пределов параметров, опреде-
ленных кривой измерения концентрации, то это симптом, не тре-
бующий никаких действий. Аларм должен сброситься, когда па-
раметры рабочей жидкости вернутся к нормальным условиям. 

Если ошибка сохраняется, проверьте конфигурацию приложения 
измерения концентрации. 

A131 Идет процесс контроля 
метрологических харак-
теристик: выходы уста-
новлены на последнее 
действительное изме-
ренное значение 

Идет процесс контроля метрологических характеристик. Выходы 
установлены на Last Measured Value. 

A132 Имитация сенсора ак-
тивна 

Имитация сенсора разрешена 

A133 Ошибка IIPROM (дис-
плей) 

Замените модуль дисплея. Если ошибка сохраняется, свяжитесь с 
Micro Motion. 

A141 DDC триггер(ы) завер-
шены 

Действий не требуется 

Не применимо Идет калибровка FD  Действий не требуется 

Не применимо Идет калибровка D1  Действий не требуется 

Не применимо Идет калибровка D2  Действий не требуется 

Не применимо Идет калибровка D3  Действий не требуется 

Не применимо Идет калибровка D4  Действий не требуется 

Не применимо Идет калибровка нуля  Действий не требуется 

Не применимо Обратный расход Действий не требуется 
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12.3 Проблемы, возникающие при измерении расхода 
 

Таблица 12-3:     Проблемы, возникающие при измерении расхода и рекомендованные действия  

Проблема Причина Рекомендованные действия 

Ненулевой расход 
при отсутствии по-
тока или уход нуля 

• Несоосность трубопро-
вода (особенно в новых 
установках) 

• Открытый или подте-
кающий клапан 

• Неправильно установ-
ленный ноль сенсора 

• Проверьте, что все параметры характеризации со-
ответствуют данным на табличке сенсора. 

• Если показания расхода не слишком высоки, про-
верьте значение нуля. Возможно, Вам понадобится 
восстановить заводское значение. 

• Проверьте состояние клапана и уплотнений. 

• Устраните монтажные напряжения в сенсоре (на-
пример, использование сенсора в качестве опоры 
трубопровода, несоосность трубопровода). 

• Свяжитесь с Micro Motion. 

Беспорядочный не-
нулевой расход при 
отсутствии потока 

• Протечки клапана или 
уплотнений 

• Пробковое течение 

• Закупоренность трубок 
или отложения на них 

• Неправильная ориента-
ция сенсора 

• Проблемы с подключе-
нием кабелей 

• Вибрации трубопровода 
с частотой близкой к 
частоте колебаний тру-
бок сенсора 

• Слишком низкое значе-
ние демпфирования 

• Монтажные напряжения 
в сенсоре 

 

• Ориентация сенсора должна соответствовать реко-
мендациям Руководства по установке сенсора. 

• Проверьте уровень сигнала на возбуждающей ка-
тушке и напряжение на детекторных катушках. См. 
Раздел 12.26 и Раздел 12.27. 

• Если кабель между сенсором и преобразователем 
включает 9-типроводный сегмент, убедитесь в пра-
вильности заземления экранирующих проводников. 

• Проверьте кабель между сенсором и преобразова-
телем. См. Раздел 12.10. 

• Для сенсоров с клеммной коробкой убедитесь в 
отсутствии влаги в ней. 

• Продуйте трубки сенсора. 

• Проверьте состояние клапана и уплотнений. 

• Устраните источники вибрации.  

• Проверьте конфигурацию параметра демпфирова-
ния.  

• Убедитесь в правильности конфигурирования еди-
ниц измерения.  

• Проверьте условия пробкового течения. См. Раздел 
12.25.  

• Проверьте наличие радиочастотных помех. См. 
Раздел 12.25.  

• Свяжитесь с Micro Motion. 
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Таблица 12-3:     Проблемы, возникающие при измерении расхода и рекомендованные действия (продол-
жение) 

Проблема Причина Рекомендованные действия 

Беспорядочный не-
нулевой расход при 
постоянном потоке 

• Пробковое течение 

• Слишком низкое значе-
ние демпфирования 

• Закупоренность трубок 
или отложения на них 

• Проблемы с подключе-
нием выходных кабелей  

• Проблемы с приёмным 
устройством 

• Проблемы с подключе-
нием кабелей 

 

• Проверьте кабель между сенсором и преобразова-
телем. См. Раздел 12.10. 

• Убедитесь в правильности конфигурирования еди-
ниц измерения.  

• Проверьте, что все параметры характеризации со-
ответствуют данным на табличке сенсора. 

• Проведите тест с ёмкостью для контроля суммы 
партии. 

• Установите ноль расходомера. 

• Проверьте заземление. См. Раздел 12.11. 

• Проверьте условия пробкового течения. См. Раздел 
12.25. 

• Проверьте приёмное устройство и кабель между 
приёмным устройством и преобразователем. 

• Проверьте сопротивление катушек сенсора и от-
сутствие короткого замыкания на корпус. См. Раз-
дел 12.28.1. 

• Замените базовый процессор или преобразователь. 

 

Неточные показа-
ния расхода или 
суммы партии 

• Проблемы с подключе-
нием кабелей 

• Неподходящие единицы 
измерения 

• Неправильный калибро-
вочный коэффициент по 
расходу  

• Неправильный М-
фактор. 

• Неправильные калибро-
вочные коэффициенты 
по плотности. 

• Неправильное заземле-
ние расходомера. 

• Пробковое течение. 

• Проблемы с приёмным 
устройством  

 

• Проверьте кабель между сенсором и преобразова-
телем. См. Раздел 12.10. 

• Убедитесь в правильности конфигурирования еди-
ниц измерения Вашего применения  

• Проверьте, что все параметры характеризации со-
ответствуют данным на табличке сенсора.  

• Проведите тест с ёмкостью для проверки суммы 
партии.  

• Установите ноль расходомера.  

• Проверьте заземление. См. Раздел 12.11.  

• Проверьте условия пробкового течения. См. Раздел 
12.25.  

• Проверьте приёмное устройство и кабель между 
приёмным устройством и преобразователем.  

• Проверьте сопротивление катушек сенсора и нали-
чие короткого замыкания на корпус. См. Раздел 
12.28.1.  

• Замените базовый процессор или преобразователь.  
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12.4 Проблемы, возникающие при измерении 
плотности 

 

Таблица 12-4:     Проблемы, возникающие при измерении плотности и рекомендованные действия  

Проблема Причина Рекомендованные действия 

Неточные 
показания 
плотности 

• Технологические проблемы (ра-
бочая жидкость) 

• Неправильные калибровочные 
коэффициенты по плотности. 

• Проблемы с подключением кабе-
лей  

• Неправильное заземление расхо-
домера  

• Пробковое течение  

• Закупоренность трубок или от-
ложения на них  

• Неправильная ориентация сенсо-
ра  

• Ошибка термосопротивления 
RTD  

• Изменение физических характе-
ристик сенсора 

• Проверьте кабель между сенсором и преобразова-
телем. См. Раздел 12.10.  

• Проверьте заземление. См. Раздел 12.11.   

• Сравните условия процесса со значениями, ото-
бражаемыми расходомером.   

• Проверьте, что все параметры характеризации со-
ответствуют данным на табличке сенсора.  

• Проверьте условия пробкового течения. См. Раздел 
12.25.  

• Если два сенсора с близкими частотами находятся 
рядом друг с другом, разнесите их.  

• Продуйте трубки сенсора.  

 

 

Необычно 
высокие 
показания 
плотности 

• Закупоренность трубок или от-
ложения на них  

• Неправильный коэффициент К2  

• Неправильное измерение темпе-
ратуры  

• Проблемы с термосопротивлени-
ем RTD  

• Для сенсоров с высокой частотой 
колебания трубок, это может 
свидетельствовать об эрозии или 
коррозии  

• Для сенсоров с низкой частотой 
колебания трубок, это может 
свидетельствовать об их загряз-
нении 

• Проверьте, что все параметры характеризации со-
ответствуют данным на табличке сенсора.   

• Продуйте трубки сенсора.   

• Убедитесь в отсутствии отложений на трубках сен-
сора.  

 

Необычно 
низкие по-
казания 
плотности 

• Пробковое течение  

• Неправильный коэффициент К2  

• Для сенсоров с низкой частотой 
колебания трубок, это может 
свидетельствовать об эрозии или 
коррозии 

 

• Сравните условия процесса со значениями, ото-
бражаемыми расходомером.   

• Проверьте, что все параметры характеризации со-
ответствуют данным на табличке сенсора.  

• Проверьте кабель между сенсором и преобразова-
телем. См. Раздел 12.10.   

• Убедитесь в отсутствии эрозии трубок сенсора, 
особенно, если жидкость абразивна.  
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12.5 Проблемы, возникающие при измерении 
температуры 

 

Таблица 12-5:     Проблемы, возникающие при измерении температуры и рекомендованные действия  

Проблема Причина Рекомендованные действия 

Показания темпе-
ратуры значитель-
но отличаются от 
температуры про-
цесса 

• Ошибка 
термосопротивления
RTD  

• Проблемы с под-
ключением кабелей  

 

• Убедитесь в отсутствии влаги или ярь-медянки в соеди-
нительной коробке.  

• Проверьте сопротивление термосопротивления RTD и 
наличие короткого замыкания на корпус. См. Раздел 
12.28.1.   

• Убедитесь в совпадении температурного калибровочно-
го коэффициента со значением на сенсорной табличке.  

• Проверьте, нет ли алармов (особенно алармов, связан-
ных с RTD).   

• Отключите внешнюю компенсацию по температуре.  

• Проверьте калибровку по температуре. 

• Проверьте кабель между сенсором и преобразователем. 
См. Раздел 12.10.   

 

Показания темпе-
ратуры незначи-
тельно отличаются 
от температуры 
процесса 

• Температурный сен-
сор не достиг равно-
весного состояния  

• Утечка тепла от сен-
сора  

 

• Спецификация точности RTD ± 1°С. Если отклонение 
показаний внутри этого диапазона, проблем нет. Если 
измерение температуры вне пределов спецификации, 
свяжитесь с Micro Motion. 

• Температура жидкости может быстро изменяться. Дож-
дитесь достижения сенсором равновесного состояния.  

• При необходимости, изолируйте сенсор.  

• Проверьте сопротивление термосопротивления RTD и 
наличие короткого замыкания на корпус. См. Раздел 
12.28.1.   

• Возможен плохой контакт RTD и сенсора. В этом случае 
сенсор придётся заменить.  
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12.6 Проблемы с миллиамперным выходом 
 

Таблица 12-6:     Проблемы с миллиамперным выходом и рекомендованные действия  

Проблема Причина Рекомендованные действия 

Отсутствие 
мА выхода 

• Проблемы с подключением кабелей  

• Ошибка контура  

• Канал не сконфигурирован на желаемую 
переменную  

 

• Проверьте блок питания и кабель блока 
питания. См. Раздел 12.9.  

• Проверьте кабель мА выхода.  

• Проверьте конфигурацию выходов при 
ошибке. См. Раздел 12.19.  

• Проверьте напряжение на клеммах выхо-
да, чтобы убедиться в го  активности.  

• Свяжитесь с Micro Motion.  

Ошибка теста 
контура 

• Проблемы с блоком питания 

• Проблемы с подключением кабелей  

• Ошибка контура  

• Канал не сконфигурирован на желаемую 
переменную  

• Неправильная конфигурация параметра 
внутреннее/внешнее питание 

• Проверьте блок питания и кабель блока 
питания. См. Раздел 12.9.  

• Проверьте кабель мА выхода.  

• Проверьте конфигурацию выходов при 
ошибке. См. Раздел 12.19.  

• Свяжитесь с Micro Motion.  

Значение мА 
выхода ниже 
4 мА 

• Обрыв в кабеле 

• Ошибка выходного контура  

• Значение переменной ниже нижней гра-
ницы диапазона (LRV)  

• Неправильные значения границ диапа-
зона (LRV и URV)   

• Условия ошибки, если действие при 
ошибке установлено на internal zero или 
downscale  

• Ошибка приёмного мА устройства  

• Сравните условия процесса со значения-
ми, отображаемыми расходомером.   

• Проверьте приёмное устройство и кабель 
между преобразователем и приёмным 
устройством.  

• Проверьте значения Upper Range Value и 
Lower Range Value. См. Раздел 12.18.   

• Проверьте конфигурацию выходов при 
ошибке. См. Раздел 12.19.   

 

Постоянное 
значение мА 
выхода  

• Ошибка в назначении переменной вы-
ходу 

• Присутствуют условия ошибки  

• Ненулевой адрес HART(1-ый мА выход)  

• Выход сконфигурирован в тестирование 
контура  

• Ошибка калибровки нуля  

• Проверьте назначение выходных пере-
менных.  

• Просмотрите и устраните условия суще-
ствующих тревожных сообщений.  

• Проверьте адрес HART и Loop Current 
Mode. См. Раздел 12.15.   

• Проверьте, не идёт ли тест контура (вы-
ход зафиксирован).  

• Проверьте конфигурацию пакетного ре-
жима HART. См. Раздел 12.16.  

• Если ошибка связана с ошибкой калиб-
ровки нуля, выключите-включите пита-
ние расходомера и повторите процедуру 
установки нуля.  
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Таблица 12-6:     Проблемы с миллиамперным выходом и рекомендованные действия (продолжение) 

Проблема Причина Рекомендованные действия 

Значение мА 
выхода посто-
янно за преде-
лами диапазо-
на 

• Неправильное назначение пере-
менной или единиц измерения 
выходу 

• Условия ошибки, если действие 
при ошибке установлено на up-
scale или downscale 

• Неправильные значения границ 
диапазона (LRV и URV)   

 

• Проверьте назначение выходных переменных. 

• Проверьте конфигурацию единиц измерения вы-
ходных переменных.  

• Проверьте конфигурацию выходов при ошибке. 
См. Раздел 12.19.   

• Проверьте значения Upper Range Value и Lower 
Range Value. См. Раздел 12.18.    

• Проверьте подстройку мА выхода.. См. Раздел 
12.17.  

 

Постоянно 
неправильное 
значение мА 
выхода 

• Проблемы контура 

• Неправильная подстройка кон-
тура  

• Неправильная конфигурация 
единиц измерения расхода  

• Неправильная конфигурация 
переменной  

• Неправильные значения границ 
диапазона (LRV и URV)  

 

• Проверьте подстройку мА выхода.. См. Раздел 
12.17.  

• Проверьте конфигурацию единиц измерения пе-
ременных.  

• Проверьте назначение переменной мА выходу. 

•  Проверьте значения Upper Range Value и Lower 
Range Value. См. Раздел 12.18.  

 

 

Значение мА 
выхода пра-
вильное при 
малых значе-
ниях тока и 
неправильное 
при больших 

• Возможно, слишком большое 
сопротивление мА контура 

• Убедитесь, что сопротивление контура мА выхо-
да ниже максимально допустимого значения (см. 
Руководство по установке на Ваш преобразова-
тель).  

 

12.7 Проблемы с частотным выходом 
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Таблица 12-7:     Проблемы с частотным выходом и рекомендованные действия  

Проблема Причина Рекомендованные действия 

Нет частотного вы-
хода 

• Остановлены сумматоры  

• Условия процесса ниже отсечки  

• Условие ошибки, если действие при 
ошибке установлено на Internal zero 
или downscale  

• Пробковое течение  

• Направление потока противопо-
ложно сконфигурированному пара-
метру направления потока  

• Ошибка приёмного частотного уст-
ройства  

• Уровень выхода не совместим с 
приёмным устройством 

• Ошибка выходного контура  

• Неправильная конфигурация пара-
метра внутреннее/внешнее питание  

• Неправильная конфигурация шири-
ны импульса  

• Выход не запитан  

• Проблемы с подключением кабелей  

• Проверьте не находятся ли условия процесса ни-
же отсечки. При необходимости, переконфигури-
руйте значение отсечки.  

• Проверьте конфигурацию выходов при ошибке. 
См. Раздел 12.19.   

• Проверьте, не остановлены ли сумматоры. При 
остановленных сумматорах частотный выход 
блокируется.  

• Проверьте условия пробкового течения. См. Раз-
дел 12.25.   

• Проверьте направление потока. См. Раздел 12.23.   

• Проверьте приёмное устройство и кабель между 
преобразователем и приёмным устройством.   

• Проверьте, что канал сконфигурирован как час-
тотный выход.  

• Проверьте конфигурацию питания частотного 
выхода (внутреннее/внешнее).  

• Проверьте значение ширины импульса. См. Раз-
дел 12.20.  

• Проведите тест контура. См. Раздел 12.12.   

 

Постоянно непра-
вильное значение 
частотного выхода 

• Неправильный масштаб выхода  

• Неправильная конфигурация еди-
ниц измерения расхода  

• Проверьте масштаб частотного выхода. См. . Раз-
дел 12.21.  

• Проверьте правильность конфигурации единиц 
измерения расхода 

Непредсказуемое 
значение частотного 
выхода 

• Радиочастотная интерференция  • Проверьте наличие радиочастотной интерферен-
ции. См. Раздел 12.13.  

 

12.8 Использование режима имитации сенсора для 
поиска и устранения неисправностей 

 

При включённом режиме имитации преобразователь отображает определённые пользователем 
значения для массового расхода, температуры и плотности. Это позволяет Вам воспроизвести 
различные условия процесса или протестировать систему. 

Имитация сенсора может помочь различить допустимый шум процесса и внешнюю вибрацию. 
Например, представьте приёмное устройство, отображающее непредсказуемые значения рас-
хода. При включённом режиме имитации, и расходе, не совпадающем с имитируемым значе-
нием, источник проблемы, скорее всего, находится где-то между преобразователем и приём-
ным устройством.  

Важно 

Если режим имитации активен, имитируемые значения используются на всех выходах и во 
всех вычислениях, включая сумматоры и инвентаризаторы, объёмный расход и концентрацию. 
Отключите все автоматические функции, связанные с выходами преобразователя и переведите 
контур в режим ручного управления. Соответственно, не используйте режим имитации, если 
Ваш процесс не разрешает этих эффектов, и не забудьте выключить (заблокировать) режим 
имитации по завершению тестирования. 
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Дополнительная информация об использовании режима имитации с помощью ProLink II 
содержится в Разделе 7.1. 

12.9 Проверка подключения кабелей питания 
 

Если кабель питания неисправен или неправильно подключён, преобразователю может не хва-
тить питания для нормального функционирования. 

Предварительные требования 

Воспользуйтесь руководством по установке преобразователя. 

Процедура 

1. Перед проверкой кабеля питания, отключите источник питания.  

 

 ПРЕДУПРЕЖДЕНИЕ! 

Если преобразователь находится в опасной зоне, подождите пять минут после от-
ключения питания. 

 

2. Проверьте правильность используемого предохранителя. Неправильный предохранитель 
может ограничить ток преобразователя и воспрепятствовать его инициализации.  

3. Убедитесь в том, что провода источника питания подсоединены к соответствующим 
клеммам.   

4. Проверьте качество контакта проводов источника питания с клеммами питания.  

5. Посмотрите на табличку с указанием напряжения внутри отделения полевых подключе-
ний.  

Проверьте, что напряжение, подаваемое на преобразователь, соответствует значениям на-
пряжения, указанным на этой табличке  

6.  Вновь включите электропитание преобразователя. 

 

 ПРЕДУПРЕЖДЕНИЕ! 

 Если преобразователь находится в опасной зоне, не включайте питание преобразо-
вателя со снятой крышкой корпуса. Включение питание преобразователя со снятой 
крышкой корпуса может привести к взрыву. 

 

7. С помощью вольтметра проверьте напряжение на клеммах питания преобразователя. Убе-
дитесь в том, что оно находится в требуемых пределах. В случае постоянного питания, 
вам, возможно, придется изменить размер кабеля.  

 

 

 

12.10 Проверка подключения кабелей от сенсора к 
преобразователю 

 

При неправильном подключении или повреждении кабеля между сенсором и преобразовате-
лем может возникнуть множество проблем с питанием и с выходами. 
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Предварительные требования 

Воспользуйтесь руководством по установке преобразователя. 

Процедура 

1. Перед тем как открывать отделение подключения кабелей, отключите источник питания.  

 ПРЕДУПРЕЖДЕНИЕ! 

Если преобразователь находится в опасной зоне, подождите пять минут после от-
ключения питания. 

 

2. Убедитесь в том, что преобразователь соединен с сенсором в соответствии с инструкция-
ми по подключению кабелей, приведенными в руководстве по установке преобразователя.   

3. Убедитесь в том, что провода находятся в хорошем контакте с клеммами. 

4. Убедитесь в целостности всех проводов кабеля между сенсором и преобразователем. 

 

 

12.11 Проверка заземления 
 

Сенсор и преобразователь должны быть заземлены. Если базовый процессор смонтирован как 
часть преобразователя или сенсора, он заземляется автоматически. Если базовый процессор 
смонтирован отдельно, то и заземляется он отдельно. 

Предварительные требования 

Воспользуйтесь: 

• руководством по установке сенсора.  

• руководством по установке преобразователя.  

Процедура 

Требования и инструкции по заземлению содержатся в руководствах по установке сенсора и 
преобразователя. 

 

 

12.12 Проведение тестов контура 
 

Тестирование контура позволяет проверить правильность коммуникации преобразователя и 
удалённого устройства. 

 

12.12.1 Проведение тестов контура с помощью дисплея 
 

Предварительные требования 

Перед проведением теста контура, сконфигурируйте каналы на входы и выходы преобразова-
теля, которые будут использоваться в Вашем приложении. 
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Следуя установленным процедурам, убедитесь в том, что тестирование контура не повлияет на 
проводимые измерения и контуры регулирования. 

Процедура 

1. Тест мА выхода(ов).  

a. Выберите нижнее значение, то есть 4 мА.  

Когда выход зафиксирован, точки движутся по дисплею. 

b. Прочитайте мА ток на приёмном устройстве и сравните его с выходом преобразовате-
ля.  

Нет необходимости в точном совпадении считываемых значений. Если значения не-
много не совпадают, Вы сможете скорректировать различия при помощи подстройки 
выхода. 

c. На преобразователе активируйте Select. 

d. С помощью Scroll и Select выберите верхнее значение, то есть 20 мА. 

Когда выход зафиксирован, точки движутся по дисплею. 

e. Прочитайте мА ток на приёмном устройстве и сравните его с выходом преобразовате-
ля.  

Нет необходимости в точном совпадении считываемых значений. Если значения не-
много не совпадают, Вы сможете скорректировать различия при помощи подстройки 
выхода.  

f. На преобразователе активируйте Select.  

2. Тест частотного выхода(ов).  

a. Выберите OFFLINE MAINT > SIM > FO SIM, и выберите желаемое значение частотного 
выхода. 

Частотный выход может быть установлен в 1, 10 или 15 кГц. 

Примечание 

При установленном приложении коммерческого учёта проведение теста контура 
частотного выхода невозможно, даже при нахождении преобразователя в небезо-
пасном режиме (unsecured). 

 

Когда выход зафиксирован, точки движутся по дисплею. 

b. Прочитайте частотный сигнал на приёмном устройстве и сравните его с выходом пре-
образователя.  

c. На преобразователе активируйте Select.  

3. Тест дискретного выхода(ов).   

a. Выберите OFFLINE MAINT > SIM > DO SIM, и выберите SET ON. 

Когда выход зафиксирован, точки движутся по дисплею. 

b. Проверьте сигнал на приёмном устройстве.  

c. На преобразователе активируйте Select.  

d. С помощью Scroll, найдите и выберите SET OFF.  

e. Проверьте сигнал на приёмном устройстве.   

f. На преобразователе активируйте Select.   
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Дополнительная информация 

• Если показания мА выхода незначительно отличаются от значений, отображаемых на 
приёмном устройстве, Вы можете скорректировать это различие, подстроив выход.  

• Если показания мА выхода отличаются значительно (±200 мкА), или на каком-то шаге 
они оказались ошибочными, проверьте кабель между преобразователем и приёмным уст-
ройством, и попробуйте ещё раз. 

• Если показания дискретного выхода обратны, проверьте конфигурацию параметра Discrete 
Output Polarity. 

 

 

 

12.12.2 Проведение тестов контура с помощью ProLink II 
 

Предварительные требования 

Перед проведением теста контура, сконфигурируйте каналы на входы и выходы преобразова-
теля, которые будут использоваться в Вашем приложении. 

Следуя установленным процедурам, убедитесь в том, что тестирование контура не повлияет на 
проводимые измерения и контуры регулирования. 

ProLink II должен быть запущен и подключён к преобразователю.  

Процедура 

1. Протестируйте мА выход(ы).  

a. Выберите ProLink > Test > Fix Milliamp 1 или ProLink > Test > Fix Milliamp 2.  

b. В Set Output To введите 4 мА.  

c. Щёлкните кнопкой мыши по Fix mA.  

d. Прочитайте мА ток на приёмном устройстве и сравните его с выходом преобразовате-
ля.  

Нет необходимости в точном совпадении считываемых значений. Если значения не-
много не совпадают, Вы сможете скорректировать различия при помощи подстройки 
выхода.  

e. Щёлкните кнопкой мыши по UnFix mA.  

f. В Set Output To введите 20 мА.   

g. Щёлкните кнопкой мыши по Fix mA.  

h. Прочитайте мА ток на приёмном устройстве и сравните его с выходом преобразовате-
ля.  

Нет необходимости в точном совпадении считываемых значений. Если значения не-
много не совпадают, Вы сможете скорректировать различия при помощи подстройки 
выхода. 

i. Щёлкните кнопкой мыши по UnFix mA. 
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2. Протестируйте частотный выход(ы).   

Примечание 

При установленном приложении коммерческого учёта проведение теста контура час-
тотного выхода невозможно, даже при нахождении преобразователя в небезопасном 
режиме (unsecured). 

 

a. Выберите ProLink > Test > Fix Freq Out.  

b. В Set Output To введите значение частоты.  

c. Щёлкните кнопкой мыши по Fix Frequency.  

d. Прочитайте частотный сигнал на приёмном устройстве и сравните его с выходом пре-
образователя.   

e. Щёлкните кнопкой мыши по UnFix Freq. 

3. Протестируйте дискретный выход(ы).  

a. Выберите ProLink > Test > Fix Discrete Output.  

b. Выберите On.  

c. Проверьте сигнал на приёмном устройстве.  

d. Выберите Off.  

e. Проверьте сигнал на приёмном устройстве. 

f. Щёлкните кнопкой мыши по UnFix. 

 

Дополнительная информация 

• Если показания мА выхода незначительно отличаются от значений, отображаемых на 
приёмном устройстве, Вы можете скорректировать это различие, подстроив выход.  

• Если показания мА выхода отличаются значительно (±200 мкА), или на каком-то шаге 
они оказались ошибочными, проверьте кабель между преобразователем и приёмным уст-
ройством, и попробуйте ещё раз. 

• Если показания дискретного выхода обратны, проверьте конфигурацию параметра Discrete 
Output Polarity. 

 

 

12.12.3 Проведение тестов контура с помощью ProLink III 
 

Предварительные требования 

Перед проведением теста контура, сконфигурируйте каналы на входы и выходы преобразова-
теля, которые будут использоваться в Вашем приложении. 

Следуя установленным процедурам, убедитесь в том, что тестирование контура не повлияет на 
проводимые измерения и контуры регулирования. 

ProLink III должен быть запущен и подключён к преобразователю.   
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Процедура 

1. Протестируйте мА выход(ы).  

a. Выберите Device Tools > Diagnostics > Testing > mA Output 1 Test или  
Device Tools > Diagnostics > Testing > mA Output 2 Test. 

b. В Fix to: введите 4. 

c. Щёлкните кнопкой мыши по Fix mA.  

d. Прочитайте мА ток на приёмном устройстве и сравните его с выходом преобразовате-
ля.  

Нет необходимости в точном совпадении считываемых значений. Если значения не-
много не совпадают, Вы сможете скорректировать различия при помощи подстройки 
выхода.  

e. Щёлкните кнопкой мыши по UnFix mA.  

f. В Fix to: введите 20.  

g. Щёлкните кнопкой мыши по Fix mA.  

h. Прочитайте мА ток на приёмном устройстве и сравните его с выходом преобразовате-
ля.  

Нет необходимости в точном совпадении считываемых значений. Если значения не-
много не совпадают, Вы сможете скорректировать различия при помощи подстройки 
выхода.  

i. Щёлкните кнопкой мыши по UnFix mA. 

2. Протестируйте частотный выход(ы). 

Примечание 

При установленном приложении коммерческого учёта проведение теста контура час-
тотного выхода невозможно, даже при нахождении преобразователя в небезопасном 
режиме (unsecured). 

 

a. Выберите Device Tools > Diagnostics > Testing > Frequency Output Test.  

b. В Fix to: введите значение частоты выхода.  

c. Щёлкните кнопкой мыши по Fix FO.  

d. Прочитайте частотный сигнал на приёмном устройстве и сравните его с выходом пре-
образователя.   

e. Щёлкните кнопкой мыши по UnFix FO.  

3. Протестируйте дискретный выход(ы).  

a. Выберите Device Tools > Diagnostics > Testing > Discrete Output Test.  

b. В Fix To: введите ON. 

c. Проверьте сигнал на приёмном устройстве.  

d. В Fix To: введите OFF  

e. Проверьте сигнал на приёмном устройстве.  

f. Щёлкните кнопкой мыши по UnFix.  
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12.12.4 Проведение тестов контура с помощью Полевого 
коммуникатора 

 

Полезный совет 

Проведение тестов контуров не является обязательной процедурой. Однако Micro Motion ре-
комендует проводить тесты контуров для каждого входа и выхода, доступных на Вашем пре-
образователе. Входы и выходы на Вашем преобразователе различаются в зависимости от ус-
ловий заказа и конфигурации каналов. Нет необходимости в проведении всех тестов контуров, 
описанных ниже. 

Предварительные требования 

Перед проведением теста контура, сконфигурируйте каналы на входы и выходы преобразова-
теля, которые будут использоваться в Вашем приложении. 

Следуя установленным процедурам, убедитесь в том, что тестирование контура не повлияет на 
проводимые измерения и контуры регулирования.  

Процедура 

1. Протестируйте мА выход(ы).  

a. Выберите Service Tools > Simulate > Simulate Outputs > mA Output Loop Test и выберите 4 mA. 

b. Прочитайте мА ток на приёмном устройстве и сравните его с выходом преобразовате-
ля.  

Нет необходимости в точном совпадении считываемых значений. Если значения не-
много не совпадают, Вы сможете скорректировать различия при помощи подстройки 
выхода.  

c. Нажмите ОК.  

d. Выберите 20 mA.  

e. Прочитайте мА ток на приёмном устройстве и сравните его с выходом преобразовате-
ля.  

Нет необходимости в точном совпадении считываемых значений. Если значения не-
много не совпадают, Вы сможете скорректировать различия при помощи подстройки 
выхода. 

f. Нажмите ОК. 

g. Выберите End.  

2. Протестируйте частотный выход(ы).  

Примечание 

При установленном приложении коммерческого учёта проведение теста контура час-
тотного выхода невозможно, даже при нахождении преобразователя в небезопасном 
режиме (unsecured). 
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a. Выберите Service Tools > Simulate > Simulate Outputs > Frequency Output Test и выберите 
уровень частотного выхода. 

b. Прочитайте частотный сигнал на приёмном устройстве и сравните его с выходом пре-
образователя.  

c. Выберите End.  

3. Протестируйте дискретный выход(ы).  

a. Выберите Service Tools > Simulate > Simulate Outputs > Discrete Output Test.  

b. Выберите Off.  

c. Проверьте сигнал на приёмном устройстве.  

d. Нажмите ОК.  

e. Выберите On.  

f. Проверьте сигнал на приёмном устройстве.  

g. Нажмите ОК.  

h. Выберите End. 

 

Дополнительная информация 

• Если показания мА выхода незначительно отличаются от значений, отображаемых на 
приёмном устройстве, Вы можете скорректировать это различие, подстроив выход.  

• Если показания мА выхода отличаются значительно (±200 мкА), или на каком-то шаге 
они оказались ошибочными, проверьте кабель между преобразователем и приёмным уст-
ройством, и попробуйте ещё раз. 

• Если показания дискретного выхода обратны, проверьте конфигурацию параметра Discrete 
Output Polarity. 

 

 

12.13 Проверка радиочастотных помех (RFI) 
 

На частотный и дискретный выходы преобразователя могут влиять радиочастотные помехи 
(RFI). Возможными источниками помех могут быть источники радиосигнала, большие транс-
форматоры, насосы или двигатели, генерирующие сильное электромагнитное поле. Возможны 
различные методы уменьшения влияния помех. Воспользуйтесь одним или несколькими ни-
жеприведёнными предложениями, подходящими для Вашего применения. 

Процедура 

• Подавите источник помех.  

• Переместите преобразователь.  

• Используйте экранированный кабель для частотного или дискретного выхода. 

− Заземлите экран выходного кабеля со стороны приёмного устройства. Если это невоз-
можно, заземлите его через кабельный уплотнитель или фитинг кабелепровода. 

− Не заземляйте экран внутри отделения подключения кабелей. 

− Нет необходимости в 360º заземлении экрана. 
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12.14 Проверка контура HART 
 

Если Вы не можете установить или поддерживать коммуникацию HART, возможно контур 
HART подключён неправильно. 

Предварительные требования 

Вам понадобятся: 

• Руководство по установке на Ваш преобразователь.  

• Полевой Коммуникатор.  

• Необязательно: Руководство HART Application Guide, доступное на www.hartcomm.org  

 

Процедура 

1. Убедитесь, что провода контура подсоединены в соответствии со схемами подключения, 
приведёнными в руководстве по установке преобразователя.  

Если Ваша сеть HART сложнее приведённых в руководстве по установке преобразователя, 
свяжитесь с Micro Motion или с HART Communication Foundation. 

2. Отключите провода первого мА выхода от преобразователя.  

3. Установите сопротивление 250 Ом на клеммы первого мА выхода.  

4. Проверьте падение напряжения на сопротивлении (4-20 мА = 1-5 В пост.).  

Если падение напряжения меньше 1 В, увеличьте сопротивление до превышения падения 
напряжения более 1 В.  

5. Подсоединив Коммуникатор к сопротивлению, попробуйте осуществить соединение (оп-
рос). 

6. Если соединение с преобразователем не может быть установлено, преобразователь, воз-
можно, нуждается в обслуживании. Свяжитесь с Micro Motion.  

 

 

 

12.15 Проверка адреса HART и режима токового 
контура 

 

Если преобразователь формирует фиксированное значение на мА выходе, возможно, заблоки-
рован параметр Loop Current Mode (режим токового контура).  

При заблокированном параметре Loop Current Mode (режим токового контура), мА выход зафик-
сирован, и не отображает данных процесса и не интерпретирует действия по ошибке. 

При изменении адреса HART (HART Address), некоторые средства коммуникации автоматиче-
ски изменяют значение параметра Loop Current Mode (режим токового контура). 

Полезный совет 

При установке или изменении адреса HART, всегда проверяйте параметр Loop Current Mode. 
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Процедура 

1. Установите адрес HART (HART Address) в значение, соответствующее Вашей сети HART. 

Адрес по умолчанию 0. Это рекомендованное значение, если только преобразователь не 
находится в моноканальной сети (multidrop network). 

2. Установите значение параметра Loop Current Mode в значение Enabled (разрешено). 

 

 

12.16 Проверка пакетного режима HART 
Пакетный режим HART может привести к непредсказуемому состоянию выхода преобразова-
теля. Обычно, пакетный режим HART заблокирован, и должен быть разрешён, только если 
другое устройство в сети HART требует коммуникации в пакетном режиме. 

1. Проверьте установку пакетного режима: enabled/disabled (разрешён/заблокирован).  

2. Если пакетный режим разрешён, заблокируйте его.  

 

12.17 Проверка подстройки миллиамперного выхода 
При неточных значениях подстройки мА выхода, преобразователь будет недокомпенсировать 
или перекомпенсировать выход. 

1. Подстройте выход, следуя стандартной процедуре.  

2. Если это не решает проблемы, свяжитесь с Micro Motion.  

 

 

12.18 Проверка нижней и верхней границы диапазона 
Если условия процесса окажутся ниже сконфигурированной нижней границы диапазона 
(LRV) или выше верхней границы диапазона (URV), выходы преобразователя могут отобра-
жать непредсказуемые значения. 

1. Обратите внимание на текущие условия процесса.  

2. Проверьте конфигурацию LRV и URV.  

 

12.19 Проверка действия миллиамперного выхода при 
ошибке  
Параметр mA Output Fault Action (действие миллиамперного выхода при ошибке) определяет со-
стояние мА выхода преобразователя при возникновении условия внутренней ошибки. Если на 
мА выходе отображается постоянное значение ниже 4 мА или выше 20 мА, преобразователь, 
возможно, обнаружил условия ошибки.  

1. Проверьте активные тревожные сообщения. 

2. При наличии условий активных тревожных сообщений, преобразователь функционирует 
правильно. Если Вы хотите изменить режим функционирования преобразователя: 

• Измените конфигурацию параметра mA Output Fault Action (действие миллиамперного 
выхода при ошибке).  

• Измените конфигурацию параметра Alarm Severity на значение Ignore.  

3. При отсутствии условий активных тревожных сообщений, продолжите поиск неисправ-
ности.  
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12.20 Проверка параметра максимальная ширина 
импульса частотного выхода 

При неправильной конфигурации параметра Frequency Output Maximum Pulse Width (максимальная 
ширина импульса частотного выхода), частотный выход может отображать неправильное зна-
чение. 

Проверьте конфигурацию параметра Frequency Output Maximum Pulse Width (максимальная шири-
на импульса частотного выхода). 

Для большинства применений подходит значение по умолчанию параметра Frequency Output 
Maximum Pulse Width (максимальная ширина импульса частотного выхода), соответствующее 
50% времени занятости (duty cycle). 

 

 

12.21 Проверка параметра метод масштабирования 
частотного выхода 
При неправильной конфигурации параметра Frequency Output Scaling Method (метод масштаби-
рования частотного выхода), частотный выход может отображать неправильное значение.  

значение. 

1. Проверьте конфигурацию параметра Frequency Output Scaling Method (метод масштабирова-
ния частотного выхода).  

2. При изменении значения параметра Frequency Output Scaling Method (метод масштабирова-
ния частотного выхода), проверьте конфигурацию всех других параметров частотного 
выхода.  

 

 

12.22 Проверка действия частотного выхода при 
ошибке 
Параметр Frequency Output Fault Action (действие частотного выхода при ошибке) определяет со-
стояние частотного выхода преобразователя при возникновении условия внутренней ошибки. 
Если на частотном выходе отображается постоянное значение, преобразователь, возможно, 
обнаружил условия ошибки.  

• Проверьте активные тревожные сообщения. 

• При наличии условий активных тревожных сообщений, преобразователь функционирует 
правильно. Если Вы хотите изменить режим функционирования преобразователя: 

• Измените конфигурацию параметра Frequency Output Fault Action (действие частотно-
го выхода при ошибке).  

• Измените конфигурацию параметра Alarm Severity на значение Ignore.  

• При отсутствии условий активных тревожных сообщений, продолжите поиск неисправ-
ности.  

 

12.23 Проверка параметра направления потока 
При неправильной конфигурации параметра Flow Direction (направление потока), преобразова-
тель может отображать непредсказуемые значения расхода и сумматоров. 
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Параметр Flow Direction (направление потока) в сочетании с действительным направлением по-
тока влияет на значения расхода, сумматоров, инвентаризаторов и состояние выходов. Для 
упрощения работы, действительное направление потока должно совпадать со стрелкой на-
правления потока на корпусе сенсора. 

 

Процедура 

1. Определите действительное направление потока через сенсор. 

2. Проверьте конфигурацию параметра Flow Direction (направление потока). 

 

 

12.24 Проверка значений отсечек 
 

Если значения отсечек сконфигурированы неправильно, преобразователь может отображать 
нулевой расход при наличии расхода или очень маленький расход при его отсутствии. 

Параметры отсечки различны для массового расхода, объёмного расхода, стандартного объём-
ного расхода газа (если применимо) и плотности. В преобразователе конфигурируется также 
независимая отсечка для каждого мА выхода. Взаимодействие отсечек иногда приводит к не-
предсказуемым результатам. 

Процедура 

Проверьте конфигурацию параметров отсечек. 

 

Полезный совет 

Для типовых применений Micro Motion рекомендует устанавливать значение параметра Mass 
Flow Cutoff равным значению стабильности нуля для Вашего сенсора, умноженному на 10. 
Значения стабильности нуля приведены в листе технических данных (Product Data Sheet) на 
Ваш сенсор. 

 

12.25 Проверка пробкового (двухфазного) течения 
 

Пробковое течение (двухфазный поток) может явиться причиной пиков сигнала на возбуж-
дающей катушке. Это может привести к отображению нулевого расхода преобразователем или 
к формированию различных тревожных сообщений. 

1. Проверьте тревожные сообщения (алармы) пробкового течения. Если преобразователь не 
генерирует алармов пробкового течения, оно не является источником проблем. 

2. Проверьте наличие кавитации, закипания жидкости, наличие протечек.  

3. Проведите мониторинг плотности жидкости при нормальных условиях. 

4. Проверьте конфигурацию значений пределов  и длительности пробкового течения (Slug 
Low Limit, Slug High Limit, Slug Duration). 

 

Полезный совет 

Сократить частоту появления алармов пробкового течения можно установкой параметра Slug 
Low Limit в меньшее значение, параметра Slug High Limit в большее значение, а параметра 
Slug Duration в большее значение. 
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12.26 Проверка уровня сигнала на возбуждающей 
катушке 

 

Избыточное или беспорядочное значение уровня сигнала на возбуждающей катушке может 
указывать на проблемы технологического процесса, сенсора или конфигурации.  

Для определения наличия избыточного или беспорядочного значения уровня сигнала на воз-
буждающей катушке необходим сбор соответствующих данных в условиях выявления про-
блем и их сравнение с данными при нормальных условиях. 

Избыточное значение уровня сигнала на возбуждающей катушке 

 

Таблица 12-8:     Причины избыточного уровня сигнала возбуждающей катушки и мето-
ды решения проблемы 

Возможная причина Рекомендуемые действия 

Пробковое течение Проверьте условия пробкового течения. См. Раздел 12.25. 

Частично заполненные 
трубки сенсора 

Исправьте условия так, чтобы трубки были заполнены полностью. 

Закупоренность расхо-
домерных трубок 

Проверьте напряжение на детекторных катушках (См. Раздел 
12.27). Если на одной из них оно близко к нулю (но ни одно из них 
не равно нулю), закупоренность может быть причиной проблем. 
Продуйте трубки. В крайнем случае, возможно, понадобится заме-
на сенсора. 

Кавитация или вскипа-
ние, наличие посторон-
них материалов в двух 
или трёхфазном потоке 

• Увеличьте входное или обратное давление сенсора.  

• Если насос расположен выше по потоку по отношению к сен-
сору, увеличьте расстояние между насосом и сенсором.  

• Возможно, необходима переориентация сенсора. Обратитесь к 
руководству по установке сенсора.  

Неисправность платы 
катушки возбуждения 
или модуля 

Свяжитесь с Micro Motion. 

Деформация трубок Проверьте напряжение на детекторных катушках (См. Раздел 
12.27). Если на одной из них оно близко к нулю (но ни одно из них 
не равно нулю), деформация трубок может быть причиной про-
блем. Возможно, понадобится замена сенсора. 

Трещина в трубках Замените сенсор. 

Дисбаланс сенсора Свяжитесь с Micro Motion. 

Механическое замыка-
ние в сенсоре 

Убедитесь, что трубки сенсора свободно колеблются. 

Обрыв возбуждающей 
или левой детекторной 
катушки 

Свяжитесь с Micro Motion. 

Расход за пределами 
диапазона 

Убедитесь, что расход находится в пределах диапазона сенсора. 

Неправильная характе-
ризация сенсора 

Проверьте характеризацию сенсора. 
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Беспорядочное значение уровня сигнала на возбуждающей катушке 

Таблица 12-9:     Причины беспорядочного уровня сигнала возбуждающей катушки и ме-
тоды решения проблемы 

Возможная причина Рекомендуемые действия 

Неправильная константа характеризации сенсора К1 Проверьте параметр К1. 

Обратная полярность детекторной или возбуждаю-
щей катушки 

Свяжитесь с Micro Motion. 

Пробковое течение Проверьте условия пробкового тече-
ния. См. Раздел 12.25. 

Налипание посторонних материалов на трубках сен-
сора 

• Продуйте трубки сенсора. 

• Замените сенсор. 

 

12.26.1 Сбор данных о сигнале возбуждающей катушки 
 

Данные об уровне сигнала на возбуждающей катушке могут использоваться для диагностики 
различных условий процесса и состояния оборудования. Накапливайте данные об уровне сиг-
нала на возбуждающей катушке в период работы в нормальных условиях, и используйте их в 
качестве базисной линии при поиске и устранении неисправностей. 

Процедура 

1. Используйте данные об уровне сигнала на возбуждающей катушке.  

2. Записывайте данные об уровне сигнала на возбуждающей катушке в течение необходимо-
го периода времени в различных условиях процесса. 

12.27 Проверка напряжения на детекторных катушках 
 

Если напряжение на детекторных катушках необычно мало, это может свидетельствовать о 
проблемах технологического процесса или оборудования. 

Для определения наличия необычно малого значения напряжения на детекторных катушках 
необходим сбор соответствующих данных в условиях выявления проблем и их сравнение с 
данными при нормальных условиях. 

 

Таблица 12-10:     Причины низкого уровня сигнала детекторной катушки и методы ре-
шения проблемы 

Возможная причина Рекомендуемые действия 

Воздух в жидкости • Увеличьте входное или обратное давление сенсора.  

• Если насос расположен выше по потоку по отношению к 
сенсору, увеличьте расстояние между насосом и сенсо-
ром.  

• Возможно, необходима переориентация сенсора. Обрати-
тесь к руководству по установке сенсора. 

Неисправен кабель между 
сенсором и преобразователем 

Проверьте кабель между сенсором и преобразователем. 

Расход за пределами диапа-
зона сенсора 

Убедитесь, что расход не за пределами диапазона сенсора. 

Пробковое течение Проверьте условия пробкового течения. См. Раздел 12.25. 
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Таблица 12-10:    Причины низкого уровня сигнала детекторной катушки и методы ре-
шения проблемы (продолжение) 

Возможная причина Рекомендуемые действия 

Трубки сенсора не вибрируют • Проверьте, не закупорены ли трубки сенсора.  

• Убедитесь, что трубки сенсора свободно колеблются 
(нет механического замыкания). 

• Проверьте подключение кабелей. 

• Проведите тест катушек сенсора. См. Раздел 12.28.1. 

Влага в электронике сенсора Обеспечьте отсутствие влаги в электронике сенсора. 

Сенсор повреждён или магниты 
сенсора размагнитились 

Замените сенсор. 

 

12.27.1 Сбор данных 
 

Данные об уровне сигнала на детекторных катушках могут использоваться для диагностики 
различных условий процесса и состояния оборудования. Накапливайте данные об уровне сиг-
нала на детекторных катушках в период работы в нормальных условиях, и используйте их в 
качестве базисной линии при поиске и устранении неисправностей. 

 

Процедура 

1. Используйте данные об уровне сигнала на детекторных катушках. 

2. Записывайте данные об уровне сигнала на левой и правой детекторных катушках в тече-
ние необходимого периода времени в различных условиях процесса.  

 

12.28 Проверка на короткое замыкание 
 

Короткое замыкание между клеммами сенсора или между клеммами сенсора и корпусом сен-
сора может привести к прекращению работы сенсора. 

 

Таблица 12-11:     Причины короткого замыкания и методы решения проблемы 

Возможная причина Рекомендуемые действия 

Влага в соединительной ко-
робке 

Убедитесь, что соединительная коробка сухая, и отсутствуют 
следы коррозии. 

Жидкость или влага внутри 
корпуса сенсора 

Свяжитесь с Micro Motion. 

Внутреннее замыкание пере-
ходного соединения. 

Свяжитесь с Micro Motion. 

Неисправный кабель Замените кабель 

Неправильное подключение 
кабеля 

Проверьте подключение кабеля внутри соединительной ко-
робки сенсора. В документе Micro Motion 9-Wire Flowmeter 
Cable Preparation and Installation Guide представлены соответ-
ствующие рекомендации. 

 



Поиск и устранение неисправностей 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

242 

12.28.1 Проверка катушек сенсора 
 

Проверка катушек сенсора может помочь в определении короткого замыкания. 

Ограничение 

Эта процедура относится только к 9-типроводному удалённому преобразователю и удалённо-
му преобразователю с удалённым базовым процессором. 

Процедура 

1. Отключите питание преобразователя.  

 ПРЕДУПРЕЖДЕНИЕ! 

Если преобразователь находится в опасной зоне, подождите 5 минут перед продолже-
нием процедуры.  

2. Снимите крышку с корпуса базового процессора.  

3. Отсоедините клеммные блоки от платы.  

4. Используя цифровой мультиметр (DMM), проверьте боковые катушки, перечисленные в 
Таблице 12-13, подсоединив выводы DMM к отсоединенным клеммным блокам для каж-
дой клеммной пары. Запишите значения.  

 

Таблица 12-12:     Катушки и проверяемые клеммные пары 

Катушка Модель сенсора Цвета клемм 

Возбуждающая катушка Все Коричневый и красный 

Левая катушка (LPO) Все Зелёный и белый 

Правая катушка (RPO) Все Синий и серый 

Термосопротивление (RTD) Все Жёлтый и фиолетовый 

Компенсационный провод (LLC) 
сенсоры  

Все, кроме Т-Серии и 
CMF400 

Жёлтый и оранжевый 

Составное термосопротивление Т-Серии Жёлтый и оранжевый 

Фиксированное сопротивление 
(см. примечание) 

CMF400 Жёлтый и оранжевый 

 

Примечание 

Данные о фиксированном сопротивлении сенсора CMF400 относятся только к некото-
рым релизам. За дополнительной информацией обратитесь к Micro Motion.  

 

Не должно быть обрывов контуров, т.е. не должно быть показаний бесконечного сопро-
тивления. Сопротивления левой и правой катушек (LPO и RPO) должны быть одинаковы-
ми или очень близкими (± 5 Ом). При любых необычных показаниях, повторите тесты со-
противления катушек в соединительной коробке сенсора для исключения влияния неис-
правного кабеля. Показания с обеих сторон должны совпадать. 
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5. Проверьте клеммы соединительной коробки сенсора на короткое замыкание на корпус  

a. Оставьте клеммные блоки базового процессора отсоединенными.  

b. Со стороны сенсора снимите крышку соединительной коробки.  

c. Проверьте каждую клемму сенсора на короткое замыкание на корпус, подсоединив 
один вывод DMM к клемме, а другой к корпусу сенсора. 

6. Проверьте сопротивление пар клемм соединительной коробки:  

a. Коричневую со всеми кроме Красной 

b. Красную со всеми кроме Коричневой 

c. Зелёную со всеми кроме Белой 

d. Белую со всеми кроме Зелёной 

e. Синюю со всеми кроме Серой 

f. Серую со всеми кроме Синей 

g. Оранжевую со всеми кроме Жёлтой и Фиолетовой 

h. Жёлтую со всеми кроме Оранжевой и Фиолетовой 

i. Фиолетовую со всеми кроме Жёлтой и Оранжевой 

Измеренное сопротивление должно быть бесконечно для каждой пары. Если значение из-
меренного сопротивления не бесконечно, то это признак короткого замыкания между 
клеммами. 

 

Дополнительная информация 

Чтобы вернуться к нормальной работе: 

1. Подсоедините клеммные блоки к клеммной плате. 

2. Закройте крышку корпуса базового процессора. 

3. Закройте крышку соединительной коробки сенсора. 

Важно 

При сборке компонентов расходомера, не забудьте смазать все кольцевые прокладки. 

 

 

12.29 Проверка светодиода базового процессора 
На базовом процессоре есть светодиод (LED), указывающий на различные состояния прибора. 

1. Подайте питание на преобразователь.  
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2. При 4-хпроводном удаленном монтаже или удаленном монтаже базового процессора с 
удаленным преобразователем:  

a. Снимите крышку базового процессора. Базовый процессор сделан в искробезопасном 
исполнении и может быть открыт в любых условиях.  

b. Проверьте состояние светодиода (LED) базового процессора.  

3. При интегральном монтаже:  

a. Ослабьте четыре винта с головкой под ключ, крепящие преобразователь к базе.  

 

Рисунок 12-1:     Компоненты расходомера интегрального монтажа 

 
 

b. Поверните преобразователь против часовой стрелки так, чтобы винты с головкой под 
ключ вышли из зацепления.  

c. Осторожно поднимите преобразователь прямо вверх, отделив его от винтов с головкой 
под ключ.  

 

Важно 

Не отсоединяйте и не повреждайте провода, соединяющие базовый процессор с 
преобразователем. 

 

d. Проверьте состояние светодиода (LED) базового процессора. 

4. При 9-типроводном удаленном монтаже:  

a. Снимите крышку. 

 

 

  

Преобразователь 

Базовый процессор 

Переходное кольцо  

4 винта с головкой под ключ (4 мм) 

База 
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Рисунок 12-2:     Компоненты расходомера при 9-типроводном удалённом мон-
таже 

 
 

b. Внутри корпуса базового процессора ослабьте три винта, удерживающие монтажную 
пластину базового процессора. Не откручивайте винты полностью.  

c. Поверните монтажную пластину так, чтобы винты вышли из зацепления. 

d. Осторожно опустите монтажную пластину так, чтобы верхняя часть базового процес-
сора стала видимой.  

Важно 

Не отсоединяйте и не повреждайте провода, соединяющие базовый процессор с 
преобразователем. 

e. Проверьте состояние светодиода (LED) базового процессора.  

 

Дополнительная информация 

Чтобы вернуться к нормальной работе: 

• При 4-хпроводном удаленном монтаже или удаленном монтаже базового процессора с 
удаленным преобразователем верните крышку на место. 

• При интегральном монтаже: 

1. Осторожно опустите преобразователь на базу, вставляя винты с головкой под ключ в 
отверстия. Не пережмите и не передавите провода. 

2. Поверните преобразователь по часовой стрелке так, чтобы винты с головкой под 
ключ зашли в зацепление. 

3. Затяните винты с моментом 2,3 -3,4 Н-м. 

• При 9-типроводном удаленном монтаже:   

 

1. Осторожно сдвиньте монтажную пластину на место. Не пережмите и не передавите 
провода.  

2. Поверните монтажную пластину так, чтобы винты зашли в зацепление.  

 

  

Крышка 

Преобразователь 

Базовый процессор 

4 винта с головкой 
под ключ (4 мм) 
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3. Затяните винты с моментом 0,7 -0,9 Н-м. 

4. Установите крышку на место. 

 

Важно 

При сборке компонентов расходомера, не забудьте смазать все кольцевые прокладки. 

 

12.29.1 Состояния светодиода базового процессора 
 

Таблица 12-13:     Состояния светодиода стандартного базового процессора  

Состояние свето-
диода 

Описание Рекомендованные действия 

1 мигание в секунду 
(ВКЛ 25%, ВЫКЛ 
75%) 

Нормальная работа  Действий не требуется 

1 мигание в секунду 
(ВКЛ 75%, ВЫКЛ 
25%) 

Пробковое течение 
(двухфазный поток) 

См. Раздел 12.25. 

Постоянно ВКЛ 

 

Идёт установка нуля 
или калибровка 

Если идёт калибровка - действий не требуется.  

Питание базового 
процессора от 5 до 
11,5 В 

Проверьте питание преобразователя.  

3 быстрых включения 
и пауза 

 

Сенсор не определя-
ется 

Проверьте подключение кабелей между преобразователем и сенсором.  

Неправильная конфи-
гурация 

Проверьте параметры характеризации сенсора.  

Повреждены штыре-
вые контакты между 
сенсором и базовым 
процессором 

Сенсор нуждается в заводском обслуживании.  

4 мигания в секунду Условие ошибки Проверьте состояние тревожных сообщений. 

ВЫКЛ (OFF) 

 

Питание базового 
процессора меньше 5 
Вольт 

• Проверьте кабель питания базового процессора.  
• Если светодиод состояния преобразователя светится, преобразователь 
получает питание. Проверьте напряжение на клеммах 1 (VDC+) и 2 
(VDC-) базового процессора. При напряжении меньше 1 VDC, проверьте 
кабель питания базового процессора. Могут быть перепутаны провода.  
• Если светодиод состояния преобразователя не светится, преобразова-
тель не получает питания. Проверьте блок питания. Если блок питания 
исправен, возможна ошибка преобразователя, дисплея или светодиода. 
Возможно, сенсор нуждается в заводском обслуживании. 

Внутренняя ошибка 
базового процессора 

Сенсор нуждается в заводском обслуживании. 
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Таблица 12-14:     Состояния светодиода усовершенствованного базового процессора  

Состояние свето-
диода 

Описание Рекомендованные действия 

Постоянно зелёный Нормальная работа Действий не требуется. 

Мигающий жёлтый Идёт установка нуля Действий не требуется.  

Постоянно жёлтый Тревожное сообщение 
низкого приоритета 

Проверьте тревожное сообщение состояния. 

Постоянно красный Тревожное сообщение 
высокого приоритета 

Проверьте тревожное сообщение состояния. 

Мигающий красный 
(ВКЛ 80%, ВЫКЛ 
20%) 

Трубки не заполнены 
продуктом 

• Если тревожное сообщение А105 (пробковое течение) активно, 
предпримите шаги, рекомендованные для этого аларма. 

• Если тревожное сообщение А033 (трубки не заполнены) активно, 
проверьте технологический процесс. Проверьте наличие воздуха в 
трубках, заполненность трубок, наличие посторонних предметов в 
трубках или отложения на трубках. 

Мигающий красный 
(ВКЛ 50%, ВЫКЛ 
50%,) 

Неисправность элек-
троники 

Сенсор нуждается в заводском обслуживании. 

Мигающий красный 
(ВКЛ 50%, ВЫКЛ 
50%, с пропуском 
каждого 4-ого) 

Неисправность сенсо-
ра 

Сенсор нуждается в заводском обслуживании. 

Постоянно ВЫКЛ 
(OFF) 

 

Питание базового 
процессора меньше 5 
Вольт 

• Проверьте кабель питания базового процессора.  
• Если светодиод состояния преобразователя светится, преобразователь 
получает питание. Проверьте напряжение на клеммах 1 (VDC+) и 2 
(VDC-) базового процессора. При напряжении меньше 1 VDC, проверьте 
кабель питания базового процессора. Могут быть перепутаны провода.  
• Если светодиод состояния преобразователя не светится, преобразова-
тель не получает питания. Проверьте блок питания. Если блок питания 
исправен, возможна ошибка преобразователя, дисплея или светодиода. 
Возможно, сенсор нуждается в заводском обслуживании. 

Внутренняя ошибка 
базового процессора 

Сенсор нуждается в заводском обслуживании. 

 

12.30 Тестирование сопротивления базового 
процессора  
 

1. Выключите питание преобразователя.  

2. При 4-хпроводном удаленном монтаже или удаленном монтаже базового процессора с 
удаленным преобразователем снимите крышку базового процессора.   

3. При интегральном монтаже: 

a. Ослабьте четыре винта с головкой под ключ, крепящие преобразователь к базе. 
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Рисунок 12-3:     Компоненты расходомера интегрального монтажа 

 
 

b. Поверните преобразователь против часовой стрелки так, чтобы винты с головкой под 
ключ вышли из зацепления.  

c. Осторожно поднимите преобразователь прямо вверх, отделив его от винтов с головкой 
под ключ.  

4. При 9-типроводном удаленном монтаже:  

a. Снимите крышку:  

Рисунок 12-4:     Компоненты расходомера при 9-типроводном удалённом мон-
таже 

 
 

b. Внутри корпуса базового процессора ослабьте три винта, удерживающие монтажную 
пластину базового процессора. Не откручивайте винты полностью.  

c. Поверните монтажную пластину так, чтобы винты вышли из зацепления. 

d. Осторожно опустите монтажную пластину так, чтобы верхняя часть базового процес-
сора стала видимой.  

 

  

Переходное кольцо  

Преобразователь 

Базовый процессор 
4 винта с головкой под ключ (4 мм) 

База 

Преобразователь 

Базовый процессор 

4 винта с головкой 
под ключ (4 мм) 

Крышка 
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5. Со стороны базового процессора отсоедините 4-провода кабеля между базовым процессо-
ром и преобразователем. 

6. Измерьте сопротивление между парами клеммами базового процессора 3 и 4, 2 и 3, 2 и 4.  

Клеммная пара Функция Ожидаемое сопро-
тивление 

3-4 RS-485/A и RS-485/B 40-50 кОм 

2-3 VDC- и RS-485/A 20-25 кОм 

2-4 VDC- и RS-485/B 20-25 кОм 

 

7. Если значение какого-нибудь из измеренных сопротивлений меньше указанных, базовый 
процессор, возможно, не сможет связываться с преобразователем или удаленным хостом. 
Возможно, расходомер нуждается в заводском обслуживании. 

 

Дополнительная информация 

Чтобы вернуться к нормальной работе: 

• При 4-хпроводном удаленном монтаже или удаленном монтаже базового процессора с 
удаленным преобразователем: 

1. Вновь соедините четыре провода кабеля между базовым процессором и преобразова-
телем.  

2. Установите крышку базового процессора на место.  

3. Подайте питание на преобразователь. 

• При интегральном монтаже:  

1. Вновь соедините четыре провода кабеля между базовым процессором и преобразова-
телем.   

2. Осторожно опустите преобразователь на базу, вставляя винты с головкой под ключ в 
отверстия. Не пережмите и не передавите провода.  

3. Поверните преобразователь по часовой стрелке так, чтобы винты с головкой под ключ 
зашли в зацепление.  

4. Затяните винты с моментом 2,3 -3,4 Н-м.  

5. Подайте питание на преобразователь.  

• При 9-типроводном удаленном монтаже: 

1. Вновь соедините четыре провода кабеля между базовым процессором и преобразова-
телем.  

2. Осторожно сдвиньте монтажную пластину на место. Не пережмите и не передавите 
провода.  

3. Поверните монтажную пластину так, чтобы винты зашли в зацепление. 

4. Затяните винты с моментом 0,7 -0,9 Н-м. 

5. Установите крышку на место.  

6. Подайте питание на преобразователь. 

 

Важно 

При сборке компонентов расходомера, не забудьте смазать все кольцевые прокладки. 
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Приложение A  
Использование дисплея преобразователя 
 

Темы данного приложения 
• Компоненты интерфейса преобразователя 

• Использование оптических переключателей 

• Использование системы меню дисплея и доступ к ней 

• Коды дисплея для технологических переменных 

• Коды и сокращения, используемые в меню дисплея 

• Блок-схемы меню дисплея преобразователя 

 

A.1 Компоненты интерфейса преобразователя 
Интерфейс преобразователя включает светодиод состояния (LED), дисплей (жидкокристалли-
ческая панель) и два оптических переключателя. 
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Рисунок A-1:     Интерфейс преобразователя 

 
A. Светодиод состояния (LED) 
B. Дисплей (ЖК панель) 
С. Переменная процесса 
D. Оптический переключатель Scroll 
E.  Индикатор оптического переключателя: горит красным, когда активирован режим 
Scroll или Select 
F. Оптический переключатель Select 
G. Единицы измерения переменной процесса 
H. Текущее значение переменной процесса 

 

A.2 Использование оптических переключателей 
 

Для управления дисплеем преобразователя воспользуйтесь оптическими переключателями. 

Преобразователь содержит два оптических переключателя: Scroll (прокрутка) и Select (выбор). 

Для активирования оптического переключателя перекройте свет пальцем руки напротив от-
верстия. 

Полезный совет 

Вы можете активировать оптический переключатель через стекло. Не снимайте крышку пре-
образователя. 

 

Индикатор оптического переключателя загорается, когда преобразователь определит, что оп-
тический переключатель активирован. 
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Таблица A-1:     Индикатор оптического переключателя и состояния оптического пере-
ключателя 

Индикатор оптического переключателя Состояния оптического переключателя 

Постоянно красный Один оптический переключатель активирован. 

Мигающий красный Два оптических переключателя активированы. 

 

A.3 Использование системы меню дисплея и доступ к 
ней  

 

Система меню дисплея используется для конфигурирования, решения административных за-
дач и задач обслуживания. 

Полезный совет 

Система меню дисплея не предоставляет функций полного конфигурирования, решения адми-
нистративных задач и задач обслуживания. Для полного управления преобразователем вос-
пользуйтесь другим средством коммуникации. 

Предварительные требования 

Для доступа к системе меню дисплея, доступ оператора к Off-line или к меню тревожных со-
общений (Alarm menu) должен быть разрешён. Для полного доступа к системе меню дисплея, 
доступ оператора к обоим меню должен быть разрешён. 

Процедура 

1. На дисплее преобразователя активируйте оптические переключатели Scroll (прокрутка) и 
Select (выбор) одновременно до появления изменений на дисплее.  

В зависимости от различных факторов, Вы оказываетесь в меню Off-line в различных его 
местах. 

• При активном аларме и разрешённом доступе к меню алармов, Вы увидите сообщение 
SEE ALARM.  

• При отсутствии активных алармов и разрешённом контроле метрологических харак-
теристик (Smart Meter Verification) в преобразователе, Вы увидите сообщение ENTER 
METER VERFY. 

• При отсутствии активных алармов и неразрешённом контроле метрологических ха-
рактеристик (Smart Meter Verification) в преобразователе, Вы увидите сообщение 
OFF_LINE MAINT. 

2. Передвигаться по меню дисплея можно, используя оптические переключатели Scroll (про-
крутка) и Select (выбор).  

• Используйте Scroll для перемещения по списку вариантов. 

• Используйте Select для выбора текущего варианта. 

3. При появлении сообщения If CODE? на дисплее во время выбора, введите значение, скон-
фигурированное для пароля Off-Line Password.  

a. При мигающем курсоре на месте первой цифры, активируйте Scroll до тех пор, пока ни 
появится правильная цифра, затем активируйте Select. 

b. Повторите процедуру для второй, третьей и четвёртой цифры.  
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Полезный совет 

Если Вам неизвестно значение пароля Off-Line Password, подождите 30 секунд. Экран 
пароля по истечению тайм-аута автоматически переведёт Вас на предыдущий экран. 

 

4. Если сообщение Scroll мигает на дисплее, активируйте оптический переключатель Scroll, 
затем Select, и затем вновь Scroll. 

Эта последовательность будет подсказана Вам на дисплее. Последовательность Scroll- 
Select-Scroll используется для защиты от случайного активирования меню Off-line. Она не 
используется как мера безопасности. 

5. Для выхода из меню дисплея и возврата на более высокий уровень меню: 

• Активируйте Scroll до появления сообщения EXIT, затем активируйте Select. 

• Если сообщение EXIT не появляется, активируйте оптические переключатели Scroll 
(прокрутка) и Select (выбор) одновременно и удерживайте до перехода на предыду-
щий экран. 

6. Для выхода из системы меню дисплея, воспользуйтесь одним из следующих методов:  

• Выходите из каждого меню отдельно, перемещаясь к вершине системы меню.  

• Дождитесь истечения тайм-аута, и на дисплее отобразятся данные переменных про-
цесса.  

 

 

A.3.1 Ввод значений с плавающей точкой с помощью дисплея 
 

Некоторые конфигурационные значения, например, Lower Range Value и Upper Range Value (ниж-
няя граница диапазона и верхняя граница диапазона), вводятся как значения с плавающей точ-
кой. Дисплей поддерживает оба варианта представления значений с плавающей точкой: деся-
тичное и экспоненциальное. 

Дисплей позволяет ввод максимум 8 символов (цифр), включая знак. Десятичная точка циф-
рой не считается. Экспоненциальное представление используется для ввода значений, тре-
бующих более 8 символов (цифр). 

Ввод значений с плавающей точкой с использованием десятичного 
представления 
Десятичное представление позволяет ввод значений от -9999999 до 99999999. Использование 
десятичной точки возможно для ввода значений с количеством цифр справа от десятичной 
точки от 0 до 4 (precision 0-4). 

Десятичные значения, вводимые с помощью дисплея, должны отвечать следующим требова-
ниям: 

• Они могут содержать максимум 8 цифр или 7 цифр и знак минус (-) для индикации отри-
цательных значений.  

• Они могут содержать десятичную точку. Десятичная точка цифрой не считается. Деся-
тичная точка должна располагаться так, чтобы количество цифр справа от десятичной 
точки было от 0 до 4 (precision 0-4). 

При первом входе в конфигурационный экран, значения выводятся в десятичном представле-
нии, а активная цифра мигает. Если значение положительно, знак не отображается. Если зна-
чение отрицательно, отображается знак минус. 
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Процедура 

• Для изменения значения:  

1. Активируйте Select для перемещения на одну позицию влево до тех пор, пока не зами-
гает цифра, которую Вы хотите изменить. Левее позиции самой левой цифры преду-
смотрено место для знака. Следующее активирование переключателя Select приведет 
к перемещению в позицию самой правой цифры. 

2. Активируйте Scroll для изменения значения активной (мигающей) цифры. 

3. Повторяйте до установления всех цифр в желаемое значение. 

• Для изменения знака значения: 

1. Активируйте Select, пока не окажетесь непосредственно слева от самой левой цифры. 

2. Используя переключатель прокрутки Scroll, определите знак минус (–) для отрица-
тельного значения или [пустое место] для положительного значения. 

• Для сдвига десятичной точки: 

1. Активируйте Select до тех пор, пока не замигает десятичная точка. 

2. Активируйте Scroll. Это приведет к исчезновению десятичной точки.  

3. Активируйте Select, и определите положение десятичной точки. 

При перемещении курсора влево от одной позиции к другой, десятичная точка будет 
мигать между каждой  парой цифр вплоть до максимального разрешения (четыре зна-
ка справа от десятичной точки). 

 

Полезный совет 

Если положение десятичной точки недопустимо, она не отображается. Продолжайте 
активировать кнопку Select до появления десятичной точки справа от отображаемого 
значения.  

 

4. Когда десятичная точка окажется в желаемой позиции, активируйте Scroll. Это приве-
дет к фиксации десятичной точки в текущем положении. 

• Для сохранения отображаемого значения в памяти преобразователя, активируйте Scroll и 
Select одновременно и удерживайте до возникновения изменений на дисплее. 

− Если отображаемое значение совпадает со значением в памяти преобразователя, Вы 
вернётесь на предыдущий экран.  

− Если отображаемое значение не совпадает со значением в памяти преобразователя, на 
дисплее будет мигать SAVE/YES? Активируйте Select.  
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• Для выхода из меню без сохранения отображаемого значения в памяти преобразователя, 
активируйте Scroll и Select одновременно и удерживайте до возникновения изменений на 
дисплее. 

− Если отображаемое значение совпадает со значением в памяти преобразователя, Вы 
вернётесь на предыдущий экран.  

− Если отображаемое значение не совпадает со значением в памяти преобразователя, на 
дисплее будет мигать SAVE/YES? Активируйте Scroll.  

 

Ввод значений с плавающей точкой с использованием экспоненци-
ального представления 
Экспоненциальное представление используется для ввода значений больше 99999999 или 
меньше -9999999. 

Экспоненциальные значения, вводимые с помощью дисплея, должны соответствовать сле-
дующему виду: SX.XXXEYY. Где: 

• S = Знак. Знак минус (-) означает отрицательное значение. [Пустое место] отображает по-
ложительное значение.  

• X.XXX = 4 цифры мантиссы.  

• E = знак экспоненты.  

• YY = две цифры показателя экспоненты. 

 

Процедура 

1. Для изменения десятичного представления на экспоненциальное:  

a. Активируйте Select, до мигания самой правой цифры. 

b. Активируйте Scroll, до появления Е.  

c. Активируйте Select.  

 

Полезный совет 

Если Вы изменили значение в десятичном представлении и не сохранили изменения в 
памяти преобразователя, при переключении в экспоненциальное представление измене-
ния будут утрачены. Сохраните десятичное значение перед переключением в экспонен-
циальное представление. 

 

2. Для ввода экспоненты: 

Вы можете ввести знак минус (только в первой позиции), число от 0 до 3 (для первой по-
зиции экспоненты), или число от 0 до 9 (для второй позиции экспоненты). 

a. Активируйте Select для перемещения курсора до самого правого символа на дисплее.  

b. Активируйте Scroll до отображения желаемой цифры.  

c. Активируйте Select для перемещения курсора на одну позицию влево.  

d. Активируйте Scroll до отображения желаемой цифры.  

3. Для ввода мантиссы:  
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a. Активируйте Select для перемещения курсора до самого правого символа мантиссы. 

b. Активируйте Scroll до отображения желаемой цифры.  

c. Активируйте Select для перемещения курсора на одну позицию влево.  

d. Активируйте Scroll до отображения желаемой цифры.  

e. Активируйте Select для перемещения курсора на одну позицию влево.  

f. Активируйте Scroll до отображения желаемой цифры.  

g. Активируйте Select для перемещения курсора на одну позицию влево.  

h. Активируйте Scroll до отображения желаемой цифры.  

4. Для ввода знака:  

a. Активируйте Select для перемещения курсора на одну позицию влево.  

b. Активируйте Scroll до отображения желаемой цифры. 

5. Для сохранения отображаемого значения в памяти преобразователя, активируйте Scroll и 
Select одновременно и удерживайте до возникновения изменений на дисплее.  

• Если отображаемое значение совпадает со значением в памяти преобразователя, Вы 
вернётесь на предыдущий экран.   

• Если отображаемое значение не совпадает со значением в памяти преобразователя, на 
дисплее будет мигать SAVE/YES? Активируйте Select.  

6. (Опция) Обратное переключение из экспоненциального представления в десятичное.  

a. Активируйте Select до тех пор, пока не замигает Е. 

b. Активируйте Select до тех пор, пока не замигает d. 

c. Активируйте Select. 

 

 

 

A.4 Коды дисплея для технологических переменных 
Некоторые конфигурационные значения (например, Low Range Value- нижняя граница диапазо-
на и Upper Range Value -верхняя граница диапазона) вводятся как значения с плавающей точкой. 
Дисплей поддерживает как десятичное, так и экспоненциальное представление значений с 
плавающей точкой. 

 

Таблица A-2:     Коды дисплея для технологических переменных  

Код Определение Комментарии 

AVE_D Средняя плотность  

AVE_T Средняя температура  

BRD_T Температура платы  

CONC Концентрация  

DRIVE% Уровень сигнала на возбужд. катушке  

EXT_P Внешнее давление   

EXT_T Внешняя температура  
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Таблица A-2:     Коды дисплея для технологических переменных (продолжение) 

Код Определение Комментарии 

FVZ Контроль нуля Только в приложении коммерческого 
учёта 

GSV F Стандартный объёмный расход газа  

GSV I Инвентаризатор стандартного объёмного рас-
хода газа 

 

GSV T Сумматор стандартного объёмного расхода газа  

LPO_A Амплитуда сигнала на левой катушке  

LVOLI Объёмный инвентаризатор  

LZERO «Живой» ноль  

MASSI Массовый инвентаризатор  

MTR_T Температура корпуса (только сенсоры Т-Серии)  

NET M Массовый расход нетто Только в приложении измерения кон-
центрации 

NET V Объёмный расход нетто Только в приложении измерения кон-
центрации 

NETMI Нетто массовый инвентаризатор Только в приложении измерения кон-
центрации 

NETVI Нетто объёмный инвентаризатор Только в приложении измерения кон-
центрации 

PWRIN Входное напряжение Относится ко входу питания базового 
процессора 

RDENS Плотность при стандартной температуре Только в приложении измерения кон-
центрации 

RPO_A Амплитуда сигнала на правой катушке  

SGU Единицы измерения SG  

STD V Стандартный объёмный расход Только в приложении измерения кон-
центрации 

STDVI Инвентаризатор Стандартного объёма  Только в приложении измерения кон-
центрации 

TCDENS Плотность, скорректированная по температуре Только в приложении измерения неф-
тепродуктов (API) 

TCORI Инвентаризатор, скорректированный по темпе-
ратуре 

Только в приложении измерения неф-
тепродуктов (API) 

TCORR Сумматор, скорректированный по температуре Только в приложении измерения неф-
тепродуктов (API) 

TCVOL Объём, скорректированный по температуре Только в приложении измерения неф-
тепродуктов (API) 

TUBEF Частота колебаний трубок  

WTAVE Взвешенное среднее  
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A.5 Коды и сокращения, используемые в меню 
дисплея 

 

Таблица A-3:     Коды и сокращения, используемые в меню дисплея 

Код или аббревиа-
тура 

Определение Комментарии 

ACK ALARM Подтверждение тревожного сообщения  

ACK ALL Подтвердить все тревожные сообщения  

ACT Действие  

ADDR Адрес  

АО1 SRC Соответствует переменной, назначенной пер-
вому мА выходу 

 

АО1 Аналоговый выход 1  

АО2 Аналоговый выход 2  

AUTO SCRLL Автоматическая прокрутка  

BKLT, B LIGHT Подсветка  

CAL Калибровать  

CH A Канал А  

CH В Канал В  

CH С Канал С  

CHANGE PASSW  
CHANGE CODE 

Изменить пароль Изменить пароль, необходимый для 
доступа к функциям дисплея 

CONFG Конфигурирование  

CORE Базовый процессор  

CUR Z Текущее значение нуля  

CUSTODY XFER Коммерческий учёт  

D EV Дискретное событие Событие, сконфигурированное с ис-
пользованием расширенной модели  

DENS Плотность  

DGAIN, DRIVE % Уровень сигнала на возбужд. катушке  

DI Дискретный вход  

DISBL Заблокировать Select для блокировки 

DO1 Дискретный выход 1  

DO2 Дискретный выход 2  

DSPLY Дисплей  

E1OR2 Событие 1 или Событие 2 Событие, сконфигурированное с ис-
пользованием базовой модели 

ENABL Разрешить Select для разрешения 

ENABLE ACK Разрешить подтверждение всех алармов Разрешить или заблокировать функ-
цию ACK ALL 
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Таблица A-3:     Коды и сокращения, используемые в меню дисплея (продолжение) 

Код или аббревиа-
тура 

Определение Комментарии 

ENABLE ALARM Разрешить доступ к меню тревожных сообще-
ний 

Доступ к меню тревожных сообщений 
с дисплея 

ENABLE AUTO Разрешить автопрокрутку Разрешить или заблокировать функ-
цию автопрокрутки (Auto Scroll) 

ENABLE OFFLN Разрешить off-line Доступ к меню off-line с дисплея 

ENABLE PASSW Разрешить пароль Разрешить или заблокировать пароль-
ную защиту функций дисплея 

ENABLE RESET Разрешить сброс сумматора Разрешить или заблокировать сброс 
сумматора с дисплея 

ENABLE START Разрешить запуск сумматора Разрешить или заблокировать за-
пуск/останов сумматора с дисплея 

EVNT1 Событие 1 Событие, сконфигурированное с ис-
пользованием только базовой модели 

EVNT2 Событие 2 Событие, сконфигурированное с ис-
пользованием только базовой модели 

EXTRN Внешний  

FAC Z Заводской ноль  

FCF Калибровочный коэффициент расхода  

FL SW, FLSWT Реле расхода  

FLDIR Направление потока  

FO Частотный выход  

FO FREQ Коэффициент частоты  

FO RATE Коэффициент расхода  

FR FL Частота=Расход  

FREQ Частота  

GSV Стандартный объём газа  

HYSTRSIS Гистерезис  

INTERN Внутренний  

IO Вход/выход  

LANG Язык  

LOCK Защита записи  

LOOP CUR Токовый контур  

MTR F М-фактор (коэффициент)  

M_ASC Modbus ASCII  

M_RTU Modbus RTU  

MAO1 мА выход 1 (первый мА выход)  

MAO2 мА выход 2 (второй мА выход)  
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Таблица A-3:     Коды и сокращения, используемые в меню дисплея (продолжение) 

Код или аббревиа-
тура 

Определение Комментарии 

MASS Массовый расход  

MBUS Modbus  

MFLOW Массовый расход  

MSMT Измерение  

OFFLN Off-line  

OFF-LINE MAINT Обслуживание в режиме off-line  

P/UNT Импульсов на единицу расхода  

POLAR Полярность  

PRESS Давление  

QUAD Quadrature  

r. Версия  

SCALE Метод масштабирования  

SIM Имитация Используется для теста контура, не в 
режиме имитации. Режим имитации 
не доступен с дисплея. 

SPECL Специальный  

SRC Источник Назначение переменной 

TEMP, TEMPR Температура  

UNT/P Единиц расхода на импульс  

VAR1 Дисплейная переменная 1  

VER Версия  

VERFY Проверка  

VFLOW Объёмный расход  

VOL Объём, объёмный расход  

WRPRO Защита записи  

XMTR Преобразователь  
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A.6 Блок-схемы меню дисплея преобразователя 
 

Рисунок A-2:     Меню Off-line – верхний уровень 

 
 

  

Активируйте одновременно Scroll и Select 
на 4 секунды 

*Этот вариант отображается только при подключении преобразователя к усовершенствованному 
базовому процессору и установленному ПО контроля метрологических характеристик. 
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Рисунок A-3:     Меню Off-line – информация о версии 

 
 

  

Активируйте одновременно Scroll и Select 
на 4 секунды 

*Этот вариант отображается только при установленном соот-
ветствующем CEQ/ETO или приложении  в преобразователе. 
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Рисунок A-4:     Меню Off-line – конфигурирование: Единицы измерения и вв/выв 

 
 

  

Активируйте одновременно Scroll и Select 
на 4 секунды 
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Рисунок A-5:     Меню Off-line – конфигурирование: М-факторы, дисплей, цифровая коммуникация 

 
 

  

Активируйте одновременно Scroll и Select на 4 секунды 

*Если Вы заблокируете доступ к меню off-line, 
меню off-line исчезнет сразу после выхода. Для 
разблокирования доступа к меню off-line, вос-
пользуйтесь ProLink II или Коммуникатором. 
**При разрешённой автопрокрутке, экран Scroll 
Rate отображается сразу за экраном Auto Scrool. 
***Если разрешён и пароль, отображается экран 
Change Code. 
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Рисунок A-6:     Меню Off-line – алармы 

 
 

  

Активируйте одновременно Scroll и Select 
на 4 секунды 

*Этот экран отображается только при разрешённой функции ACK ALL 
и при наличии неподтверждённых алармов. 
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Рисунок A-7:     Меню Off-line – контроль метрологических характеристик: верхний уровень 

 
 

 

Рисунок A-8:     Меню Off-line – расписание процедуры контроля метрологических характеристик 

 
 

  

Активируйте одновременно Scroll и Select 
на 4 секунды 
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Рисунок A-9:     Меню Off-line – тест контроля метрологических характеристик 
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Рисунок A-10:     Меню Off-line – результаты контроля метрологических характеристик 
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Рисунок A-11:     Меню Off-line – сумматоры и инвентаризаторы 

 
 

(1) Экраны уставки события могут использоваться для определения или изменения уставки для События 1 или События 
2 в базовых моделях событий. Эти экраны отображаются только, если события определены как массовый или объ-
ёмный сумматор. Заметьте, что эта функция не относится к дискретным событиям (расширенной модели собы-
тия). 

(2) Преобразователь должен быть сконфигурирован на разрешение запуска и останова сумматоров с дисплея.  

(3) Преобразователь должен быть сконфигурирован на разрешение сброса сумматоров с дисплея.  
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Рисунок A-12:     Меню Off-line – Имитация (тест контура) 

 
 

  

Активируйте одновременно Scroll и Select 
на 4 секунды 

*Выходы могут быть зафиксированы на 2, 4, 12, 20 и 22 мА. 
**Фиксирует выход. 
***Снимает фиксацию выхода. 
**** Выходы могут быть зафиксированы на 1, 10 или 15 кГц. 
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Рисунок A-13:     Меню Off-line – установка нуля 

 
 

 

 

 

 

 

 

Активируйте одновременно Scroll и Select 
на 4 секунды 
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Приложение B  
Использование ProLink II с преобразователем 
 

Темы данного приложения 
• Основная информация о ProLink II 

• Подключение ProLink II 

• Блок-схемы меню ProLink II 

 

B.1 Основная информация о ProLink II 
ProLink II – это работающее под Windows ПО, предназначенное для конфигурирования и об-
служивания преобразователей Micro Motion. Оно предоставляет полный доступ к функциям и 
данным преобразователя. 

Требования ProLink II 

Для установки ProLink II необходимы: 

• Носитель с установочным пакетом ProLink II 

• Установочный набор ProLink II для Вашего типа подключения 

Для приобретения ProLink II и соответствующего установочного набора свяжитесь с Micro 
Motion. 

Документация ProLink II 

Инструкции данного руководства предполагают предварительное знакомство пользователя с 
ПО ProLink II или общее представление о программах Windows. Дополнительная информация 
по использованию ProLink II, содержится в руководстве по ProLink II (ProLink® II Software for 
Micro Motion® Transmitters: Installation and Use Manual). 

В большинстве случаев руководство по ProLink II устанавливается вместе с программой. Кро-
ме того, оно доступно на CD с документацией Micro Motion и на сайте Micro Motion 
(www.micromotion.com). 

Свойства и функции ProLink II 

ПО ProLink II обеспечивает полную функциональность при конфигурировании и работе пре-
образователя. ProLink II предоставляет также дополнительные функции, включая: 

• Возможность сохранения конфигурации преобразователя в файле ПК, её перезагрузки в 
преобразователь или тиражирование по другим преобразователям.  

• Возможность ведения журнала данных специальных типов в файле ПК. 

• Мастер ввода в эксплуатацию.  

• Мастер поверки.  

• Мастер подготовки к измерению газа.  

 

Эти функции описаны в руководстве по ProLink II. Они не описываются в данном документе. 
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Сообщения ProLink II 

По мере использования ProLink II с преобразователем Micro Motion, Вы столкнётесь с различ-
ными сообщениями и замечаниями. В данном документе описываются не все сообщения и 
замечания. 

Важно 

Пользователь ответственен за реакцию на сообщения и замечания и за соответствие всем со-
общениям по безопасности. 

 

B.2 Подключение ProLink II 
 

Подключение ProLink II к преобразователю позволяет прочесть данные процесса, сконфигури-
ровать преобразователь и решить задачи обслуживания, поиска и устранения неисправностей. 

 

B.2.1 Виды подключения ProLink II 
 

Для подключения ProLink II к преобразователю можно использовать различные типы подклю-
чений. Выберите тип подключения, наиболее подходящий для Вашей сети и задач, которые 
Вы намерены решать. 

Преобразователь поддерживает следующие типы подключения ProLink II: 

• Подключение к порту обслуживания (service port)  

• Подключение HART/Bell 202 

• Подключение HART/RS-485 

• Подключение Modbus/RS-485 7-битное (Modbus ASCII) 

• Подключение Modbus/RS-485 8-битное (Modbus RTU) 

При выборе типа подключения, примите во внимание следующее: 

• При подключении к сервисному порту используются стандартные параметры, уже опре-
делённые в ProLink II, и поэтому Вам не надо их конфигурировать.  

• Подключение HART/Bell 202 использует стандартные параметры подключения HART, 
уже определённые в ProLink II. Адрес преобразователя – единственный параметр, кото-
рый Вам необходимо сконфигурировать. 

• Некоторые типы подключений требуют открытия отделений подключения кабелей или 
отделений подключения питания. Эти типы подключения должны использоваться только 
как временные и могут требовать дополнительных мер безопасности.  

• Подключения Modbus, включая подключение к сервисному порту, как правило, быстрее, 
чем подключения HART.  

• При использовании подключения HART, ProLink II не позволит открыть более одного ок-
на одновременно. Это сделано для управления трафиком сети и оптимизации скорости. 

• Нельзя осуществить конкурентное подключение с использованием тех же самых клемм. 
Можно осуществить конкурентное подключение, если используются различные клеммы.  
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B.2.2 Подключение к порту обслуживания (service port) 
 

 ПРЕДУПРЕЖДЕНИЕ! 

При нахождении преобразователя в опасной зоне, не используйте подключение к порту 
обслуживания. Подключение к порту обслуживания требует открытия отделения под-
ключения кабелей, что при подаче питания на преобразователь может привести к взры-
ву. При нахождении преобразователя в опасной зоне, используйте подключение, не тре-
бующее снятия крышки преобразователя. 
 

Предварительные требования 

• ПО ProLink II установлено и лицензировано на Вашем ПК.  

• Одно из следующего:  

− конвертор RS-485 – RS-232  

− конвертор USB – RS-485  

• Доступный последовательный или USB порт  

• Адаптеры (при необходимости), например 9-25 пин.  

 

Процедура 

1. Подключите конвертор сигналов к последовательному или USB порту.  

2. Обеспечьте доступ к клеммам порта обслуживания:  

a. Снимите крышку преобразователя для доступа к отделению подключения кабелей.  

b. Открутите винт на откидной крышке с предупреждающей надписью и откройте отде-
ление подключения питания. 

3. Подключите выводы конвертора сигналов к клеммам 7 (485/A) и 8 (RS-485/.B) порта об-
служивания. 

 

Полезный совет 

Обычно, но не всегда, чёрный вывод это 485/A, а красный вывод – RS-485/B. 
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Рисунок B-1:     Подключение к порту обслуживания 

 
A. ПК  
B. Конвертор сигналов  
С. Клемма порта обслуживания 7 (RS-485/A)  
D. Клемма порта обслуживания 8 (RS-485/B)  
E.  Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 

 

4. Запустите ProLink II. 

5. Выберите Connection > Connect to Device.  

6. Установите Protocol в значение Service Port.  

 

Полезный совет 

Подключение по порту обслуживания использует стандартные параметры и стандарт-
ный адрес. Вам не надо конфигурировать их здесь. 

 

7. Установите значение COM Port в значение PC COM, используемое для этого подключе-
ния. 

8. Щёлкните кнопкой мыши по Connect.  

Требуется помощь?  При появлении сообщения об ошибке: 

• Поменяйте выводы местами и попробуйте снова.  

• Убедитесь в правильности определения COM порта.  

• Проверьте физическое подключение ПК и преобразователя.  

 

 

B.2.3 Подключение по HART/Bell 202 
 

Вы можете подключиться непосредственно к клеммам мА выхода преобразователя, к любой 
точке локального контура HART или к любой точке моноканальной сети HART. 
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 ПРЕДУПРЕЖДЕНИЕ! 

При нахождении преобразователя в опасной зоне, не используйте подключение непосред-
ственно к клеммам преобразователя. Подключение непосредственно к клеммам преобра-
зователя требует открытия отделения подключения кабелей, что при подаче питания на 
преобразователь может привести к взрыву. При нахождении преобразователя в опасной 
зоне, используйте подключение, не требующее открытия отделения подключения кабе-
лей. 
  

 

 ПРЕДУПРЕЖДЕНИЕ! 

Подключение непосредственно к клеммам мА выхода преобразователя может повлиять 
на мА выход. Если вы используете мА выход для регулирования расхода, перед подклю-
чением непосредственно к клеммам мА выхода преобразователя, переведите устройства 
в ручное управление. 

 

Предварительные требования 

• ПО ProLink II установлено и лицензировано на Вашем ПК.  

• Одно из следующего:  

− конвертор RS-232 – Bell 202  

− конвертор USB – Bell 202  

• Доступный последовательный или USB порт  

• Адаптеры (при необходимости), например 9-25 пин.  

 

Процедура 

1. Подключите конвертор сигналов к последовательному или USB порту.   

2. Чтобы подключиться непосредственно к клеммам преобразователя:  

a. Снимите крышку преобразователя для доступа к отделению подключения кабелей.  

b. Подключите выводы конвертора сигналов к клеммам 1 и 2. 

 

Полезный совет 

Подключение HART не чувствительно к полярности. Не имеет значения, какой вывод 
Вы подключите, к какой клемме. 

 

c. При необходимости, добавьте сопротивление.  

 

Важно 

Подключение HART/Bell 202 требует падения напряжения в 1 Вольт. Для достижения 
этого значения, добавьте сопротивление 250-600 Ом. 
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Рисунок B-2:     Подключение к клеммам преобразователя 

 
A. ПК  
B. Конвертор сигналов  
С. Сопротивление 250-600 Ом  
D. Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 

 

3. Для подключения к точке локального контура 

a. Подключите выводы конвертора сигналов к любой точке контура.  

b. При необходимости, добавьте сопротивление.  

 

Важно 

Подключение HART/Bell 202 требует падения напряжения в 1 Вольт. Для достижения 
этого значения, добавьте сопротивление 250-600 Ом. 
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Рисунок B-3:     Подключение к локальному контуру 

 
A. ПК  
B. Конвертор сигналов  
С. Комбинация сопротивлений R1, R2 и R3, соответствующая требованиям HART коммуникации.  
D. Распределённая система управления или ПЛК  
E.  Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 

 

 

4. Для подключения к моноканальной сети HART: 

c. Подключите выводы конвертора сигналов к любой точке сети.  

d. При необходимости, добавьте сопротивление.  

 

Важно 

Подключение HART/Bell 202 требует падения напряжения в 1 Вольт. Для достижения 
этого значения, добавьте сопротивление 250-600 Ом. 
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Рисунок B-4:     Подключение к моноканальной сети 

 
A. Конвертор сигналов  
B. Сопротивление 250-600 Ом  
С. Устройства сети  
D. Мастер-устройство  
 

5. Запустите ProLink II.  

6. Выберите Connection > Connect to Device.  

7. Установите Protocol в значение HART Bell 202. 

  

Полезный совет 

Подключение HART/Bell 202 использует стандартные параметры. Нет необходимости 
конфигурировать их здесь. 

 

8. При использовании конвертора сигналов USB, разрешите Converter Toggles RTS. 

9. Установите Address/Tag в значение, соответствующее сконфигурированному адресу опро-
са преобразователя.  

Полезные советы 

• Если Вы впервые связываетесь с преобразователем, используйте адрес по умолча-
нию: 0.  

• Если вы находитесь не в условиях моноканальной сети HART, адрес опроса обыч-
но оставляют в значении по умолчанию.  

• Если Вам неизвестен адрес преобразователя, щёлкните кнопкой мыши по Poll (оп-
рос). Программа проведёт опрос сети и выдаст список всех обнаруженных преобра-
зователей.  

 

10. Установите значение COM Port в значение PC COM, используемое для этого подключе-
ния.  

11. Установите Master в соответствующее значение.  

Вариант Описание 

Secondary Используйте, если в сети есть другой хост, например система управления. 

Primary Используйте, если в сети нет другого хоста. Коммуникатор не является 
хостом. 
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12. Щёлкните кнопкой мыши по Connect.  

Требуется помощь?  При появлении сообщения об ошибке: 

• Проверьте адрес HART преобразователя.  

• Убедитесь, что используете специфицированный COM порт.  

• Проверьте физическое подключение ПК и преобразователя.  

• Увеличьте или уменьшите сопротивление.  

• Убедитесь в отсутствии конфликта с другим мастером HART.  

 

 

 

 

B.2.4 Подключение HART/RS-485 
 

Вы можете подключиться непосредственно к клеммам RS-485 преобразователя или к любой 
точке сети. 

 ПРЕДУПРЕЖДЕНИЕ! 

При нахождении преобразователя в опасной зоне, не используйте подключение непосред-
ственно к клеммам преобразователя. Подключение непосредственно к клеммам преобра-
зователя требует открытия отделения подключения кабелей, что при подаче питания на 
преобразователь может привести к взрыву. При нахождении преобразователя в опасной 
зоне, используйте подключение, не требующее открытия отделения подключения кабе-
лей.  

 

Предварительные требования 

• ПО ProLink II установлено и лицензировано на Вашем ПК.  

• Одно из следующего:  

− конвертор RS-232 – RS-485  

− конвертор USB – RS-485 

• Доступный последовательный или USB порт  

• Адаптеры (при необходимости), например 9-25 пин.  

 

Процедура 

1. Подключите конвертор сигналов к последовательному или USB порту.   

2. Чтобы подключиться непосредственно к клеммам преобразователя:  

a. Снимите крышку преобразователя для доступа к отделению подключения кабелей.  

b. Подключите выводы конвертора сигналов к клеммам 5 (RS-485/A) и 6 (RS-485/B). 

 

Полезный совет 

Подключение HART не чувствительно к полярности. Не имеет значения, какой вывод 
Вы подключите, к какой клемме. 
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Рисунок B-5:     Подключение к клеммам преобразователя 

 
A. ПК  
B. Конвертор сигналов  
С. Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 
 

 

 

3. Для подключения к сети RS-485:  

a. Подключите выводы конвертора сигналов к любой точке сети.  

b. При необходимости, добавьте сопротивление.  
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Рисунок B-6:     Подключение к сети 

 
A. ПК  
B. Конвертор сигналов  
С. При необходимости, сопротивления 120 Ом, ½ Вт по обеим концам сегмента  
D. Распределённая система управления или ПЛК  
E.  Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
  
 
Примечание 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 
 

 

4. Запустите ProLink II.  

5. Выберите Connection > Connect to Device.  

6. Установите параметры коммуникации в значения, сконфигурированные в преобразовате-
ле.   

Если преобразователь не был сконфигурирован, используйте значения по умолчанию, по-
казанные здесь. 

Таблица B-1:     Значения параметров соединения HART/RS-485 по умолчанию 

Параметр Значение по умолчанию 

Protocol HART 

Baud 1200 

Parity Odd 

Stop Bits 1 

Address 0 

 

Полезный совет 

Если Вам не известны установки параметров коммуникации, Вы можете подключиться 
по порту обслуживания, всегда использующему установки по умолчанию, или другое 
средство коммуникации для просмотра или изменения установок. 

 

7. Установите значение COM Port в значение PC COM, используемое для этого подключе-
ния.  

8. Установите Master в соответствующее значение.  
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Вариант Описание 

Secondary Используйте, если в сети есть другой хост, например система управления. 

Primary Используйте, если в сети нет другого хоста. Коммуникатор не является 
хостом. 

 

9. Щёлкните кнопкой мыши по Connect. 

Требуется помощь?   При появлении сообщения об ошибке: 

• Проверьте адрес HART преобразователя.  

• Убедитесь, что используете специфицированный COM порт.  

• Проверьте физическое подключение ПК и преобразователя.  

• Убедитесь в отсутствии конфликта с другим мастером HART. 

• При большой длине линии связи или при влиянии шума от внешнего источника на 
сигнал, установите сопротивления 120 Ом, ½ Вт параллельно выходу с обеих сторон 
коммуникационного сегмента. 

 

 

B.2.5 Подключение Modbus/RS-485 
 

Вы можете подключиться непосредственно к клеммам RS-485 преобразователя или к любой 
точке сети. 

 ПРЕДУПРЕЖДЕНИЕ! 

При нахождении преобразователя в опасной зоне, не используйте подключение непосред-
ственно к клеммам преобразователя. Подключение непосредственно к клеммам преобра-
зователя требует открытия отделения подключения кабелей, что при подаче питания на 
преобразователь может привести к взрыву. При нахождении преобразователя в опасной 
зоне, используйте подключение, не требующее открытия отделения подключения кабе-
лей.   
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Предварительные требования 

• ПО ProLink II установлено и лицензировано на Вашем ПК.  

• Одно из следующего:  

− конвертор RS-232 – RS-485  

− конвертор USB – RS-485 

• Доступный последовательный или USB порт  

• Адаптеры (при необходимости), например 9-25 пин.  

 

Процедура 

1. Подключите конвертор сигналов к последовательному или USB порту.   

2. Чтобы подключиться непосредственно к клеммам преобразователя:  

a. Снимите крышку преобразователя для доступа к отделению подключения кабелей.  

b. Подключите выводы конвертора сигналов к клеммам 5 (RS-485/A) и 6 (RS-485/B). 

Полезный совет 

Обычно, но не всегда, чёрный вывод это 485/A, а красный вывод – RS-485/B. 
 

Рисунок B-7:     Подключение к клеммам преобразователя 

 
A. ПК  
B. Конвертор сигналов  
С. Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 

 

3. Для подключения к сети RS-485  

a. Подключите выводы конвертора сигналов к любой точке сети RS-485/  

b. При необходимости, добавьте сопротивление.  
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Рисунок B-8:     Подключение к сети 

 
A. ПК  
B. Конвертор сигналов  
С. При необходимости, сопротивления 120 Ом, ½ Вт по обеим концам сегмента  
D. Распределённая система управления или ПЛК  
E.  Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 
 

 

4. Запустите ProLink II.  

5. Выберите Connection > Connect to Device.  

6. Установите параметры коммуникации в значения, сконфигурированные в преобразовате-
ле.   

Если преобразователь не был сконфигурирован, используйте значения по умолчанию, по-
казанные здесь. 

Таблица B-2:     Значения параметров коммуникации Modbus/RS-485 по умолчанию 

Параметр Значение по умолчанию 

Protocol Modbus RTU 

Baud 9600 

Parity Odd 

Stop Bits 1 

Address 1 

 

Полезный совет 

Если Вам не известны установки параметров коммуникации, Вы можете подключиться 
по порту обслуживания, всегда использующему установки по умолчанию, или другое 
средство коммуникации для просмотра или изменения установок. 

 

7. Установите значение COM Port в значение PC COM, используемое для этого подключе-
ния.  

8. Установите Master в соответствующее значение.  
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Требуется помощь?  При появлении сообщения об ошибке: 

• Проверьте адрес Modbus преобразователя.  

• Убедитесь, что используете специфицированный COM порт.  

• Проверьте физическое подключение ПК и преобразователя.  

• Увеличьте или уменьшите сопротивление. 

• При большой длине линии связи или при влиянии шума от внешнего источника на 
сигнал, установите сопротивления 120 Ом, ½ Вт параллельно выходу с обеих сторон 
коммуникационного сегмента. 

• Убедитесь в отсутствии конкурентного подключения Modbus к преобразователю. 

 

 

B.3 Блок-схемы меню ProLink II 
 

Рисунок B-9:     Главное меню 

 
 

  



Использование ProLink II с преобразователем 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

288 

Рисунок B-10:     Главное меню (продолжение) 

 
 

  

*Информация об использовании Data Logger содержится в руководстве на ProLink II. 
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Рисунок B-11:     Меню конфигурирования 
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Рисунок B-12:     Меню конфигурирования (продолжение) 
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Рисунок B-13:     Меню конфигурирования (продолжение) 
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Рисунок B-14:     Меню конфигурирования (продолжение) 
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Рисунок B-15:     Меню конфигурирования (продолжение) 
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Рисунок B-16:     Меню конфигурирования (продолжение) 
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Рисунок B-17:     Меню конфигурирования (продолжение) 
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Рисунок B-18:     Меню конфигурирования (продолжение) 
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Приложение C  
Использование ProLink III с преобразователем 
 

Темы данного приложения 
• Основная информация о ProLink III 

• Подключение ProLink III 

• Блок-схемы меню ProLink III 

 

C.1 Основная информация о ProLink III 
ProLink III – это работающее под Windows ПО, предназначенное для конфигурирования и об-
служивания преобразователей Micro Motion. Оно предоставляет полный доступ к функциям и 
данным преобразователя. 

Требования ProLink III 

Для установки ProLink II необходимы: 

• Носитель с установочным пакетом ProLink III 

• Установочный набор ProLink III для Вашего типа подключения 

Для приобретения ProLink III и соответствующего установочного набора свяжитесь с Micro 
Motion. 

Документация ProLink III 

Инструкции данного руководства предполагают предварительное знакомство пользователя с 
ПО ProLink III или общее представление о программах Windows. Дополнительная информация 
по использованию ProLink III, содержится в руководстве по ProLink III (ProLink® III Software 
for Micro Motion® Transmitters: Installation and Use Manual). 

В большинстве случаев руководство по ProLink III устанавливается вместе с программой. 
Кроме того, оно доступно на CD с документацией Micro Motion и на сайте Micro Motion 
(www.micromotion.com). 

Свойства и функции ProLink II 

ПО ProLink III обеспечивает полную функциональность при конфигурировании и работе пре-
образователя. ProLink III предоставляет также дополнительные функции, включая: 

• Возможность сохранения конфигурации преобразователя в файле ПК, её перезагрузки в 
преобразователь или тиражирование по другим преобразователям.  

• Возможность ведения журнала данных специальных типов в файле ПК. 

• Возможность просмотра трендов различных типов данных на ПК 

• Возможность подключения и просмотра информации для более чем одного устройства.  

• Мастер подключения.  

 

Эти функции описаны в руководстве по ProLink III. Они не описываются в данном документе. 
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Сообщения ProLink III 

По мере использования ProLink III с преобразователем Micro Motion, Вы столкнётесь с раз-
личными сообщениями и замечаниями. В данном документе описываются не все сообщения и 
замечания. 

Важно 

Пользователь ответственен за реакцию на сообщения и замечания и за соответствие всем со-
общениям по безопасности. 

 

C.2 Подключение ProLink III 
 

Подключение ProLink III к преобразователю позволяет прочесть данные процесса, сконфигу-
рировать преобразователь и решить задачи обслуживания, поиска и устранения неисправно-
стей. 

 

C.2.1 Виды подключения ProLink III 
 

Для подключения ProLink III к преобразователю можно использовать различные типы под-
ключений. Выберите тип подключения, наиболее подходящий для Вашей сети и задач, кото-
рые Вы намерены решать. 

Преобразователь поддерживает следующие типы подключения ProLink III: 

• Подключение к порту обслуживания (service port)  

• Подключение HART/Bell 202 

• Подключение HART/RS-485 

• Подключение Modbus/RS-485 7-битное (Modbus ASCII) 

• Подключение Modbus/RS-485 8-битное (Modbus RTU) 

При выборе типа подключения, примите во внимание следующее: 

• При подключении к сервисному порту используются стандартные параметры, уже опре-
делённые в ProLink II, и поэтому Вам не надо их конфигурировать.  

• Подключение HART/Bell 202 использует стандартные параметры подключения HART, 
уже определённые в ProLink III. Адрес преобразователя – единственный параметр, кото-
рый Вам необходимо сконфигурировать. 

• Некоторые типы подключений требуют открытия отделений подключения кабелей или 
отделений подключения питания. Эти типы подключения должны использоваться только 
как временные и могут требовать дополнительных мер безопасности.  

• Подключения Modbus, включая подключение к сервисному порту, как правило, быстрее, 
чем подключения HART.  

• При использовании подключения HART, ProLink III не позволит открыть более одного 
окна одновременно. Это сделано для управления трафиком сети и оптимизации скорости. 

• Нельзя осуществить конкурентное подключение с использованием тех же самых клемм. 
Можно осуществить конкурентное подключение, если используются различные клеммы.  
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C.2.2 Подключение к порту обслуживания (service port) 
 

 ПРЕДУПРЕЖДЕНИЕ! 

При нахождении преобразователя в опасной зоне, не используйте подключение к порту 
обслуживания. Подключение к порту обслуживания требует открытия отделения под-
ключения кабелей, что при подаче питания на преобразователь может привести к взры-
ву. При нахождении преобразователя в опасной зоне, используйте подключение, не тре-
бующее снятия крышки преобразователя. 
 

Предварительные требования 

• ПО ProLink III установлено и лицензировано на Вашем ПК.  

• Одно из следующего:  

− конвертор RS-232 – RS-485  

− конвертор USB – RS-485  

• Доступный последовательный или USB порт  

• Адаптеры (при необходимости), например 9-25 пин.  

 

Процедура 

1. Подключите конвертор сигналов к последовательному или USB порту.  

2. Обеспечьте доступ к клеммам порта обслуживания:  

c. Снимите крышку преобразователя для доступа к отделению подключения кабелей.  

d. Открутите винт на откидной крышке с предупреждающей надписью и откройте отде-
ление подключения питания. 

3. Подключите выводы конвертора сигналов к клеммам 7 (485/A) и 8 (RS-485/.B) порта об-
служивания. 

 

Полезный совет 

Обычно, но не всегда, чёрный вывод это 485/A, а красный вывод – RS-485/B. 
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Рисунок C-1:     Подключение к порту обслуживания 

 
A. ПК  
B. Конвертор сигналов  
С. Клемма порта обслуживания 7 (RS-485/A)  
D. Клемма порта обслуживания 8 (RS-485/B)  
E.  Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 

 

4. Запустите ProLink III. 

5. Выберите Connection > Connect to Device.  

6. Установите Protocol в значение Service Port.  

 

Полезный совет 

Подключение по порту обслуживания использует стандартные параметры и стандарт-
ный адрес. Вам не надо конфигурировать их здесь. 

 

7. Установите значение COM Port в значение PC COM, используемое для этого подключе-
ния. 

8. Щёлкните кнопкой мыши по Connect.  

Требуется помощь?  При появлении сообщения об ошибке: 

• Поменяйте выводы местами и попробуйте снова.  

• Убедитесь в правильности определения COM порта.  

• Проверьте физическое подключение ПК и преобразователя.  

 

 

C.2.3 Подключение по HART/Bell 202 
 

Вы можете подключиться непосредственно к клеммам мА выхода преобразователя, к любой 
точке локального контура HART или к любой точке моноканальной сети HART. 
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 ПРЕДУПРЕЖДЕНИЕ! 

При нахождении преобразователя в опасной зоне, не используйте подключение непосред-
ственно к клеммам преобразователя. Подключение непосредственно к клеммам преобра-
зователя требует открытия отделения подключения кабелей, что при подаче питания на 
преобразователь может привести к взрыву. При нахождении преобразователя в опасной 
зоне, используйте подключение, не требующее открытия отделения подключения кабе-
лей. 
  

 

 ПРЕДУПРЕЖДЕНИЕ! 

Подключение непосредственно к клеммам мА выхода преобразователя может повлиять 
на мА выход. Если вы используете мА выход для регулирования расхода, перед подклю-
чением непосредственно к клеммам мА выхода преобразователя, переведите устройства 
в ручное управление. 

 

Предварительные требования 

• ПО ProLink III установлено и лицензировано на Вашем ПК.  

• Одно из следующего:  

− конвертор RS-232 – Bell 202  

− конвертор USB – Bell 202  

• Доступный последовательный или USB порт  

• Адаптеры (при необходимости), например 9-25 пин.  

 

Процедура 

1. Подключите конвертор сигналов к последовательному или USB порту.   

2. Чтобы подключиться непосредственно к клеммам преобразователя:  

a. Снимите крышку преобразователя для доступа к отделению подключения кабелей.  

b. Подключите выводы конвертора сигналов к клеммам 1 и 2. 

 

Полезный совет 

Подключение HART не чувствительно к полярности. Не имеет значения, какой вывод 
Вы подключите, к какой клемме. 

 

c. При необходимости, добавьте сопротивление.  

 

Важно 

Подключение HART/Bell 202 требует падения напряжения в 1 Вольт. Для достижения 
этого значения, добавьте сопротивление 250-600 Ом. 
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Рисунок C-2:     Подключение к клеммам преобразователя 

 
A. ПК  
B. Конвертор сигналов  
С. Сопротивление 250-600 Ом  
D. Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 

 

3. Для подключения к точке локального контура 

e. Подключите выводы конвертора сигналов к любой точке контура.  

f. При необходимости, добавьте сопротивление.  

 

Важно 

Подключение HART/Bell 202 требует падения напряжения в 1 Вольт. Для достижения 
этого значения, добавьте сопротивление 250-600 Ом. 
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Рисунок C-3:     Подключение к локальному контуру 

 
A. ПК  
B. Конвертор сигналов  
С. Комбинация сопротивлений R1, R2 и R3, соответствующая требованиям HART коммуникации.  
D. Распределённая система управления или ПЛК  
E.  Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 

 

 

4. Для подключения к моноканальной сети HART: 

a. Подключите выводы конвертора сигналов к любой точке сети.  

b. При необходимости, добавьте сопротивление.  

 

Важно 

Подключение HART/Bell 202 требует падения напряжения в 1 Вольт. Для достижения 
этого значения, добавьте сопротивление 250-600 Ом. 
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Рисунок C-4:     Подключение к моноканальной сети 

 
A. Конвертор сигналов  
B. Сопротивление 250-600 Ом  
С. Устройства сети  
D. Мастер-устройство  
 

5. Запустите ProLink III.  

6. Выберите Connection > Connect to Device.  

7. Установите Protocol в значение HART Bell 202. 

  

Полезный совет 

Подключение HART/Bell 202 использует стандартные параметры. Нет необходимости 
конфигурировать их здесь. 

 

8. При использовании конвертора сигналов USB, разрешите Converter Toggles RTS. 

9. Установите Address/Tag в значение, соответствующее сконфигурированному адресу опро-
са преобразователя.  

Полезные советы 

• Если Вы впервые связываетесь с преобразователем, используйте адрес по умолча-
нию: 0.  

• Если вы находитесь не в условиях моноканальной сети HART, адрес опроса обыч-
но оставляют в значении по умолчанию.  

• Если Вам неизвестен адрес преобразователя, щёлкните кнопкой мыши по Poll (оп-
рос). Программа проведёт опрос сети и выдаст список всех обнаруженных преобра-
зователей.  

 

10. Установите значение COM Port в значение PC COM, используемое для этого подключе-
ния.  

11. Установите Master в соответствующее значение.  

Вариант Описание 

Secondary Используйте, если в сети есть другой хост, например система управления. 

Primary Используйте, если в сети нет другого хоста. Коммуникатор не является 
хостом. 
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12. Щёлкните кнопкой мыши по Connect.  

Требуется помощь?  При появлении сообщения об ошибке: 

• Проверьте адрес HART преобразователя.  

• Убедитесь, что используете специфицированный COM порт.  

• Проверьте физическое подключение ПК и преобразователя.  

• Увеличьте или уменьшите сопротивление.  

• Убедитесь в отсутствии конфликта с другим мастером HART.  

 

 

 

 

C.2.4 Подключение HART/RS-485 
 

Вы можете подключиться непосредственно к клеммам RS-485 преобразователя или к любой 
точке сети. 

 ПРЕДУПРЕЖДЕНИЕ! 

При нахождении преобразователя в опасной зоне, не используйте подключение непосред-
ственно к клеммам преобразователя. Подключение непосредственно к клеммам преобра-
зователя требует открытия отделения подключения кабелей, что при подаче питания на 
преобразователь может привести к взрыву. При нахождении преобразователя в опасной 
зоне, используйте подключение, не требующее открытия отделения подключения кабе-
лей.  

 

Предварительные требования 

• ПО ProLink III установлено и лицензировано на Вашем ПК.  

• Одно из следующего:  

− конвертор RS-232 – RS-485  

− конвертор USB – RS-485 

• Доступный последовательный или USB порт  

• Адаптеры (при необходимости), например 9-25 пин.  

 

Процедура 

1. Подключите конвертор сигналов к последовательному или USB порту.   

2. Чтобы подключиться непосредственно к клеммам преобразователя:  

a. Снимите крышку преобразователя для доступа к отделению подключения кабелей.  

b. Подключите выводы конвертора сигналов к клеммам 5 (RS-485/A) и 6 (RS-485/B). 

 

Полезный совет 

Подключение HART не чувствительно к полярности. Не имеет значения, какой вывод 
Вы подключите, к какой клемме. 
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Рисунок C-5:     Подключение к клеммам преобразователя 

 
A. ПК  
B. Конвертор сигналов  
С. Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 
 

 

 

3. Для подключения к сети RS-485:  

a. Подключите выводы конвертора сигналов к любой точке сети.  

b. При необходимости, добавьте сопротивление.  
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Рисунок C-6:     Подключение к сети 

 
A. ПК  
B. Конвертор сигналов  
С. При необходимости, сопротивления 120 Ом, ½ Вт по обеим концам сегмента  
D. Распределённая система управления или ПЛК  
E.  Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
  
 
Примечание 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 
 

 

4. Запустите ProLink II.  

5. Выберите Connection > Connect to Device.  

6. Установите параметры коммуникации в значения, сконфигурированные в преобразовате-
ле.   

Если преобразователь не был сконфигурирован, используйте значения по умолчанию, по-
казанные здесь. 

Таблица C-1:     Значения параметров коммуникации HART/RS-485 по умолчанию 

Параметр Значение по умолчанию 

Protocol HART 

Baud 1200 

Parity Odd 

Stop Bits 1 

Address 0 

 

Полезный совет 

Если Вам не известны установки параметров коммуникации, Вы можете подключиться 
по порту обслуживания, всегда использующему установки по умолчанию, или другое 
средство коммуникации для просмотра или изменения установок. 

 

7. Установите значение COM Port в значение PC COM, используемое для этого подключе-
ния.  

8. Установите Master в соответствующее значение.  
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Вариант Описание 

Secondary Используйте, если в сети есть другой хост, например система управления. 

Primary Используйте, если в сети нет другого хоста. Коммуникатор не является 
хостом. 

 

9. Щёлкните кнопкой мыши по Connect. 

Требуется помощь?   При появлении сообщения об ошибке: 

• Проверьте адрес HART преобразователя.  

• Убедитесь, что используете специфицированный COM порт.  

• Проверьте физическое подключение ПК и преобразователя.  

• Убедитесь в отсутствии конфликта с другим мастером HART. 

• При большой длине линии связи или при влиянии шума от внешнего источника на 
сигнал, установите сопротивления 120 Ом, ½ Вт параллельно выходу с обеих сторон 
коммуникационного сегмента. 

 

 

C.2.5 Подключение Modbus/RS-485 
 

Вы можете подключиться непосредственно к клеммам RS-485 преобразователя или к любой 
точке сети. 

 ПРЕДУПРЕЖДЕНИЕ! 

При нахождении преобразователя в опасной зоне, не используйте подключение непосред-
ственно к клеммам преобразователя. Подключение непосредственно к клеммам преобра-
зователя требует открытия отделения подключения кабелей, что при подаче питания на 
преобразователь может привести к взрыву. При нахождении преобразователя в опасной 
зоне, используйте подключение, не требующее открытия отделения подключения кабе-
лей.   
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Предварительные требования 

• ПО ProLink III установлено и лицензировано на Вашем ПК.  

• Одно из следующего:  

− конвертор RS-232 – RS-485  

− конвертор USB – RS-485 

• Доступный последовательный или USB порт  

• Адаптеры (при необходимости), например 9-25 пин.  

 

Процедура 

1. Подключите конвертор сигналов к последовательному или USB порту.   

2. Чтобы подключиться непосредственно к клеммам преобразователя:  

a. Снимите крышку преобразователя для доступа к отделению подключения кабелей.  

b. Подключите выводы конвертора сигналов к клеммам 5 (RS-485/A) и 6 (RS-485/B). 

Полезный совет 

Обычно, но не всегда, чёрный вывод это 485/A, а красный вывод – RS-485/B. 
 

Рисунок C-7:     Подключение к клеммам преобразователя 

 
A. ПК  
B. Конвертор сигналов  
С. Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 

 

3. Для подключения к сети RS-485  

a. Подключите выводы конвертора сигналов к любой точке сети RS-485/  

b. При необходимости, добавьте сопротивление.  
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Рисунок C-8:     Подключение к сети 

 
A. ПК  
B. Конвертор сигналов  
С. При необходимости, сопротивления 120 Ом, ½ Вт по обеим концам сегмента  
D. Распределённая система управления или ПЛК  
E.  Преобразователь с открытыми отделениями подключения кабелей и отделения подключения питания  
 
Примечание 
На рисунке показано подключение к последовательному порту. Подключение к USB также поддерживается. 
 

 

4. Запустите ProLink III.  

5. Выберите Connection > Connect to Device.  

6. Установите параметры коммуникации в значения, сконфигурированные в преобразовате-
ле.   

Если преобразователь не был сконфигурирован, используйте значения по умолчанию, по-
казанные здесь. 

Таблица C-2:     Значения параметров коммуникации Modbus/RS-485 по умолчанию 

Параметр Значение по умолчанию 

Protocol Modbus RTU 

Baud 9600 

Parity Odd 

Stop Bits 1 

Address 1 

 

Полезный совет 

Если Вам не известны установки параметров коммуникации, Вы можете подключиться 
по порту обслуживания, всегда использующему установки по умолчанию, или другое 
средство коммуникации для просмотра или изменения установок. 

 

7. Установите значение COM Port в значение PC COM, используемое для этого подключе-
ния.  

8. Установите Master в соответствующее значение.  
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Требуется помощь?  При появлении сообщения об ошибке: 

• Проверьте адрес Modbus преобразователя.  

• Убедитесь, что используете специфицированный COM порт.  

• Проверьте физическое подключение ПК и преобразователя.  

• Увеличьте или уменьшите сопротивление. 

• При большой длине линии связи или при влиянии шума от внешнего источника на 
сигнал, установите сопротивления 120 Ом, ½ Вт параллельно выходу с обеих сторон 
коммуникационного сегмента. 

• Убедитесь в отсутствии конкурентного подключения Modbus к преобразователю. 

 

 

C.3 Блок-схемы меню ProLink III 
 

Рисунок C-9:     Device Tools: Main -Главное меню 
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Рисунок C-10:     Device Tools: Configuration (with Weights & Measures) – Конфигурирование (с приложе-
нием коммерческого учёта) 

                                                                    
 

 

Рисунок C-11:     Device Tools: Configuration (with Concentration Measurement) – конфигурирование (с 
приложением измерения концентрации) 
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Рисунок C-12:     Configuration: Process Measurement (with Petroleum Measurement) – конфигурирование  
(с приложением измерения нефти по API( 

                            
 

 

Рисунок C-13:     Configuration: I/O –конфигурирование вв/выв 
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Рисунок C-14:     Configuration: Transmitter Display – конфигурирование дисплея преобразователя 

                                  
 

 

Рисунок C-15:     Configuration: Events – конфигурирование событий 
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Рисунок C-16:     Configuration: Communications –конфигурирование коммуникаций 

                           
 

 

Рисунок C-17:     Configuration: Informational Parameters – конфигурирование информационных парамет-
ров 
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Рисунок C-18:     Device Tools: Calibration - калибровка 

                                                   
 

 

Рисунок C-19:     Calibration: Density Calibration – калибровка плотности 
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Рисунок C-20:     Calibration: Temperature Calibration калибровка температуры 

            
 

 

Рисунок C-21:     Device Tools: Configuration Transfer – перенос конфигурации 
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Рисунок C-22:     Diagnostics: Testing - диагностика, тестирование 

                           
 

 

Рисунок C-23:     Diagnostics: Meter Verification – диагностика, контроль метрологических характеристик 
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Рисунок C-24:     Device Tools: Trending - тренды 
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Приложение D  
Использование Полевого Коммуникатора с преобразо-
вателем 
 

Темы данного приложения 
• Основная информация о Полевом Коммуникаторе 

• Подключение Полевого Коммуникатора 

• Блок-схемы меню Полевого Коммуникатора 

 

D.1 Основная информация о Полевом 
Коммуникаторе 

Полевой Коммуникатор – это ручной инструмент, предназначенный для конфигурирования 
различных приборов, включая преобразователи Micro Motion. Он предоставляет полный дос-
туп к функциям и данным преобразователя. 

Документация Полевого Коммуникатора 

Большинство инструкций данного руководства предполагает Ваше предварительное знакомст-
во с Полевым Коммуникатором и умение выполнять следующие задачи: 

• Включение Полевого Коммуникатора  

• Перемещение по меню Полевого Коммуникатора  

• Установка соединения с HART-совместимыми устройствами  

• Пересылка конфигурационных данных в устройство  

• Использование алфавитно-цифровой клавиатуры для ввода информации  

Если Вы не знакомы с этими задачами, перед использованием Полевого Коммуникатора озна-
комьтесь с соответствующим руководством. Руководство по использованию Полевого Комму-
никатора доступно на CD с документацией Micro Motion и на сайте Micro Motion. 

Описатели устройств (Device Description-DD) 

Для того чтобы Полевой Коммуникатор работал с вашим прибором, необходима установка 
соответствующего DD. Преобразователь Модели 2700 требует следующего DD HART:. 

Для просмотра описателей устройств (DD), установленных в Коммуникаторе: 

1. В меню приложения HART нажмите Utility > Available Device Descriptions.  

2. Листая список производителей (Scroll), выберите (Select) Micro Motion, затем пролистайте 
список установленных DD. 
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Если Micro Motion в списке отсутствует или отсутствует необходимый DD, воспользуйтесь ути-
литой Easy Upgrade Utility для установки необходимого DD или свяжитесь с Micro Motion. 

Меню Полевого Коммуникатора и сообщения  

Многие меню в данном руководстве начинаются с меню On-Line. Убедитесь в том, что Вы 
знаете как попасть в меню On-Line. 

При использовании Полевого Коммуникатора с преобразователями Micro Motion, Вы будете 
получать различные сообщения и замечания. В данном документе эти сообщения и замечания 
не описываются. 

 

Важно 

Пользователь ответственен за реакцию на сообщения и замечания и соответствие требованиям 
по безопасности. 

 

 

D.2 Подключение Полевого коммуникатора 
 

При подключении Полевого Коммуникатора к преобразователю Вы можете прочесть данные 
процесса, сконфигурировать преобразователь и решать задачи обслуживания и поиска и уст-
ранения неисправностей. 

Полевой Коммуникатор можно подключить к клеммам мА выхода преобразователя, к любой 
точке локального контура HART или к любой точке моноканальной сети HART. 

 

 ПРЕДУПРЕЖДЕНИЕ! 

Если преобразователь находится в опасной зоне, не подключайте Полевой Коммуника-
тор к клеммам мА выхода преобразователя. Это требует открытия отделения подключе-
ния кабелей, что в опасной зоне может привести к взрыву. 

 

Предварительные требования 

В Коммуникаторе должны быть установлены следующие HART DD:. 

 

Процедура 

1. Для подключения к клеммам преобразователя:  

a. Снимите крышку отделения подключения кабелей.  

b. Подключите выводы Полевого Коммуникатора к клеммам 1 и 2 преобразователя и, 
при необходимости, добавьте сопротивление.  

Полевой Коммуникатор подключается через сопротивление 250-600 Ом. 

 

Полезный совет 

Подключение HART не чувствительно к полярности. Не имеет значения, какой вы-
вод Вы подключите, к какой клемме. 
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Рисунок D-1:     Подключение Полевого Коммуникатора к клеммам преобра-
зователя 

 
A. Полевой Коммуникатор  
B. Сопротивление 250-600 Ом  
С. Преобразователь с открытыми отделениями подключения кабелей и от-
деления подключения питания  
 

 

2. Для подключения к точке локального контура HART, подсоедините выводы Полевого 
Коммуникатора к любой точке контура и при необходимости, добавьте сопротивление.  

Полевой Коммуникатор подключается через сопротивление 250-600 Ом.  

 

Рисунок D-2:     Подключение Полевого Коммуникатора к локальному контуру 
HART 

 
A. Полевой Коммуникатор  
B. Сопротивление 250-600 Ом  
С. Преобразователь с открытыми отделениями подключения кабелей и отделе-
ния подключения питания  
 

 

3. Для подключения к точке моноканальной сети HART, подсоедините выводы Полевого 
Коммуникатора к любой точке сети. 

 

 

  



Использование Полевого коммуникатора с преобразователем 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

324 

Рисунок D-3:     Подключение Полевого Коммуникатора к моноканальной сети 

 
A. Полевой Коммуникатор  
B. Сопротивление 250-600 Ом  
С. Приборы в сети  
D. Мастер-устройство  
 

 

4. Включите Полевой Коммуникатор и подождите появления главного меню на экране. 

5. При подключении к моноканальной сети:  

a. Установите Полевой Коммуникатор в режим опроса (poll).  

Выводятся все обнаруженные адреса. 

b. Введите адрес HART преобразователя.  

Адрес HART по умолчанию 0. Однако, в моноканальной сети адрес HART, возможно, 
был изменён. 

 

Дополнительная информация 

Чтобы попасть в главное меню, выберите HART Application > Online. Большая часть задач конфи-
гурирования, обслуживания и поиска и устранения неисправностей осуществляются из меню 
Online. 

 

Полезный совет 

Вам могут встретиться сообщения, связанные с DD или с активными предупреждениями. На-
жмите соответствующие кнопки для игнорирования сообщений и продолжения. 

 

D.3 Блок-схемы меню Полевого Коммуникатора 
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Рисунок D-4:     Меню On-Line 
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Рисунок D-5:     Обзорное меню 

 
 

  

*Выводится только при разрешённом  
приложении контроля метрологических 
характеристик 
**Выводится только при разрешённом 
приложении коммерческого учёта. Но-
мера меню подстраиваются соответст-
венно. 
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Рисунок D6:     Меню конфигурирования 
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Рисунок D-7:     Меню ручных установок 

 
 

  

*Выводится только при разрешённом 
приложении измерения нефти по API. 
Номера меню подстраиваются соответ-
ственно. 
**Выводится только при разрешённом 
приложении измерения концентрации.  
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Рисунок D-8:     Меню ручных установок: Характеризация 
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Рисунок D-9:     Меню ручных установок: Измерения 

 
 

  

*Выводится только при Volume Flow Type = 
Liquid. Номера меню подстраиваются соот-
ветственно. 



Использование Полевого коммуникатора с преобразователем 

Руководство по конфигурированию и применению 

 

331 

Рисунок D-10:     Меню ручных установок: Измерения (продолжение) 

 
 

  

*Выводится только при разрешённом 
приложении измерения нефти по API. 
Номера меню подстраиваются соответ-
ственно. 
**Выводится только при разрешённом 
приложении измерения концентрации.  
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Рисунок D-11:     Меню ручных установок: Дисплей 

 
 

  

*Выводится только при разрешённом 
параметре Auto Scroll. Номера меню 
подстраиваются соответственно. 
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Рисунок D-12:     Меню ручных установок: Вв/Выв 

 
 

  

*Варианты зависят от метода масштаби-
рования частотного выхода  
(FO Scaling Method). 
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Рисунок D-13:     Меню ручных установок: Вв/Выв (продолжение) 
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Рисунок D-14:     Меню установки предупреждений 
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Рисунок D-15:     Меню инструментов обслуживания 

 
 

  

*Выводится только при разрешённом приложе-
нии измерения нефти по API. Номера меню 
подстраиваются соответственно. 
**Выводится только при разрешённом прило-
жении измерения концентрации. Номера меню 
подстраиваются соответственно. 
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Рисунок D-16:     Меню инструментов обслуживания: Переменные 

 
 

  

*Если Volume Flow Type = GSV, отображаются перемен-
ные GSV. 

**Выводится только при разрешённом приложении изме-
рения нефти по API. Номера меню подстраиваются соот-
ветственно. 

***Выводится только при разрешённом приложении из-
мерения концентрации. Номера меню подстраиваются 
соответственно. 

**** Выводится только при разрешённом приложении 
коммерческого учёта. 
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Рисунок D-17:     Меню инструментов обслуживания: Переменные (продолжение) 

 
 

  

*Выводится только при разрешённом приложе-
нии измерения нефти по API. Номера меню 
подстраиваются соответственно. 

**Выводится только при разрешённом прило-
жении измерения концентрации. Номера меню 
подстраиваются соответственно. 
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Рисунок D-18:     Меню инструментов обслуживания: Обслуживание 

 
 

 

 

  

*Выводится только при разрешённом приложении 
контроля метрологических характеристик. 

**Выводится только при разрешённом приложении 
контроля метрологических характеристик (Smart Me-
ter Verification). Для более ранних версий – Meter Ver-
ification Method). 
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Рисунок D-19:     Меню инструментов обслуживания: Имитация 

                                            
 

 

 

 

 

 

 

 

 

*Варианты зависят от конфигурирования Каналов. 
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Приложение E  
Значения по умолчанию и диапазоны 
 

E.1 Значения по умолчанию и диапазоны 
 

Значения по умолчанию и диапазоны представляют типичную заводскую конфигурацию пре-
образователя. В зависимости от способа заказа преобразователя, некоторые значения могут 
быть сконфигурированы на заводе и не представлены в данной таблице. 

 

Таблица E-1:     Значения по умолчанию и диапазоны преобразователя 

Тип Параметр По умолчанию Диапазон Примечания 

Flow (Расход) Flow direction (Направле-
ние потока) 

Forward 
(Прямое) 

  

Flow damping  (Демпфи-
рование ) 

0.8 sec (сек) (1) 0.0 – 60.0 
sec (сек) 

Введенное пользователем значение 
округляется в меньшую сторону до 
ближайшего из списка значений. В 
режиме Special значения в списке 
равны 1/5 от нормальных. Для га-
зовых применений Micro Motion 
рекомендует значение 2.56. 

Flow calibration factor (Ка-
либровочный коэффици-
ент) 

1.00005.13  Для сенсоров Т-Серии, значение 
представляет сочлененные FCF и 
FT.  

Mass flow units (Единицы 
измерения массового рас-
хода) 

g/s (г/с)   

Mass flow cutoff (Отсечка 
массового расхода) 

0.0 g/s (г/с)  Рекомендуемая установка: 0.5% от 
максимального расхода сенсора. 

Volume flow type (Тип 
расхода) 

Liquid (Жид-
кость) 

  

Volume flow units (Едини-
цы измерения объёмного 
расхода) 

L/s (л/с)   

Volume flow cutoff (От-
сечка объёмного расхода) 

0.0 L/s (л/с) 0.0 – x L/s 
(л/с) 

х получается умножением FCF на 
0.2 при использовании единиц из-
мерения L/s. 

Meter factors 
(Коэффици-
енты) 

Mass factor (Массового 
расхода) 

1.00000   

Density factor (Плотности) 1.00000   

Volume factor (Объёмного 
расхода) 

1.00000   

Density  
(Плотность) 

Density damping (Демп-
фирование) 

1.6 sec (сек) 0.0 – 60.0 
sec (сек) 

Введенное пользователем значение 
округляется до ближайшего из 
списка. 

 

 

(1) В специальном режиме, значение по умолчанию 0.64сек. 



Значения по умолчанию и диапазоны 

Преобразователи Micro Motion Модели 2700 с аналоговыми выходами 

 

342 

Таблица E-1:     Значения по умолчанию и диапазоны преобразователя (продолжение) 

Тип Параметр По умолчанию Диапазон Примечания 

 Density  units (Единицы 
измерения  плотности) 

g/cm3 (г/см3)   

Density cutoff (Отсечка) 0.2 g/cm3 (г/см3) 0.0 – 0.5 g/cm3 (г/см3)  

D1 0 g/cm3 (г/см3)   

D2 1 g/cm3 (г/см3)   

K1 1000 µsec (мксек) 1000 – 50,000 µsec 
(мксек) 

 

K2 50,000 µsec (мксек) 1000 – 50,000 µsec 
(мксек) 

 

FD 0.00000   

Temp Coefficient (Тем-
пер. коэффициент) 

4.44   

Slug flow  
(Пробковое 
течение) 

Slug flow low limit 
(Нижний предел) 

0.0 g/cm3 (г/см3) 0.0 – 10.0 g/cm3 (г/см3)  

 Slug flow high limit 
(Верхний предел) 

5.0 g/cm3 (г/см3) 0.0 – 10.0 g/cm3 (г/см3)  

Slug duration (Длитель-
ность) 

0.0 sec (сек) 0.0 – 60.0 sec (сек)  

Temperature 
(Температура) 

Temperature damping 
(Демпфирование) 

4.8 sec (сек) 0.0 – 38.4 sec (сек) Введенное значение ок-
ругляется в меньшую 
сторону до ближайшего 
из списка. 

Temperature units (Ед. 
изм.  температуры) 

Deg C (ºС)   

Temperature calibration 
factor (Калибровочный 
коэффициент) 

1.00000T0.0000   

Pressure  

(Давление) 

Pressure units (Ед. изме-
рения давления) 

PSI (фунт/дюйм2)   

Flow factor (Поправочн. 
коэфф. по расходу) 

0.00000   

Density factor (Поправ. 
коэфф. по плотн.) 

0.00000   

Cal pressure (Давление 
калибровки) 

0.00000   

Сенсор  

Т-Серии 

D3 0.00000   

D4 0.00000   

K3 0.00000   

K4 0.00000   

FTG 0.00000   

FFQ 0.00000   

DTG 0.00000   

DFQ1 0.00000   

DFQ2 0.00000   
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Таблица E-1:     Значения по умолчанию и диапазоны преобразователя (продолжение) 

Тип Параметр По умолчанию Диапазон Примечания 

Special units  

(Спец. ед. 
изм.) 

Base mass units (Базовые 
ед. изм массы) 

g (грамм)   

Base mass time (Базовые ед. 
изм времени) 

Sec (сек)   

Mass flow conversion factor 
(Коэффициент преобразо-
вания для массового расхо-
да) 

1   

Base volume unit (Базовые 
ед. изм объёма) 

L   

Base volume time(Базовые 
ед. изм. времени) 

Sec (сек)   

Volume flow conversion 
factor  (Коэфф. преобразо-
вания для объёмного рас-
хода) 

1   

Variable map-
ping 

(Схема пере-
менных) 

Primary variable (Первая 
переменная) 

Mass flow 
(Массовый 
расход) 

  

Secondary variable (Вторая 
переменная) 

Density (Плот-
ность) 

  

Tertiary variable (Третья 
переменная) 

Mass flow 
(Массовый 
расход) 

  

Quaternary variable (Чет-
вёртая переменная) 

Volume flow 
(Объёмный 
расход) 

  

mA output 1 

(Первый мА  

выход) 

Primary variable (Первая 
переменная) 

Mass flow 
(Массовый рас-
ход) 

  

LRV -200.00000 g/s   

URV 200.00000 g/s   

AO cutoff (Отсечка) 0.00000 g/s   

AO added damping (Доба-
вочное демпфирование) 

0.00000 sec   

LSL -200 g/s  Только для чтения 

USL 200 g/s  Только для чтения 

MinSpan (Минимальная 
шкала) 

0.3 g/s  Только для чтения 

Fault action (Действие по 
ошибке) 

Downscale 
(Ниже нижней 
границы диапа-
зона) 

  

AO fault level – downscale AN: 2.0 mA 1.0 – 3.6 mA  
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Таблица E-1:     Значения по умолчанию и диапазоны преобразователя (продолжение) 

Тип Параметр По умолчанию Диапазон Примечания 

 AO fault level - upscale 22 mA 21.0 – 24.0 mA  

Last measured value timeout 
(Тайм-аут) 

0.00 sec   

mA output 2 

(Второй мА  

выход) 

Secondary variable (Вторая 
переменная) 

Density (Плот-
ность) 

  

LRV 0.00 g/cm3 

(г/см3) 
  

URV 10.00 g/cm3 

(г/см3) 
  

AO cutoff Not-A-Number 
(Нет) 

  

AO added damping 0.00000 sec   

LSL 0.00 g/cm3 

(г/см3) 
 Только для чтения 

USL 10.00 g/cm3 

(г/см3) 
 Только для чтения 

MinSpan 0.05 g/cm3 

(г/см3) 
 Только для чтения 

Fault action Downscale   

AO fault level – downscale AN: 2.0 mA 1.0 – 3.6 mA  

AO fault level - upscale 22 mA 21.0 – 24.0 mA  

Last measured value timeout 0.00 sec   

LRV 
(Нижняя гра-
ница диапа-
зона) 

Mass flow rate -200.000 g/s   

Volume flow rate -0.200 l/s   

Density 0.000 g/cm3   

Temperature -240.000˚C   

Drive gain 0.000%   

Gas standard volume flow -423.78 SCFM   

External temperature -240.000˚C   

External pressure 0.000 psi   

URV 
(Нижняя гра-
ница диапа-
зона) 

Mass flow 200.000 g/s   

Volume flow 0.200 l/s   

Density 10.000 g/cm3   

Temperature 450.000˚C   
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Таблица E-1:     Значения по умолчанию и диапазоны преобразователя (продолжение) 

Тип Параметр По умолчанию Диапазон Примечания 

 Drive gain 100.000%   

Gas standard volume flow 
rate 

423.78 SCFM   

External temperature 450.000˚C   

External pressure 100.000 psi   

Frequency 
output 

(Частотный 
выход) 

Tertiary variable (Третья 
переменная) 

Mass flow (Массовый рас-
ход) 

  

Frequency factor (Частота) 1,000.00 Hz (Гц) 0.001 – 
10,000.00 Гц 

 

Flow Rate factor (Соотв. 
Расход) 

1000 kg/min   

Frequency pulse width (Ши-
рина импульса) 

277 mSec 0 или 0.5 – 
277.5  ms 

 

Scaling method (Метод ) Freq=Flow (Част.=Расход)   

Frequency fault action  
(Действие по ошибке) 

Downscale   

Frequency fault level – up-
scale 

15,000 Hz (Гц) 10.0 – 15,000 
Гц 

 

Frequency output polarity 
(Полярность) 

Active high (Активный 
высокий) 

  

Last measured value timeout 0.0 sec 0.0 – 60.0 sec  

Discrete out-
put 
(Дискретный 
выход) 

Source Flow direction   

Fault indicator (Индикатор 
ошибки) 

None   

Power(Питание) Internal (Внутреннее)   

Polarity (Полярность) Active high (Активный 
высокий) 

  

Polarity (По-
лярность) 

Active low (Активный низ-
кий) 

   

Display Backlight on/off On   

 Backlight intensity 63 0-63  

 Refresh rate 200 ms 100-10000 ms  

 Variable 1 Mass flow rate   

 Variable 2 Mass total   

 Variable 3 Volume flow rate   

 Variable 4 Volume total   

 Variable 5 Density   

 Variable 6 Temperature   

 Variable 7 Drive gain   

 Variable 8-15 None   
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Таблица E-1:     Значения по умолчанию и диапазоны преобразователя (продолжение) 

Тип Параметр По умолчанию Диапазон Примечания 

 Display totalizer start/stop Disabled   

Display totalizer reset Disabled   

Display auto scroll Disabled   

Display offline menu Enabled   

Display offline password Disabled   

Display alarm menu Enabled   

Display acknowledge all 
alarms 

Enabled   

Offline password 1234   

Auto scroll rate 10 sec   

Digital  
communication 

Fault action None   

Fault timeout 0 sec 0.0 – 60.0 sec  

Modbus address 1   

Modbus ASCII support Enabled   

Floating-point byte order 3-4-1-2   
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Приложение F  
Компоненты преобразователя и подключение кабелей 
 

Темы данного приложения 
• Варианты подключения 

• Клеммы и заземление источника питания 

• Клеммы кабелей ввода/вывода (I/O) 

 

F.1 Варианты подключения 
 

Преобразователи Модели 1700 и 2700 могут быть установлены пятью различными способами, 
и лишь один из них соответствует Вашему конкретному варианту. 

• Интегральный – Преобразователь смонтирован непосредственно на сенсоре. Нет необ-
ходимости в отдельном монтаже преобразователя, достаточно подключить питание к ка-
белю вв/выв. 

 

Рисунок F-1:     Интегральный монтаж 

                                   
 

 

• Высокотемпературный гибкий кабелепровод – Некоторые высокотемпературные рас-
ходомеры поставляются с предустановленным гибким кабелепроводом между сенсором и 
преобразователем. Нет необходимости в монтаже каких-либо кабелей между сенсором и 
преобразователем, нужно лишь отдельно смонтировать электронный блок, подключить 
питание и кабели вв/выв к преобразователю. 

 

 

 

 

  

Преобразователь 

Сенсор 
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Рисунок F-2:     Монтаж с высокотемпературным гибким кабелепроводом 

                                   
 

Монтаж с высокотемпературным гибким кабелепроводом совпадает с 4-хпроводным уда-
лённым монтажом, однако расстояние между сенсором и преобразователем ограничено 
длиной гибкого кабелепровода. 

 

• 4-хпроводный удалённый монтаж – Преобразователь монтируется отдельно от сенсора. 
Необходимо смонтировать преобразователь отдельно от сенсора, подключить 4-
хпроводный кабель между преобразователем и сенсором и подключить питание и кабели 
вв/выв к преобразователю.  

 

Рисунок F-3:     4-хпроводный удалённый монтаж – крашенный алюминиевый 
корпус 

 
 

  

Преобразователь 

Базовый процес-
сор 

4-хпроводный 
кабель 

Сенсор 
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Рисунок F-4:     4-хпроводный удалённый монтаж – корпус из нержавеющей стали  

 
 

• 9-типровдный монтаж – Преобразователь и базовый процессор объединены в одну 
сборку, монтируемую отдельно от сенсора. Необходимо смонтировать сборку преобразо-
ватель/базовый процессор отдельно от сенсора, подключить 9-типроводный кабель между 
сборкой преобразователь/базовый процессор и сенсором и подключить питание и кабели 
вв/выв к преобразователю.  

 

 

 

 

  

Преобразователь 

4-хпроводный 
кабель 

Базовый процес-
сор 

Сенсор 
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Рисунок F-5:     9-типроводный удалённый монтаж 

 
 

• Удалённый базовый процессор с удалённым сенсором – При монтаже удалённого ба-
зового процессора с удалённым сенсором разделены все три компонента – преобразова-
тель, базовый процессор и сенсор – каждый из которых монтируется отдельно. 4-
хпроводный кабель соединяет преобразователь и базовый процессор, а 9-типроводный 
кабель соединяет базовый процессор и сенсор. 

 

 

 

  

Преобразователь 

Соединительная 
коробка 

9-типроводный 
кабель 

Сенсор 
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Рисунок F-6:     Монтаж удалённого базового процессора с удалённым сенсором 

 
 

 

F.2 Клеммы и заземление источника питания 
 

Рисунок F-7:     Клеммы подключения кабелей блока питания 

                                   
A. Откидная крышка 
B. Приборное заземление 
С. Клеммы блока питания (9 и 10) 

 

  

9-типроводный кабель 

Сенсор 

Соединительная коробка 

Базовый процессор 

4-хпроводный кабель 

Преобразователь 
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F.3 Клеммы кабелей ввода/вывода (I/O) 
 

Рисунок F-8:     Клеммы кабелей ввода/вывода (I/O) 

                                   
A. мА/HART 
B. Частотный выход или дискретный выход 
С. RS-485 
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Приложение G  
Хронология NE53 
 

G.1 Хронология NE53 
Дата Версия ПО Тип Изменения ПО Руково-

дство 

08/2000 1.х Расширение про-
граммного обеспече-
ния 

Добавление записи тэга устройства с ис-
пользованием Modbus 

3600204 А 

Корректировка про-
граммного обеспече-
ния 

Совершенствование коммуникации с HART 
Tri-Loop 

Добавление функции Индикация типа платы выходов на дисплее 
при подаче питания 

05/2001 2.х Расширение про-
граммного обеспече-
ния 

Добавление тревожного сообщения А106 
для индикации разрешения пакетного режи-
ма HART 

3600204 В 
3600647 А 

Добавление доступа к биту ошибки состоя-
ния преобразователя по Modbus 

Доступ к управлению пакетным режимом 
HART по Modbus 

Добавление поддержки преобразователя 
Модели 1700 

Добавление поддержки варианта искробезо-
пасного преобразователя 

Добавление поддержки конфигурирования 
единиц измерения переменных процесса 
массового расхода, объёмного расхода, 
плотности и температуры с дисплея 

Добавление поддержки назначения пере-
менных процесса миллиамперному и час-
тотному выходам с дисплея 

Корректировка про-
граммного обеспече-
ния 

Уточнение во взаимодействии установки 
цифрового выхода по ошибке и тайм-аутом 
последнего измеренного значения 

Добавление функции Возможность назначения уровня сигнала на 
возбуждающей катушке мА выходу 

Добавление компенсации давления по HART 

Возможность конфигурирования Канала В 
как дискретного выхода 

12/2001 3.х Расширение про-
граммного обеспече-
ния 

Добавление поддержки конфигурирования 
платы конфигурируемых вх/вых 

3600647 В 
3600785 А 
20000325 А 
20000325 В 
20000150 А 
20000150 В 
20000148 А 

Доступ к информации о версии с дисплея и 
по Modbus 

Конфигурирование отсечки по плотности 

Дополнительные переменные HART могут 
быть назначены QV 
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Дата Версия ПО Тип Изменения ПО Руково-
дство 

   Функция останова/запуска сумматоров с дисплея 
может быть разрешена или заблокирована 

 

Совершенствование приложения измерения неф-
тепродуктов (API) 

Доступ к Live zero с дисплея 

Расширение вариантов установок выхода по 
ошибке 

Новые температурные алгоритмы криогенных 
приложений 

Корректировка 
программного 
обеспечения 

Повышение стабильности частотного выхода и 
преобразование единиц измерения 

Улучшение сигнала объёмного расхода при обна-
ружении пробкового течения 

Улучшение обработки значений плотности и про-
цедур калибровки при условиях ошибки 

Изменения конфигурирования дисплея, экрана 
расхода и оптических переключателей 

Совершенствование коммуникации HART и па-
кетного режима 

Добавление функ-
ции 

Добавление приложения измерения нефтепродук-
тов (API) 

Добавление коммерческого учёта в плату конфи-
гурируемых вх/вых 

Добавление опроса по HART внешних давления и 
температуры 

06/2003 4.х Расширение про-
граммного обес-
печения 

Добавление поддержки преобразователя Модели 
1500 

20000325 С 
20000150 С 
3600647 С 
20000148 В 
20001715 А 

Расширение переменных, выводимых на дисплей 
преобразователя Модели 1700 

Корректировка 
программного 
обеспечения 

Улучшение обработки некоторых условий ошиб-
ки 

Уточнение работы калибровочных ячеек Modbus 

Уточнение во взаимодействии между некоторыми 
единицами измерения плотности и значениями 
отсечки по плотности 

Улучшение работы установок источника мА с 
дисплея 

Совершенствование опроса давления и темпера-
туры 

Совершенствование коммуникации с HART Tri-
Loop и др. 

Уточнение значения, возвращаемого регистрами 
Modbus при условии ошибки 

Добавление функ-
ции 

Доступ к дискретным значениям по Modbus 
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Дата Версия ПО Тип Изменения ПО Руково-
дство 

09/2006 5.х Расширение про-
граммного обеспече-
ния 

Назначение дискретному выходу реле рас-
хода 

20001715 В 

Конфигурирование индикации ошибки на 
дискретный выход 

Поддержка назначений различных действий 
на дискретный вход 

Добавление поддержки опроса светодиода 
состояния преобразователя по Modbus 

Расширение команд HART и Modbus 

Расширение компаратора до пяти конфигу-
рируемых событий 

Функция восстановления заводской конфи-
гурации 

Функция восстановления заводского нуля 

Расширение архива тревожных сообщений 

Избирательная защита конфигурационных 
данных 

Расширенный выбор назначений источника 
для мА выхода 

Расширение памяти для значений диапазона 
мА 

Расширение приложения коммерческого 
учёта для независимой реализации соответ-
ствия NTEP и OIML 

Корректировка про-
граммного обеспече-
ния 

Совершенствование дисплея для отображе-
ния данных с плавающей точкой 

Добавление функции Конфигурирование приоритета тревожного 
сообщения 

Функции стандартного объёмного расхода 
газа 

Доступность контроля метрологических ха-
рактеристик расходомера, как опции 

Выбор языка отображения дисплея 

09/2009 6.х Расширение про-
граммного обеспече-
ния 

Конфигурирование частотного выхода как 
дискретного выхода в преобразователях Се-
рии 1000 

20001715 ВA 

Возможность назначения дискретному вы-
ходу реле расхода в преобразователях Серии 
1000 

Возможность фиксирования Первой дис-
плейной переменной на назначение Первого 
мА выхода 

Конфигурирование метода масштабирования 
частотного выхода и связанных с ним пара-
метров с помощью дисплея 
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Дата Версия ПО Тип Изменения ПО Руково-
дство 

   Поочерёдный вывод на дисплей названия 
переменной, текущего значения с единицами 
измерения и температуры приведения для 
переменных приложений специального ис-
пользования измерения плотности и измере-
ния нефтепродуктов по API 

 

Корректировка про-
граммного обеспече-
ния 

Не допустимы следующие комбинации: 

• Действие по ошибке для мА выхода = 
None (нет) и действие по ошибке для 
цифрового выхода = None (нет) 

• Действие по ошибке для частотного вы-
хода = None (нет) и действие по ошибке 
для цифрового выхода = None (нет) 

Переменные дисплея, соответствующие объ-
ёмному расходу, автоматически переключа-
ются либо на жидкость, либо на стандарт-
ный объёмный расход газа (SGV), в соответ-
ствии с текущей установкой параметра Vol-
ume Flow Type (тип объёмного расхода) 

Добавление функции Конфигурирование гистерезиса реле расхода 

Добавление проверки нуля расходомера 
(Field verification Zero) в приложениях ком-
мерческого учёта 

Контрольная сумма ПО преобразователя и 
базового процессора может быть назначена 
дисплейной переменной и прочитана с по-
мощью ProLink II. 
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A 
API, См. приложение измерения нефтепродуктов 
 

C 
CTL   53 

D 
DD, См. коммуникатор HART, DD 

G 
GSV, См. измерение стандартного объёмного 
расхода газа 

M 
Modbus 

адрес   130 
дополнительная задержка ответа средств 

коммуникации   130 
конфигурирование цифровой коммуникации 

Modbus/RS-485   130 
порядок следования байтов в числах с 

плавающей точкой   130 

N 
NTEP 
См. приложение коммерческого учета 

O 
OIML 
См. приложение коммерческого учета 

P 
ProLink II    

блок-схемы меню   287 
обзор   273, 274 
подключение 

HART/Bell 202   276 
HART/RS-485   281, 305 
Modbus/RS-485   284 
начальное подключение   9 
сервисный порт   275 

типы подключения   274 
требования 273 

ProLink III    
блок-схемы меню   311 
обзор   297, 298 
подключение 

HART/Bell 202   300 
Modbus/RS-485   308 
начальное подключение   9 
сервисный порт   299 

подключение к преобразователю   298 

типы подключения   298 
требования   297, 298 

R 
Rate Factor   111 

А 
Автопрокрутка   81 
адрес 

адрес HART   124, 129 
адресModbus   130 

адрес опрашиваемого устройства, См. адрес 
Modbus 

адрес опроса, См. адрес HART 
алармы (тревожные сообщения) 

коды алармов   208 
конфигурирование действий при аларме   89 
отклик преобразователя   157 
поиск и устранение неисправностей   208 
приоритет алармов состояния 

варианты   91 
конфигурирование   90 

просмотр и подтверждение 
с помощью ProLink II   155 
с помощью ProLink III   156 
с помощью дисплея   152 
с помощью Полевого 

коммуникатора   156 
алармы состояния См. алармы 

Б 
базовые события, См. события 
блок-схемы меню    

ProLink II   287 
ProLink III   311 
дисплей   262 
Полевой коммуникатор   311 

В 
верхняя граница диапазона(URV)   102 
время отклика   89 

Г 
гистерезис   117 

Д 
дата   96 
двухфазный поток, См. измерение плотности, 

пробковое течение 
действие при ошибке 

влияние тайм-аута   90 
дискретные выходы   119 
мА выходы   107 
цифровая коммуникация   131 
частотные выходы   113 
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действие при ошибке для цифровой коммуникации 
131 

демпфирование по расходу 
взаимодействие с добавочным 

демпфированием   27 
влияние на измерение объёма   27 
конфигурирование   26 

демпфирование    
взаимодействие добавочного демпфирования 

и демпфирования по переменной 
процесса   106 

демпфирование по плотности   48 
демпфирование по расходу   26 
демпфирование по температуре   51 
добавочное демпфирование   105 
на мА выходах   105 

десятичные значения 
ввод с дисплея   254 
разрядность переменных дисплея   79 

детекторные катушки    
поиск и устранение неисправностей   240 
сбор данных   241 

диагностика 
имитация сенсора   135 
интеллектуальный контроль 

метрологических характеристик (Smart 
Meter Verification)   173 

тест контура 
с помощью ProLink II   230 
с помощью ProLink III   231 
с помощью дисплея   228 
с помощью Полевого коммуникатора   

233 
дискретные выходы    

действие при ошибке    
варианты   120 
конфигурирование 119 

источник    
варианты   115 
конфигурирование 115 

конфигурирование   114 
отображение ошибки   120 
полярность    

варианты   118 
конфигурирование 118 

реле расхода   117 
тест контура    

с помощью ProLink II   230 
с помощью ProLink III   231 
с помощью дисплея   228 
с помощью Полевого коммуникатора 

233 
дисплей    

блок-схемы меню   262 
доступ к меню системы   253 
значения с плавающей точкой   254 
значения сумматора и приложение 

коммерческого учета   164 
коды меню   259 
коды переменной процесса   257 
компоненты   251 
конфигурирование безопасности 

доступ к меню off-line   85 

доступ к меню алармов   85 
пароль доступа к меню off-line   85 
пароль доступа к меню алармов   85 

конфигурирование режимов дисплея 
автопрокрутка   81 
мигание светодиода состояния   82 
переменные дисплея   78 
подсветка   81 
разрядность дисплея   79 
частота обновления   80 
язык дисплея   77 

оптические переключатели   252 
представление в десятичной форме   254 
представление в экпоненциальной 

форме   254 
разрешение и запрет на действия оператора 

подтверждение всех алармов   84 
сброс сумматоров   83 
запуск и останов сумматоров   83 

состояния светодиода состояния   208 
добавочное демпфирование   105 
дополнительная задержка ответа средств 

коммуникации   130 
документация   4 

Е 
единицы измерения 

давление    
варианты   74 

массовый расход    
варианты   24 
конфигурирование   23 
специальные единицы   25 

объемный расход    
варианты   30 
конфигурирование   30 
специальные единицы   32 

плотность    
варианты   46 
конфигурирование   46, 48 

стандартный объёмный расход газа    
варианты   36 
конфигурирование   36 
специальные единицы   37 

температура    
варианты   51 
конфигурирование   51 

З 
заземление   351 

поиск и устранение неисправностей   228 
защита записи   21, 138 
значения по умолчанию   341 
значения с плавающей точкой, См. дисплей, 

значения с плавающей точкой 

И 
измерение массового расхода 

демпфирование по расходу   26 
единицы измерения    

варианты   24 
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конфигурирование 23 
конфигурирование   23 
м-фактор   192 
отсечка    

взаимодействие с отсечкой 
мА выхода   28 

влияние на измерение объёма   28 
конфигурирование   27 

поиск и устранение неисправностей   220 
измерение объёмного расхода 

влияние демпфирования по плотности   49 
влияние демпфирования по расходу   27 
влияние отсечки по массовому расходу   28 
влияние отсечки по плотности   50 
единицы измерения 

варианты   30 
конфигурирование   30 

конфигурирование   29 
м-фактор   192, 193 
отсечка 

взаимодействие с отсечкой 
аналогового выхода   33 

конфигурирование 33 
поиск и устранение неисправностей   220 
тип объёмного расхода   29 

измерение плотности 
демпфирование 

взаимодействие с добавочным 
демпфированием   50 

влияние на измерение объёма   49 
единицы измерения 

варианты   46 
конфигурирование   46 

конфигурирование   45 
м-фактор   192 
отсечка 

влияние на измерение объёма   50 
конфигурирование   50 

поиск и устранение неисправностей   222 
пробковое течение 

конфигурирование   47 
поиск и устранение 

неисправностей   238 
режим работы преобразователя   48 

измерение стандартного объёмного расхода 
газа   34 

влияние демпфирования по расходу   27 
влияние отсечки по массовому расходу   28 
единицы измерения    

варианты   36 
конфигурирование   36 

конфигурирование   34 
отсечка    

взаимодействие с отсечкой 
аналогового выхода   39 

конфигурирование   39 
стандартная плотность   35 
тип объёмного расхода   35 

измерение температуры 
демпфирование    

влияние на измерение 
технологических параметров 
процесса   52 

конфигурирование   50 
единицы измерения    

варианты   51 
конфигурирование   51 

конфигурирование   50 
поиск и устранение неисправностей   223 

измерение технологических параметров процесса 
влияние скорости расчетов   89 
влияние частоты обновления   87, 88 

имитация 
имитация сенсора    

с помощью ProLink II   135 
с помощью ProLink III   135 
с помощью Полевого 

коммуникатора   135 
имитация сенсора 

обзор   136 
поиск и устранение неисправностей   226 
с помощью ProLink II   135 
с помощью ProLink III   135 
с помощью Полевого коммуникатора   135 

инвентаризаторы    
запуск и останов   158 
сброс   161 

интеллектуальный контроль метрологических 
характеристик (Smart Meter Verification) 

автоматическое выполнение и планирование    
с помощью ProLink II   185 
с помощью ProLink III   185 
с помощью дисплея   184 
с помощью Полевого 

коммуникатора   186 
определение   173 
подготовка к тестированию   174 
проведение теста 

с помощью ProLink II   177 
с помощью ProLink III   178 
с помощью дисплея   175 
с помощью Полевого 

коммуникатора   179 
результаты теста 

интерпретирование   182 
просмотр с помощью ProLink II   177 
просмотр с помощью ProLink III   178 
просмотр с помощью дисплея   175 
просмотр с помощью Полевого 

коммуникатора   179 
содержание   179 

требования   174 
интерфейс преобразователя 

См.также дисплей 
компоненты   251 

информационные параметры   94 

К 
кабели 

заземление   351 
поиск и устранение 

неисправностей   228 
кабели блока питания  

поиск и устранение 
неисправностей   227 
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кабели сенсора 
поиск и устранение 

неисправностей   227 
клеммы блока питания   351 
клеммы вв/выв   352 

кабель блока питания 
поиск и устранение неисправностей   227 

кабель сенсора 
поиск и устранение неисправностей   227 

калибровка по воздуху, См. калибровка, плотность 
калибровка 

определение   173 
плотность D1 и D2 

обзор   194 
с помощью ProLink II   194 
с помощью ProLink III   196 
с помощью Полевого 

коммуникатора   197 
плотность D3 и D4 

обзор   199 
с помощью ProLink II   199 
с помощью ProLink III   200 
с помощью Полевого 

коммуникатора   201 
температура   203 

калибровка по воде, См. калибровка, плотность  
калибровка плотности, См. калибровка, плотность 
калибровка температуры, См. калибровка, 

температура 
калибровочное давление, См. компенсация по 

давлению 
калибровочный коэффициент по плотности, См. 

компенсация давления 
калибровочный коэффициент по расходу, См. 

компенсация давления 
катушки сенсора    

поиск и устранение неисправностей   241, 
242 

клеммы блока питания   351 
клеммы вв/выв   352 
коммерческий учёт, См. приложение 

коммерческого учёта 
коммуникатор HART 

DD   321 
HART/Bell 202 

конфигурирование   124 
подключение к Полевому 

коммуникатору   322 
HART/RS-485 

конфигурирование   129 
адрес   124, 129, 235 
контур   235 
пакетный режим   125, 236 
переменные 

варианты   127 
взаимодействие с выходами 

преобразователя   128 
конфигурирование   126 

режим токового контура   124, 235 
коммуникация, См. цифровая коммуникация 

протоколы   3 
компенсация давления    

единицы измерения давления 

варианты   74 
конфигурирование    

с помощью ProLink II   69 
с помощью Полевого 

коммуникатора   73 
обзор   69 

контроль метрологических характеристик, См. 
Интеллектуальный контроль метрологических 
характеристик 

контроль стабильности нуля (FZV), См. 
приложение коммерческого учета 

конфигурирование 
блок-схема 
восстановление заводской конфигурации 

с помощью ProLink II   22 
с помощью ProLink III   22 

время отклика   86 
дискретные выходы   114 
дисплей   77, 82, 85 
защита записи   21, 138 
значения по умолчанию   341 
измерение массового расхода   23 
измерение объёмного расхода   29 
измерение плотности   45 
измерение стандартного объёмного расхода 

газа   34 
измерение температуры   50 
информационные параметры   94 
каналы   99 
коммерческий учет, См. приложение 

коммерческого учета 
компенсация давления, См. компенсация 

давления 
мА выходы   100 
приложение измерения концентрации, См. 

приложение измерения концентрации 
приложение измерения нефти по API, См. 

приложение измерения нефти по API 
события    

базовые   121 
расширенные   121 

сохранение конфигурации   137 
цифровая коммуникация   124 
частотные выходы   108 

конфигурирование канала   99 
короткое замыкание 

поиск и устранение неисправностей   241 
коэффициент температурного расширения 

(TEC)   53 
кривая, См. приложение измерения концентрации 

Л 
локальный дисплей, См. дисплей 
локальный интерфейс оператора (LOI), См. 

дисплей 

М 
М-фактор, См. Поверка 
максимальная ширина импульса   112 
масштабирование 

мА выходы   102 
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частотные выходы   111 
материал сенсора   97 
материал футеровки сенсора   97 
матрица, См. приложение измерения концентрации 
меню конфигурирования off-line, См. дисплей 
меню алармов (тревожных сообщений), 

См. дисплей 
мертвая зона, См. гистерезис 
миллиамперные выходы    

действие при ошибке    
варианты   107 
конфигурирование   107 

добавочное демпфирование    
взаимодействие с демпфированием по 

плотности   50 
взаимодействие с демпфированием по 

расходу   27 
конфигурирование   105 

конфигурирование   100 
нижняя и верхняя границы диапазона    

значения по умолчанию   103 
конфигурирование   102 

отсечка аналогового выхода    
взаимодействие с отсечкой объёмного 

расхода   33 
конфигурирование   104 

переменная процесса    
варианты   101 
конфигурирование   100 

поиск и устранение 
неисправностей   224, 236 

тест контура    
с помощью ProLink II   230 
с помощью ProLink III   231 
с помощью дисплея   228 
с помощью Полевого 

коммуникатора   233 

Н 
направление потока 

поиск и устранение неисправностей   237 
Направление Потока 

варианты   41 
влияние на дискретные выходы   44 
влияние на мА выходы   41 
влияние на сумматоры и 

инвентаризаторы   45 
влияние на цифровую коммуникацию   44 
влияние на частотные выходы 44 
конфигурирование   40 

нижняя граница диапазона (LRV)   102 
ноль 

восстановление заводского нуля 
с помощью ProLink II   188 
с помощью ProLink III   189 
с помощью дисплея   187 
с помощью Полевого 

коммуникатора   191 
восстановление предыдущего значения нуля 

с помощью ProLink II   188 
с помощью ProLink III   189 
с помощью дисплея   187 

с помощью Полевого 
коммуникатора   191 

проверка нуля 
с помощью ProLink II   14 
с помощью ProLink III   15 

процедура 
с помощью ProLink II   188 
с помощью ProLink III   189 
с помощью дисплея   187 
с помощью Полевого 

коммуникатора   191 

О 
обслуживание заказчиков 

контакты   ii 
описатель   95 
опрос    

давление    
с помощью ProLink II   69 
с помощью Полевого 

коммуникатора   73 
температура 

приложение измерения концентрации 
      с помощью ProLink II   58 
      с помощью ProLink III   61 
      с помощью Полевого 

  коммуникатора   64 
приложение измерения нефти по API 
      с помощью ProLink II   53 
      с помощью ProLink III   54 
      с помощью Полевого 

  коммуникатора   56 
оптимизация LD   194, 196, 197 
оптические переключатели   252 
отсечка аналогового выхода   104 
отсечки    

взаимодействие отсечки аналогового выхода 
и отсечки переменной процесса   104 

массовый расход   27 
объемный расход   33 
отсечка аналогового выхода   104 
плотность   50 
поиск и устранение неисправностей   238 

П 
пакетный режим   125 
параметры калибровки, См. характеризация 
пароль    

доступа к меню алармов   85 
доступа к меню конфигурирования off-

line   85 
первая переменная (PV)   126 
переменные процесса 

См. также измерение массового расхода 
См. также измерение объёмного расхода 
См. также измерение плотности 
См. также измерение стандартного 

объёмного расхода газа 
См. также измерение температуры 
запись значений   149 
коды, используемые на дисплее   257 
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конфигурирование переменных дисплея   78 
просмотр значений   150 

период обновления   80 
пломба, См. приложение коммерческого учета 
плотность, См. также стандартная плотность 
поверка    

альтернативный метод для объёмного 
расхода   193 

определение   173 
стандартный метод   192 

подключение 
ProLink II 

типы   274 
ProLink III 

типы   298 
Полевой коммуникатор   322 
при запуске   9 

поиск и устранение неисправностей    
HART-коммуникации   235, 236 
алармы   208 
восстановление заводской конфигурации 

с помощью ProLink II   22 
с помощью ProLink III   22 

дискретные выходы   234, 237 
заземление   228 
измерение массового расхода   220, 237, 238 
измерение объёмного расхода   220, 237, 238 
измерение плотности   238 
измерение температуры   223 
кабели   227 
короткие замыкания   241, 242 
мА выходы   224, 236-238 
напряжение на детекторной катушке   240 
пробковое течение (двухфазный поток)   238 
радиочастотные помехи (RFI)   234 
светодиод состояния   208 
тестирование системы   226 
уровень сигнала на возбуждающей 

катушке   238, 239 
частотные выходы   225, 234, 237 

Полевой коммуникатор 
DD   321 
блок-схемы меню   324 
обзор   321, 322 
подключение к преобразователю   322 
подключение при запуске   9 

полярность 
дискретные выходы   118 
частотные выходы   110 

поправочный коэффициент по объему (VCF)   53 
порядок следования байтов в числах с плавающей 

точкой   130 
представление в десятичной форме, См. дисплей, 

представление в десятичной форме 
представление в экспоненциальной форме, См. 

дисплей, представление в экспоненциальной 
форме 

преобразователь 
заземление   351 
клеммы блока питания   351 
клеммы вв/выв   352 
код модели   3 
средства коммуникации и протоколы   3 

типы установки   347 
приложение измерения концентрации 

конфигурирование 
с помощью ProLink II   58 
с помощью ProLink III   61 
с помощью Полевого 

коммуникатора   64 
обзор   58 
производные переменные и расчетные 

переменные процесса   67 
стандартные матрицы   66 

приложение измерения нефти по API 
конфигурирование    

с помощью ProLink II   53 
с помощью ProLink III   54 
с помощью Полевого 

коммуникатора   56 
обзор   53 
таблицы API   57 

приложение коммерческого учёта 
аларм состояния A027: нарушение защиты   

139, 170 
варианты сброса сумматора   140, 143 
влияние на выходы 

NTEP   165 
OIML   166 

влияние на использование и 
функционирование 

NTEP   166 
OIML   167 

влияние на переменные процесса 
NTEP   165 
OIML   166 

данные процесса  
NTEP   164 
OIML   164 

замена базового процессора   171 
обзор   139, 140 
обзор использования   163 
опломбирование   140, 143 
регулирующие агентства   139 
режимы переключения 

с помощью ProLink II   169 
с помощью ProLink III   169 
с помощью возможности 

переключателя   170 
сравнение состояния вкл и выкл 

безопасности   139 
типы безопасности   139 
установка 

с помощью ProLink II   140 
с помощью ProLink III   143 

пробковое течение   См. измерение плотности, 
пробковое течение 

программная безопасность, См. приложение 
коммерческого учета 

производная переменная, См. приложение 
измерения концентрации 

протоколы   3 

Р 
радиочастотные помехи    
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поиск и устранение неисправностей   234 
расширенное использование измерения плотности, 

См. приложение измерения концентрации 
расширенные события, См. события 
режим токового контура   124, 125 
реле расхода   117 

С 
светодиод, См. светодиод состояния 
светодиод состояния   152, 208 
серийный номер сенсора   96 
скорость вычислений   89 
скорость прокрутки   81 
снятие защиты, См. Приложение коммерческого 

учёта 
события    

конфигурирование базовых событий   121 
конфигурирование расширенных 

событий   121 
модели событий   120 
действие при расширенном событии 

варианты   123 
конфигурирование   121 

сообщения по безопасности   ii 
сохранение конфигурации   137 
средства коммуникации   3 
специальные единицы измерения    

единица массового расхода   25 
единица объёмного расхода   32 
единица стандартного объёмного расхода 

газа   37 
стандартная плотность   35 
статус См. также алармы 
сумматоры    

запуск и останов    
разрешение функций дисплея   83 
совершение действия   158 

отображение значений и приложение 
коммерческого учёта   164 

переустановка    
варианты для приложения 

коммерческого учёта   140, 143 
разрешение функций дисплея   83 
совершение действия   160 

Т 
тайм-аут для отображения последнего 

действительного значения, См. тайм-аут при 
ошибке 

тайм–аут при ошибке 
влияние на действие при ошибке 
конфигурирование   90 

тест контура    
с помощью ProLink II   230 
с помощью ProLink III   231 
с помощью дисплея   228 
с помощью Полевого коммуникатора   233 

тестирование 
тест контура    

с помощью ProLink II   230, 231 
с помощью дисплея   228 

с помощью Полевого 
коммуникатора   233 

тестирование системы 
с помощью ProLink II   135 
с помощью Полевого 

коммуникатора   135 
тип объёмного расхода 

приложения измерения газа   35 
приложения измерения жидкости   29 

тип фланца сенсора   98 
типы установки 

4-хпроводный удаленный   347 
9-типроводный удаленный   347 
гибкий высокотемпературный кабелепровод   

347 
интегральный 347 
удаленный базовый процессор с удаленным 

преобразователем   347 
третья переменная (TV)   108, 126 

У 
уровень сигнала на возбуждающей катушке 

сбор данных   240 
поиск и устранение неисправностей   239 

Ф 
физическая безопасность, См. приложение 

коммерческого учета 

Х 
Характеризация    

параметры калибровки расхода   13 
параметры на сенсорных табличках   10 
параметры плотности   12 
процедура   10 

Ц 
цифровая коммуникация    

действие при ошибке для цифровой 
коммуникации 

варианты   132 
конфигурирование   131 

конфигурирование параметров HART/Bell 
202   124 

конфигурирование параметров HART/RS-
485   129 

конфигурирование параметров 
Modbus/RS-485   130 

Ч 
частота обновления 

дисплей   80 
Частота обновления  

влияние на измерение технологических 
параметров процесса   88 

конфигурирование   87 
несовместимые функции   88 

частотный коэффициент   111 
частотные выходы    
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действие при ошибке    
варианты   114 
конфигурирование   113 

конфигурирование   108 
максимальная ширина импульса   112 
метод масштабирования    

конфигурирование   111 
частота=расход   111 

переменная процесса    
варианты   109 
конфигурирование   108 

поиск и устранение неисправностей   225,237 
полярность    

варианты   110 
конфигурирование   110 

тест контура    

с помощью ProLink II   230 
с помощью ProLink III   231 
с помощью дисплея   228 
с помощью Полевого 

коммуникатора   233 
четвертая переменная (QV)   126 

Ш 
ширина импульса   112 

Я 
язык 

для дисплея   77 
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